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Introduction
Creating Voice Applications
1  Introduction

The OpenScape Fusion Application Builder, below referred to as Application 
Builder, is an administrative application for creating interactive voice applications 
for different deployment scenarios. You can use a voice application as voice 
dialog system. It enables the automatic playback of prompts, entering telephone 
keys via DMTF and making voice entries by means of speech recognition as well 
as forwarding to other subscribers. For example, prompts may inform the caller 
and help to navigate in the application. Entries via telephone keypad and via 
speech recognition enable the caller to find his/her way through the application 
and to enter data and names. A prompt text may read like this:

“Welcome to the XY company. If you would like to be connected to one of our 
assistants and know the extension, please push 1. If you would like to be 
connected with our hotline, please push 2. If you would...”

In this way callers can be routed to the appropriate conversation partner or routine 
jobs can be performed as automated procedures. Examples of voice application 
deployment scenarios are simple information provided via phone, automated 
reservations and orders or automated telephone exchanges.

1.1  Creating Voice Applications

The Application Builder offers the design interface for voice applications with 
which it can assemble and configure an application in the form of a callflow. The 
applications are later provided in the Media Server.

NOTICE:  The Media Server does not support the SIP NOTIFY 
mechanism for REFER method as described in RFC3515.

A call flow consists of function blocks, so-called controls, and the connections that 
create a transition between the controls. The control features may e.g. comprise: 
playing an audio file, executing a database query or setting up a telephone 
connection to a subscriber. The connections between the controls in the callflow 
indicate from which control a transition to another control is possible. When 
constructing a callflow the user determines which controls exist in the callflow and 
which controls are interconnected. Configuring means the user may set the 
properties of the contained controls. For example, he/she can set for a control to 
play audio files, which audio files to play and in which sequence. Furthermore, 
variables can be defined for storing data and grammar files applied for speech 
recognition. A voice application may contain several callflow pages in the callflow.

Thus, the callflow does not contain any information about the execution of the 
model, e. g. how audio files are accessed and how these audio files are forwarded 
to a PBX so that a caller can listen to these files. 

The result delivered by the Application Builder is packed in a *.mdp.zip. file 
and contains all data required for the execution. Besides the callflow of an appli-
cation with all its control and connection properties the files also represent the 
configuration of the voice applications and the properties of the variables, 
A31003-S50A0-U103-02-7619, 10/2020
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Introduction
Application Builder Features
prompts and grammar files used. You can import the exported archive file in other 
workspaces or use it as backup copy.

You can create and simulate the deployment packages for the application offline. 
Uploading the Deployment Packages is a separate step executed outside the 
Application Builder. You find information on this in section How to Provide an 
Application (Deployment).

1.2  Application Builder Features

The following table lists the Application Builder features:

• Creating and editing voice applications

– Chaining applications

– Using bookmarks for indicating the most different positions in the appli-
cation

– Integrating prompts in the available languages

– Supporting text-to-speech (TTS) for announcing text

– Definition of variables to store and forward data and information

– Importing applications used so far in the Application Builder 

NOTICE:  Please note that you cannot import all applications with 
all features if the platforms have different features. In most cases 
the imported application needs further processing.

• Creating and modifying callflows

– Creating a callflow within an editor

– Attaching notes to a call flow

– Linking different callflow pages

• Use of text-to-speech

• Language modification for GUI, documentation and online help after a 
program reboot

1.3  Features of an Application

A voice application created with the Application Builder may have the following 
features:

• Playing and recording of sound files

• Performing actions depending on date, weekday, national holidays and time 
considering the time zone (usage of time profiles)

• Branching in the menu navigation depending on statistic as well as dynamic 
values

• Forwarding to an extension

• Speech recognition

• Creating and applying call flow rules using specific conditions
 A31003-S50A0-U103-02-7619, 10/2020
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Who should read these Instructions?
• Definition, use and basic operations with variables

• Sending documents 

• Searching for contacts and users

• Selecting a supported language

• Database query

• Authenticating an ONS number or the user ID

• Managing and querying a call journal

• Displaying and querying a user's presence status. The contained information 
may indicate whether a user is in a meeting, absent or available.

• Creating and editing conferences

• Enqueueing incoming calls in queues of a contact center

1.4  Who should read these Instructions?

This manual addresses system administrators and Professional Service 
employees whose task it is to establish and maintain a voice application.

You need not have any programming knowledge to create a voice application. It 
is created and edited in the form of a callflow using the graphical user interface of 
an editor.

1.5  Document Conventions

The following conventions are used in the manual to clearly distinguish the 
various types of information.

NOTICE:  A note in inserted in the text to draw your attention to a 
feature or to provide information that facilitates working with the 
program.

IMPORTANT:  Text indicated in this way signalizes high priority 
information. The corresponding details must be heeded to avoid 
damages to the system or loss of data.

Representation Purpose

1. Click on OK. The single operating instruction steps are num-
bered.

• First alternative

– Second alternative

Alternative operational steps are represented by 
unnumbered lists.

Boldface Menu names, menu entries, dialog buttons, dialog 
field names, buttons and tabs appear bolded.
A31003-S50A0-U103-02-7619, 10/2020
OpenScape UC Application V10 Fusion Application Builder, User Guide 11



Introduction
Acronym Directory
1.6  Acronym Directory

The following table lists the acronyms used in this manual in alphabetic sequence.

Courier font Path descriptions and file names are indicated in 
Courier font, e. g. c:\Program Files\... or Exam-
ple.txt

Reference to a section References to sections in the document are 
marked in italics. 

<Text in pointed brackets > Texts that may have individual contents are repre-
sented in pointed brackets, e. g. the specification 
C:\<user directory>\ may mean: C:\Mayer\ or 
C:\kkh\

Acronym Meaning

ACD Automatic Call Distribution

ANI Automatic Number Identification

APL Access Protocol Layer

ASR Automatic Speech Recognition

CAD Call Attached Data

CCBS Completion of Calls to Busy Subscriber

CCNR Completion of Calls on No Reply

CVS Concurrent Versions System

DLL Dynamic Link Libraries

DNIS Dialed Number Identification Service

DSN Data Source Name

DTMF Dual-Tone Multi-Frequency

IP Internet Protocol

ITU International Telecommunication Union

IVR Interactive Voice Response

LCID Local ID

MSP XPR Service Provider

NLU Natural Language Understanding

ODBC Open DataBase Connectivity

OSCC OpenScape Contact Center

RCP Rich Client Platform

SSML Speech Synthesis Markup Language

Representation Purpose
 A31003-S50A0-U103-02-7619, 10/2020
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History of Changes
1.7  History of Changes

SQL Structured Query Language

TTS Text-To-Speech

XML Extensible Markup Language

Date Changes Reason

11/2019 Initialization of V110

10/2020 Added note in Chapter 1.1 
Creating Voice Applications

UCBE-24886

Acronym Meaning
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Setting up the Application Builder
How to Install the Application Builder
2  Setting up the Application Builder 

You set up the Application Builder as client application via the setup routine.

The setup media of the OpenScape UC Application are provided as ISO files. The 
OpenScapeUcSuiteApps--OptionalPackage-<version>.iso file 
contains the WIN32\APPLICAT.ZIP file. This file contains the 
application_builder_setup.exe file required for installing the Application 
Builder.

2.1  How to Install the Application Builder

Prerequisites

• The required hardware environment must be provided in the setup location. 
You can obtain detailed information from the OpenScape UC Application 
Planning Guide.

Step by Step

1) Start the application_builder_setup.exe file.

2) The setup wizard for the Application Builder opens.

3) Select the setup language and confirm with OK.

4) The license agreement is displayed. You accept the conditions of the license 
agreements with Accept.

5) Confirm the setup directory with Install.

If you wish to change the setup path, click on the Browse... button and select 
the path in the system.

Setup starts. The process status is displayed.

6) Complete the installation with the Finish button.

The Application Builder is installed.

2.2  Operating Requirements

Smooth operation of the Application Builder for configuring a voice application 
requires the following:

• OpenScape UC Application server installation 
See the OpenScape UC Application Installation and Upgrade installation 
instructions on this

• Configured PBX

We recommend the configuration of a Concurrent Version System (CVS) or 
similar systems for storing the files of the configured voice application or 
controlling the access to such files.
 A31003-S50A0-U103-02-7619, 10/2020
14 OpenScape UC Application V10 Fusion Application Builder, User Guide



Setting up the Application Builder
Operating Requirements
NOTICE:  For further information on the installation and configu-
ration of the OpenScape UC Application please refer to the corre-
sponding installation or administration manuals.
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How to Start the Application Builder
3  First Steps with the Application Builder

This section describes all steps you must execute from starting the Application 
Builder to performing a first application. We divide them into the following major 
steps:

• Starting the Application Builder

• Adding a pre-defined language

• Creating the first application

• Simulating this application (optional)

• Adding a server profile
This step is required for logging the Application Builder on to the OpenScape 
UC Application.

• Logging the Application Builder on to the OpenScape UC Application

• Providing and executing the application on the OpenScape UC Application

Executing the first application effects an audio file being played on the telephone 
to the caller who calls a specific OpenScape UC Application phone number.

To familiarize you with the basic procedure of creating and providing an appli-
cation, we keep it simple as far as possible. For example, we describe how to use 
a pre-defined language instead of a user-defined language. 

In further sub-sections of this section the first application will be extended step by 
step, so that you learn how to use further Application Builder features.

In the last sub-sections we provide a first insight into the Application Builder 
features.

3.1  How to Start the Application Builder

Step by Step

1) Start the Application Builder by selecting Start > Programs > Unify > 
OpenScape Fusion Application Builder.

2) When starting the Application Builder select the workspace. Click on the 
Browse... button to select an existing directory or create a new folder.

The data and configuration settings of the workspace, the applications and 
compositions are stored and also loaded in this directory.

NOTICE:  Make sure not to use the workspace subfolder of the 
Application Builder setup path. This folder contains superordinate 
meta data that must not be overridden or deleted.

NOTICE:  If you want the above dialog to be skipped and the 
Application Builder automatically be started with the workspace 
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First Steps with the Application Builder
How to Add a Predefined Language
used last when you boot the program, activate the Always start 
with the last recently used Workspace check box.

3) Confirm the selected workspace with OK.

4) You can select the language of the graphic interface and online help in the 
Tools > Preferences menu. However, switching languages does not take 
effect until the Application Builder is rebooted. You find more information on 
this in section "Configuring Preferences".

Next steps

Add a predefined language.

3.2  How to Add a Predefined Language

Step by Step

1)  Click on the Workspace Settings item in the workspace. 

The Workspace Settings tab for defining and configuring the languages to 
be used opens in the editor area.

2) Click on the Add... button. 

The Add Languages to the Workspace dialog opens.
A31003-S50A0-U103-02-7619, 10/2020
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First Steps with the Application Builder
How to Add a Predefined Language
3) Activate the check box of the desired language(s) and confirm your selection 
with the OK button. 

The selected language appears indicated in the All Workspace Languages 
list and the properties of the added workspace language are displayed. The 
following language properties are available:

Field Description

Name The Name serves as unique identifier of a language 
resource.

Code The Code describes the values of the CultureInfo class 
defined by Microsoft, which contain the cultural proper-
ties of a country. These properties contain the name of 
the culture, the writing system, the calendar used as well 
as the date format and sorted character strings. The 
code consists of a two-digit culture code in small letters 
according to ISO 639 linked to a language and also of a 
two-digit fractional culture code in small letters linked to a 
country or region. The format consists of two letters, a 
hyphen and two letters, for example ja-jp for Japan.

Locale ID The Locale ID or LCID (locale identifiers) for short 
describes a unique code of a language resource intro-
duced by Microsoft, which is also used e.g. by your oper-
ating system. Using this ID the operating system can 
adjust the specific properties and representations of 
information output such as date and currency specifica-
tions or weekday names.

Type The Type indicates for each language resource whether 
the language is predefined, i.e. was installed via the UC 
system or whether it is a user-defined language.

Properties Description

Language Name The Name serves as unique identifier of a language 
resource.

Language Description Optional description of the selected language.

Language Code The Code describes the values of the CultureInfo class 
defined by Microsoft, which contain the cultural proper-
ties of a country. These properties contain the name of 
the culture, the writing system, the calendar used as well 
as the date format and sorted character strings. The 
code consists of a two-digit culture code in small letters 
according to ISO 639 linked to a language and also of a 
two-digit fractional culture code in small letters linked to a 
country or region.
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First Steps with the Application Builder
How to Create the First Application
Via the Set this Language as Workspace Default Language... link you can 
define the selected language as language for all prompt, grammar and 
resource files.

3.3  How to Create the First Application

Prerequisites

• A language must have been configured as workspace language for an appli-
cation to be created trouble-free. In the most simple case, add a pre-set 
language to the workspace.

• Provide the audio file (media file) to be played to the caller. The media file 
must have the format *.wav or *.pcm.

Locale ID The Locale ID or LCID (locale identifiers) for short 
describes a unique code of a language resource intro-
duced by Microsoft, which is also used e.g. by your oper-
ating system. Using this ID the operating system can 
adjust the specific properties and representations of 
information output such as date and currency specifica-
tions or weekday names.

Extra Information The optional information displayed here can be used by 
a target platform for identifying the workspace language. 

Resource Folders The Resource Folder describes the folder in which the 
prompts and grammar files configured for the workspace 
or an application are stored according to the associated 
language. For each language already assigned by the 
system a folder name is already predefined. For each 
user-defined language a folder name must be specified 
in the right column.

Properties Description
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Step by Step

1) Start the Application Builder by selecting Start > Programs > Unify > 
OpenScape Fusion Application Builder and choosing a workspace.

As the error message shows, the workspace language must first be 
configured in the next steps.

2) Click on any entry in the workspace view with the right mouse button and 
select New > Application....

The Select Type of new Application dialog opens.

3) Click on the Symvia Application (AF 2.0) entry.

4) Click on Next.

The Specify Name of new Application dialog opens.

5) Click on the Finish button.

A new entry with the name of the new application, for example Symvia Appli-
cation 1, has automatically been added to the workspace view.

Furthermore, an error and a warning have appeared in the problem view 
because certain configurations for this application are missing.

6) Expand the plus sign that precedes Symvia Application 1.

7) Expand the plus sign that precedes Application Callflows.
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An entry, for example Callflow 1 [Incoming], is displayed, the name of which 
consists of the callflow's name and an expression in square brackets that 
points to the type of start event. 

A callflow determines the actions the application performs when a specific 
start event has occurred. [Incoming] means that the start event is a call to a 
specific phone number of the OpenScape UC Application.

8) Double-click the entry Callflow 1 [Incoming].

The callflow editor, dividing itself in a workspace and the palette, opens. A 
callflow is programmed with the help of controls. Such programming is not 
performed in the form of code lines entered in an editor but in the form of a 
flow diagram consisting of blocks (the controls) and arrows between the 
controls. The Start control and the End control have already been added to 
the callflow automatically and you can see them in the workspace. 

9) Click on the Prompt control in the palette with the left mouse button, keep the 
mouse button pressed and drag the control into the workspace; then release 
the mouse button.

NOTICE:  If the palette does not display a Prompt control, open 
<application name> > Application Settings in the workspace 
view, click on the Application Configuration tab and activate the 
Support of Interactive Voice Response (IVR) Controls check 
box in the Capability Settings section.

The Prompt control is added to the workspace.

10) Click on the Connection entry in the palette.

11)  Drag the mouse pointer into the workspace.

A plug icon appears next to the mouse pointer now. This indicates that you 
are ready for drawing connection lines between the controls.

12) Drag the mouse pointer onto the Start control in the workspace.

In addition to the plug icon, a plus sign appears next to the mouse pointer. 
Furthermore, an information box appears that contains an error message 
among other things.

13) Click with the left mouse button on the Start and Prompt control in succession.

A green arrow is drawn from the Start to the Prompt control. 

The plus sign next to the mouse pointer has disappeared.

Also gone is the white X on a red background in the top right corner of the 
Start control. This means that no error is present in the Start control anymore.

14) Move the mouse pointer onto the Start control again.

The information box does not show an error message anymore.

15) Click with the left mouse button on the Prompt and End control in succession.

A green arrow is drawn from the Prompt to the End control.

The yellow warning triangle in the top right corner of the End control has 
disappeared, because there is now a connection to this control.
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The white X on a red background in the top right corner of the Prompt control 
has been exchanged for a yellow warning triangle, because there is no error 
message but a warning present for the Prompt control. The content of the 
warning is displayed in an information box when you move the mouse pointer 
onto the Prompt control. To make this warning vanish also, a media file will be 
assigned to the Prompt control in the next steps. Proceeding through those 
steps we will describe only the most simple case. Please obtain continuative 
details from section How to Create and Configure an Application Prompt.

16) Click on the Select entry in the palette.

The plug icon next to the mouse pointer disappears.

17) Double-click the Prompt control.

The Change Properties for Prompt dialog opens.

18) Click on the Announcements tab.

19) Click on the green plus sign.

The Select Prompts to add to Announcement list dialog opens.

20) Click on the Create new Prompt... link.

The Set Properties of the Application Prompt dialog is displayed.

21) In the Prompt Files field, click on the <Click to select file> entry.

Icons appear on the right in this row.
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NOTICE:  These icons appear only if you use specific Windows 
themes such as any Aero theme or the Windows 7 basic theme.

You can change the Windows theme for example by clicking on 
the Windows desktop background with the right mouse button and 
selecting Personalize. Alternatively, you can open Start > 
Control Panel > Personalization or Start > Control Panel > 
Appearance and Personalization > Personalization.

22) Click on the first icon.

The Windows dialog for selecting a file opens.

23) Select the audio file (media file) to be played to the caller of the application.

24) Click on the Open button.

The Windows dialog closes and the name of the media file is displayed in the 
Prompt Files field.

25) Click on the OK button.

The Set Properties of the Application Prompt dialog closes.

26) Click on the OK button.

The Set Properties of the Application Prompt dialog closes and the name 
of the prompt is displayed in the announcement list.

27) Click on the OK button.

The Change Properties for Prompt dialog closes.

The top right corner of the Prompt control does not display a warning icon 
anymore. However, in the problem view under the workspace you can still see 
an error and a warning.

28) Push the Ctrl + S hotkey to save the changes. 

The error message in the problem view disappears. You can ignore the 
warning.

29) In the workspace view, double-click on <application name> > Application 
Prompts and click on the displayed prompt in the All Symvia Application 
Prompts area.

The right-hand section shows details of this prompt.

30) You have now created a first application.

You can compare this application with the SimpleIVR example application. 
You find this example application in the sub-directory Samples\Applica-
tions of the Application Builder's setup directory (not in the workspace 
directory). Import the example application as described in section How to 
Import Workspace Elements. After the import, the workspace view features 
the new entry SimpleIVR.
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Next steps

We recommend to simulate the created application.

So that you can use the created application you must generate a server profile for 
the OpenScape UC Application administrator in the Application Builder, log the 
Application Builder on to the OpenScape UC Application and provide the appli-
cation on this OpenScape UC Application.

3.4  How to Simulate the First Application

Prerequisites

• The application to be simulated must be error-free but warnings may be 
present.

Step by Step

1) Click on any entry in the workspace view with the right mouse button and 
select Test Application....

2) Activate the Step through Simulation option.

3) Click on the Start Simulation button.

4) Click on the Start Simulation button as often as it takes to select the End 
control.

In the meantime, you can check on the application's actions in the Runtime 
Output and Runtime Variables sections.

Next steps

So that you can use the created application you must log the Application Builder 
on to the OpenScape UC Application and provide the application on this 
OpenScape UC Application.
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3.5  How to Create a Server Profile

You must create a server profile for the administrator of the OpenScape UC Appli-
cation to connect the Application Builder to the OpenScape UC Application.

Prerequisites

• You need the password of user administrator at the OpenScape UC Appli-
cation, the IP address of the application computer (back-end computer) of the 
OpenScape UC Application and the port used for connecting the OpenScape 
UC Application. Port 4711 is used by default.

Step by Step

1) Click on the OpenScape Server entry in the workspace view.

2) Click on the Server Profiles... button. 

The Configure the available Server Profiles opens. You receive an 
overview of all available server profiles. 

3) Click on the Add... button.

The Create new Server Profile dialog opens.

4) Choose Server Type and specify the following values:

5) Confirm your entries with OK.

The created profile is added to the list of server profiles.

Field Function

User Name Name of an OpenScape UC Application user without domain. 

Example: administrator

Server Domain OpenScape UC Application domain. For the time being, only 
the system domain is supported. 

This is no Linux or Windows domain.

Server Address Address of the application computer (back-end computer) of 
the OpenScape UC Application inclusive port number. 

Example of usage with unencrypted connection:

js-soc://10.9.30.94:4711

Profile Name The profile name is automatically allocated with values of the 
fields User Name and Server Address. 

Example:

administrator@system on js-soc://
10.9.30.94:4711

Store Password of 
server profile

If you wish to store the server profile password, activate this 
check box. 

Password Password of the server profile

Confirm Password Password of the server profile
A31003-S50A0-U103-02-7619, 10/2020
OpenScape UC Application V10 Fusion Application Builder, User Guide 25



First Steps with the Application Builder
How to Log on to the OpenScape UC Application
Next steps

You can now log the Application Builder on to the OpenScape UC Application.

3.6  How to Log on to the OpenScape UC Application

Prerequisites

• The Current Status field shows the login status of the currently selected 
server profile. You can log on a server profile only if the value of this field is 
Not Logged In. If another server profile is still logged in, log it out with a click 
on the Logout button.

• There is at least one server profile.

• Each firewall between the computer that operates the Application Builder and 
the application computer (back-end computer) of the OpenScape UC Appli-
cation opens the port specified in the server profile. Example: Port 4711 in 
js-soc://10.9.30.94:4711

Step by Step

1) In the Change Status combo box select the desired server profile for logging 
on to the OpenScape UC Application.

2) Click on Login.

The login dialog opens.

3) Enter the password.

4)  If required, activate the Remember password for this Profile check box.

5) Click on OK.

Value Logged In in the Current Status field confirms the successful login. A 
successful login in also stated in the console.

Examples:

14:13:10,323 Account ’administrator@system’ on Server ’js-soc://
10.9.30.94:4711’

After a successful login, the Deployed Applications tab of the OpenScape 
Server Content shows the provided applications. Such applications may 
have been created with the Application Builder.

Logging the user off with a click on the Logout button in the OpenScape 
Server Login area displays a note in the bottom right corner on the Deployed 
Applications tab of the OpenScape Server Content section that describes 
the tab's content as outdated.

Example:

No Server Connection

Showing last recent Contents of js-soc://10.9.30.94:4711 from 15.11.13 
14:20

After a fresh user login, the note disappears.
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3.7  How to Deploy the First Application

Prerequisites

• The application to be deployed must not contain any errors. 

• You need the phone number that must be called for making the application 
start (start event of the application).

Step by Step

1) In the menu bar, click on the icon to provide the current application or 
select an application from the combo box via the triangle.

The Application Deployment dialog opens.

2) If the Currently not connected to an OpenScape Server message is 
displayed, select a value in the Server Profile field.

3) Click on Login.

4) Enter the password for this server profile.

5) Click on the OK button.

6) Click on Next.

7) Enter the phone number that must be called for making the application start 
(start event of the application) in the Phone Number field.

8) You can activate the Enable Runtime Tracing check box.

If you activate this check box, the application will create log data in the server 
log. This data may help you understanding problems or errors that occurred 
at the application's runtime.

With this check box enabled, all controls configured for this purpose will 
create log data. The controls will not create any log data if the check box 
remains disabled.

9) Click on Next.

10) Enter a new modification message or activate the check box to use the default 
modification message

11) Click on Next

12) Activate or deactivate the check box Overwrite Application Configuration to 
specify if the current Application Configuration on the Server will be replaced 
by the new one.

13) Click on Next

14) Activate or deactivate the check boxes on the left-hand side in the Language 
workspace to provide the respective language.
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15) Click on Next.

16) Click on the Finish button.
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17) Click on the OK button.

18) Double-click the OpenScape Server entry in the workspace view.

19) The application is now deployed on the OpenScape UC Application and can 
be configured. Log on to the CMP.

The OpenScape Server Content > Deployed Applications section now 
shows a new entry with the application's name, for example Symvia Appli-
cation 1.

When you click on the plus sign that precedes the entry, the phone number to 
be called for making the application start is displayed.

20) Log on to the CMP (Common Management Platform).

21) Open Configuration > UnifiedCommunications > Configuration > Media 
Server.

22) Double-click the computer on which the media server is installed.

NOTICE:  The names of the OpenScape UC Application 
computers displayed here are determined in the knut.-
responsefile.txt file during the OpenScape UC Application 
setup. Typically, these names are no host names or FQDNs. The 
default value for the back end computer of the OpenScape UC 
Application (application computer) is offboard. Please obtain 
details from the OpenScape UC Application, Installation and 
Upgrade setup guide.
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23)  Click on the Applications tab.
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An entry with the application's name, for example SymviaApplication1, is 
displayed.

24) Click on this entry.
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25) If you use a proxy server the configuration of which shall be detected automat-
ically, activate the Automatically detect Proxy Server Settings radio 
button.

If you wish to configure the proxy server manually, activate the Manual Proxy 
Server Configuration radio button and execute the following sub-steps:

a) Enter the proxy server's IP address in the HTTP(S) Proxy Server field.

b) Enter the port number of the port the proxy server communicates over in 
the Port field.

c) If required, activate the Enable Proxy Server Authentication check box 
and fill the User name field with the user name to be deployed and the 
Password field with the password.

26) Select the language to be used by the application as default in the Appli-
cation Default Language field.

27) If you do not wish to use the default address translation context, select 
another value in the Address translation context field.

On the CMP, address translation contexts are created under Configuration 
> Unified Communications > Configuration > Address Translation 
Contexts. Please obtain details on this from the OpenScape UC Application, 
Installation and Upgrade setup guide and the administrator documentation 
OpenScape UC Application, Configuration and Administration.

28) Click on the Deployment tab.
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29) If the application is to create log data, activate the Enable Runtime Tracing 
check box.

30) Click on the Save button.

31) If the OpenScape UC Application is available in the Large Deployment or Very 
Large Deployment scenario and several Media Server computers are 
present, execute steps 22 to 30 for all other Media Server computers also.

Please obtain details on the Large Deployment and Very Large Deployment 
scenarios from the OpenScape UC Application Planning Guide.

You can now use the application.

32) Test the application by dialing the phone number entered in step 7. 

The media file assigned to the Prompt control in the callflow is played to the 
caller. 

Next steps

You have familiarized yourself with the basic steps of creating and providing an 
application. The ensuing sub-sections of section The first Steps with the Appli-
cation Builder will provide a rough overview of how to broaden such knowledge. 
The sections User Interface and Controls describe single Application Builder 
elements and proceedings in detail.

The sub-section Samples\Applications of the Applicaton Builder setup 
directory (not the workspace directory) contains sample applications. The 
SimpleIVR application resembles your first application. The section How to Import 
Workspace Elements describes how to provide such applications. You can use 
those applications as basis for your own applications.
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3.8  How to Use TTS in an Application

In this section we describe how you modify the first created application in such a 
way that written text transformed into spoken language by TTS (Text to Speech) 
and offered to the caller is used instead of the audio file (media file).

Prerequisites

• You must have created an application as described in section How to Create 
the first Application.

• You need the password of user root of the OpenScape UC Application to 
determine the deployment scenario.

Step by Step

1) Start the Application Builder by selecting Start > Programs > Unify > 
OpenScape Fusion Application Builder and choosing a workspace.

2) In the workspace view, double-click on <application name> > Application 
Prompts and click on the displayed prompt in the All Symvia Application 
Prompts area.

The right-hand section shows details of this prompt.

3) Make sure that the language displayed in the fields Prompt Text and Prompt 
Files corresponds to the language you installed in step 9 on the Media 
Servers.

4) Click on the file displayed in the Prompt Files field.

Icons appear to the left of this row.

NOTICE:  These icons appear only if you use specific Windows 
themes such as any Aero theme or the Windows 7 basic theme.

You can change the Windows theme for example by clicking on 
the Windows desktop background with the right mouse button and 
selecting Personalize. Alternatively, you can open Start > 
Control Panel > Personalization or Start > Control Panel > 
Appearance and Personalization > Personalization.

5) Click on the button for removing a media file.

The file name is removed.

6) Click in the Prompt Texts field and enter the text to be offered as spoken 
language to the caller.

Example:

Welcome to company XYZ.

7) Push the Ctrl + S hotkey to save the changes. 

8) You must check whether the required TTS language is installed on all 
computers of the OpenScape UC Application that host a Media Server. 
Because such computers depend on the deployment scenario of the 
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OpenScape UC Application used, you first must determine which deployment 
scenario is on hand. You do this in the following sub-steps:

NOTICE:  Please obtain deployment scenario details from the 
OpenScape UC Application Planning Guide.

NOTICE:  This step and the ensuing one are not necessary for 
creating the application in the Application Builder, but are well 
required for executing the application on the OpenScape UC 
Application.

a) Open a command line on the application computer (back-end computer) 
of the OpenScape UC Application.

b) Log on a user root.

c) Enter the following commands in succession:

rpm -qa | grep OpenScapeUC_IntegratedSimplex

rpm -qa | grep OpenScapeUC_StandardDuplexSmall

rpm -qa | grep OpenScapeUC_Large_BE

rpm -qa | grep OpenScapeUC_VeryLarge_BE

The command of the above listed ones that delivers a non-empty output 
indicates the deployment scenario used. The table specifies on which 
computers in this case a Media Server is present mandatorily or 
optionally. For Large Deployment or Very Large Deployment, Media 
Servers can be installed on several Media Server computers. Please 

Component installed on 
the application computer

Deployment 
scenario

Media Server on the computer

Application 
computer

Media Server 
computer

OpenScapeUC_Integrated
Simplex

Integrated 
Deployment

Mandatory Optional

OpenScapeUC_StandardD
uplexSmall

Small Deploy-
ment

Mandatory Not allowed

OpenScapeUC_Large_BE Large Deploy-
ment

Not allowed Mandatory

OpenScapeUC_VeryLarge
_BE

Very Large 
Deployment

Not allowed Mandatory
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obtain the maximum number of Media Server computers from the 
OpenScape UC Application Planning Guide.

If osc-setup is installed on the application computer and a repository is 
available in osc-setup, you can execute the following command alterna-
tively to the above ones:

osc-setup se OpenScapeUC_

The line marked with a i in the first column of the output table indicates 
the installed deployment scenario.

Sample output:

...

S | Name                            | Summary | Type

...

--+---------------------------------+---------+------

i | OpenScapeUC_StandardDuplexSmall | OpenScape UC - 
StandardDuplexSmall | package

...

Please obtain osc-setup and repository details from the OpenScape UC 
Application, Installation and Upgrade setup guide.

9) Install the demanded TTS language on all computers on which a Media 
Server has been set up. Please obtain details on this from the OpenScape UC 
Application, Installation and Upgrade setup guide. The setup command for 
the German TTS language for example reads as follows:

osc-setup in uc-tts-de_de

Next steps

We recommend to simulate the created application.

Log the Application Builder on to the OpenScape UC Application if this has not 
been done yet.

You must provide the created application on the OpenScape UC Application for 
using it.

3.9  How to Create an Application for Switching Languages

This section describes how you expand your first created application in such a 
way that the TUI language is switched.

Prerequisites

• You must have created an application as described in section How to Create 
the first Application.

• Because TTS is used in the example that we document in the following steps 
you must have followed the instructions given in section How to Use TTS in 
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an application. Deviating from the documented example, you can use prompt 
files as described in section How to Create the first Application instead. 

Step by Step

1) Start the Application Builder by selecting Start > Programs > Unify > 
OpenScape Fusion Application Builder and choosing a workspace.

2) Because the sample applications described in sections How to Create the first 
Application and How to Use TTS in an Application contain only one language, 
another language must first be added to the Application Builder. To do this, 
execute the following sub-steps:

a) In the workspace view, double-click Workspace Settings.

b) Click on the Add... button.

c) Tick the check box of the language the application to be created shall be 
able to switch to also.

d) Click on the OK button.

e) Push the Ctrl + S hotkey to save the changes.

The added language will be displayed in the All Workspace Languages 
section. The language exclusively available until another language was 
added is marked as default workspace language.

3) In the workspace view, double-click on <application name> > Application 
Prompts and click on the displayed prompt in the All Symvia Application 
Prompts area.

The right-hand section shows details of this prompt.

4) In the Prompt Texts field, click in the line of the added language and enter 
the text to be offered as spoken language to the caller.

Example:

Welcome at company XYZ.

5) Push the Ctrl + S hotkey to save the changes. 

6) Double-click on <application name> > Application Callflows > <callflow 
name> in the Application Builder's workspace view.

7) Drag a SystemInfo control into the workspace.

A SystemInfo control serves for storing system information in a variable. 
System information may be the current time or date, the available languages 
or the logged-in user. In our case, the available languages are later to be 
stored in a variable.

8) Click on the connection from the Prompt control to the End control.

Drag points of this connection appear.

9) Move the mouse pointer onto the red drag point of the End control.

A plug icon and a double arrow are displayed next to the mouse pointer.
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10) Click on the red drag point at the End control with the left mouse button, keep 
the mouse button pressed, drag the mouse pointer to the SystemInfo control 
and release the mouse button.

The connection now does not link the Prompt control to the End control 
anymore but the Prompt control to the SystemInfo control.

11) Double-click the SystemInfo control.

The configuration dialog for this control opens.

12) Click on the Retrievals tab.

The information retrieval list is displayed.

13) Click on the green plus sign with the left mouse button.

The Create new Retrieval for Information Retrieval List dialog is 
displayed.

14) Click on the Enabled Languages entry.

15) In the Value Storage section, click on the ... button.

The Select the Application Variable to use dialog is displayed.

16) Click on the Create new Variable... link.

The Set Properties of the Application Variable dialog is displayed.

17) Change the value in the Variable Name field to APPLICATION_LANGUAGES 
for example. This variable is to store which languages are available in the 
application. Leave the variable type set to value String List.

18) Click on the OK button.

The dialog closes. The variable just created is selected.

19) Click on the OK button.

The dialog closes.

20) Click on the OK button.

The dialog closes.

21) Click on the OK button.

The dialog closes. 

The variable just created is an application variable, meaning that it is valid in 
the entire application. Consequently, it cannot only be used in the callflow that 
contains the just configured SystemInfo control but in all other callflows of the 
same application. It cannot be used in other applications. You can thus use 
the data encapsulation principle in the Application Builder as it is deployed in 
higher programing languages also. Open <application name> > Appli-
cation Variables in the workspace view. When you click on the desired 
variable in the All Symvia Application Variables section, properties of this 
variable are displayed in the right-hand section.

22) Double-click on <application name> > Application Callflows > <callflow 
name> in the Application Builder's workspace view.

23) Drag a DtmfSelection control into the workspace.
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A DtmfSelection control serves for reading a list to the caller from which he/
she then selects a value by pushing a key on his/her keypad. Here, the control 
will serve for selecting a language from the list of available languages.

24) Click on the Connection entry in the palette.

25) Create a connection from the SystemInfo control to the DtmfSelection control.

The white X on a red background in the top right corner of the SystemInfo 
control disappears.

26) Click on the Select entry in the palette.

27) Double-click the DtmfSelection control.

The Change Properties for DtmfSelection dialog opens.

28) Change the value of the Name field to Select language.

29) Click on the Introduction tab.

On this tab you configure which announcements shall be played when this 
control is reached upon executing the application. These announcements are 
to inform the caller about the language currently configured for the TUI. They 
serve as an introduction to subsequent announcements for selecting a 
language.

30) Click on the green plus sign.

The Select Prompts to add to Announcement list dialog opens.

31) Click on the Create new Prompt... link.

The Set Properties of the Application Prompt dialog is displayed.

32) Enter the current_language value in the Prompt Name field.

33) In the Prompt Texts field specify in the respective language the text you wish 
to use to initiate switching the language for the caller.

Examples:

German: Die gegenwärtige Sprache ist:

English: The current language is:

34) Click on the OK button.

The dialog closes. 

35) Click on the OK button.

The newly created prompt has been added to the end of the announcement 
list.

Later, when the application is being executed, this text will be announced to 
the caller as spoken language.

The prompt just created is an application prompt, meaning that it is valid in the 
entire application. It cannot only be used in the currently edited callflow but in 
all other callflows of the same application. It cannot be used in other applica-
tions. The data encapsulation principle as it is deployed in higher programing 
languages can thus also be used in the Application Builder for prompts. You 
can later see the just created prompt in the workspace view <application 
name> > Application Prompts. If you then click the desired prompt in the All 
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Symvia Application Prompts area, the area on the right hand side displays 
the prompt's properties.

36) You cannot enter the language's name in the DtmfSelection control perma-
nently, because the language used is unknown at the time of the control's 
creation. Instead, a variable LANGUAGE is used in the next steps. 

Click on the small black triangle to the right of the green plus sign and select 
Add Variable... .

The Select Variables to add to Announcement list dialog opens.

37) Tick the check box that precedes the LANGUAGE [Application Default 
Variable] entry.

38) Click on the OK button.

The LANGUAGE entry is added to the end of the announcement list.

In order to play the value of the LANGUAGE variable as spoken language 
correctly, a transformation must be created in the next steps.

39) Click in the Transformation column in the LANGUAGE entry's line.

A button with ellipsis appears.

NOTICE:  This button appears only if you use specific Windows 
themes such as any Aero theme or the Windows 7 basic theme.

You can change the Windows theme for example by clicking on 
the Windows desktop background with the right mouse button and 
selecting Personalize. Alternatively, you can open Start > 
Control Panel > Personalization or Start > Control Panel > 
Appearance and Personalization > Personalization.

40) Click on this button.

The Select Value Transformation for Variable dialog opens.

41) Click on the Create new Transformation... link.

42) Enter a name for the transformation in the Transformation Name field, for 
example LanguageCode.

43) In the field thereunder, you can optionally give a short description.

44) Click on Next.

The Specify the Directive of the Variable Value Transformation dialog 
opens. 

45) The translation type is determined in this dialog. Select the Language Code 
Transformation [String] value from the Transformation Directive combo box.

46) Click on the Finish button.

The dialog closes and a new value has been added to the list of 
transformations.

47) The application to be created is to switch the language, i. e. at least two 
workspace languages must have been configured. Because a transformation 
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is only valid for one language, the OK button is still grayed out and cannot be 
used yet. Execute steps 41 to 46 also for the language added in step 2.

Another value has been added to the list of transformations.

48) Click on the OK button.

The playback list displays the transformation added last.

49) Click on the small black triangle to the right of the green plus sign and select 
Add Pause... .

50) Click on the OK button.

A pause has been added to the playback list. Announcements are better 
understood when not being played in immediate succession.

51) Click on the Iteration tab.

On this tab you configure which variables shall be used for selecting a 
language.

52) Leave the Iterate over Variable List radio button active.

53) Click on the button with the ellipsis next to the Variable List to iterate field.

The Select the Application Variable or a Member Variable to use dialog is 
displayed.

54) Click on the variable you created in steps 16 to 20 and that contains the list of 
the workspace languages, for example APPLICATION_LANGUAGES. This 
variable determines which languages will later be offered to the caller for 
selection when the application is being executed.

55) Click on the OK button.

The variable name is displayed in the Variable List to iterate field.

56) Leave the Iterator Variable Name and Selection Key Variable Name fields 
unchanged.

57) Click on the button with the ellipsis next to the Variable for selected Element 
field.

The Select the Application Variable to use dialog opens.

58) Click on the Create new Variable... link.

The Set Properties of the Application Variable dialog is displayed.

59) Change the value in the Variable Name field to SELECTED_LANGUAGE for 
example. This variable is to store the language the caller has selected. Leave 
the variable type set to value String.

60) Click on the OK button.

The dialog closes. The variable just created is selected.

The variable just created is an application variable like the 
APPLICATION_LANGUAGES variable created in step 17, meaning that it is 
valid in the entire application.

61) Click on the OK button.
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The dialog closes. The Variable for selected Element field displays the just 
created variable.

62) Click on the Selection tab.

On this tab you configure which announcements shall be played to the caller 
for selecting a language.

Examples: "Please press 1 for German. Please press 2 for English."

63) Click on the green plus sign.

The Select Prompts to add to Announcement list dialog opens.

64) Click on the Create new Prompt... link.

The Set Properties of the Application Prompt dialog is displayed.

65) Enter the switch_language_for... value in the Prompt Name field.

66) In the Prompt Texts field specify in the respective language the text you wish 
to use to initiate switching the language for the caller.

Examples:

German: Für:

English: For:

67) Click on the OK button.

The dialog closes. The just created prompt is selected through a tick.

68) Click on the OK button.

The newly created prompt has been added to the end of the announcement 
list.

Later, when the application is being executed, this text will be announced to 
the caller as spoken language.

The prompt just created is an application prompt, meaning that it is valid in the 
entire application. It cannot only be used in the currently edited callflow but in 
all other callflows of the same application. It cannot be used in other applica-
tions. The data encapsulation principle as it is deployed in higher programing 
languages can thus also be used in the Application Builder for prompts. You 
can later see the just created prompt in the workspace view <application 
name> > Application Prompts. If you then click the desired prompt in the All 
Symvia Application Prompts area, the area on the right hand side displays 
the prompt's properties.

69) Click on the small black triangle to the right of the green plus sign and select 
Add Variable... .

The Select Variables to add to Announcement list dialog opens.

70) Activate the check box that precedes the ITERATOR entry.

71) Click on the OK button.

The ITERATOR entry is added to the end of the announcement list.

In order to play the value of the ITERATOR variable as a spoken language 
correctly, a transformation must be selected for the ITERATOR variable in the 
next steps.
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72) Click in the Transformation column in the LANGUAGE entry's line.

A button with ellipsis appears.

NOTICE:  This button appears only if you use specific Windows 
themes such as any Aero theme or the Windows 7 basic theme.

You can change the Windows theme for example by clicking on 
the Windows desktop background with the right mouse button and 
selecting Personalize. Alternatively, you can open Start > 
Control Panel > Personalization or Start > Control Panel > 
Appearance and Personalization > Personalization.

73) Click on this button.

The Select Value Transformation for Variable dialog opens.

74) In the list, click on the LanguageCode transformation you created further 
above and then on OK.

The dialog closes. The announcement playback list displays the added 
LanguageCode transformation for the ITERATOR variable.

75) Click on the green plus sign.

The Select Prompts to add to Announcement list dialog opens.

76) Click on the Create new Prompt... link.

The Set Properties of the Application Prompt dialog is displayed.

77) Enter the switch_language_...press value in the Prompt Name field.

78) In the Prompt Texts field specify in the respective language the text you wish 
to use to initiate switching the language for the caller.

Examples:

German: Drücken Sie:

English: press:

79) Click on the OK button.

The dialog closes. The just created prompt is selected through a tick.

80) Click on the OK button.

The newly created prompt has been added to the end of the announcement 
list.

Later, when the application is being executed, this text will be announced to 
the caller as spoken language.

The prompt just created is an application prompt, meaning that it is valid in the 
entire application. 

81) Click on the small black triangle to the right of the green plus sign and select 
Add Variable... .

The Select Variables to add to Announcement list dialog opens.

82) Activate the check box that precedes the KEY entry.
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83) Click on the OK button.

The KEY entry is added to the end of the announcement list.

84) Click on the small black triangle to the right of the green plus sign and select 
Add Pause... .

85) Change the displayed numerical value to 500.

86) Click on the OK button.

A pause has been added to the playback list. Announcements are better 
understood when not being played in immediate succession.

Configuring the playback list for selecting a language is now complete. This 
configuration effects the following output as a spoken language when 
executing the application: "For German, press 1." A pause of 500 milliseconds 
follows. "For English press 2." The switch_language_for... prompt thus stands 
for the word "for", the ITERATOR variable stands for a language name in the 
list of available workspace languages, the switch_language_...press prompt 
stands for "press" and the KEY variable stands for the keypad key that must 
be pressed if the just announced language shall be selected. This playback 
list is repeated until all language names in the list of available workspace 
languages have been announced.

87) Click on the OK button.

The dialog closes.

88) Drag a Language control into the workspace.

Using this control you can switch the language of the announcements to be 
played during the application's runtime. This language is also the application 
language. It can be switched to all languages licensed and installed on the 
OpenScape UC Application.

89) Click on the Connection entry in the palette.

90) Create a connection from the DtmfSelection control to the Language control.

The Select the Event for the Connection dialog opens. This dialog is always 
displayed if a control may have several exits and one or more exists are not 
used yet.

91) Select the Element Selected entry and click on the OK button.

This means the Language control is executed if the caller makes a correct 
selection at runtime of the application.

92) Create a connection from the DtmfSelection control to the End control.

This means that the caller has made an incorrect or no selection and the 
execution of the application is terminated.

The white X on a red background in the top right corner of the DtmfSelection 
control disappears.

93) Click on the Select entry in the palette.

94) Double-click the Language control.

The Change Properties for Language dialog opens.
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95) Change the value of the Name field to Switch language.

96) Activate the Specify by Variable radio button.

97) Click on the button with the ellipsis next to the Specify by Variable field.

The Select the Application Variable or a Member Variable to use dialog is 
displayed.

98) Click on the variable you created in steps 58 to 60 and that contains the list of 
the workspace languages selected by the caller, for example 
SELECTED_LANGUAGE. 

99) Click on the OK button.

The dialog closes. The variable name is displayed in the Specify by Variable 
field.

100)Click on the OK button.

The dialog closes. 

101)Drag a Prompt control into the workspace.

102)Click on the Connection entry in the palette.

103)Create a connection from the Language control to the DtmfSelection control.

The Select the Event for the Connection dialog opens.

104)Select the Language Changed entry and click on the OK button.

This means that executing the DtmfSelection control, which will first inform the 
caller about the currently configured language, comes next if the language 
was successfully switched.

105)Create a connection from the Language control to the Prompt control just 
added.

This means that the Prompt control will be executed if switching the language 
was not successful.

The white X on a red background in the top right corner of the Language 
control disappears.

106)Click on the Select entry in the palette.

107)Double-click the Prompt control.

The Change Properties for Prompt dialog opens.

108)Change the value of the Name field to Error.

109)Click on the Announcements tab.

110)Click on the green plus sign.

The Select Prompts to add to Announcement list dialog opens.

111)Click on the Create new Prompt... link.

The Set Properties of the Application Prompt dialog is displayed.

112)Enter the error value in the Prompt Name field.
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113)In the Prompt Texts field specify the text in the respective language.

Examples:

German: Ein Fehler ist aufgetreten.

English: An error has occured.

114)Click on the OK button.

The dialog closes. 

115)Click on the OK button.

The newly created prompt has been added to the end of the announcement 
list.

Later, when the application is being executed, this text will be announced to 
the caller as a spoken language if switching the language failed.

The prompt just created is an application prompt, meaning that it is valid in the 
entire application. 

116)Click on the OK button.

117)Click on the Connection entry in the palette.

118)Create a connection from the Prompt control edited last to the End control.

The white X on a red background in the top right corner of the Prompt control 
disappears.

119)Push the Ctrl + S hotkey to save the changes.

The asterisk that precedes the callflow’s name on the tab disappears.

Creating the application is now complete.

120)Install the language added in step 2 as TTS language on the OpenScape UC 
Application according to the instructions given in section How to Use TTS in 
an Application.

NOTICE:  This step is not necessary for the above application 
creation in the Application Builder, but is well required for 
executing the application on the OpenScape UC Application.

Next steps

We recommend to simulate the created application.

Log the Application Builder on to the OpenScape UC Application if this has not 
been done yet.

You must provide the created application on the OpenScape UC Application for 
using it.
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3.10  How to Create an Application for Switching Languages with a custom 
Language and Media Files

This section describes how you expand your first created application in such a 
way that the TUI language is switched. In contrast to section How to Create an 
Application for Switching Languages, a custom language (for example Canadian 
French) is used instead of a predefined language and sound files (Media files) 
instead of TTS for the prompts.

Prerequisites

• You must have created an application as described in section How to Create 
the first Application.

Step by Step

1) Start the Application Builder by selecting Start > Programs > Unify > 
OpenScape Fusion Application Builder and choosing a workspace.

2) Because the example application described in section How to Create the first 
Application contains only one language, another language must first be 
added to the Application Builder. This language is to be user-defined. To do 
this, execute the following steps:

3) In the workspace, double-click the Workspace Settings entry. 

The editor area has now the Workspace Settings tab open for specifying and 
configuring the languages to be used.

4) Click on the Configure custom Language Definitions... link. 

The dialog of the same name appears.

5) Click on the Add... button.

The Add Custom Language... dialog opens. 

6) Enter the following information:

• Language Name

Example: Canadian French

• Language Description

Example: Quebecois

• Language Code

Example: fr-CA

• Locale ID (LCID)

Example: 3084

You can retrieve the Language Code and the associated Locale ID from the 
Microsoft Internet pages. 

7) Click on the OK button. 

The created language is shown in the list of custom language definitions.
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You can select a language and edit it via the provided buttons, copy it or 
remove it from the list. Information about how to proceed is given in section 
How to Edit a Custom-Language Definition.

NOTICE:  A language configured in a workspace is also available 
in all other workspaces of the same Application Builder entity. This 
is independent from whether or not this language has been added 
to a workspace via Workspace Settings > Workspace 
Languages > All Workspace Languages > Add....

8)  Click on the OK button.

The Configure Custom Language Definitions dialog closes and the 
created language is added to the list.

9) Click on the Add... button.

The list of selectable languages features the just created language.

10) Activate the check box associated to this language.

11) Click on the OK button.

The All Workspace Languages area displays this language.

However, this entry is marked with a white X on a red background.

12) In the Workspace Language Properties area doubleclick on <Click to enter 
folder>.

13) Enter the name, for example quebecois, of the directory in which the sound 
files (media files) for this language shall be stored.

14) Push the Ctrl + S hotkey to save the changes.

The white X on a red background next to the language name has 
disappeared.

However, the workspace entry <application name> > Application Prompts 
features a white X on a red background, because a sound file was assigned 
to a prompt in section How to Create the first Application. This assignment 
was performed only for the language added at this time but not for the custom 
language just created. Consequently, another sound file to prompt 
assignment must be performed in the next steps.

15) Doubleclick on <application name> > Application Prompts.

The prompt created in section How to Create the first Application is displayed. 
Next to the prompt name you see a white X on a red background.

16) In the Prompt Files field, click on the <Click to select file> entry.

Icons appear on the right in this row.

NOTICE:  These icons appear only if you use specific Windows 
themes such as any Aero theme or the Windows 7 basic theme.

You can change the Windows theme for example by clicking on 
the Windows desktop background with the right mouse button and 
selecting Personalize. Alternatively, you can open Start > 
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Control Panel > Personalization or Start > Control Panel > 
Appearance and Personalization > Personalization.

17) Click on the first icon.

The Windows dialog for selecting a file opens.

18) Select the media file to be played to the caller of the application.

IMPORTANT:  Make sure that the selected media file has exactly 
the same name as the media file selected in section How to 
Create the first Application.

19) Click on the Open button.

The Windows dialog closes and the name of the media file is displayed in the 
Prompt Files field.

20) Push the Ctrl + S hotkey to save the changes. 

The white X on a red background next to <application name> > Application 
Prompts has disappeared.

21) Double-click on <application name> > Application Callflows > <callflow 
name> in the Application Builder's workspace view.

22) Drag a SystemInfo control into the workspace.

A SystemInfo control serves for storing system information in a variable. 
System information may be the current time or date, the available languages 
or the logged-in user. In our case, the available languages are later to be 
stored in a variable.

23) Click on the connection from the Prompt control to the End control.

Drag points of this connection appear.

24) Move the mouse pointer onto the red drag point of the End control.

A plug icon and a double arrow are displayed next to the mouse pointer.

25) Click on the red drag point at the End control with the left mouse button, keep 
the mouse button pressed, drag the mouse pointer to the SystemInfo control 
and release the mouse button.

The connection now does not link the Prompt control to the End control 
anymore but the Prompt control to the SystemInfo control.

26) Double-click the SystemInfo control.

The configuration dialog for this control opens.

27) Click on the Retrievals tab.

The information retrieval list is displayed.

28) Click on the green plus sign with the left mouse button.

The Create new Retrieval for Information Retrieval List dialog is 
displayed.
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29) Click on the Enabled Languages entry.

30) In the Value Storage section, click on the ... button.

The Select the Application Variable to use dialog is displayed.

31) Click on the Create new Variable... link.

The Set Properties of the Application Variable dialog is displayed.

32) Change the value in the Variable Name field to APPLICATION_LANGUAGES 
for example. This variable is to store which languages are available in the 
application. Leave the variable type set to value String List.

33) Click on the OK button.

The dialog closes. The variable just created is selected.

34) Click on the OK button.

The dialog closes.

35) Click on the OK button.

The dialog closes.

36) Click on the OK button.

The dialog closes. 

The variable just created is an application variable, meaning that it is valid in 
the entire application. Consequently, it cannot only be used in the callflow that 
contains the just configured SystemInfo control but in all other callflows of the 
same application. It cannot be used in other applications. You can thus use 
the data encapsulation principle in the Application Builder as it is deployed in 
higher programing languages also. Open <application name> > Appli-
cation Variables in the workspace view. When you click on the desired 
variable in the All Symvia Application Variables section, properties of this 
variable are displayed in the right-hand section.

37) Double-click on <application name> > Application Callflows > <callflow 
name> in the Application Builder's workspace view.

38) Drag a DtmfSelection control into the workspace.

A DtmfSelection control serves for reading a list to the caller from which he/
she then selects a value by pushing a key on his/her keypad. Here, the control 
will serve for selecting a language from the list of available languages.

39) Click on the Connection entry in the palette.

40) Create a connection from the SystemInfo control to the DtmfSelection control.

The white X on a red background in the top right corner of the SystemInfo 
control disappears.

41) Click on the Select entry in the palette.

42) Double-click the DtmfSelection control.

The Change Properties for DtmfSelection dialog opens.

43) Change the value of the Name field to Select language.
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44) Click on the Introduction tab.

On this tab you configure which announcements shall be played when this 
control is reached upon executing the application. These announcements are 
to inform the caller about the language currently configured for the TUI. They 
serve as an introduction to subsequent announcements for selecting a 
language.

45) Click on the green plus sign.

The Select Prompts to add to Announcement list dialog opens.

46) Click on the Create new Prompt... link.

The Set Properties of the Application Prompt dialog is displayed.

47) Enter the current_language value in the Prompt Name field.

48) In the Prompt Files field, click on the upper <Click to select file> entry.

Icons appear on the right in this row.

NOTICE:  These icons appear only if you use specific Windows 
themes such as any Aero theme or the Windows 7 basic theme.

You can change the Windows theme for example by clicking on 
the Windows desktop background with the right mouse button and 
selecting Personalize. Alternatively, you can open Start > 
Control Panel > Personalization or Start > Control Panel > 
Appearance and Personalization > Personalization.

49) Click on the first icon.

The Windows dialog for selecting a file opens.

50) Select the media file that contains the spoken language for the following text.

Examples:

German: Die gegenwärtige Sprache ist:

English: The current language is:

51) In the Prompt Files field, click on the lower <Click to select file> entry. 

Icons appear on the right in this row.

NOTICE:  These icons appear only if you use specific Windows 
themes such as any Aero theme or the Windows 7 basic theme.

You can change the Windows theme for example by clicking on 
the Windows desktop background with the right mouse button and 
selecting Personalize. Alternatively, you can open Start > 
Control Panel > Personalization or Start > Control Panel > 
Appearance and Personalization > Personalization.

52) Click on the first icon.

The Windows dialog for selecting a file opens.
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53) Select the media file that contains the spoken language for the following text.

Examples:

German: Die gegenwärtige Sprache ist:

English: The current language is:

IMPORTANT:  Make sure that the selected media file has exactly 
the same name as the file selected in step 50.

54) Click on the OK button.

The dialog closes. 

55) Click on the OK button.

The newly created prompt has been added to the end of the announcement 
list.

Later, when the application is being executed, this text will be announced to 
the caller as spoken language.

The prompt just created is an application prompt, meaning that it is valid in the 
entire application. It cannot only be used in the currently edited callflow but in 
all other callflows of the same application. It cannot be used in other applica-
tions. The data encapsulation principle as it is deployed in higher programing 
languages can thus also be used in the Application Builder for prompts. You 
can later see the just created prompt in the workspace view <application 
name> > Application Prompts. If you then click the desired prompt in the All 
Symvia Application Prompts area, the area on the right hand side displays 
the prompt's properties.

56) You cannot enter the language's name in the DtmfSelection control perma-
nently, because the language used is unknown at the time of the control's 
creation. Instead, a variable LANGUAGE is used in the next steps. 

Click on the small black triangle to the right of the green plus sign and select 
Add Variable... .

The Select Variables to add to Announcement list dialog opens.

57) Tick the check box that precedes the LANGUAGE [Application Default 
Variable] entry.

58) Click on the OK button.

The LANGUAGE entry is added to the end of the announcement list.

In order to play the value of the LANGUAGE variable as spoken language 
correctly, a transformation must be created in the next steps.

59) Click in the Transformation column in the LANGUAGE entry's line.

A button with ellipsis appears.

NOTICE:  This button appears only if you use specific Windows 
themes such as any Aero theme or the Windows 7 basic theme.

You can change the Windows theme for example by clicking on 
the Windows desktop background with the right mouse button and 
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selecting Personalize. Alternatively, you can open Start > 
Control Panel > Personalization or Start > Control Panel > 
Appearance and Personalization > Personalization.

60) Click on this button.

The Select Value Transformation for Variable dialog opens.

61) Click on the Create new Transformation... link.

62) Enter a name for the transformation in the Transformation Name field, for 
example LanguageCode.

63) In the field thereunder, you can optionally give a short description.

64) Click on Next.

The Specify the Directive of the Variable Value Transformation dialog 
opens. 

65) The translation type is determined in this dialog. Select the Language Code 
Transformation [String] value from the Transformation Directive combo box.

66) Click on the Finish button.

The dialog closes and a new value has been added to the list of 
transformations.

67) The application to be created is to switch the language, i. e. at least two 
workspace languages must have been configured. Because a transformation 
is only valid for one language, the OK button is still grayed out and cannot be 
used yet. Execute steps 61 to 66 also for the language added in step 2.

Another value has been added to the list of transformations.

68) Click on the OK button.

The playback list displays the transformation added last.

69) Click on the small black triangle to the right of the green plus sign and select 
Add Pause... .

70) Click on the OK button.

A pause has been added to the playback list. Announcements are better 
understood when not being played in immediate succession.

71) Click on the Iteration tab.

On this tab you configure which variables shall be used for selecting a 
language.

72) Leave the Iterate over Variable List radio button active.

73) Click on the button with the ellipsis next to the Variable List to iterate field.

The Select the Application Variable or a Member Variable to use dialog is 
displayed.

74) Click on the variable you created in steps 31 to 35 and that contains the list of 
the workspace languages, for example APPLICATION_LANGUAGES. This 
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variable determines which languages will later be offered to the caller for 
selection when the application is being executed.

75) Click on the OK button.

The variable name is displayed in the Variable List to iterate field.

76) Leave the Iterator Variable Name and Selection Key Variable Name fields 
unchanged.

77) Click on the button with the ellipsis next to the Variable for selected Element 
field.

The Select the Application Variable to use dialog opens.

78) Click on the Create new Variable... link.

The Set Properties of the Application Variable dialog is displayed.

79) Change the value in the Variable Name field to SELECTED_LANGUAGE for 
example. This variable is to store the language the caller has selected. Leave 
the variable type set to value String.

80) Click on the OK button.

The dialog closes. The variable just created is selected.

The variable just created is an application variable like the 
APPLICATION_LANGUAGES variable created in step 32, meaning that it is 
valid in the entire application.

81) Click on the OK button.

The dialog closes. The Variable for selected Element field displays the just 
created variable.

82) Click on the Selection tab.

On this tab you configure which announcements shall be played to the caller 
for selecting a language.

Examples: "Please press 1 for German. Please press 2 for English."

83) Click on the green plus sign.

The Select Prompts to add to Announcement list dialog opens.

84) Click on the Create new Prompt... link.

The Set Properties of the Application Prompt dialog is displayed.

85) Enter the switch_language_for... value in the Prompt Name field.

86) Select in the Prompt Files field the media files that correspond to the 
following text for both languages:

Examples:

German: Für:

English: For:

IMPORTANT:  Make sure that the selected media files have 
exactly the same name.
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87) Click on the OK button.

The dialog closes. The just created prompt is selected through a tick.

88) Click on the OK button.

The newly created prompt has been added to the end of the announcement 
list.

Later, when the application is being executed, this text will be announced to 
the caller as spoken language.

The prompt just created is an application prompt, meaning that it is valid in the 
entire application. It cannot only be used in the currently edited callflow but in 
all other callflows of the same application. It cannot be used in other applica-
tions. The data encapsulation principle as it is deployed in higher programing 
languages can thus also be used in the Application Builder for prompts. You 
can later see the just created prompt in the workspace view <application 
name> > Application Prompts. If you then click the desired prompt in the All 
Symvia Application Prompts area, the area on the right hand side displays 
the prompt's properties.

89) Click on the small black triangle to the right of the green plus sign and select 
Add Variable... .

The Select Variables to add to Announcement list dialog opens.

90) Activate the check box that precedes the ITERATOR entry.

91) Click on the OK button.

The ITERATOR entry is added to the end of the announcement list.

In order to play the value of the ITERATOR variable as a spoken language 
correctly, a transformation must be selected for the ITERATOR variable in the 
next steps.

92) Click in the Transformation column in the LANGUAGE entry's line.

A button with ellipsis appears.

NOTICE:  This button appears only if you use specific Windows 
themes such as any Aero theme or the Windows 7 basic theme.

You can change the Windows theme for example by clicking on 
the Windows desktop background with the right mouse button and 
selecting Personalize. Alternatively, you can open Start > 
Control Panel > Personalization or Start > Control Panel > 
Appearance and Personalization > Personalization.

93) Click on this button.

The Select Value Transformation for Variable dialog opens.

94) In the list, click on the LanguageCode transformation you created further 
above and then on OK.

The dialog closes. The announcement playback list displays the added 
LanguageCode transformation for the ITERATOR variable.

95) Click on the green plus sign.
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The Select Prompts to add to Announcement list dialog opens.

96) Click on the Create new Prompt... link.

The Set Properties of the Application Prompt dialog is displayed.

97) Enter the switch_language_...press value in the Prompt Name field.

98) Select in the Prompt Files field the media files that correspond to the 
following text for both languages:

Examples:

German: Drücken Sie:

English: press:

IMPORTANT:  Make sure that the selected media files have 
exactly the same name.

99) Click on the OK button.

The dialog closes. The just created prompt is selected through a tick.

100)Click on the OK button.

The newly created prompt has been added to the end of the announcement 
list.

Later, when the application is being executed, this text will be announced to 
the caller as spoken language.

The prompt just created is an application prompt, meaning that it is valid in the 
entire application. 

101)Click on the small black triangle to the right of the green plus sign and select 
Add Variable... .

The Select Variables to add to Announcement list dialog opens.

102)Activate the check box that precedes the KEY entry.

103)Click on the OK button.

The KEY entry is added to the end of the announcement list.

104)Click on the small black triangle to the right of the green plus sign and select 
Add Pause... .

105)Change the displayed numerical value to 500.

106)Click on the OK button.

A pause has been added to the playback list. Announcements are better 
understood when not being played in immediate succession.

Configuring the playback list for selecting a language is now complete. This 
configuration effects the following output as a spoken language when 
executing the application: "For German, press 1." A pause of 500 milliseconds 
follows. "For English press 2." The switch_language_for... prompt thus stands 
for the word "for", the ITERATOR variable stands for a language name in the 
list of available workspace languages, the switch_language_...press prompt 
stands for "press" and the KEY variable stands for the keypad key that must 
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be pressed if the just announced language shall be selected. This playback 
list is repeated until all language names in the list of available workspace 
languages have been announced.

107)Click on the OK button.

The dialog closes.

108)Drag a Language control into the workspace.

Using this control you can switch the language of the announcements to be 
played during the application's runtime. This language is also the application 
language. It can be switched to all languages licensed and installed on the 
OpenScape UC Application.

109)Click on the Connection entry in the palette.

110)Create a connection from the DtmfSelection control to the Language control.

The Select the Event for the Connection dialog opens. This dialog is always 
displayed if a control may have several exits and one or more exists are not 
used yet.

111)Select the Element Selected entry and click on the OK button.

This means the Language control is executed if the caller makes a correct 
selection at runtime of the application.

112)Create a connection from the DtmfSelection control to the End control.

This means that the caller has made an incorrect or no selection and the 
execution of the application is terminated.

The white X on a red background in the top right corner of the DtmfSelection 
control disappears.

113)Click on the Select entry in the palette.

114)Double-click the Language control.

The Change Properties for Language dialog opens.

115)Change the value of the Name field to Switch language.

116)Activate the Specify by Variable radio button.

117)Click on the button with the ellipsis next to the Specify by Variable field.

The Select the Application Variable or a Member Variable to use dialog is 
displayed.

118)Click on the variable you created in steps 78 to 80 and that contains the list 
of the workspace languages selected by the caller, for example 
SELECTED_LANGUAGE. 

119)Click on the OK button.

The dialog closes. The variable name is displayed in the Specify by Variable 
field.

120)Click on the OK button.

The dialog closes. 
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121)Drag a Prompt control into the workspace.

122)Click on the Connection entry in the palette.

123)Create a connection from the Language control to the DtmfSelection control.

The Select the Event for the Connection dialog opens.

124)Select the Language Changed entry and click on the OK button.

This means that executing the DtmfSelection control, which will first inform the 
caller about the currently configured language, comes next if the language 
was successfully switched.

125)Create a connection from the Language control to the Prompt control just 
added.

This means that the Prompt control will be executed if switching the language 
was not successful.

The white X on a red background in the top right corner of the Language 
control disappears.

126)Click on the Select entry in the palette.

127)Double-click the Prompt control.

The Change Properties for Prompt dialog opens.

128)Change the value of the Name field to Error.

129)Click on the Announcements tab.

130)Click on the green plus sign.

The Select Prompts to add to Announcement list dialog opens.

131)Click on the Create new Prompt... link.

The Set Properties of the Application Prompt dialog is displayed.

132)Enter the error value in the Prompt Name field.

133)Select in the Prompt Files field the media files that correspond to the 
following text for both languages:

Examples:

German: Ein Fehler ist aufgetreten.

English: An error has occured.

134)Click on the OK button.

The dialog closes. 

135)Click on the OK button.

The newly created prompt has been added to the end of the announcement 
list.

Later, when the application is being executed, this text will be announced to 
the caller as a spoken language if switching the language failed.

The prompt just created is an application prompt, meaning that it is valid in the 
entire application. 
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136)Click on the OK button.

137)Click on the Connection entry in the palette.

138)Create a connection from the Prompt control edited last to the End control.

The white X on a red background in the top right corner of the Prompt control 
disappears.

139)Push the Ctrl + S hotkey to save the changes.

The asterisk that precedes the callflow’s name on the tab disappears.

Creating the application is now complete.

140)Install the two languages used as the TTS languages on the OpenScape UC 
Application according to the following steps 141 and 142.

NOTICE:  The steps 141 and 142 are not necessary for the above 
application creation in the Application Builder, but are well 
required for executing the application on the OpenScape UC 
Application.

141)You must check whether the required TTS language is installed on all 
computers of the OpenScape UC Application that host a Media Server. 
Because such computers depend on the deployment scenario of the 
OpenScape UC Application used, you first must determine which deployment 
scenario is on hand. You do this in the following sub-steps:

NOTICE:  Please obtain deployment scenario details from the 
OpenScape UC Application Planning Guide.

NOTICE:  This step and the ensuing one are not necessary for 
creating the application in the Application Builder, but are well 
required for executing the application on the OpenScape UC 
Application.

a) Open a command line on the application computer (back-end computer) 
of the OpenScape UC Application.

b) Log on a user root.

c) Enter the following commands in succession:

rpm -qa | grep OpenScapeUC_IntegratedSimplex

rpm -qa | grep OpenScapeUC_StandardDuplexSmall

rpm -qa | grep OpenScapeUC_Large_BE

rpm -qa | grep OpenScapeUC_VeryLarge_BE
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The command of the above listed ones that delivers a non-empty output 
indicates the deployment scenario used. The table specifies on which 
computers in this case a Media Server is present mandatorily or 
optionally. For Large Deployment or Very Large Deployment, Media 
Servers can be installed on several Media Server computers. Please 
obtain the maximum number of Media Server computers from the 
OpenScape UC Application Planning Guide.

If osc-setup is installed on the application computer and a repository is 
available in osc-setup, you can execute the following command alterna-
tively to the above ones:

osc-setup se OpenScapeUC_

The line marked with a i in the first column of the output table indicates 
the installed deployment scenario.

Sample output:

...

S | Name                            | Summary | Type

...

--+---------------------------------+---------+------

i | OpenScapeUC_StandardDuplexSmall | OpenScape UC - 
StandardDuplexSmall | package

...

Please obtain osc-setup and repository details from the OpenScape UC 
Application, Installation and Upgrade setup guide.

142)Install the demanded TTS language on all computers on which a Media 
Server has been set up. Please obtain details on this from the OpenScape UC 
Application, Installation and Upgrade setup guide. The setup command for 
the German TTS language for example reads as follows:

osc-setup in uc-tts-de_de

Component installed on 
the application computer

Deployment 
scenario

Media Server on the computer

Application 
computer

Media Server 
computer

OpenScapeUC_Integrated
Simplex

Integrated 
Deployment

Mandatory Optional

OpenScapeUC_StandardD
uplexSmall

Small Deploy-
ment

Mandatory Not allowed

OpenScapeUC_Large_BE Large Deploy-
ment

Not allowed Mandatory

OpenScapeUC_VeryLarge
_BE

Very Large 
Deployment

Not allowed Mandatory
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Next steps

We recommend to simulate the created application.

Log the Application Builder on to the OpenScape UC Application if this has not 
been done yet.

You must provide the created application on the OpenScape UC Application for 
using it.

3.11  Workspace

A workspace serves as superordinate container, which includes and manages all 
created elements and configured properties. A workspace contains as elements 
any number of applications with one callflow per application that can be divided 
in any number of linked callflow pages.

At the Application Builder start, a folder must be created as storage for the 
workspace at the start. In this folder, all configurations of the single workspace 
components are locally stored. These files and their contents cannot be used for 
the execution of created voice applications yet. Only an explicit deployment 
copies the files to the server and allows an execution.

NOTICE:  This deployment has nothing to do with the deployment 
scenarios of the OpenScape UC Application.

Languages

Besides the licensed languages, further languages can be activated by means of 
their language codes and their locale ID. The languages are used for configuring 
prompts and grammar files.

Prompts

Prompts are either assigned to sound files or are created by defining text and a 
text-to-speech engine. Each sound file is to be assigned to an available language, 
while for each activated language a text can be specified for creation by means 
of a text-to-speech engine.

Grammar files

Grammar files serve as basis for speech recognition and are assigned to an 
activated language each.

Variables

Variables are wildcards and storage location for data such as phone numbers or 
DTMF entries. The names are freely selectable.

NOTICE:  The properties and components set in the workspace 
are globally valid and applicable for the entire workspace, i.e. also 
for all applications available in this workspace. Application-
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specific language and database settings are not possible. You can 
export prompts, grammar files and variables specific to a 
workspace.

3.12  Applications and Compositions

You design applications and compositions using the Application Builder. The 
configurations of the application or composition are stored locally. The application 
is not compressed in a file and made available in the Media Server until the design 
is complete. You can reach the application via one or several phone numbers 
assigned to the application.

Compositions are applications or application fragments that can be used recur-
rently in Symvia Application, for example logging a user on to the system (LogIn). 
The composition is created once and is stored as a deployable unit on the Media 
Server. Deployed applications then use a reference to the deployed compo-
sition.If a composition is modified, only this composition is re-deployed. All appli-
cations using this composition will automatically take advantage of the 
modification.

For Server based compositions the following applies: 

• Within the Application Builder, each composition can be deployed directly on 
the Openscape UC Media Server after connecting to the Media Server.

• All deployed compositions on a connected Media Server will be displayed in 
the Application Management of the Application Builder.

• A deployed composition can be removed from the connected Media Server.

• A deployed composition can be imported from the connected Media Server 
into the Application Builder.

• For a deployed composition on a connected Media Server all deployed appli-
cations using this composition can be listed.

• While deploying an application using one or more compositions the user can 
decide to deploy the referenced compositions too.

• All applications using a modified and redeployed composition will automati-
cally take advantage of the modification.

• In case of an incompatible interface change of a composition (number and 
type of input or output parameters, number of exits) a deployed application 
using the old interface cannot be instantiated. The Application Builder 
provides a sanity check to identify applications with an invalid reference to 
compositions, so the user can adjust and redeploy these applications

• In the Application Management the user can change the following properties 
of an deployed IVR application/composition directly on a connected Media 
Server without redeploying:

– Tags

– Default language (only application)

– Phone number binding (only application)

– Tracing (only application)
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• For each change the time of the modification, the modifying user and a new 
revision number will be automatically added to the deployed application/
composition.

Each deployed composition will be stored in a separate deployment package 
named <composition-id>.mdp.zip located in the deployment-customfolder of the 
OpenScape UC Media Server. It contains the following items:

• package.xml - Media Server package file

• package.deployment.xml - Media Server package deployment configuration

• symvia.composition.xml - composition configuration file

• composition/<composition-id>.xml - xml representation of the composition 
call flow

• res/... - composition resource files (prompts, grammars, 
documents)appbuilder/ - export file of the Application Builder composition

• conf/symvia.properties.xml - custom control configuration of the composition 
(optional)

• lib/... - custom control libraries (optional)

The deployed composition is neither a Media Server application nor a Media 
Server component. It is managed by a composition deployment handler in the 
Symvia Provider of the Media Server. The deployment handler monitors the 
composition configuration files and creates, updates and removes the composi-
tions stored in the composition repository of the Symvia Provider. The Symvia 
Provider also provides a composition factory which will be injected to each appli-
cation session at creation time. Each deployed application using one or more 
compositions will no longer include an embedded copy of the composition but 
rather contains a composition reference with the actual interface parameters. The 
application uses the injected composition factory to create the composition 
instances, adapt the actual interface parameters and replace each composition 
reference with the appropriate composition instance. After creating the appli-
cation session all referenced compositions are instantiated and ready to be 
processed. If a referenced composition cannot be found in the composition repos-
itory or the composition interface is not compatible to the composition reference, 
the application session cannot be created. 

every configured application or composition and are thus immediately usable. 
Furthermore, prompts, grammar files and variables can be configured in each 
application that are only available in the respective application. Application-
specific language settings are not possible. Application-specific prompts, 
grammar files and variables can be copied to other applications, though. The 
same applies for compositions.

3.13  Speech Recognition

In case of applications created with the Application Builder, the user may have to 
make entries for continuing with the callflow. 

If a speech recognition system has been installed, the Application Builder allows 
making entries by specifying digits on the phone keypad and by voice. Speech 
recognition is performed by a software with a speech grammar that decodes 
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announcements, compares them with permanent entries and, as the case may 
be, executes associated commands. 

NOTICE:  For further information about speech recognition 
please consult the manuals of the speech recognition software 
used.

3.14  Callflow

You can model a callflow in every voice application. A graphical editor is used for 
this purpose. Each callflow consists of controls that represent specific features. 
For example, controls exist for playing prompts, for selection in a menu, for 
entering DMTF keys or using time profiles. Each control can be used as often as 
you wish and be connected to other controls. Controls are connected according 
to specific events or conditions. For example, the connected control is forwarded 
to after the successful playback of an announcement or selecting a menu option 
with a DTMF key. In addition, you can connect callflow pages within an appli-
cation.

The prompts, grammar files and variables configured in a workspace or appli-
cation are used in the single control for the respectively possible functionality. 
Prompts are used as information announcements, grammar files as precondition 
for using speech recognition and variables for storing data.

The Application Builder can detect and represent syntactical errors in the 
workspace configuration, the applications and controls within call flows. While 
errors prevent the successful execution of an application and must therefore be 
rectified, warnings specify improvement options.

NOTICE:  The Application Builder cannot check the usefulness of 
a call flow design; this must be done by the user himself/herself.

The Application Builder can be operated offline, i.e. without connection to the 
server. The workspace that is stored in local files is subsequently provided for the 
server during deployment. The detailed process is described in the section 
Deployment.
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4  User Interface

This section contains a detailed description of the single GUI items of the Appli-
cation Builder and their functions.

The following figure shows the Application Builder GUI with some of its views. The 
Problems, Bookmark, Search and Properties views are combined in the form 
of tabs, so that only the Problem view is fully visible.

The menu bar and toolbar are always displayed. The views can be optionally 
displayed and opened and closed as required.

Menu bar

The single menu options of the menu bar are described in detail in the Menu Bar 
section.

Toolbar

The single elements of the toolbar are represented in the Toolbar section.

Workspace views

The Views term describes different tabs of the Application Builder GUI. Among 
these are:

• the workspace that displays in a tree strucure the different workspace items 
and existing applications as well as their elements.
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• the outline view, which represents an open callflow in minimized format.

• the problem view for displaying notes and errors in the workspace or in a 
composition or an application.

• the properties view, which displays the information of a selected control, 
prompt, variable etc.

• the bookmark view, which lists the created bookmarks,

• the search view for listing search hits and the associated results.

• the help view for representing context-sensitive help information.

• the callflow editor for creating and editing callflows, prompts and variables. 
The editor includes a palette, which lists the available controls.

You can control the activation or deactivation of the single views via the View 
menu option.

4.1  Menu Bar

The menu bar is the only GUI item that cannot be freely positioned.

It is anchored beneath the Application Builder's caption bar and comprises the 
following options:

• File

• Edit

• View

• Search

• Tools

• Help

4.1.1  File

This menu contains the following options:

Option Function

New > Application... This menu option serves for creating a new application. The 
user can select the application type on the basis of which an 
application is to be created.

New>Symvia Control 
Composition

This menu option serves for creating a new composition. 
The user can select the composition type on the basis of 
which a composition is to be created.

Close This menu option closes the editors currently displayed in 
the editor area.

Close All This option closes all editors opened in the editor area.

Save Use this menu option to save the current state of the tabs 
presently displayed in the editor area.
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Save As... This menu option is disabled.

Save All Use this menu option to save the state of all editors pres-
ently displayed in the editor area.

Rename... With this menu option you can rename the selected applica-
tions or call flows.

Refresh This menu option refreshes the view of all areas with refer-
ence to the last modifications after saving or deploying an 
application. Modifications to applications are immediately 
executable but the problem view is not immediately 
updated. Errors and warnings are only put out with saving, 
updating or executing an application. This function is only 
enabled if it makes sense in the respective context.

Refresh Problems This menu option refers to the Problems view only. It 
updates the problems view according to the current state.

Print... The menu option enables printing the currently opened call 
flow. In the open Print dialog you can select a printer and 
set print options.

Switch Workspace This options opens the dialog for changing to another work-
space.

Backup Workspace... This option opens the Backup Workspace dialog. Enter the 
your backup target path in Settings. All files from your 
workspace are saved.

Import This feature comprises the import of a previously exported 
application, composition or a custom control. You find more 
information on this in the sections How to Import Workspace 
Items and How to Import Custom Controls.

Option Function
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4.1.1.1  How to Import Workspace Items

You can add workspace items to the current workspace. If the import belongs to 
another target platform, the contained element may be transformed for the 
Symvia platform.

Step by Step

1) Select File > Import > Symvia Workspace Items....

The Symvia Workspace Item Import dialog opens. 

2) Click on the Browse... button and select the archive file from which the 
workspace item will be imported.

INFO:  Select for example in the Application Builder setup folder 
(not in the workspace directory) the OpenScape Fusion 
Application Builder\Samples\Applica-
tions\SimpleIVR.zip file. This file is one of the example 
applications and example compositions shipped with the Appli-
cation Builder.

Export This feature comprises the Export of a workspace item to an 
archive file. Exporting applications, compositions as work-
space item and custom controls is supported. You find more 
information on this in the sections How to Export Work-
space Items and How to Export Custom Controls.

Properties Depending on the selected element (application, callflow or 
control), the element's properties are displayed when you 
enable this menu option:

• Application: You receive general information such as 
storage location, date of the last access, file size and 
type.

• Callflow: The properties for the callflow are divided into 3 
sections.

– General: You receive information such as storage 
location, date of the last access, file size and type.

– Callflow: You receive information about the current 
callflow content and editor settings. 

– Event: The callflow is linked to an event. In this dialog 
you can select between Incoming Call or Call 
Disconnected via a drop-down list.

• Control: Since each control is to be distinguished 
according to its type, the configuration dialog of the corre-
sponding control type opens. Here you do not only 
receive information but you can also immediately perform 
settings or change them.

Exit This menu option terminates the Application Builder.

Option Function
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3) Click on Next.

The next dialog displays the content of the selected archive file. Items already 
available in the Application Builder are represented with a warning icon.

4) Activate the check boxes behind the items you wish to import.

5) Confirm the specifications with Finish.

4.1.1.2  How to Import Custom Controls

You can add custom controls to the control's palette.

Step by Step

1) Select File > Import > Symvia Custom Controls.....

The Symvia Custom Control Import dialog opens. 

2) Click on the Browse... button and select the archive file from which you would 
like to import custom controls.

3) Click Continue to view a selection of the imported controls.

NOTICE:  If you skip the selection and click Finish directly, all 
custom controls are imported from the archive file.

The controls are listed in the next dialog. The control selection is displayed by 
a check box. By default, the check boxes are activated.

4) Confirm the specifications with Finish.

In the controls' palette you will find the Custom Controls group which includes 
the imported controls.

4.1.1.3  How to Export Workspace Items

You can export workspace items from the current workspace. This way you can 
create a backup copy of the application or composition in the form of an archive 
file. The archive file contains all important definition files of the application and 
may contain additional resource files of the application. You can use the created 
archive file also for importing the application or compositions to another 
workspace. Please note that no workspace prompts or workspace grammars can 
be exported.

Step by Step

1) Select File > Export > Symvia Workspace Items....

The Symvia Workspace Item Export dialog opens.

2) Enter the path to the archive file in the Archive File field or click on the 
Browse... button and select the archive file to which you wish to export.
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3) Click on Next.

The exportable elements are displayed. You can also see if a composition or 
application uses a composition. If this is the case make sure that the 
composition is also selected for the export.

A custom control probably used in a composition or application is included in 
the export of this composition or application.

4) Activate the check boxes that precede the items you wish to export.

5) Select Next or Finish.

6) In the next dialog select the additional resources to be saved in the archive 
file. Activate the corresponding check boxes.

a) Include Prompt Audio Files into the Export

b) Include Grammar Specification Files in the Export

c) Include other Application Resource Files into the Export

d) Include additional Documentation Files in the Export

7) Select Next or Finish.

Via the Back button you can return to the previous dialog.

8) In the next dialog, specify optionally additional information to be displayed 
during the import.

9) Confirm the specifications with Finish.

A dialog confirms the successful export.

10) Click on OK.

4.1.1.4  How to Export Custom Controls

You can export custom controls from the current workspace. This way you can 
create a backup copy of the control in the form of an archive file. The archive file 
contains definitions and resources of the controls. You can use the created 
archive file also for importing controls to another workspace.

Step by Step

1) Select File > Export > Symvia Custom Controls....

The Export Symvia Custom Control dialog opens.

2) Select the archive file in which the controls are to be exported via the Browse 
button.

3) Select Next.

4) In the next dialog select the controls to be saved in the archive file. Activate 
the corresponding check boxes.

5) Select Next or Finish.

Via the Back button you can return to the previous dialog.
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6) In the next dialog, specify optionally additional information to be displayed 
during the export.

7) Confirm the specifications with Finish.

A dialog confirms the successful export.

8) Click on OK.

4.1.2  Edit

This menu contains the following options:

Option Function

Undo This menu option undoes the last performed action. These 
are all actions. You can use this option repeatedly.

Repeat This menu option cancels the last undoing. It can be applied 
repeatedly.

Cut A selected control, linkage or note in the callflow is copied 
with this command and deleted in its original place when 
being pasted somewhere else. You cannot cut a connection 
in the callflow since a connection is permanently assigned 
to a control.

Copy A selected control, linkage or note in the callflow is copied 
with this command and left in its original place when being 
pasted somewhere else. You cannot copy a connection in 
the callflow since a connection is permanently assigned to a 
control. You can also copy callflows, applications and com-
positions.

Paste Inserts a cut or copied control, linkage or note in the callflow 
or a copied application or a copied callflow in an arbitrary 
place. You cannot copy or cut and paste a connection in the 
callflow since a connection is permanently assigned to a 
control.

Delete This menu option deletes the connection, note, linkage or 
control selected in the callflow. When a control is deleted, all 
connections starting from or ending at this control are also 
deleted. You can also delete selected callflows and applica-
tions.

Select All This menu option selects all controls, notes and linkages 
available in the active callflow. Since connections are 
always permanently assigned to controls, they are selected, 
too.

Add Bookmark This menu option pastes a bookmark in the bookmark view 
for the currently opened control or callflow. Bookmarks are 
represented in the bookmark view and can be selected from 
there, see section View Bookmarks View. You cannot exe-
cute the Undo command for the add-bookmark feature.
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4.1.3  View

4.1.4  Callflow

This menu item becomes visible if a callflow editor is activated. The menu options 
are active only if the callflow editor has the focus. This menu contains the 
following options:

Option Function

Workspace Activates or deactivates the workspace view.

Outline Activates or deactivates the outline view.

Properties Activates or deactivates the properties view.

Problems Activates or deactivates the problem view.

Bookmark Activates or deactivates the bookmark view.

Search Activates or deactivates the search view.

Console Activates or deactivates the console view. 

Navigation Problem view This menu option enables the selective activa-
tion of the Problem View tabs. 

Bookmark view This menu option enables the selective activa-
tion of the Bookmark View tabs. 

Activate Workspace This menu option enables the selective activa-
tion of the Workspace View tabs. 

Activate Editor This menu option enables the selective activa-
tion of the Editor tabs. 

Maximize Active View or 
Editor.

This menu option maximizes the active win-
dow.

Minimize Active View or 
Editor

This menu option minimizes the active ele-
ments.

Reset Perspective... A perspective defines the arrangement of all 
freely positionable GUI elements of the Appli-
cation Builder window. This menu option 
resets the perspective of the workspace to the 
default settings.

Option Function

Show grid Enable/disable grid in callflow editor

Show label Show/Hide Callflow Name and Application Name

Show legend Show/hide legend

Show shadow activate/deactivate the shaded display of a control.
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4.1.5  Search

This menu option opens the search dialog and enables searching for a character 
string in all workspace items. The search result is displayed in the search view.

All names, descriptions and control properties are searched, e. g. also character 
strings that form a welcome text in a prompt control.

<<Details button

This button expands the Search dialog with the Settings and Scope tabs, thus 
enabling a more detailed search. After you have clicked this button, it turns into 
<<Details. When you click this button, the two tabs close again.

• Settings tab
Case Sensitive
Activate the associated check box if upper and lower case writing is to be 
heeded. If you enter an uppercase search item, only uppercase hits will be 
delivered.
Whole Word
Activate the associated check box if only whole words are to be accepted in 
the search. Otherwise, all terms starting with the search item will be put out. 
For example, if you enter an A as search item, all terms beginning with A will 
be put out as hit.

• Scope tab
On this tab you set the search scope. 

4.1.6  Tools

Under the Tools menu item you find the options Manage Workspaces..., 
Configure Symvia Custom Controls... and Preferences. The dialogs are 
provided for the general settings and the administration of the Application Builder. 
You can perform settings in the following areas of the Preferences dialog:

• General

• Help, Help > Content

• Network

Show ruler activate/deactivate the ruler at the top left margin of the call-
flow editor

Snap to geometry When you activate this feature and position controls, lines 
are displayed in relation to other controls. In this way you 
can position controls precisely on the same level or in the 
same distance from each other.

Zoom in The callflow editor view is enlarged. The maximum enlarge-
ment is 400%.

Zoom out The callflow editor view is minimized. The minimum reduc-
tion is 50%.

Option Function
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• Logging, Logging > Categories

• Symvia, Symvia > Confirmations

4.1.6.1  Managing Workspaces

Here you can manage the workspaces used last. Each list entry corresponds to 
a single workspace once used for a session.

You can remove workspaces, purge them or change the sequence in which they 
appear in the workspace selection dialog. 

IMPORTANT:  Please note that purged workspaces are removed 
permanently from the disk after you have confirmed the dialog. 

4.1.6.2  Configuring Custom Controls

Here you can administrate custom controls. Each list entry corresponds to a 
single custom control. You can remove, edit, delete or add controls. Please refer 
to section How to Create a Custom Control.

4.1.6.3  Configuring Preferences

Configuration dialog General

The General area lets you perform the following settings:
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Option Function

Language This is the language used by the Application Builder. A 
modification will not take effect until a reboot.

Automatically start with the 
last recently used Work-
space

This setting determines whether the workspace used last is 
to be deployed when starting the Application Builder.

Maximum Number of saved 
recently used Workspaces

This is the number of workspaces used last to be registered 
by the Application Builder. The default value is 10.

Restore open Editors after 
Start of Application

This option is active by default and serves for automatically 
displaying all open editor areas of an application after a pro-
gram reboot.

Update delay for newly 
reported Problems (ms)

This field determines the delay for displaying entries newly 
made in the Problems view. The default value is 300 milli-
seconds.

Focus Animation Duration 
(ms)

This setting defines the time in which the focus animation is 
displayed. Focus animation describes the red frame that 
appears in the problems view when you doubleclick an error 
entry. This animation serves highlighting purposes only and 
is terminated when you select the faulty element. The high-
est value is 999. The default value is 180 milliseconds. 
Entry “0” deactivates the function.

Focus Animation Line 
Width

This setting defines the line width of the focus animation's 
red frame. The highest value is 9. The default value is 2. 
The entry “0” deactivates the function.
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Configuration dialog Help

In the Help area you can perform the following settings, which influence the Help 
representation.

Show Confirmation Dialog 
after successful Workspace 
Backup

If this option is activated, a confirmation dialog will be 
shown after successfully workspace export.

Restore Defaults This button resets all values to the defaulted ones.

Apply This button copies the modified settings.

Option Function

Open help search

In the dynamic help view

In a browser

Open help contents

In the help browser

In an external browser Help is opened in a preconfigured browser if the check box 
Include Help Content from Remote Infocenter has been 
activated under Help > Content and a valid Infocenter has 
been configured via the Add button. If this option is inactive, 
the installed help is displayed in an Application Builder win-
dow.

Open window context help

Option Function
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Configuration Dialog Network

The network settings are used if network accesses occur from the Application 
Builder, e.g. while an application is being simulated.

The Network area lets you perform the following settings:

In the dynamic help view The context sensitive help is displayed in the help view.

In an infopop The context sensitive help is displayed in a pop-up window.

Open dialog context help

In a dialog tray The context sensitive help of dialogs is displayed in a dialog 
tray.

In an infopop The context sensitive help of dialogs is displayed in a pop-
up window.

Restore Defaults This button resets all values to the defaulted ones.

Apply This button copies the modified settings.

Option Function

Do not use a Proxy Server When this option is active, no proxy server is used. 

Automatically detect Proxy 
Server Settings

When this option is active, the proxy server and port are 
automatically detected and set. 

Manual Proxy Server Con-
figuration

When this option is active, the fields for the manual proxy 
server and port input are enabled.

Option Function
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Configuration dialog Logging

The Application Builder features comprehensive logging. The settings determine 
which information is stored where and when.

In the Logging section you find three tabs with the following configuration 
options:

HTTP(S) Proxy Server Specify the proxy server. 

Port Specify the port.

Enable Proxy Server 
Authentication

When this option is active, specify a Username and the 
associated Password. 

Option Function
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In the Logging  > Categories area a log layer is configured for each category. 

If an event of the configured log level or of a grosser log level occurs for a 
category, a log data set is created.

Option Function

Console Here you can enable the display of log data in the Console 
at runtime. In the Message Layout field you can configure 
the Log4J format of the log data sets. Log4J is a Java log-
ging API. You will find information on Log4J in the internet. 
The default format string for log information is %d{ABSO-
LUTE}: [%x] %-5p %c{2} - %m%n and can be restored via 
the Restore Defaults button.

Network Socket Here you can activate a check box for the Application 
Builder to provide debug information to the network. If you 
activate this option, you can configure the port number of 
the log server via which clients can connect this server.

Rolling File If you activate the check box in this section, log data is writ-
ten in a file or logging is attached to a file. Furthermore, you 
can configure the Log4J format of the log data sets, the file 
path, the maximum file size and the maximum number of 
log files.
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Configuration dialog Symvia

The Symvia area lets you perform the following settings:

Option Function

Level • Off
No log data sets are created.

• Fatal
A log data set is created in case of a fatal error only.

• Error

• Unexpected

• Warning

• Information

• Fine

• Finest
Very detailed log data sets are created.

Default value for an unknown category: Warning
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Option Function

Automatically show Grid 
when opening Editor for 
new Callflow

This setting defines whether the grid is to be automatically 
displayed when creating a new callflow.

Grid spacing of Callflow 
Editor (Pixel)

Grid spacing of the callflows in pixels. The default value is 
12.

Automatically show Cap-
tion when opening Editor 
for new Callflow

You can define whether a writing is configured in the call-
flow editor.

Automatically show Legend 
when opening Editor for 
new Callflow

You can define whether the legend is configured in the call-
flow editor.

Automatically show Shad-
ows when opening Editor 
for new Callflow

When you activate this option, all controls are automatically 
displayed shaded upon the creation of a new callflow.

Automatically show Rulers 
when opening Editor for 
new Callflow

Setting that automatically displays rules at the top and left 
editor margin when creating a new callflow.

Automatically enable ’Snap 
to Geometry’ when opening 
Editor for new Callflow

Ticking this check box automatically displays the auxiliary 
lines for the geometric arrangement of controls when creat-
ing a new callflow.
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Configuration dialog Symvia > Confirmations

In the Confirmations area you can perform the following settings:

Allow Items on Callflow to 
be manually resized

After activating this option you can change a control's size 
in the callflow. The size will otherwise be determined auto-
matically by the length of the control name. 

Changing this option is not effective for a currently opened 
callflow. Close the callflow and reopen it.

Connection Creation Pro-
cedure used on Callflows:

You can determine how to create a connection between two 
controls.

• Click on Source and Target Item
To create a connection between two controls, click on the 
source control and then on the target control.

• Drag from Source to Target Item
To create a connection between two controls, click on the 
source control and keep the mouse button pressed, then 
drag the mouse pointer onto the target control and 
release the mouse button.

Changing this option is not effective for a currently opened 
callflow. Close the callflow and reopen it.

Connection Router Type 
used on Callflows

The following connection types are available: 

• Straight Router
The connection line is straight and directly adjusted. If a 
third control is between two controls, the line is hidden by 
the third control.

• Linear Router
The connection line is straight and directly adjusted. If a 
third control is between two controls, the line bends 
around the third control.

• Orthogonal Router
The connection between two controls always consists of 
horizontal, vertical and/or right angles. It is not hidden by 
a third control.

Changing this option does not take effect until rebooting the 
Application Builder. 

Option Function
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4.1.7  Help

This menu has the following options:

Option Function

Show Confirmation Dialog after suc-
cessful Application Deployment

A dialog appear that confirms the successful 
deployment of an application. 

Show Confirmation Dialog after suc-
cessful Application Export

A dialog appears that confirms the successful 
export of an application. 

Show Confirmation Dialog after suc-
cessful Composition Export.

A dialog appears that confirms the successful 
export of a composition. 

Show Confirmation Dialog after suc-
cessful Custom Control Export

A dialog appears that confirms the successful 
export of the custom controls. 

Show Confirmation Dialog after start-
ing Monitoring external Custom Con-
trol File.

A dialog appears that confirms the successful start 
of monitoring a custom control.
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4.1.7.1  Dynamic Help

A click on the Dynamic Help menu option opens the help view in the form of a 
tab. It contains an overview of all topics.

Depending on the selected help page, the bottom margin shows different links:

• All Topics leads to the help's table of contents.

• Related Topics shows the links that provide information about the desired 
element. 

• Bookmarks displays the help pages that you have selected as bookmark.

• Index opens the keyword overview of the help.

• Search shows the page on which you can specify a search item for searching 
the help.

You find further information about the help in section Help View.

4.1.7.2  Search

When you select the Search menu option you are directly taken to the search 
page of the help.

Enter the item to be searched for in the Search expression field and then click 
on Go. The hits and their number are displayed in the bottom section of the view.

NOTICE:  The special characters * (arbitrary sequence), ? (any 
character), ““ (expression) and the Boolean operators AND, OR 
and NOT are allowed in search items.

Under Search scope you can configure the range in which the search is to be 
performed.

1. Click on the Default link to view or change the settings. 

Option Function

Help Contents This menu option opens the Online help. Depending on the 
settings you have made in the Tools > Preferences... 
menu option this is done in an external browser or in an 
Application Builder window.

Dynamic Help This menu option opens the help view with an overview of 
all topics. You find further information in section Dynamic 
Help.

Search This menu option immediately opens the Search topic in the 
help view. Here you can enter a specific term as online help 
search item. You find further information in section Search.

About OpenScape Fusion 
Application Builder

This menu option provides information about the Applica-
tion Builder. You find more information in section About 
Application Builder.
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2. Select the Default entry and click on the Edit... button. The following dialog 
opens:
In this dialog you can determine whether to search the local help document . 
Activate the Enable search engine check box for this purpose. In addition, 
you can select one of the two radio buttons to define the topics to be 
searched.

• Search all topics

• Search only the following topics
Activate the check box of the desired Working set content. This 
activates the topic itself and all subordinate topics for the search.

4.1.7.3  About OpenScape Fusion Application Builder

If you have selected the About OpenScape Fusion Application Builder menu 
option, a dialog opens that delivers information about the Application Builder.

Click on the Installation Details button to obtain information about the plug-ins 
and configurations. The dialog Application Builder Installation Details opens. 
It contains the tabs Plug-ins and Configuration.

Plug-ins tab

All Application Builder plug-ins are listed. Select an entry in the list. The following 
options become active:

• The Legal Info button offers information about the license in HTML format. In 
this case your default browser opens. 

• The Show Signing Info button offers information about the certificate of the 
selected plug-in if it is signed. 

• The Columns button offers an overview of the displayed columns. If you 
select a column you can change its displayed width. 

Configuration tab

If you select the Configuration tab you receive the entire Application Builder 
settings.

• The View Error Log button opens a window for displaying the error log file. If 
required, a dialog is displayed for selecting a program to view the error log. 
We recommend to prefer the editor. 

• The Copy to Clipboard button copies the settings to the clipboard. From 
there you can paste the settings into other programs by pushing the [Ctrl] 
+ [V] key combination, for example. 

4.2  Toolbar

Except for the zoom feature the toolbar offers a selection of the features that are 
also available via the menu bar. For a detailed description of the features please 
also refer to the corresponding chapter on the menu bar.
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4.3  Workspace View

The workspace view represents configuration options for the entire workspace 
and also the connected OpenScape server, the configured compositions and 
applications as well as their configuration options and associated callflows. The 
view appears in a tree structure:

Icon Function

Create new application or composition

Save open editors or performed settings

Save all callflows or all performed settings

Open dialog for printing the selected callflow 

Provide the currently selected application (deployment). 
Via the triangle you can choose from all available applica-
tions and compositions. 

Opens the dialog for testing the application. Via the triangle 
you can choose from all available applications and compo-
sitions.

Undo work step

Redo

Cut the selected object and copy it to the clipboard

Copy the selected object to the clipboard

Paste the cut or copied element from the clipboard into the 
desired position. 

Zoom factor of workspace representations

IMPORTANT:  You can also change the zoom factor by 
keeping the Ctrl key pressed while turning the mouse wheel.
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For the entire view you can select the following entries:

• Workspace Settings for configuring the supported languages

• Workspace Variables for creating and editing wildcards

• Workspace Prompts for integrating and creating announcements

• Workspace Grammars for activating rules and assignments for speech 
recognition 

• OpenScape Servers for logging on server profiles and configuring them. In 
addition, you can query the connected OpenScape server for hosted Symvia 
applications and their bindings. 

• Symvia Control Compositions for creating applications or application 
fragments that can be used again in the Symvia Application. Composition 
changes are global and have an effect on all referenced compositions.

For each newly created application the entries for configuring variables, prompts, 
grammars, and resources are created. The configuration of these variables, 
prompts, grammars, and resources is only valid in the respective application. 
Furthermore, the callflows created in an application are displayed.

For each workspace entry a specific icon is displayed. 

Icon Meaning

Workspace settings

Workspace or Application Variables 
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If errors or warnings exist in an entry's settings, the  icon is added for an error 

or the  icon is added for a warning. For example,  indicates that the Symvia 

application is faulty, and  marks a prompt for which warnings exist. When you 
select the corresponding entry, the errors or warnings are displayed in the 
Problem view.

4.3.1  Workspace Settings

If you doubleclick the Workspace Settings entry in the workspace view, the 
Workspace Settings tab for defining and configuring the languages to be used 
opens.

You need to define at least one supported language for each workspace and 
application. Applications inherit these languages from the workspace, but can be 
disabled individually. Only for the language set here you can select language-
dependent resources such as prompts or grammar files in the application. 

IMPORTANT:  Default languages are German and English (US). 
If you wish to use additional languages, appropriate TTS and ASR 
language packages must be installed on each media server of the 
OpenScape UC Application, for example uc-tts-zh_cn for the TTS 
language Chinese (Mandarin) or uc-asr-nl_be for the ASR 

Workspace or Application Prompts

Workspace or Application Grammars

Callflow

Icon Meaning
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language Flemish. You find details in the setup guideOpenScape 
UC Application Installation and Upgrade.

On the left-hand side, the tab shows a list of All Workspace Languages. As soon 
as you have selected one of the listed languages, the Workspace Language 
Properties appear on the right hand side.

4.3.1.1  How to Add a Predefined Language

Step by Step

1)  Click on the Workspace Settings item in the workspace. 

The Workspace Settings tab for defining and configuring the languages to 
be used opens in the editor area.

2) Click on the Add... button. 

The Add Languages to the Workspace dialog opens.

3) Activate the check box of the desired language(s) and confirm your selection 
with the OK button. 

The selected language appears indicated in the All Workspace Languages 
list and the properties of the added workspace language are displayed. The 
following language properties are available:

Field Description

Name The Name serves as unique identifier of a language 
resource.

Code The Code describes the values of the CultureInfo class 
defined by Microsoft, which contain the cultural proper-
ties of a country. These properties contain the name of 
the culture, the writing system, the calendar used as well 
as the date format and sorted character strings. The 
code consists of a two-digit culture code in small letters 
according to ISO 639 linked to a language and also of a 
two-digit fractional culture code in small letters linked to a 
country or region. The format consists of two letters, a 
hyphen and two letters, for example ja-jp for Japan.

Locale ID The Locale ID or LCID (locale identifiers) for short 
describes a unique code of a language resource intro-
duced by Microsoft, which is also used e.g. by your oper-
ating system. Using this ID the operating system can 
adjust the specific properties and representations of 
information output such as date and currency specifica-
tions or weekday names.

Type The Type indicates for each language resource whether 
the language is predefined, i.e. was installed via the UC 
system or whether it is a user-defined language.
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Via the Set this Language as Workspace Default Language... link you can 
define the selected language as language for all prompt, grammar and 
resource files.

4.3.1.2  How to Remove a Predefined Language

Step by Step

1)  Click on the Workspace Settings item in the workspace. 

The Workspace Settings tab for defining and configuring the languages to 
be used opens in the editor area.

2) Select the language you wish to remove from the list.

3) Click on the Remove button.

The language is removed from the list.

Properties Description

Language Name The Name serves as unique identifier of a language 
resource.

Language Description Optional description of the selected language.

Language Code The Code describes the values of the CultureInfo class 
defined by Microsoft, which contain the cultural proper-
ties of a country. These properties contain the name of 
the culture, the writing system, the calendar used as well 
as the date format and sorted character strings. The 
code consists of a two-digit culture code in small letters 
according to ISO 639 linked to a language and also of a 
two-digit fractional culture code in small letters linked to a 
country or region.

Locale ID The Locale ID or LCID (locale identifiers) for short 
describes a unique code of a language resource intro-
duced by Microsoft, which is also used e.g. by your oper-
ating system. Using this ID the operating system can 
adjust the specific properties and representations of 
information output such as date and currency specifica-
tions or weekday names.

Extra Information The optional information displayed here can be used by 
a target platform for identifying the workspace language. 

Resource Folders The Resource Folder describes the folder in which the 
prompts and grammar files configured for the workspace 
or an application are stored according to the associated 
language. For each language already assigned by the 
system a folder name is already predefined. For each 
user-defined language a folder name must be specified 
in the right column.
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4.3.1.3  How to Create a Custom Language Definition

Step by Step

1)  Click on the Workspace Settings item in the workspace. 

The Workspace Settings tab for defining and configuring the languages to 
be used opens in the editor area.

2) Click on the link Configure Custom Language Definitions.... 

The dialog of the same name appears.

3) Click on the Add... button.

The Add Custom Language dialog opens. 

4) Enter the following information:

• Language Name

• Language Description

• Language Code

• Locale ID

You can obtain the Language Code and the associated Locale ID from the 
Microsoft internet pages. 

5) Click the OK button. 

The created language is displayed in the list of custom language definitions.

You can select an available language and edit, copy or remove it from the list 
via the offered buttons. How to proceed is described in section How to Edit a 
Custom Language Definition.

6)  Click the OK button.

The dialog Configure Custom Language Definitions closes and the 
created language is added to the list.

4.3.1.4  How to Edit a Custom Language Definition

Step by Step

1)  Click on the Workspace Settings item in the workspace. 

The Workspace Settings tab for defining and configuring the languages to 
be used opens in the editor area.

2) Click on the link Configure Custom Language Definitions....

3) Select the language to be edited in the list. 

4) Click on the Edit... button.

The dialog Edit Custom Language Definitions opens. 

5) Change the language settings. 

6) Confirm your changes with OK. 
A31003-S50A0-U103-02-7619, 10/2020
OpenScape UC Application V10 Fusion Application Builder, User Guide 91



User Interface
Workspace View
The changes are applied to the language.

4.3.1.5  How to Remove a Custom Language Definition

Step by Step

1)  Click on the Workspace Settings item in the workspace. 

The Workspace Settings tab for defining and configuring the languages to 
be used opens in the editor area.

2) Click on the link Configure Custom Language Definitions....

3) Select the language to be removed in the list. 

4) Click on the Remove button.

The language is removed from the list of custom defined languages. 

4.3.2  Workspace Variables

If you doubleclick the Workspace Variables entry in the workspace view, the tab 
for defining and configuring the variables opens in the editor area.

In contrast to application-dependent variables, workspace variables are valid in 
the entire workspace and can be used across the application. 
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4.3.2.1  How to Create a new Workspace Variable

Step by Step

1) Click on the Add... button.

The Create Workspace Variable view opens.

2) Assign a name to the workspace variable.

3) Enter optionally a Workspace Variable Description. 

4) Click on OK.

The newly created workspace variable is in bottom position in the All 
Workspace Variables list. The aliases Alias for Symvia Application (AF 
2.0) and Alias for OpenScape Vogue Application (OpenScape 2.0) appear 
subordinately.

A click on Delete removes a selected workspace variable.

Using the Up or Down button you can move a selected variable up or down 
the list. 

The newly created variable is of type String by default. 

Next steps

Configure the workspace variable.

4.3.2.2  How to Configure a Workspace Variable

Step by Step

1) Click on the small triangle that precedes the corresponding variable.

The application alias of the variable opens. 

2) Select the corresponding variable Alias for Symvia Application (AF 2.0).

The Symvia Application Variable Details view opens.

3) If required, edit the values of the Variable Name and Variable Description 
field. 

4) From the Variable type combo box, select a primitive, complex or a list 
variable type.

• String

• Integer

• Boolean

• Float

• URI

Example:
A31003-S50A0-U103-02-7619, 10/2020
OpenScape UC Application V10 Fusion Application Builder, User Guide 93



User Interface
Workspace View
You may use a variable of type URI in a Send control to specify the path 
to a file to be attached to the message to be sent.

A variable of type URI is needed in the Message control for responding to 
a message. This variable contains the URI for the media file to be used 
as reply. The typical contents of this media file is spoken language 
recorded with the Record control.

• Date

• Time

• User

A user contains the account ID, the name, the language code and the 
One-Number Service number.

A variable of type User can for example be used in the Send control for 
sending a message to this user.

• Contact

A contact contains for example the account ID of the user who has this 
contact, the last name, the first name, e-mail addresses, the fax number 
and phone numbers of the contact. 

A variable of type Contact can for example be used in the Send control for 
sending a message to this contact.

• CallInfo

A CallInfo contains the user device, the date, the time, the direction 
(inbound/outbound), the call duration, and the device and name of the 
conversational partner.

• Tree

A WebService control stores a result of a web service in a variable of type 
Tree. The automatic speech recognition (ASR) transforms in an NLU 
control the spoken input of a user in a semantic result, which is then 
stored in a variable of type Tree.

INFO:  Speech recognition with subsequent storing of a result in 
a variable is, besides in the NLU control, also performed in the 
SpeechInput control. There, however, the semantic result is not 
stored in a variable of type Tree but of type RecognitionResult, the 
sub-elements or which are fixed.

• Dataset

A dataset stores the result of a database query in a DatabaseRead 
control.

• Conference

A conference contains for example an ID, a title, a list of invited users, a 
list of moderators, a start date, a start time and a status.

file:///C:/application_builder/my_workspace/items/Symvia Application 1/resources/inst.txt
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• Message

A message contains for example a message type, an ID, an originator, a 
recipient list, a subject, a text, a date and a time.

A variable of type Message identifies for example in the Message control 
the message to be replied to.

• EventData

This variable type can store the values of an application event.

• RoutingInfo

A RoutingInfo stores the routing recommendations for a call in a contact 
center. It contains for example the ID of the routing queue recommended 
for the call, the number of calls in this queue, the ID of the agent recom-
mended for processing the call and the estimated waiting time in the 
queue until the call is processed.

• QueueInfo

A QueueInfo stores the following data of a contact center queue: the 
number of calls in the queue, the estimated and average waiting time in 
the queue until the call is processed, the waiting time of the oldest call in 
the queue and the service level of the queue in percent.

• RecognitionResult

In a SpeechInput control the automatic speech recognition (ASR) trans-
forms the spoken input of a caller in a textual meaning, which is then 
stored in a variable of type RecognitionResult.

A RecognitionResult consists of the following sub-elements:

- Result (String): The textual meaning (semantic result) of the utterance 
(voice input) of the caller

- Utterance (String): The caller's voice input that corresponds to the 
textual meaning

- Confidence (Integer): The recognition confidence of the textual meaning 
in percent

INFO:  Speech recognition with subsequent storing of the result in 
a variable is, besides in the NLU control, also performed in the 
SpeechInput control. However, the textual meaning is stored there 
in a variable of type Tree the sub-elements of which are configu-
rable in the NLU control. A confidence does not store this control, 
though.

• MessageImportance

This enumeration variable type contains the importance level of a 
message. The values are Low, Normal and High.

You can use this variable type for example in a Send control or Prompt 
control for sending or playing a message's importance. However, a trans-
formation must have been previously defined for this variable type for the 
values Low, Normal and High to be reproduced by correct words in each 
supported language. In German, for example, such equivalents would be 
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the words Niedrig, Normal and Hoch. You start a transformation with a 
click on the Transformations... button next to the variable list.

• MessageSensitivity

This enumeration variable type contains the sensitivity level of a 
message.

• MessageType

This enumeration variable type contains the type of a message.

• PresenceStatus

This enumeration variable type contains the presence status.

• You can also use lists of all above variable types except for tree and event 
data.

5) Save the changes with . 

4.3.2.3  How to Configure the Transformation of a Variable Value

Using the Transformations... button you can create a variable the value of which 
is transformed after the announcement. The resulting, transformed value is then 
used for the announcement instead of the original value. Each variable transfor-
mation is available in the entire application.

Step by Step

1) Click on the Transformations... button.

The Configure the available Symvia Variable Transformations dialog 
opens.

2) Click on Add.

The Specify Variable Value Transformation dialog opens.

3) Enter the following values:

4) Click on Next.

5) Select a Transformation Directive from the drop down list.

The transformation directive corresponds to the logic used for transforming 
the variable value into text that can be spoken. Every directive can be used 
for a specific file type and may request result values.

6) Click on Next.

Field Description

Transformation 
Name

The name serves as unique identifier of the variable value 
transformation. 

Transformation 
Description

Optional Description of the Variable Value Transformation.
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7) Add Transformation Arguments via .

Specify the transformation arguments (input value) and the corresponding 
results (output value) for each of the activated languages. If the variable is to 
be announced, its current value is searched for in the arguments list. If the 
value is found, the corresponding result value of the current language is used.

Using the icon you can remove selected transformation arguments. 

8) Click on Next or Finish.

If you click on Next you can test the previously specified values.

9) Click on Finish.

The variable value configuration is added to the Configure the available 
Symvia Variable Transformations table.

The changes are copied when the entry is saved.

Using the Edit... button you can change the configurations of a selected trans-
formation. 

With the Copy... button you copy a selected transformation with its settings. 

A click on the Remove button removes a selected transformation perma-
nently from the list. 

You can change the order of the selected transformations with the Up and 
Down buttons.

4.3.2.4  How to Import Variables

Step by Step

1) Click on Import Variables from another Workspace....

The Import Workspace Variables dialog opens.

2) Click on Browse... for selecting the corresponding workspace.

All variables of the other workspace are automatically displayed with their 
properties. 

3) Select the desired variable.

To import all variables of a workspace, click on the Select All button. 

With a click on the Deselect All button you undo all variable selections. 

4) Click on the Finish button.

The imported variable is itemized in the All Workspace Variables list.

4.3.2.5  Further Configurations

The Workspace Variables tab features at the top right margin three more icons 
the functions of which are explained in the below table.
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On the top right margin of the All Workspace Variables area you find the icon. 
A click on this icon displays only the variables defined for the workspace in the All 
Workspace Variables list. The respective aliases can be displayed again via the 
small triangle to the left of each variable.

4.3.3  Workspace Prompts

If you doubleclick the Workspace Prompts entry in the workspace view, the tab 
for defining and configuring the workspace prompts opens in the editor area. 
Prompts or announcements are either sound files or spoken language created 
from written text by means of Text-to-Speech (TTS). They are used to serve 
various purposes in the controls. Examples are welcome announcements, 
operating instructions or information for the caller, which is announced.

Icon Function

After a click on this icon you can determine whether a vari-
able alias shall be displayed only for a Symvia Application, 
for an OpenScape Vogue application or for both. Activate 
the check box of the desired application in the opened dia-
log and then click on the OK button. After clicking on the 
small triangle you can select either Symvia Application or 
OpenScape Vogue Application.

In the icon's active state the areas All Workspace Vari-
ables and Application Variable Details or Workspace 
Variable Details are positioned next to each other (verti-
cally). This is the default setting. The area All Workspace 
Variables is found in the left half of the tab.

With a click on this icon you position the areas All Work-
space Variables and Application Variable Details or 
Workspace Variable Details on top of each other (horizon-
tally), with the area All Workspace Variables always being 
in the upper half of the tab.
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In contrast to application prompts, workspace prompts are valid in the entire 
workspace and can be used across the application. Workspace prompts are also 
displayed in the list of application prompts, albeit specially indicated.

4.3.3.1  How to Create a Workspace Prompt

Step by Step

1) Click on the Add... button. 

The Create Workspace Prompt dialog opens.

2) Enter the Workspace Prompt Name. 

3) You can optionally enter Workspace Prompt Description . 

4) Click the OK button. 

The newly created prompt is itemized in the All Workspace Prompts list on 
the Workspace Prompts tab. It does not have a text yet for using a text-to-
speech engine. 

Next steps

Configure the workspace prompt.
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4.3.3.2  How to Configure a Workspace Prompt

Prerequisites

• The prompt you wish to assign a media file to must have already been 
created. The media file must have the format *.wav or *.pcm. 

• Some icons appear only if you use specific Windows themes such as any 
Aero theme or the Windows 7 basic theme. You can change the Windows 
theme for example by clicking on the desktop background with the right 
mouse button and selecting Personalize. Alternatively, you can open Start > 
Control Panel > Personalization or Start > Control Panel > Appearance 
and Personalization > Personalization.

Step by Step

1) Select the alias of the corresponding prompt.

The right-hand area of the tab features Workspace Prompt Details.

NOTICE:  Please note that prompts can only be used for the 
available and configured languages. Languages are configured in 
the Workspace Settings on the Workspace Languages tab.

IMPORTANT:  Default languages are German and English (US). 
If you wish to use additional languages, appropriate TTS and ASR 
language packages must be installed on each media server of the 
OpenScape UC Application, for example uc-tts-zh_cn for the TTS 
language Chinese (Mandarin) or uc-asr-nl_be for the ASR 
language Flemish. You find details in the setup guide OpenScape 
UC Application Installation and Upgrade.

2) The Prompt Name field allows changing the prompt's alias name.

3) You can enter a description in the Prompt Description field.

4) In the Prompt Category field you can assign a category to the prompt. 

5) In the Prompt Texts field you enter a text for each configured language. This 
text is transformed into an announcement of the corresponding language by 
means of TTS if the prompt is used in an active application. This requires an 
installed TTS system.

In addition, the use of definitions in the XML-based SSML is supported. This 
serves for creating announcements in prompts with help of TTS. But instead 
of specifying a continuous text for announcement output, the text playback 
can be adjusted with the help of a special notation. For example, phone 
numbers may be announced digit by digit and slowly, thus for everybody to 
understand. Specify the desired entry in SSML for using SSML as text.

In the following example a specified number is announced as phone number:

“<say-as interpret-as=”telephone”>012387654</say-as>”
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You find a list of all possible definitions in SSML in the user guide of the 
supported speech recognition system (Nuance Recognizer) in the supplied 
ISO setup files of the languages for implementing TTS. Further information 
about SSML is contained in the web pages of the W3C institution.

6) In the Symvia Application Prompt Details area, click in the Prompt Files 
table on <Click to select file> in the row of the language for which you wish 
to import and assign a media file. 

Buttons appear to the left of this row.

NOTICE:  These icons appear only if you use specific Windows 
themes such as any Aero theme or the Windows 7 basic theme.

You can change the Windows theme for example by clicking on 
the desktop background with the right mouse button and selecting 
Personalize. Alternatively, you can open Start > Control Panel > 
Personalization or Start > Control Panel > Appearance and 
Personalization > Personalization.

You can perform a simple or an extended import.

In case of a simple import, you assign precisely one media file to a prompt for 
one language. As a result, this media file is imported in the media file repos-
itory of the workspace. Importing the media file occurs invisibly and implicitly. 
This is the most common application. 

In case of an extended import you can import several media files for a prompt 
for one or several languages in the media file repository of the workspace. 
This is useful if you wish to import music or tones for several languages in one 
go. One media file will then be assigned to a prompt for one language.

The opposite is also true: Each media file in this directory is available in the 
media file repository of the server. However, not every media file in this repos-
itory need to be assigned to a prompt.

A media file must always have the same name for all available languages, so 
that it can be stored in the corresponding resources folder for the respective 
language.

NOTICE:  Each workspace, composition, server (i. e. each 
OpenScape UC Application installation), and application has its 
own media file repository and resource directory. These reposi-
tories are independent from each other.

If you wish to perform a simple import, click in the Prompt Files table on the 
first ... button in the row in which you clicked on <Click to select file>, select 
a media file and click on Open. For this case, import in the media file repos-
itory is complete and the assignment to the prompt has been entered but not 
been saved yet. Continue with the next major step.

If, however, you wish to perform an extended import, execute the following 
sub-steps:

a) Click on the second ... button in this row.
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A dialog opens that displays the list of prompts available in the media file 
repository of the workspace.

b) Click on the small triangle on the Import... button and select Extended 
Import....

c) Click on the Add... button.

d) Select one or several media files and click on Open.

The media files are displayed in the list of media files to be imported.

e) Click on Next.

f) Activate the check boxes of the languages for which media files shall be 
imported in the media file repository of the workspace.

g) Click on the Finish button.

The media files are itemized in the list of files available in the media file 
repository of the workspace. The media files to which you have assigned 
languages not selected in the Prompt Files table are represented grayed 
out. If you select a media file of such languages, the OK button appears 
grayed out. Click on a file of the language you selected in the Prompt 
Files table. Using the Play button you can play this media file. 

h) Click on the OK button. 

For this case, import in the media file repository is complete and the 
assignment to the prompt has been entered but not been saved yet.

Regardless whether you performed a simple of extended import, icons to the 
right of the file name indicate whether the file exists and whether the file has 
a format that the Application Builder supports. 

If you wish to remove the assignment of the media file to the prompt, click on 
the file name and then on the third icon. However, this will not remove the 
media file from the media file repository of the workspace and not from the 
resource directory either.

7) If you click on the Configure Prompt Categories of the Workspace... link, 
you can add or remove prompt categories or assign them different colors or 
descriptions. Each prompt category is available in the entire workspace.

8) If necessary, you can click on the link Configure available Languages in the 
Workspace Settings Editor... to access the Workspace Settings > 
Workspace Languages > All Workspace Languages tab. You find more 
information on this in the Workspace Settings section.

9)  If you click on the Import Prompts from another Workspace... link, you can 
perform the actions described in section How to Import Prompts from another 
Workspace.

10) Push the hotkey CTRL + S or select File > Save in the menu to store media 
file assignments to prompts.
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4.3.3.3  How to Import Prompts from another Workspace

Step by Step

1) Click on the Import Prompts from another Workspace... link.

The Import Workspace Prompts dialog opens

2) Use the Browse... button to select the workspace from which the prompts 
shall be imported.

All prompts of the selected workspace are added to the list in the dialog 
Import Workspace Prompts.

3) Select in the list the prompts you wish to import or click on the Select All 
button to mark all prompts available in the workspace.

4) Click on Next.

5) Activate the check box of the language to be used for the prompt files.

If the prompt is to be available in several languages and the corresponding 
audio files with the different languages are available, activate the check boxes 
of the desired languages.

6) Click on the Finish button.

The imported prompts are itemized in the All Workspace Prompts list on the 
Workspace Prompts tab.

Enabling the Deselect All button undoes all prompt selections.

4.3.3.4  Further Configurations

The Workspace Prompts tab features at the top right margin four more icons the 
functions of which are explained in the below table.

Icon Function

This icon serves for filtering the prompt display. By enabling 
this icon you can determine for which applications a prompt 
alias is to be displayed. Activate the check box of the 
desired application in the opened dialog and then click on 
the OK button. Only the prompt aliases of the selected 
application are listed.
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At the top right margin of the All Workspace Prompts area the following two 
icons are available:

4.3.4  Workspace Grammars

If you doubleclick the Workspace Grammars entry in the workspace view, the tab 
for configuring the workspace-spanning grammar files opens in the editor area. 

This icon lets you filter the prompts on the basis of the 
assigned languages. Activate the check box of the desired 
language and then click on the OK button. Only the proper-
ties of the desired languages are displayed.

This icon is active by default. It places the sections All 
Workspace Prompts and Symvia Application Prompts 
Details or Workspace Prompt Details next to each other 
(vertically). The area All Workspace Prompts is found in the 
left half of the tab.

When you activate this icon, the areas All Workspace 
Prompts and Symvia Application Prompt Details or 
Workspace Prompt Details are positioned on top of each 
other (horizontally), with the area All Workspace Prompts 
always being in the upper half of the tab.

Icon Function

With the help of this icon you can sort all grammars defined 
for the workspace alphabetically ascending.

A click on this icon displays only the prompts defined for the 
workspace in the All Workspace Prompts list. The respec-
tive aliases can be displayed again via the plus sign of a 
prompt.

Icon Function
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A grammar file contains assignments and rules for speech recognition.

The assignments assign meanings to utterances. Utterances are words the caller 
speaks, recognized by speech recognition (ASR) during the application's runtime. 
Meanings are the interpretation results of such utterances.

Example:

Utterance: Hallo

Meaning: Hello

Standard grammars

Standard grammars are grammars provided by the Application Builder and usable 
in the entire workspace. However, you cannot configure them. The following 
standard grammars are available:

• DTMF Grammars

– Standard DTMF #

– Standard DTMF *

– Standard DTMF 0

– Standard DTMF 0-9

– Standard DTMF1 

– Standard DTMF 2

– Standard DTMF 3

– Standard DTMF 4

– Standard DTMF 5

– Standard DTMF 6

– Standard DTMF 7

– Standard DTMF 8

– Standard DTMF 9

– Standard DTMF Sequence

– Standard DTMF Sequence (# terminated)

– Standard DTMF Sequence (* terminated)

– Standard DTMF Sequence (separated)

– Standard DTMF Sequence (separated, # terminated)

– Standard DTMF Sequence (separated, * terminated)

• Number Grammars

– Standard Number 0-24

– Standard Number 0-366

– Standard Number 0-6

– Standard Number 0-9

– Standard Number 0-9,999

– Standard Number 0-99

– Standard Number 0-99,999

– Standard Number 0-999

– Standard Number 0-999,999
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– Standard Number 0-999,999,999

– Standard Number 1-12

– Standard Number 1-12 (ordinal)

– Standard Number 1-3

– Standard Number 1-3 (ordinal)

– Standard Number 1-31

– Standard Number 1-31 (ordinal)

– Standard Number 1-366 (ordinal)

– Standard Number 1-54

– Standard Number 1-54 (ordinal)

– Standard Number 1-60

– Standard Number 1-7

– Standard Number 1-7 (ordinal)

– Standard Number 1-9

– Standard Number 1-9 (ordinal)

– Standard Number 1-99

– Standard Number 2-200

– Standard Number Sequence 0-9

– Standard Number Sequence 0-9 (separated)

– Standard Number Sequence 0-99

– Standard Number Sequence 0-99 (separated)

• Garbage Grammars

– Standard Garbage (leading)

– Standard Garbage (inner)

• Letter Grammars

– Standard Letter

– Standard Letter Sequence

– Standard Letter Sequence (separated)

• Date/Time Grammars

– Standard Date

– Standard Time

– Standard Time Range

• Standard Cancel

• Standard Decline

• Standard Accept

• Standard Boolean

• Standard Help

• Standard Repeat

Standard grammars are not displayed in the workspace but in the grammar 
selection dialogs of the controls. For example, click in the SpeechInput control on 
the Recognition first and the on the icon.
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4.3.4.1  How to Create a new Workspace Grammar

Step by Step

1) Click on the Add... button. 

The Create Workspace Grammar dialog opens.

2) Specify the Workspace Grammar Name. You can optionally enter a 
Workspace Grammar Description.

3) Click the OK button. 

The grammar appears in the list of All Workspace Grammars. No grammar 
file has yet been assigned to the added grammar.

Next steps

Assign a grammar file that you create or import to the grammar.

4.3.4.2  How to Create a Grammar File for the Workspace 

Prerequisites

• Some icons appear only if you use specific Windows themes such as any 
Aero theme or the Windows 7 basic theme. You can change the Windows 
theme for example by clicking on the desktop background with the right 
mouse button and selecting Personalize. Alternatively, you can open Start > 
Control Panel > Personalization or Start > Control Panel > Appearance 
and Personalization > Personalization.

• IMPORTANT: The default languages for the automatic speech recognition 
are German and English (US). If you wish to use additional languages, the 
corresponding ASR language packages must be installed on each media 
server of the OpenScape UC Application; for example uc-asr-nl_be for the 
ASR language Flemish. You find details in the setup guide OpenScape 
UC Application Installation and Upgrade.

Step by Step

1) Select the alias name of the corresponding grammar. 

In the Workspace Grammar Details area of the tab you are provided with 
further setting options. 

NOTICE:  Please note that grammar files can only be used for the 
available and configured languages. Languages are configured in 
the workspace settings on the workspace languages tab. 

2) In the Workspace Grammar Details area, click in the Grammar Files table 
on <Click to select file> in the row of the language for which you wish to 
import and assign a grammar file. 

Buttons appear to the left of this row.
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INFO:  These icons appear only if you use specific Windows 
themes such as any Aero theme or the Windows 7 basic theme.

You can change the Windows theme for example by clicking on 
the desktop background with the right mouse button and selecting 
Personalize. Alternatively, you can open Start > Control Panel > 
Personalization or Start > Control Panel > Appearance and 
Personalization > Personalization.

3) Click on the second ... button in this row. 

The Select Grammar File dialog opens. All available grammar specification 
files are listed. 

4) Click on the Create... button.

The Create Grammar File dialog opens. 

5) Specify the File Name. The file must be a GRM file. You can optionally add a 
File Description. 

6) Click on Next.

7) Activate the check box of the languages for which a grammar file shall be 
created. 

Only languages active in the workspace are displayed. 

8) Click on Next.

The dialog that specifies the utterances of the respective language opens. 
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In the top-left area of the dialog you see the respective language represented 
by the country's flag.

9) Click on to add a new utterance. 

10) Enter an Utterance. Each utterance corresponds to the spoken call input to 
be recognized by the grammar. 

11) Enter the meaning of this utterance under Result. 

With  you remove selected utterances from the table. 

With  you can use utterances specified for another language in the 
grammar file. 

NOTICE:  Please note that in this case the utterances already 
created for the language are overwritten. 

12) Click on Next.

You reach the dialog of the next language for specifying utterances and their 
meaning. 

13) After you have created utterances and meanings for all languages, click on 
Finish.

The Create Grammar File dialog closes. The grammar file is listed in the 
Select Grammar File dialog and can be selected. This dialog shows the list 
of files available in the grammar file repository of the workspace. Empty 
grammar files appear in red.

INFO:  Each workspace, composition and application has its own 
grammar file repository and resource directory. These reposi-
tories are independent from each other.

14) Choose the grammar file of the above selected language and click on OK.

The chosen grammar file is listed for the selected language in the Grammar 
Files field.

NOTICE:  The grammar file must always have the same name for 
all available languages, so that it can be stored in the corre-
sponding resources folder for the respective language.

15) Push the hotkey CTRL + S or select File > Save in the menu to store the 
changes.
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4.3.4.3  How to Import a Grammar File

Step by Step

1) Mark the respective grammar. 

In the Symvia Application Grammar Details area of the tab you are 
provided with further setting options. 

NOTICE:  You need to assign already existing grammar files to 
grammars. Please note that grammar files can only be used for 
the available and configured languages. Languages are 
configured in the workspace settings on the workspace 
languages tab. 

2) Click on the Browse... button next to the Grammar File field. 

The Select Grammar File dialog opens. All available grammar specification 
files are listed. 

The grammar files need not match the set workspace languages. Via the 
Only show those Files that are available for every Workspace Language 
option you can make sure that the displayed grammar files are applicable for 
all configured languages.

NOTICE:  If you want to insert a grammar file already used, 
proceed with step 10. If you wish to add a new grammar file, skip 
to step 3.

3) Click on the Import... button.

The Import Grammar Files dialog opens.

4) Click on the Add... button.

5) Select the desired grammar file in the opened dialog and click on the Open 
button.

The selected grammar file is integrated in the list of grammar files to be 
imported.

6) Select the grammar file just added and click on Next.

7) Determine the grammar file language by activating the check box of the 
relevant language.

If the grammar is to be available in several languages and the corresponding 
grammar files with the different languages are available, activate the check 
boxes of the desired languages.

8) Click on the Finish button.

The grammar file is itemized in the list of available files in the Select 
Grammar File dialog.

Via the Details button you receive a view of the code of a grammar file.
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9) Select the grammar file and click on OK.

The selected grammar file and the languages for which it is to be used are 
itemized in the Symvia Application Grammar Details list.

NOTICE:  The grammar file must always have the same name for 
all available languages, so that it can be stored in the corre-
sponding resources folder for the respective language.

4.3.4.4  How to Import a Grammar from another Workspace

Step by Step

1) Click on the Import Grammars from another Workspace... link.

2) Select the corresponding workspace from the selection list or via the 
Browse... button.

All grammars of the other workspace are automatically displayed with their 
properties.

3) Click on OK.

The grammars of the file are added to the list in the Workspace Grammars 
dialog.

4) Select the desired grammar in the list.

A click on the Select All button marks all grammars in the list.

Enabling the Deselect All button undoes all grammar selections.

5) Click on Next or Finish.

6) Determine the grammar file language by activating the check box of the 
relevant language.

If the grammar is to be available in several languages and the corresponding 
grammar files with the different languages are available, activate the check 
boxes of the desired languages.

7) Click on the Finish button.

The grammar to be imported from the other workspace is integrated in the 
current workspace and appears in the All Workspace Grammars list.

4.3.4.5  Further Configurations

The Workspace Grammars tab features at the top-right margin four more icons 
the functions of which are explained in the below table.
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At the top right margin of the All Workspace Grammars area the following two 
icons are available:

4.3.5  OpenScape Servers

Using an application created with the Application Builder requires the Application 
Builder being connected to an OpenScape UC Application. Please obtain 
OpenScape UC Application details from the OpenScape UC Application System 
Description. In the Application Builder GUI, the OpenScape UC Application is 
called OpenScape Server. When you double-click the OpenScape Server entry 
in the workspace view you can edit the settings for connecting an OpenScape UC 
Application.

The OpenScape Server tab contains the following areas:

• OpenScape Server Logon
You perform the login in this area.

Icon Function

This icon serves for filtering the grammar display. By 
enabling this icon you can determine for which applications 
a grammar alias is to be displayed. Activate the check box 
of the desired application in the opened dialog and then 
click on the OK button. Only the grammar aliases of the 
selected application are listed.

This icon lets you filter the grammars by the assigned lan-
guage. Activate the check box of the desired language and 
then click on the OK button. Only the properties of the 
desired languages are displayed.

This icon is active by default. It places the sections All 
Workspace Grammars and Symvia Application Gram-
mar Details next to each other (vertically).

A click on this icon places the sections All Workspace 
Grammars and Symvia Application Grammar Details on 
top of each other (horizontally), with section All Workspace 
Grammars always being in the top half of the screen.

Icon Function

With the help of this icon you can sort all grammars defined 
for the workspace alphabetically ascending.

A click on this icon displays only the prompts defined for the 
workspace in the All Workspace Grammars list. The 
respective aliases can be displayed again via the plus sign 
of a grammar.
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• Server Profile Configuration
In this area you manage the profiles deployed for logging on to an OpenScape 
UC Application. 
A server profile is a combination of a user's login name, the IP address of the 
application computer (back-end computer) of the OpenScape UC Application 
and a port number.
Example: administrator@system auf js-soc://10.9.30.97:4711

• Logon Configuration
You configure login details here.

• OpenScape Server Content
This area informs you about applications, server prompts and server time 
profiles used on the OpenScape UC Application.

4.3.5.1  Configuring OpenScape UC Application Users

The Available Server Profiles indicates how many OpenScape UC Application 
server profiles were configured in the Application Builder. Profiles not yet used for 
successfully logging on to an OpenScape UC Application are also counted 
among the available server profiles. 

Click on the Server Profiles... button. 

The Configure the available Server Profiles opens. You receive an overview of 
all available profiles. Here you can add, edit and remove server profiles. 

The below table contains the available options:
A31003-S50A0-U103-02-7619, 10/2020
OpenScape UC Application V10 Fusion Application Builder, User Guide 113



User Interface
Workspace View
4.3.5.2  How to Create a Server Profile

You must create a server profile for the administrator of the OpenScape UC Appli-
cation to connect the Application Builder to the OpenScape UC Application.

Prerequisites

• You need the password of user administrator at the OpenScape UC Appli-
cation, the IP address of the application computer (back-end computer) of the 
OpenScape UC Application and the port used for connecting the OpenScape 
UC Application. Port 4711 is used by default.

Step by Step

1) Click on the OpenScape Server entry in the workspace view.

2) Click on the Server Profiles... button. 

The Configure the available Server Profiles opens. You receive an 
overview of all available server profiles. 

3) Click on the Add... button.

The Create new Server Profile dialog opens.

Icon Function

Add... With this button you can create server profiles and config-
ure them for the first time. The Create new Server Profile 
for Login dialog opens.

Edit... With this button you can edit a server profile previously 
selected in the list and change the configuration. That is 
only possible if this server profile is not used for logging on 
to an OpenScape UC Application at this time.

Copy... With this button you can copy a server profile previously 
selected in the list.

Remove With this button you can permanently remove a server pro-
file previously selected in the list. 

Test With this button you can check a server profile previously 
selected in the list. 

Set as Default With this button you can select a server profile previously 
marked in the list as default. 

Import Profiles from 
another Workspace

With this link you can import server profiles from another 
available workspace in the current workspace. 
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4) Choose Server Type and specify the following values:

5) Confirm your entries with OK.

The created profile is added to the list of server profiles.

Next steps

You can now log the Application Builder on to the OpenScape UC Application.

4.3.5.3  How to Import a Server Profile

This section describes how to import a server profile from another workspace.

Step by Step

1) Click on the Server Profiles... button. 

The Configure the available Server Profiles opens. You receive an 
overview of all available server profiles. 

2) Click on the Import Profiles from another Workspace... link.

3) Select the desired workspace from the selection list. Via the Browse... button 
you can add workspaces to the selection. 

All server profiles of the other workspace are automatically displayed.

Field Function

User Name Name of an OpenScape UC Application user without domain. 

Example: administrator

Server Domain OpenScape UC Application domain. For the time being, only 
the system domain is supported. 

This is no Linux or Windows domain.

Server Address Address of the application computer (back-end computer) of 
the OpenScape UC Application inclusive port number. 

Example of usage with unencrypted connection:

js-soc://10.9.30.94:4711

Profile Name The profile name is automatically allocated with values of the 
fields User Name and Server Address. 

Example:

administrator@system on js-soc://
10.9.30.94:4711

Store Password of 
server profile

If you wish to store the server profile password, activate this 
check box. 

Password Password of the server profile

Confirm Password Password of the server profile
A31003-S50A0-U103-02-7619, 10/2020
OpenScape UC Application V10 Fusion Application Builder, User Guide 115



User Interface
Workspace View
4) Select the desired server profiles and click on Finish.

A click on the Select All button marks all available server profiles of the 
workspace.

Enabling the Deselect All button undoes all server profile selections.

The server profiles to be imported from the other workspace are integrated in 
the current workspace and appear in the Server Profiles List.

4.3.5.4  How to Configure the Login to the OpenScape UC Application

You can configure the login process as to make the Application Builder start with 
automatically connecting the OpenScape UC Application under a server profile to 
be set.

Step by Step

1) Activate the check box Automatically do Login during Application Builder 
Startup if login is to occur automatically.

2) Determine the desired login behavior by selecting one of the following 
options.

• Always ask for Profile for Login: During login you will be prompted to 
specify the server profile for logging on to the OpenScape UC Application.

• Always login with Default Profile: The default server profile is always 
used for logging on.

• Always login with specified profile: The currently specified server 
profile is always used.

• Always login with the last used Profile: The server profile used last 
serves for logging on.

4.3.5.5  How to Log on to the OpenScape UC Application

Prerequisites

• The Current Status field shows the login status of the currently selected 
server profile. You can log on a server profile only if the value of this field is 
Not Logged In. If another server profile is still logged in, log it out with a click 
on the Logout button.

• There is at least one server profile.

• Each firewall between the computer that operates the Application Builder and 
the application computer (back-end computer) of the OpenScape UC Appli-
cation opens the port specified in the server profile. Example: Port 4711 in 
js-soc://10.9.30.94:4711
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Step by Step

1) In the Change Status combo box select the desired server profile for logging 
on to the OpenScape UC Application.

2) Click on Login.

The login dialog opens.

3) Enter the password.

4)  If required, activate the Remember password for this Profile check box.

5) Click on OK.

Value Logged In in the Current Status field confirms the successful login. A 
successful login in also stated in the console.

Examples:

14:13:10,323 Account ’administrator@system’ on Server ’js-soc://
10.9.30.94:4711’

After a successful login, the Deployed Applications tab of the OpenScape 
Server Content shows the provided applications. Such applications may 
have been created with the Application Builder.

Logging the user off with a click on the Logout button in the OpenScape 
Server Login area displays a note in the bottom right corner on the Deployed 
Applications tab of the OpenScape Server Content section that describes 
the tab's content as outdated.

Example:

No Server Connection

Showing last recent Contents of js-soc://10.9.30.94:4711 from 15.11.13 
14:20

After a fresh user login, the note disappears.

4.3.5.6  OpenScape Server Content

On the OpenScape Server Content tab you can see information about compo-
nents queried by OpenScape UC Application or transferred to it.

IMPORTANT:  The content of the OpenScape Server Content 
tab represents the status during the last communication to 
OpenScape UC Application. This content need not necessarily be 
up-to-date.

When you log the user off with a click on the Logout button in the 
OpenScape Server Login section, a note is displayed bottom 
right on the Deployed Applications, Server Prompts > All 
Symvia Server Prompts and Server Time Profiles > All 
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Symvia Server Time Profiles tabs that describes the contents on 
the aforementioned tabs as obsolete.

Example:

No Server Connection

Showing last recent Contents of js-soc://10.9.30.94:4711 from 
15.11.13 14:20

After a fresh user login, the note disappears.

Deployed Applications

On this tab you can see information about the applications used on the 
OpenScape UC Application. Such applications may have been created with the 
Application Builder.

Server Prompts

Server prompts are prompts not stored on the computer that hosts the Application 
Builder but on the computer that hosts the OpenScape UC Application. As a 
result, all server prompts are available to all applications of the same workspace 
provided on this OpenScape UC Application. Changes to one of these prompts 
are immediately available to all of these applications.

Workspace prompts, composition prompts and application prompts, however, are 
available on the computer that was specified upon the creation of those prompts. 

You find server prompt details in section How to Create and Configure Server 
Prompts.

The Server Prompts > All Symvia Server Prompts area shows server prompts 
only.

Server Time Profiles

Server time profiles are time profiles not stored on the computer that hosts the 
Application Builder but on the computer that hosts the OpenScape UC Appli-
cation. As a result, all server time profiles are available to all applications of the 
same workspace provided on this OpenScape UC Application. Changes to one of 
these time profiles are immediately available to all of these applications. In 
contrast, a time profile created in a TimeProfile control is only available in this 
TimeProfile control.

You find server time profile details in sections How to Create a Server Time Profile 
and How to Add an Existing Server Time Profile.

Icons

Click in the OpenScape Server Content section on  at the top-right margin for 
updating the configurations of the Symvia protocols of the server or of the created 
applications. Modifications to the configuration of Symvia logs and Symvia appli-
cations are stored in the database via the Save command. The displayed infor-
mation is only a snapshot. An update refreshes the configurations and information 
in the Symvia protocols and Symvia applications of the server. 
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The OpenScape Server Content tab features at the top-right margin several 
icons the functions of which are explained in the below table.

At the top right margin of the Server Prompts > All Symvia Server Prompts 
area you find the following icons:

At the top right margin of the Server Prompts > All Symvia Server Time 
Profiles area you find the following icons:

Icon Function

This icon is only displayed if you are not logged in at an 
OpenScape UC Application. You can use this icon to dis-
play the content present in the OpenScape Server Con-
tent area when you were logged in at the penultimately 
connected OpenScape UC Application. Click on this icon or 
on the associated triangle to select the corresponding 
server profile. That way you can determine which server 
prompts and server time profiles were valid for this server 
profile at a time in the past.

This icon is only displayed if you are logged in at an 
OpenScape UC Application. You use this icon to update the 
content of the OpenScape Server Content area whereby 
only changes are transmitted.

This icon is only displayed if you are logged in at an 
OpenScape UC Application. With help of this icon you 
update the content of the OpenScape Server Content 
whereby a download in enforced that contains changed as 
well as unchanged components.

IMPORTANT:  

Using this icon you can display or hide languages for 
prompt texts and prompt files in the Server Prompts > 
Symvia Application Prompt Details area.

Icon Function

A click on this icon sorts the server prompts alphabetically. 
Another click on the icon undoes the sorting. This icon is 
only effective if the server prompts are not displayed sorted 
by categories.

A click on this icon sorts the server prompts by categories. 
Another click on the icon undoes the sorting.

A click on this icon displays only the prompts defined for the 
workspace in the All Workspace Grammars list. The 
respective aliases can be displayed again via the plus sign 
of a grammar.
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4.3.5.7  How to Create and Configure a Server Prompt

Prerequisites

• You must be logged in at an OpenScape UC Application.

• Some icons appear only if you use specific Windows themes such as any 
Aero theme or the Windows 7 basic theme. You can change the Windows 
theme for example by clicking on the desktop background with the right 
mouse button and selecting Personalize. Alternatively, you can open Start > 
Control Panel > Personalization or Start > Control Panel > Appearance 
and Personalization > Personalization.

Step by Step

1) You can assign server prompts to prompt categories. Prompt categories differ 
in their names, descriptions and color representations. You can display server 
prompts sorted by categories in the All Symvia Server Prompts area. Server 
prompt categories are independent from workspace prompt categories, 
composition prompt categories and application prompt categories. 

After a click on the Categories... button or on the Configure Prompt 
Categories of the Server... link you can add or remove prompt categories or 
assign them another color or description. 

2) Click on the Add... button. 

The Create Symvia Server Prompt dialog opens.

3) Enter the Prompt Name. 

4) You can specify a Prompt Description optionally. 

5) Click on the OK button. 

The prompt is itemized in the All Symvia Server Prompts list of the 
OpenScape Server Content tab. It does not have a text yet for using a text-
to-speech engine. 

In the right-hand section Symvia Application Prompt Details you find the 
following options:

NOTICE:  Please note that prompts can only be used for the 
available and configured languages. Languages are configured in 
the Workspace Settings on the Workspace Languages tab.

IMPORTANT:  Default languages are German and English (US). 
If you wish to use additional languages, appropriate TTS and ASR 

Icon Function

A click on this icon sorts the server time profiles alphabeti-
cally. Another click on the icon undoes the sorting.
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language packages must be installed on each media server of the 
OpenScape UC Application, for example uc-tts-zh_cn for the TTS 
language Chinese (Mandarin) or uc-asr-nl_be for the ASR 
language Flemish. You find details in the setup guide OpenScape 
UC ApplicationInstallation and Upgrade.

6) In the Prompt Category field you can assign a category to the prompt. 

7) In the Prompt Texts field you can enter a text for each configured language. 
This text is transformed into an announcement of the corresponding language 
by means of TTS if the prompt is used in an active application. This requires 
an installed TTS system.

In addition, the use of definitions in the XML-based SSML is supported. This 
serves for creating announcements in prompts with help of TTS. But instead 
of specifying a continuous text for announcement output, the text playback 
can be adjusted with the help of a special notation. For example, phone 
numbers may be announced digit by digit and slowly, thus for everybody to 
understand. Specify the desired entry in SSML for using SSML as text.

In the following example a specified number is announced as phone number:

“<say-as interpret-as=”telephone”>012387654</say-as>”

You find a list of all possible definitions in SSML in the user guide of the 
supported speech recognition system (Nuance Recognizer) in the supplied 
ISO setup files of the languages for implementing TTS. Further information 
about SSML is contained in the web pages of the W3C institution.

8) In the Prompt Files table of the Symvia Application Prompt Details area, 
click on <Click to select file> in the row of the language for which you wish 
to import or assign a media file of the format *.wav or *.pcm. 

Buttons appear to the left of this row.

INFO:  These icons appear only if you use specific Windows 
themes such as any Aero theme or the Windows 7 basic theme.

You can change the Windows theme for example by clicking on 
the desktop background with the right mouse button and selecting 
Personalize. Alternatively, you can open Start > Control Panel > 
Personalization or Start > Control Panel > Appearance and 
Personalization > Personalization.

You can perform a simple or an extended import.

In case of a simple import, you assign precisely one media file to a prompt for 
one language. This will import the media file in the media file repository of the 
server (i. e. the OpenScape UC Application installation). This occurs invisibly 
and implicitly. This is the most common application.

In case of an extended import you can import several media files for a prompt 
for one or several languages in the media file repository of the server. This is 
useful if you wish to import music or tones for several languages in one go. 
One media file will then be assigned to a prompt for one language.

Each OpenScape UC Application has its own ID.
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The opposite is also true: Each media file in this directory is available in the 
media file repository of the server. However, not every media file in this repos-
itory need to be assigned to a prompt.

A media file must always have the same name for all available languages, so 
that it can be stored in the corresponding resources folder for the respective 
language.

INFO:  Each workspace, composition, server (i. e. each 
OpenScape UC Application installation), and application has its 
own media file repository and resource directory. These reposi-
tories are independent from each other.

If you wish to perform a simple import, click in the Prompt Files table on the 
first ... button in the row in which you clicked on <Click to select file>, select 
a media file and click on Open. That finishes the import and assignment in this 
case. Continue with the next major step.

If, however, you wish to perform an extended import, execute the following 
sub-steps:

a) Click on the second ... button in this row.

A dialog opens that displays the list of media files available in the media 
file repository of the server.

b) Click on the small triangle on the Import... button and select Extended 
Import....

c) Click on the Add... button.

d) Select one or several media files and click on Open.

The media files are displayed in the list of media files to be imported.

e) Click on Next.

f) Activate the check boxes of the languages for which media files shall be 
imported in the media file repository of the server.

The media files are automatically copied to the resource folder of the 
prompts for the corresponding languages.

NOTICE:  A media file must always have the same name for all 
available languages, so that it can be stored in the corresponding 
resources folder for the respective language.

g) Click on the Finish button.

The media files are itemized in the list of files available in the media file 
repository of the server. The media files to which you have assigned 
languages not selected in the Prompt Files table are represented grayed 
out. If you select a media file of such languages, the OK button appears 
grayed out. Click on a file of the language you selected in the Prompt 
Files table. Using the Play button you can play this media file. 

h) Click on the OK button. 
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For this case, import in the media file repository is complete and the 
assignment to the prompt has been entered but not been saved yet.

Regardless whether you performed a simple of extended import, icons to the 
right of the file name indicate whether the file exists and whether the file has 
a format that the Application Builder supports. 

If you wish to remove the assignment of the media file to the prompt, click on 
the file name and then on the third icon. However, this will not remove the 
media file from the media file repository of the server and not from the 
resource directory either.

9) If necessary, you can click on the link Configure available Languages in the 
Workspace Settings Editor... to access the Workspace Settings > 
Workspace Languages > All Workspace Languages tab. You find more 
information on this in the Workspace Settings section.

10)  After a click on the Repository... button you can import media files in the 
repository or remove, rename, play or update them but you cannot assign 
them to a prompt.

11)  With a click on the Import Prompts from another Server... link you open a 
dialog for importing prompts available on another server.

12) Push the hotkey CTRL + S or select File > Save in the menu to transfer the 
changes to the OpenScape UC Application.

4.3.5.8  How to Create a Server Time Profile

This section describes how to create a server time profile. This time profile is 
available to all TimeProfile controls. If you need a time profile exclusively available 
in a single TimeProfile control, create the time profile in this control. In order to 
create such a time profile you need not be logged in at an OpenScape UC Appli-
cation. You find details in section How to Create a new Time Profile.

Prerequisites

• You must be logged in at an OpenScape UC Application.

Step by Step

1) Click on the Add... button to create a new profile.

The Create new Time Profile dialog opens. 

2) Specify under Time Profile Name the name of the new time profile, for 
example During business hours, Outside business hours, 
Public holiday or Company holidays.

INFO:  We recommend to specify the word Server as name. This 
will help once more to differentiate server time profiles from time 
profiles available only in a single TimeProfile control. A 
TimeProfile control displays both types of time profiles in a 
common list.
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The Time Range List itemizes already created time profile ranges for the 
time profile.

3) Click on .

The Create new Time Profile Range dialog opens. 

4) Specify the values of the new time profile range. For this purpose, activate 
one of the radio buttons described in the following:

a) Specify range of full Calendar Days (will not recur): Here you can 
select the start date and end date of a time range. The time profile range 
comprises whole days and does not recur.

Example: 20.11.2013 - 27.11.2013

b) Specify Range within a specific Day of Year (will recur every Year): 
Here you can select a day of a month, a month, a start time and an end 
time. This time profile range recurs every year.

Example: Every 20 November from 00:09:00 to 17:00:00

c) Specify Range within a specific Day of Week (will recur every week): 
Here you can select a weekday, a start time and an end time. This time 
profile range recurs weekly.

Example: Every Wednesday from 00:09:00 to 17:00:00

5) Click on OK.

The Create new Time Profile Range dialog closes.

The create time profile range has been added under Time Range List.

6) The following icons are available for the Time Range List.

7) Click on OK or Apply.

The created server time profile has been added to the server time profiles list.

IMPORTANT:  Each time profile corresponds to a new exit of a 
TimeProfile control.

The Symvia Application Time Profile Properties area displays properties 
of the created server time profile.

8) If needed, enter a value in the Time Profile Description field. 

Icon Description

This icon enables creating a new time profile range for this server time 
profile.

Using this icon you can change an already created and selected time 
profile range.

A click on this icon removes a selected time profile range from the list.

If you have created several time profile ranges, they are applied in top-to-
bottom order. Using these icons you can move selected time profile 
ranges in the list up or down.
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You can use server time profiles in a TimeProfile control. In this case they are 
displayed in a list together with other time profiles. This list also displays 
descriptions of all applied time profiles. Meaningful descriptions facilitate 
configuring a TimeProfile control.

9)  With a click on the Import Time Profiles from another Server... link you 
open a dialog for importing server time profiles available on another server.

10) Push the hotkey CTRL + S or select File > Save in the menu to transfer the 
changes to the OpenScape UC Application.

4.3.6  Symvia Control Compositions 

Symvia control compositions are application fragments that, created once, can be 
implemented in any number of applications as application fragments. Reusability 
is thus increased. A typical example of a composition a user's logging on to the 
system. Modifications to a composition are automatically applied in all applica-
tions in which the composition has been implemented. 

NOTICE:  You may perform application-specific modifications 
only in the respective application but not in the composition. 

Compositions are similar to functions or methods in higher programming 
languages.

Compositions are created and configured in the Application Builder's workspace. 

NOTICE:  Example compositions are available in the 
Samples\Compositions sub-folder of the Application Builder's 
installation folder (not in the workspace directory). These compo-
sitions are shipped with the Application Builder. The How to 
Import Workspace Elements section describes how to provide 
these compositions.

The context menu of a composition offers various configuration options. Right-
click a composition in the workspace to open the application's context menu. The 
following options are available:

• New enables the creation of a new composition or callflow.

• Copy copies the selected composition with all its settings to the clipboard.

• Paste creates a copy of the selected composition.

• Delete removes the selected composition from the workspace.

• Rename changes the composition's name.

• Export Element... serves for exporting a composition to an archive file.

• Properties represents a summary of the general and lingual composition 
settings. You receive general information such as storage location, date of 
last access, file size and application type and you can manage language 
resources available for the application.
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The Composition Variables, Composition Prompts and Composition 
Grammars are configured analog to the areas in the workspace of the same 
name. The settings in these sections are exclusively valid for the respective 
composition. You can configure the following elements for compositions:

NOTICE:  Since the composition settings of the variables, 
prompts, grammars and resources are identical with the appli-
cation settings, you find the specific instructions in the section 
Applications. 

• Composition Settings
(cf. section Composition Setting)

• Composition Variables
(cf. section Application Variables)

• Composition Prompts
(cf. section Application Prompts)

• Composition Grammars
(cf. section Application Grammars)

• Composition Resources
(cf. section Application Resources)

NOTICE:  The following descriptions only consider the differ-
ences to the settings in the workspace. 

4.3.6.1  Composition Settings

The composition settings contain all data and configuration options relevant for 
the Symvia control composition. The view includes the following tabs:

• Composition Overview

• Composition Configuration

• Composition Languages

• Composition Databases

• Composition Webservices

4.3.6.2  Composition Overview

The Composition Overview enables delivering information about the control 
composition and can be used to document the composition's design and 
processing in detail at runtime. This does not influence the composition's behavior 
at runtime.
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In the Modification History the user who has performed changes leaves an 
entry. Entries always include the author (user), date and an optional message 
about the changes performed.

1. Click on .
A new entry is added to the list. The date is pre-set.

A click on the  icon removes an entry permanently.

2. Enter the author and a short, expressive message for the reader in the corre-
sponding fields.
The changes are copied when the entry is saved. 

In the Documentation Files section you can deposit supplementing documents 
with further information about the composition and its controls. The files may be 
of any type. 

1. Click on .

2. Select the file from the system and click on Open. 
The file is added to the list. File type and size are added to the list as additional 
information.

A click on the  icon removes a selected document permanently.

A click on the  icon opens a selected document file in the associated appli-
cation.

With the  icon you can export a selected document.
The changes are copied when the entry is saved. 
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4.3.6.3  Composition Configuration

The composition configuration contains the properties of the Symvia control 
composition. A composition corresponds to a pre-defined callflow module, which 
offers a specific, independent application functionality. It defines its input and 
output variables as well as its exits or events and can only use the resources it 
has configured itself. You can use each composition in any callflow of a Symvia 
application.

In case of the general configurations you assign the Composition Name and the 
Composition Description. Both is used with the composition display.

In the Input Arguments section you can use an input argument for adjusting the 
composition's functionality at runtime. When entering the composition, a corre-
sponding variable value is transferred to the composition for each of the input 
arguments. You can access the argument variables within the entire composition. 

1. Click on .

2. Enter an argument description and specify a default value.

3. Activate the Optional check box if the argument is to be created as optional 
size in the composition.

A click on the icon removes a selected argument permanently.
The changes are copied when the entry is saved. 

You can use the Result Variable to pass a single value calculated within the using 
application or composition. When entering the composition, a corresponding 
application in transferred to the composition for each of the result variables. This 
variable is assigned to the result value. You can access the result variables within 
the entire composition. 

1. Click on .
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2. Enter a variable description.

A click on the icon removes a selected result variable permanently.
The changes are copied when the entry is saved. 

The Completion Event corresponds to the exit from the composition and can be 
used to represent a concrete result of the composition. Every composition must 
state at least one event. 

4.3.6.4  Composition Languages

The composition languages show a list of languages supported by the 
workspace. 

A supported language corresponds to a specific language that can be used for 
the composition. Every supported language is relevant for reporting problems and 
each language-dependent resource, for example prompts or grammars, of the 
composition must be available once for each of the supported languages. The 
selected languages are treated like being supported by the control composition, 
all currently available workspace languages are selected by default.

A click on the Select All button marks all languages in the list. 

A click on the Deselect All button disables all language markings in the list. 

4.3.6.5  Composition Databases

You can bind compositions to databases for different purposes. The Composition 
Databases tab offers a list of all database configurations currently available within 
the composition. Each database configuration corresponds to a virtual database 
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connectivity and stores detailed information about how the connection to the 
specified data provider shall be set up.

You can add and remove database configurations as well as move them up or 
down the list and query them.

1. Click on Add.
The Add Database to Composition dialog opens. 

2. Enter the following values:

Field Description

Database Name The name serves as unique identifier of the data-
base. 

Database Description Optional description of the database. 

Database Driver Archive The database driver archive is a Java archive that 
contains the driver classes for the database configu-
ration. 

If there is no archive for selection, select the entry 
Import new Resource.... Choose the corresponding 
file in the Select the Resource File to import and 
click on Open. The resource is offered in the list for 
selection. 

Database Driver Classname Specify the Java class name that corresponds to the 
driver from the specified archive.
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3. Click on OK. 
The database configuration is added to the list of composition databases. 
The changes are copied when the entry is saved. 

A click on the Remove button removes a selected database configuration perma-
nently from the list. 

You can change the order of the selected database configurations with the Up 
and Down buttons. 

Using the Query... button you can query the connection of a selected database 
configuration. 

4.3.6.6  Composition Webservices

The Composition Webservices offer all webservice configurations currently 
available within the composition. Each webservice configuration corresponds to 
a virtual webservice connectivity and stores detailed information about how the 
connection to the specified service shall be set up as well as the result of the last 
successful query.

Database Access URL Specify the Database Access URL in the described 
format.

jdbc:mysql://<Host>:3306/<database>

Database Login User Specify the user name for authentication.

Database Login Password Specify the login password for authenticating the 
user.

Field Description
A31003-S50A0-U103-02-7619, 10/2020
OpenScape UC Application V10 Fusion Application Builder, User Guide 131



User Interface
Workspace View
You can add and remove composition webservices as well as move them up or 
down the list and query them.

1. Click on Add.
The Add Webservice to Composition dialog opens. 

2. Enter the following values:

3. Click on OK. 
The webservice configuration is added to the list of composition webservices. 
The changes are copied when the entry is saved. 

A click on the Remove button removes a selected webservice configuration 
permanently from the list. 

You can change the order of the selected webservice configurations with the Up 
and Down buttons. 

You can use the Query... button to send a query to the Webservice Access URI 
of a selected web service. The result will be displayed in the Webservice Query 
Result field.

4.3.7  Symvia Application

An entry is created in the workspace view for each application created with the 
Application Builder. By default, the name of an application begins with Symvia 

Field Description

Webservice Name The name serves as unique identifier of the webser-
vice. 

Webservice Description Optional webservice description. 

Webservice Type The type defines the architecture style or the protocol 
used. Select REST Architecture or SOAP Protocol 
from the list.

Webservice Access URI Specify the Werbservice Access URI used for con-
necting to the service. Example:

http://weather.yahooapis.com/
forecastrrs?=94089u=c

Webservice Authentication 
User

User with whom you gain authorized access to the 
web service.

Webservice Authentication 
Password

Password of the Webservice Authentication user.

Webservice SSL Agree-
ment

Select one of the following values:

• Only accept officially trusted SSL Certificates

• Accept officially trusted and self-signed SSL 
Certificates
This value will only be offered if an HTTPS 
address was entered in the Webservice Access 
URI field.
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Application. Beneath this entry you can configure all properties of the appli-
cation. 

The Application Variables, Application Prompts and Application Grammars 
are configured analog to the areas in the workspace of the same name, but they 
are exclusively effective for the respective application. You can configure the 
following elements for configured applications:

• Application Settings
(cf. section Symvia Control Application Settings)

• Application Variables
(cf. section Application Variables)

• Application Prompts
(cf. section Application Prompts)

• Application Grammars
(cf. section Application Grammars)

• Application Resources
(cf. section Application Resources)

NOTICE:  The following descriptions only consider the differences 
to the settings in the workspace. 

The context menu of an application offers various configuration options. Right-
click an application in the workspace to open the application's context menu. The 
following options are available:

• New enables the creation of a new application or callflow.

• Cut removes the selected application and stores it with all its settings in the 
clipboard. The function is inactive.

• Copy copies the selected application with all its settings to the clipboard.

• Paste inserts a copy of a selected or cut application.

• Delete removes the selected application from the workspace.

• Rename... changes the application's name.

• Deploy Application... compiles the resources for the deployment. 
Resources are uploaded outside the Application Builder. 

• Test Application... tests the callflow contained in the application and emits 
error messages and warnings. 

• Export Element... serves for exporting an application to an archive file.

• Properties represents a summary of the general and lingual application 
settings. You receive general information such as storage location, date of 
last access, file size and application type and you can manage language 
resources available for the application.

4.3.7.1  Application Settings

The application settings contain all data and configuration options relevant for a 
Symvia application. The view includes the following tabs:
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• Application Overview

• Application Configuration

• Application Databases

• Application Webservices

4.3.7.2  Application Overview

The Application Overview enables delivering information about the application 
and can be used to document the application's design and processing in detail at 
runtime. This does not influence the application's behavior at runtime.

In the Modification History the user who has performed changes leaves an entry 
for documenting the history of changes. Changes can thus be traced and clarity 
is maintained. Entries always include the author (user), date and an optional 
message about the changes performed.

1. Click on .
A new entry is added to the list. The date is pre-set.

A click on the icon removes an entry permanently.

2. Enter the author and a short, expressive message for the reader in the corre-
sponding fields.
The changes are copied when the entry is saved. 

In the Documentation Files section you can deposit supplementing documents 
with further information about the application and its controls. The files may be of 
any type. 

1. Click on .
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2. Select the file from the system and click on Open. 
The file is added to the list. File type and size are added to the list as additional 
information.

A click on the icon removes a selected document permanently.

A click on the opens a selected document file in the associated application.

With the icon you can export a selected document.
The changes are copied when the entry is saved. 

4.3.7.3  Application Configuration

The application configuration contains general properties of the Symvia appli-
cation. The settings are applied during the provision of the application and 
influence the application behavior at runtime.

General Settings

In the General Settings area you specify the Application Error Prompt. The 
defined prompt is played if the application finds an noncorrectable error. The 
setting is optional. 

Furthermore, you set here the barge-in mode of the application, which is 
important when using an NLU control for speech recognition. This mode deter-
mines when the speech recognition starts during an announcement playback and 
the announcement playback is stopped. The barge-in mode may adopt the 
following values:

• Off
You cannot interrupt the announcement playback. It will be carried out until 
the end. Speech and DTMF key recognition will not start until all announce-
ments of the announcement list were played. 
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• Speech
Announcement playback is interrupted as soon as the speech recognition 
system registers any tone at a minimum volume or the caller makes a DTMF 
input. It is irrelevant here whether a keyword was recognized.

• Hotword
Playing the announcements of the announcement list is only canceled if the 
speech recognition has recognized a keyword in the user's voice input as 
valid.

• Polite
Playing the announcement list is interrupted as long as the user performs a 
voice entry. Playing the announcement list is only canceled if the speech 
recognition has recognized a keyword in the user's voice input as valid. 
Otherwise, after expiration of the maximum talk delay, the announcement list 
will be continued from the point at which it was interrupted. When the caller 
then makes another voice entry, the announcement will be interrupted again.

Network Settings

In the Network Settings area you configure how the application connects the 
Internet at runtime and how the application services connect the proxy server. 

1. Activate one of the following settings: 

• Do not use a Proxy Server No additional configuration is necessary. 

• Automatically detect Proxy Server Settings. No additional configu-
ration is necessary. 

• Manual Proxy Server Configuration. No additional configuration is 
necessary. Follow the further steps. 

2. Enter a HTTP(S)Proxy Server.

3. Specify the port.

4. Activate the Enable Proxy Server Authentication: check box if you would 
like to activate secured user access. 

5. Specify a Username and the associated Password. 
The changes are copied when the entry is saved. 

Start Events

Callflows start based on occurring start events. The following start events are 
already installed:

• Incoming Call

• Call Disconnected

• Contact Center Agent Ready

• Contact Center Failure

You can create additional start events in the Start Events area. This is described 
in section "How to Create a Start Event". You can use such events like the pre-
installed ones. The start event sequence in the list is irrelevant.

Language Settings

The Language Settings area displays the languages currently available in the 
workspace. Languages can be activated or deactivated in applications. Each 
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activated language is available during the provision of the application and 
relevant for reporting problems. All currently available workspace languages are 
selected by default.

A click on the Select All button selects all languages in the list. 

Via the Deselect all button all languages selected for the application are deleted. 

From the drop-down list Application Default Language select the default 
language for the application. 

Capability Settings

The Capability Settings area displays the control groups supported by the appli-
cation. Only controls of those groups are shown in the palette of the callflow 
editor, can be used in the callflow and can deliver additional application events. 

• Support of Interactive Voice Response (IVR) Controls
IVR controls are used for example for playing a prompt, collecting DTMF 
inputs, forwarding to another phone, recording a voicemail or collecting utter-
ances via speech recognition.

• Support of Unified Communications (UC) Controls
UC controls are used for example for sending a message, authenticating at 
an OpenScape UC Application, changing a password, accessing any 
groupware data or operation with phone conferences.

• Support of Contact Center (ACD) Controls
ACD controls are used at contact centers for example for adding a call to a 
queue, requesting a callback from an agent or retrieving status information for 
a call or queue.

4.3.7.4  How to Create a Start Event 

Step by Step

1) Open <application name> > Application Settings > Application Configu-
ration > Start Events.

2) Click on the icon plus sign.

The Create Symvia Application Start Event dialog appears.

3) Enter a string to uniquely identify the event in the Event Identifier field.

This event ID will be used later when the OpenScape UC Application is 
changed.

4) Enter a name for the event in the Event Name field.

INFO:  When you click in this field and push Ctrl + space bar, a 
tooltip is displayed.

Based on its name the start event will later be assigned to a callflow.

5) Enter a label for the event in the Event Label field.
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INFO:  When you click in this field and push Ctrl + space bar, a 
tooltip is displayed.

After the start event has been assigned to a callflow, this label appears next 
to the callflow's name in the workspace view.

6) Enter a short descriptive text for the event in the Event Description field.

INFO:  When you click in this field and push Ctrl + space bar, a 
tooltip is displayed.

This description assists in assigning the start event to a callflow.

7) Click on Next.

The dialog for creating members of the start event appears.

8) When the start event occurs, a variable of type EventData is supplied. This 
variable may have members that may be used for processing the event. If the 
start event is to supply such members, continue with step 9. If not, continue 
with step 13.

9) Click on the icon plus sign.

A member1 of type String is added to the Start Event Data Members table.

10) Change the ID and, if needed, the member type.

11) Enter values in the Name and Description columns.

12) If required, add further members.

The member sequence is irrelevant.

13) Click on the Finish button.

The new start event is displayed in the list of start events. It is, however, not 
yet assigned to a callflow.

14) In the workspace view, under <application name> > Application Callflows 
> <callflow name>, click with the right mouse button on the callflow for which 
the start event was created.

15) Click on Properties.

The Preferences for <callflow name> dialog opens.

16) In the navigator, click on Event.

17) You now see the Event the Callflow is bound to combo box from which you 
select the start event's name created in step 4.

Under this combo box the start event's description composed in step 6 is 
displayed.
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INFO:  A click on the Configure external Start Events 
supported by the Application... link takes you back to the list of 
start events.

18) Click on the OK button.

The workspace view displays the start event's label created in step 5 besides 
the callflow's name.

19) This callflow now provides a variable named EVENTDATA that contains the 
members created in steps 9 to 12. You can check this via the following sub-
steps:

INFO:  Because this variable is available in this callflow only, it is 
not displayed in the workspace view under Workspace Variables 
> All Workspace Variables, not under Symvia Control Compo-
sitions > <composition name> > Composition Variables > All 
Symvia Composition Variables and not under <application 
name> > Application Variables > All Symvia Application 
Variables either.

a) Double-click the callflow name in the workspace view.

The callflow is opened in the workspace.

b) Drag the Assign control from the palette into the workspace and release 
the mouse button.

c) Double-click this control.

d) Click on the Commands tab.

e) Click on the icon plus sign.

f) Click on the ... button next to the Variable field.

The EVENTDATA variable is displayed in bottom position.

g) Click on the triangle preceding this variable.

The members created in steps 9 to 12 are displayed.

h) Click on the Cancel button.

i) Click on the Cancel button.

j) Click on the Cancel button.

20) Reconfigure the callflow, so that it reacts to the occurring event in the manner 
you wish it to react.

On the application's side you have now executed all steps for making the 
application react to the occurring start event in the desired way. 

21) Change the OpenScape UC Application as to make the start event occur in 
the desired situation. In particular, make sure that the event ID configured in 
step 3 is supplied and that the members created in steps 9 to 12 are allocated 
with values.
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4.3.7.5  Application Databases

You can bind applications to databases for different purposes. The Application 
Databases tab offers a list of all database configurations currently available within 
the application. Each database configuration corresponds to a virtual database 
connectivity and stores detailed information about how the connection to the 
specified data provider shall be set up.

1. Click on Add.
The Add Database to Application dialog opens. 

2. Enter the following values:

Field Description

Database Name The name serves as unique identifier of the data-
base. 

Database Description Optional description of the database. 

Database Driver Archive The database driver archive is a Java archive that 
contains the driver classes for the database configu-
ration. 

If there is no archive for selection, select the entry 
Import new Resource.... Choose the corresponding 
file in the Select the Resource File to import and 
click on Open. The resource is offered in the list for 
selection. 

Database Driver Classname Specify the Java class name that corresponds to the 
driver from the specified archive.
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3. Click on OK. 
The database configuration is added to the list of application databases. 
The changes are copied when the entry is saved. 

A click on the Remove button removes a selected database configuration perma-
nently from the list. 

You can change the order of the selected database configurations with the Up 
and Down buttons. 

Using the Query... button you can query the connection of a selected database 
configuration. 

4.3.7.6  Application Webservices

The Application Webservices offer all webservice configurations currently 
available within the application. Each webservice configuration corresponds to a 
virtual webservice connectivity and stores detailed information about how the 
connection to the specified service shall be set up as well as the result of the last 
successful query.

1. Click on Add.
The Add Webservice to Application dialog opens. 

2. Enter the following values:

Database Access URL Specify the Database Access URL in the described 
format.

jdbc:mysql://<Host>:3306/<database>

Database Login User Specify the user name for authentication.

Database Login Password Specify the login password for authenticating the 
user.

Field Description
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3. Click on OK. 
The webservice configuration is added to the list of application webservices. 
The changes are copied when the entry is saved. 

A click on the Remove button removes a selected webservice configuration 
permanently from the list. 

You can change the order of the selected webservice configurations with the Up 
and Down buttons. 

You can use the Query... button to send a query to the Webservice Access URI 
of a selected web service. The result will be displayed in the Webservice Query 
Result field.

Example result:

Field Description

Webservice Name The name serves as unique identifier of the webser-
vice. 

Webservice Description Optional webservice description. 

Webservice Type The type defines the architecture style or the protocol 
used. Select REST Architecture or SOAP Protocol 
from the list.

The Web Service Configuration of the Application 
Builder supports the following REST methods:

• POST - Creates a resource by URI and optionally 
request body

• GET - Retrieves a resource by URI

• PUT - Updates a resource by URI and optionally 
request body

• DELETE - Deletes a resource by URI

Webservice Access URI Werbservice Access URI used for connecting to the 
service. 

Example:

http://weather.yahooapis.com/
forecastrrs?=94089u=c

Webservice Authentication 
User

User with whom you gain authorized access to the 
web service.

Webservice Authentication 
Password

Password of the Webservice Authentication user.

Webservice SSL Agree-
ment

Select one of the following values:

• Only accept officially trusted SSL Certificates

• Accept officially trusted and self-signed SSL 
Certificates
This value will only be offered if an HTTPS 
address was entered in the Webservice Access 
URI field.
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4.3.7.7  Application Management

After connecting to an Openscape UC Media Server the Application Management 
of the Application Builder shows all IVR applications deployed on this server. In 
the table view each application is displayed with:

• name

• phone number binding

• modification time

• modification summary of format <user>:<message>[<revision number>]

properties.

• default language (language the application starts with)

• phone number binding

• runtime tracing

• application tags (comma separated list of associated key words)

The applications displayed in the table view can be sorted manually by using the 
Up and Down buttons or automatically (ascending or descending) by clicking on 
the column title.

The applications displayed in the table view can be filtered by their properties. 
Every application which has a pattern match in at least one of the checked 
properties is displayed in the table view after applying the filter.

Deployed applications can be imported again in the workspace of the Application 
Builder by pressing the Import button. 
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If the application still exists in the workspace of the Application Builder the 
deployed application can only be imported if the user agrees to overwrite the 
existing application.

4.3.7.8  Application Variables

The list in the All Symvia Application Variables area of the Symvia Application 
Variables tab contains the variables configured in the workspace. These 
variables appear in gray writing and cannot be edited here. You can, however, 
modify the properties of a selected variable that was configured as workspace 
variable via the Edit this Alias in the Workspace Variables Editor... link. They 
are forwarded to the Workspace Variables. You receive processing information 
in section Workspace Variables.

A click on the Add... button takes you to the Create Symvia Application 
Variable dialog. For every newly created application variable you must specify 
the Variable Name and, optionally, a Variable Description. You can select the 
Variable Type from the drop-down list or via the ... button in the Select Variable 
Type dialog.

A click on Delete removes selected application variables. 

Using the Up or Down button you can move a selected variable up or down the 
list.

In the Symvia Application Variable Details area you can view and change the 
settings of the available and selected application variables.

4.3.7.9  How to Configure the Transformation of a Variable Value

Using the Transformations... button you can create a variable the value of which 
is transformed after the announcement. The resulting, transformed value is then 
used for the announcement instead of the original value. Each variable transfor-
mation is available in the entire application.

Step by Step

1) Click on the Transformations... button.

The Configure the available Symvia Variable Transformations dialog 
opens.

2) Click on Add.

The Specify Variable Value Transformation dialog opens.
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3) Enter the following values:

4) Click on Next.

5) Select a Transformation Directive from the drop down list.

The transformation directive corresponds to the logic used for transforming 
the variable value into text that can be spoken. Every directive can be used 
for a specific file type and may request result values.

6) Click on Next.

7) Add Transformation Arguments via .

Specify the transformation arguments (input value) and the corresponding 
results (output value) for each of the activated languages. If the variable is to 
be announced, its current value is searched for in the arguments list. If the 
value is found, the corresponding result value of the current language is used.

Using the icon you can remove selected transformation arguments. 

8) Click on Next or Finish.

If you click on Next you can test the previously specified values.

9) Click on Finish.

The variable value configuration is added to the Configure the available 
Symvia Variable Transformations table.

The changes are copied when the entry is saved.

Using the Edit... button you can change the configurations of a selected trans-
formation. 

With the Copy... button you copy a selected transformation with its settings. 

A click on the Remove button removes a selected transformation perma-
nently from the list. 

You can change the order of the selected transformations with the Up and 
Down buttons.

4.3.7.10  How to Import Variables from another Application

Step by Step

1) Click on the Import Variables from another Application... link. 

2) Select the application from which the variables are to be imported.

When you have selected an application, the available variables are automat-
ically displayed.

3) Select one or several of the desired variables and click on Finish.

Field Description

Transformation 
Name

The name serves as unique identifier of the variable value 
transformation. 

Transformation 
Description

Optional Description of the Variable Value Transformation.
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The imported variables are integrated in the All Symvia Application 
Variables list on the Symvia Application Variables tab.

4.3.7.11  Further Configurations

The Symvia Application Variables tab features at the top right margin two more 
icons the functions of which are explained in the below table.

4.3.7.12  Application Prompts

The list in the All Symvia Application Prompts area on the Symvia Application 
Prompts tab contains already configured workspace prompts. These prompts 
appear in gray writing and cannot be edited here. You can, however, modify the 
properties of a selected prompt that was configured as workspace prompt via the 
Edit this Alias in the Workspace Prompt Editor... link. You reach the 
Workspace Prompts tab. See section Workspace Prompts.

4.3.7.13  How to Create and Configure an Application Prompt

Prerequisites

• The prompt you wish to assign a media file to must have already been 
created. The media file must have the format *.wav or *.pcm. 

• Some icons appear only if you use specific Windows themes such as any 
Aero theme or the Windows 7 basic theme. You can change the Windows 
theme for example by clicking on the desktop background with the right 
mouse button and selecting Personalize. Alternatively, you can open Start > 
Control Panel > Personalization or Start > Control Panel > Appearance 
and Personalization > Personalization.

Step by Step

1) You can assign application prompts to prompt categories. Prompt categories 
differ in their names, descriptions and color representations. You can display 
application prompts sorted by categories in the All Symvia Application 
Prompts area. Application prompt categories are independent from 

Icon Function

This icon is active by default. It places the areas All Appli-
cation Variables and Symvia Application Variable 
Details next to each other. The area All Vogue Application 
Variables is found in the left half of the tab.

When you activate this icon, the areas All Symvia Applica-
tion Variables and Symvia Application Variable Details 
are positioned on top of each other, with the area All Sym-
via Application Variables always being in the upper half of 
the tab.
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workspace prompt categories, composition prompt categories and server 
prompt categories. 

After a click on the Categories... button or on the Configure Prompt 
Categories of the Application... link you can add or remove prompt 
categories or assign them another color or description. Each prompt category 
is available in the entire application.

2) Click on the Add... button.

3) Enter the Prompt Name. 

4) You can specify a Prompt Description optionally. 

5) Click on the OK button. 

The prompt is itemized in the All Symvia Application Prompts list. It does 
not have a text yet for using a text-to-speech engine. 

In the right-hand section Symvia Application Prompt Details you find the 
following options:

NOTICE:  Please note that prompts can only be used for the 
available and configured languages. Languages are configured in 
the Workspace Settings on the Workspace Languages tab.

IMPORTANT:  Default languages are German and English (US). 
If you wish to use additional languages, appropriate TTS and ASR 
language packages must be installed on each media server of the 
OpenScape UC Application, for example uc-tts-zh_cn for the TTS 
language Chinese (Mandarin) or uc-asr-nl_be for the ASR 
language Flemish. You find details in the setup guide OpenScape 
UC Application Installation and Upgrade.

6) In the Prompt Category field you can assign a category to the prompt. 

7) In the Prompt Texts field you enter a text for each configured language. This 
text is transformed into an announcement of the corresponding language by 
means of TTS if the prompt is used in an active application. This requires an 
installed TTS system.

In addition, the use of definitions in the XML-based SSML is supported. This 
serves for creating announcements in prompts with help of TTS. But instead 
of specifying a continuous text for announcement output, the text playback 
can be adjusted with the help of a special notation. For example, phone 
numbers may be announced digit by digit and slowly, thus for everybody to 
understand. Specify the desired entry in SSML for using SSML as text.

In the following example a specified number is announced as phone number:

“<say-as interpret-as=”telephone”>012387654</say-as>”

You find a list of all possible definitions in SSML in the user guide of the 
supported speech recognition system (Nuance Recognizer) in the supplied 
ISO setup files of the languages for implementing TTS. Further information 
about SSML is contained in the web pages of the W3C institution.
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8) In the Symvia Application Prompt Details area, click in the Prompt Files 
table on <Click to select file> in the row of the language for which you wish 
to import and assign a media file. 

Buttons appear to the left of this row.

INFO:  These icons appear only if you use specific Windows 
themes such as any Aero theme or the Windows 7 basic theme.

You can change the Windows theme for example by clicking on 
the desktop background with the right mouse button and selecting 
Personalize. Alternatively, you can open Start > Control Panel > 
Personalization or Start > Control Panel > Appearance and 
Personalization > Personalization.

You can perform a simple or an extended import.

In case of a simple import, you assign precisely one media file to a prompt for 
one language. As a result, the media file is imported in the media file repos-
itory of the application. This occurs invisibly and implicitly. This is the most 
common application.

In case of an extended import you can import several media files for a prompt 
for one or several languages in the media file repository of the application. 
This is useful if you wish to import music or tones for several languages in one 
go. One media file will then be assigned to a prompt for one language.

The opposite is also true: Each media file in this directory is available in the 
media file repository of the application. However, not every media file in this 
repository need to be assigned to a prompt.

A media file must always have the same name for all available languages, so 
that it can be stored in the corresponding resources folder for the respective 
language.

INFO:  Each workspace, composition, server (i. e. each 
OpenScape UC Application installation), and application has its 
own media file repository and resource directory. These reposi-
tories are independent from each other.

If you wish to perform a simple import, click in the Prompt Files table on the 
first ... button in the row in which you clicked on <Click to select file>, select 
a media file and click on Open. That finishes the import and assignment in this 
case. Continue with the next major step.

If, however, you wish to perform an extended import, execute the following 
sub-steps:

a) Click on the second ... button in this row.

A dialog opens that displays the list of media files available in the media 
file repository of the application.

b) Click on the small triangle on the Import... button and select Extended 
Import....

c) Click on the Add... button.
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d) Select one or several media files and click on Open.

The media files are displayed in the list of media files to be imported.

e) Click on Next.

f) Activate the check boxes of the languages for which media files shall be 
imported in the media file repository of the application.

The media files are automatically copied to the resource folder of the 
prompts for the corresponding languages.

NOTICE:  A media file must always have the same name for all 
available languages, so that it can be stored in the corresponding 
resources folder for the respective language.

g) Click on the Finish button.

The media files are itemized in the list of files available in the media file 
repository of the application. The media files to which you have assigned 
languages not selected in the Prompt Files table are represented grayed 
out. If you select a media file of such languages, the OK button appears 
grayed out. Click on a file of the language you selected in the Prompt 
Files table. Using the Play button you can play this media file. 

h) Click on the OK button. 

Regardless whether you performed a simple of extended import, icons to the 
right of the file name indicate whether the file exists and whether the file has 
a format that the Application Builder supports. 

If you wish to remove the assignment of the media file to the prompt, click on 
the file name and then on the third icon. However, this will not remove the 
media file from the media file repository of the application and not from the 
resource directory either.

9) If necessary, you can click on the link Configure available Languages in the 
Workspace Settings Editor... to access the Workspace Settings > 
Workspace Languages > All Workspace Languages tab. You find more 
information on this in the Workspace Settings section.

10)  If you click on the Enable or disable Languages for the Application... link, 
you reach the Application Configuration tab of the Symvia Application 
Settings. As described in section Application Configuration, you can perform 
language settings there.

11)  If you click on the Import Prompts from another Application or Compo-
sition... link, you can perform the actions described in section How to Import 
Prompts from another Application.

12) Push the hotkey CTRL + S or select File > Save in the menu to store media 
file assignments to prompts.
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4.3.7.14  How to Import Prompts from another Application

Via the Import Prompts from another Application link you can add further 
prompts from other existing applications analog to the import of prompts from 
other workspaces:

Step by Step

1) Click on the Import Prompts from another Application... link.

2) Select the application the prompts of which are to be imported. The available 
prompts are automatically displayed.

3) Select one or several prompts and click on Next.

4) In the next dialog specify for which available languages the prompt to be 
imported is to be used.

5) Click on the Finish button. 

The imported prompts are integrated in the All Symvia Application Prompts 
list on the Application Prompts tab.

4.3.7.15  Further Configurations

The Application Prompts tab features at the top right margin three more icons 
the functions of which are explained in the below table.

At the top-right margin of the All Symvia Composition Prompts area the 
following three icons are available:

Icon Function

This icon lets you filter the prompts on the basis of the 
assigned languages. Activate the check box of the desired 
language and then click on the OK button. Only the proper-
ties of the desired languages are displayed.

This icon is active by default. It places the areas All Symvia 
Application Prompts and Symvia Application Prompts 
Details next to each other. The area All Symvia Applica-
tion Prompts is found in the left half of the tab.

When you activate this icon, the areas All Symvia Applica-
tion Prompts and Symvia Application Prompt Details 
are positioned on top of each other, with the area All Sym-
via Application Prompts always being in the upper half of 
the tab.
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4.3.7.16  Application Grammars

The list on the Workspace > <application name> > Application Grammars > 
All Symvia Application Grammars tab contains already created workspace 
grammars. These grammars appear in gray writing and cannot be edited here. 
You can, however, modify the properties of a selected grammar that was 
configured as workspace grammar via the Edit this Alias in the Workspace 
Grammar Editor... link. You reach the Workspace > Workspace Grammars > 
All Workspace Grammars tab. See section Workspace Grammars on this.

4.3.7.17  How to Create a new Application Grammar

Step by Step

1) Click on the Add... button.

2) Specify a Grammar Name and, optionally, a Grammar Description.

3) Click the OK button. 

The grammar appears in the list of All Symvia Application Grammars. No 
grammar file has yet been assigned to the added grammar.

Next steps

Assign a grammar file that you create or import to the grammar.

4.3.7.18  How to Create a Grammar File for an Application

Prerequisites

• IMPORTANT: The default languages for the automatic speech recognition 
are German and English (US). If you wish to use additional languages, the 
corresponding ASR language packages must be installed on each media 
server of the OpenScape UC Application; for example uc-asr-nl_be for the 

Icon Function

With the help of this icon you can sort all prompts defined 
for the composition alphabetically ascending.

Using this icon you can sort and display the prompts by cat-
egories. 

A click on this icon displays only the prompts defined for the 
composition in the All Composition Prompts list. The 
respective aliases can be displayed again via the plus sign 
of a prompt.
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ASR language Flemish. You find details in the setup guide OpenScape 
UC Application Installation and Upgrade.

• Some icons appear only if you use specific Windows themes such as any 
Aero theme or the Windows 7 basic theme. You can change the Windows 
theme for example by clicking on the desktop background with the right 
mouse button and selecting Personalize. Alternatively, you can open Start > 
Control Panel > Personalization or Start > Control Panel > Appearance 
and Personalization > Personalization.

Step by Step

1) Select the alias name of the corresponding grammar. 

In the Symvia Application Grammar Details area of the tab you are 
provided with further setting options. 

NOTICE:  Please note that grammar files can only be used for the 
available and configured languages. Languages are configured in 
the workspace settings on the workspace languages tab. 

2) In the Symvia Application Grammar Details area, click in the Grammar 
Files table on <Click to select file> in the row of the language for which you 
wish to import and assign a grammar file. 

Buttons appear to the left of this row.

INFO:  These icons appear only if you use specific Windows 
themes such as any Aero theme or the Windows 7 basic theme.

You can change the Windows theme for example by clicking on 
the desktop background with the right mouse button and selecting 
Personalize. Alternatively, you can open Start > Control Panel > 
Personalization or Start > Control Panel > Appearance and 
Personalization > Personalization.

3) Click on the second ... button in this row. 

The Select Grammar File dialog opens. All available grammar specification 
files are listed. 

4) Click on the Create... button.

The Create Grammar File dialog opens. 

5) Specify the File Name. The file must be a GRM file. You can optionally add a 
File Description. 

6) Click on Next.

7) Activate the check box of the languages for which a grammar file shall be 
created. 

Only languages active in the workspace are displayed. 

8) Click on Next.
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The dialog that specifies the utterances of the respective language opens. 

In the top-left area of the dialog you see the respective language represented 
by the country's flag.

9) Click on to add a new utterance. 

10) Enter an Utterance. Each utterance corresponds to the spoken call input to 
be recognized by the grammar. 

11) Enter the meaning of this utterance under Result. 

With  you remove selected utterances from the table. 

With  you can use utterances specified for another language in the 
grammar file. 

NOTICE:  Please note that in this case the utterances already 
created for the language are overwritten. 

12) Click on Next.

You reach the dialog of the next language for specifying utterances and their 
meaning. 

13) After you have created utterances and meanings for all languages, click on 
Finish.

The Create Grammar File dialog closes. The grammar file is listed in the 
Select Grammar File dialog and can be selected. This dialog shows the list 
of files available in the grammar file repository of the application. Empty 
grammar files appear in red.
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INFO:  Each workspace, composition and application has its own 
grammar file repository and resource directory. These reposi-
tories are independent from each other.

14) Choose the grammar file of the above selected language and click on OK.

The chosen grammar file is listed for the selected language in the Grammar 
Files field.

NOTICE:  The grammar file must always have the same name for 
all available languages, so that it can be stored in the corre-
sponding resources folder for the respective language.

15) Push the hotkey CTRL + S or select File > Save in the menu to store the 
changes.

To edit the language settings, click on the Configure available Languages in 
the Workspace Settings Editor.... You reach the Workspace Languages tab. 
You find further information in section Workspace.

To activate/deactivate available languages for the application, click on the link 
Enable or disable Languages for the Application.... The view switches to the 
Application Languages tab. In there select the languages to be activated with a 
tick or remove the tick to disable the languages.

4.3.7.19  How to Import Variables from another Application

Via the Import Grammars from another Application... link you can add further 
grammars from other existing applications analog to the import of grammars from 
other workspaces:

Step by Step

1) Click on the Import Grammars from another Application... link.

2) Select the application the grammars of which are to be imported. The 
available grammars are automatically displayed.

3) Select one or several grammars and click on Next.

4) Click on the Finish button.

The imported grammars are integrated in the All Symvia Application 
Grammars list on the Application Grammars tab.
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4.3.7.20  How to Import Grammar Specification Files in the Application

Step by Step

1) Click on the Import Grammar Specification Files into the Application... 
link.

2) Click the Add button.

3) Select grammar files of the format *.grm.

4) Click on the Open button.

You can assign only displayed audio files, thus audio files integrated in the 
application.

4.3.7.21  Further Configurations

The Application Grammars tab features at the top-right margin three more icons 
the functions of which are explained in the below table.

At the top-right margin of the All Symvia Application Grammars area, the 
following two icons are available:

Icon Function

This icon lets you filter the grammars by the assigned lan-
guage. Activate the check box of the desired language and 
then click on the OK button. Only the properties of the 
desired languages are displayed.

This icon is active by default. It places the areas All Symvia 
Application Grammars and Symvia Application Gram-
mar Details next to each other. The area All Symvia Appli-
cation Grammars is found in the left half of the tab.

When you activate this icon, the areas All Symvia Applica-
tion Grammars and Symvia Application Grammar 
Details are positioned on top of each other, with the area 
All Symvia Application Grammars always being in the 
upper half of the tab.

Icon Function

With the help of this icon you can sort all grammars defined 
for the application alphabetically ascending.

A click on this icon displays only the grammars defined for 
the composition in the All Application Grammars list. The 
respective aliases can be displayed again via the plus sign 
of a grammar.
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4.3.7.22  Application Resources

The Application Resources tab serves for copying any file that exists on the file 
system to the resource repository of an application, so that these files can be used 
in the callflow controls. That way, you can use files of any other file type besides 
prompt files or grammar files also. 

Example:

The Send control displays all application resource files for selection if you wish to 
attach a file to the message to be sent.

INFO:  If, in contrast, you use the Send control in a composition, 
only the composition resource files are displayed for selection. 
They are also listed in the workspace view under Symvia Control 
compositions > <composition name> > Composition 
Resources. 

4.3.7.23  How to Import Resources

Step by Step

1) Click on the Import... button.

The Select Resource File(s) to be imported dialog opens.

2) Select the desired file.

3) Confirm your selection with OK.

The file is copied to the specified resources folder of your application and 
integrated in the All Symvia Application Resources list.

Select an entry in the application resources list and the following properties 
are listed in the right area of the tab: Resource Name, Resource Type, 
Resource Size and the Resource Date on which the file was added to the 
application resources. This data serves for viewing and cannot be modified.

Selected files are irretrievably removed from the application resources via the 
Delete button.

With Rename... you can rename selected application resource files.

4.3.7.24  How to Import Resources from another Application

Step by Step

1) Click on the XImport Resources from another Application link to add 
further resource files from other applications:

2) Select the Application from which the resources are to be imported. The 
available resources are automatically displayed.

3) Select one or several of the desired resources and click on Finish. 
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The imported resources are integrated in the All Symvia Application 
Resources list on the Application Resources tab.

4.3.7.25  Further Configurations

The Application Resources tab features at the top right margin two more icons 
the functions of which are explained in the below table.

At the top-right margin of the All Symvia Application Resources area the 
following three icons are available:

4.3.7.26  Callflow Editor

Callflows are created with a callflow editor and listed in the workspace. Each of 
them is assigned to an application.

4.3.7.27  How to Create a Callflow

Step by Step

1) Click on an application in the workspace with the right mouse button.

2) Select New > Callflow....

3) Enter a name for the callflow in the Callflow Name field.

Icon Function

This icon is active by default. It places the areas All Symvia 
Application Grammars and Symvia Application Gram-
mar Details next to each other. The area All Symvia Appli-
cation Grammars is found in the left half of the tab.

When you activate this icon, the areas All Symvia Applica-
tion Grammars and Symvia Application Grammar 
Details are positioned on top of each other, with the area 
All Symvia Application Grammars always being in the 
upper half of the tab.

Icon Function

Using this icon you set a flat folder view.

A click on this icon displays only the resources defined for 
the composition in the All Composition Resources list. The 
respective aliases can be displayed again via the plus sign 
of a resource.

You can update the list of resource files via this icon or the 
F5 key.
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4) Select one of the following inbound events from the Event the Callflow is 
bound to combo box:

Incoming Call

Select this value is the callflow is to be started with an incoming call.

Call Disconnected

Select this value if the callflow is to be started as soon as the call that 
started the application has been terminated.

Contact Center Agent Ready

Select this value if the callflow is to be started as soon as a call that started 
the application is being processed by the contact center.

INFO:  This option is only displayed if the Support of Contact 
Center (ACD) Controls check box in the workspace view under 
<application name> > Application Settings > Application 
Configuration > Capability Settings has been activated.

INFO:  A variable EVENTDATA is created automatically. You can 
select the Transfer Number sub-element of this variable as 
associated value in the callflow to be created, for example in an 
Assign control.

You can see this variable in this callflow only. It is not visible as 
workspace variable, composition variable, application variable 
and not in another callflow either. However, other variables of the 
same name may exist in such places.

Contact Center Failure

Select this value if the callflow is to be started as soon as a call that started 
the application cannot be processed by the contact center.

INFO:  This option is only displayed if the Support of Contact 
Center (ACD) Controls check box in the workspace view under 
<application name> > Application Settings > Application 
Configuration > Capability Settings has been activated.

INFO:  A variable EVENTDATA is created automatically. You can 
select the Failure Reason sub-element of this variable as 
associated value in the callflow to be created, for example in an 
Assign control.

You can see this variable in this callflow only. It is not visible as 
workspace variable, composition variable, application variable 
and not in another callflow either. However, other variables of the 
same name may exist in such places.

5) Click on OK.
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A new callflow is displayed in the workspace under <application name> > 
Application Callflows. The callflow name is followed by the inbound event 
in abbreviated format ([Incoming], [Disconnect], [ACD Ready] or [ACD 
Failure]).

6) Double-click this new entry.

The callflow is displayed in the callflow editor. If you have selected Incoming 
Call as inbound event, the callflow is empty. Otherwise, a first control has 
been added automatically.

7) Complete the callflow by dragging controls from the palette into the callflow 
editor where you configure them and connect them to the other controls.

8) Save the callflow.

The callflow is itemized underneath the application in the workspace list.

9) Double-click this entry.

The callflow editor consisting of workspace and palette opens. The palette 
shows the tools and controls available for this callflow. You drag most of them 
onto the workspace by drag-and-drop for editing an application. Depending 
on the above configured event, the workspace contains controls already.

4.3.7.28  Context Menu of a Callflow

When you rightclick a callflow, its context menu opens. The following options are 
then available:

• New enables the creation of a new application.

• Open with Callflow Editor enables viewing the graphic representation of an 
existing callflow as well as its configuration and editing.

• Cut cuts the selected callflow and copies it to the clipboard.

• Copy copies the selected callflow with all its settings to the clipboard.

• Paste creates a copy of the selected callflow.

• Delete removes the selected callflow from the workspace or application.

• Rename... changes the callflow name.

• Properties displays general information such as storage location, last access 
date, file size and callflow type and displays a summary of the contained 
controls and the associated editor settings.

With a doubleclick on the callflow's name in the workspace list the editor opens 
for editing the callflow with the associated palette. The palette contains controls 
for usage in the callflow editor.

4.3.7.29  The Palette

The palette is part of the callflow editor. All controls and tools are listed in the 
palette. The palette can be docked to the left or right margin. The palette can be 
hidden via a triangle icon in the top bar.
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The palette includes all available controls. Several controls are assigned to a 
group. You can edit settings of the palette via different context menus.

4.3.7.30  Tools and Controls

The following table shows all available tools and controls of the palette and 
provides a short description of the functionality:

INFO:  The controls of groups General Controls, IVR Controls, 
UC Controls and ACD Controls are displayed in a special dialog 
if the focus is on the workspace or on the palette and you push the 
paste key. You can filter the list of the controls displayed in this 
dialog using a search string. The jokers ? and * are available for 
filtering. If you click on a control in this dialog, it will be added to 
the callflow in the workspace.

Icon Functionality

The select tool (mouse pointer) enables selecting single 
elements such as controls, connections or notes. 
Selected elements can be moved in their geometric as 
well as structural position.

A connection serves for connecting two controls. A con-
nection indicates the processing order from control to con-
trol.

Using the Sticky Note tool you can add comments and 
notes anywhere in the callflow.

The Callflow Link enables connecting two callflows 
within an application.

This control is not displayed if a subflow is open in the 
workspace.

One of the following three controls is displayed. Click on 
the small triangle to display one of the others.

You use the List Iterator to create a pointer onto a vari-
able lists.

The List Modifier is a tool for changing variable lists and 
adding/removing arguments to/from the list. The List 
Sorter allows sorting variable lists as well as changing the 
sort order and sort criterion.

One of the following three controls is displayed. Click on 
the small triangle to display one of the others.

• String Operator

• Time Operator

• Date Operator

These controls enable editing string values, time values 
and date values.
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With the Parallel Flow control processing a callflow is 
branched and rejoined.

Control Compositions

The Control Compositions group is displayed automati-
cally if at least one composition exists. The composition's 
name, for example Composition 1 is shown in the pal-
ette. You handle this control analog to the other controls. 
Drag the composition to the workspace. 

Subflow Elements

The Subflow Entry control marks the start of a subflow. 

This control is only displayed if a subflow is open in the 
workspace.

The Subflow Exit control marks the end of a subflow.

This control is only displayed if a subflow is open in the 
workspace.

The Subflow Loop control is followed by the controls 
that need to be traversed in the query loop of the variable 
lists.

This control is only displayed if a subflow is open in the 
workspace.

Composition Elements

The Composition Entry control marks the beginning of 
a composition. 

This control is only displayed if a composition is open in 
the workspace. However, it is not displayed if a subflow of 
a composition is open.

The Composition Exit control marks an end of the com-
position. 

This control is only displayed if a composition is open in 
the workspace. However, it is not displayed if a subflow of 
a composition is open.

General Controls

The Start control marks the beginning of a callflow and is 
mandatory for an application.

The End control marks the end of a callflow.

In the Assign control you can assign values to the vari-
ables. You can define your own variables and fill them 
with contents required in other controls.

Using the Compare control you can execute compari-
sons according to a previously defined rule. You can 
define a list of rules here for configuring branches in the 
callflow based on conditions.

Icon Functionality
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System information is put out at runtime and retrieved in a 
variable with the SystemInfo Control. The contents in 
the variable can then be further used in the callflow. The 
information may put out the current date, time etc.

The WebService control offers the option to submit 
requests to a REST web service and to write the result in 
a variable that can be used in the course of the callflow.

With the help of the DatabaseWrite control you enter 
data/data records in already available databases. A JDBC 
driver must be used for the database.

The DatabaseRead control enables retrieving data/data 
records from available databases. A caller is e.g. able to 
query the current state of his/her order from a contact 
center.

In the TimeProfile control you can, depending on the call 
time, implement a branch in the callflow.

The Delay control inserts pauses in the callflow.

IVR Controls

IVR controls appear in callflows and subflows of applications only if this has been config-
ured under Application Settings > Application Configuration > Capability Settings. 
IVR controls appear in callflows and subflows of compositions only if this has been con-
figured under Composition Settings > Composition Configuration > Capability Set-
tings.

The Prompt control plays one or several announce-
ments and branches then to a continuative control, for 
example the DtmfMenu control or the SpeechMenu con-
trol.

The BackingPrompt control allows inserting announce-
ments. Such announcements are played until another 
control is executed that plays its own announcement. 

Using the DtmfInput control a caller can enter digit 
strings such as his/her customer number via telephone 
keypad.

The DtmfMenu control enables the caller to navigate 
through a menu with his/her phone keypad.

Via the DTMF Selection Control a variable list is iterated 
where every element can be selected via a DTMF key.

The Language control enables switching the language 
during runtime. Thus the caller can listen to announce-
ments in his/her native language, for example.

The task of the Transfer control is to dial a phone number 
after one or several announcements have been played. 
Example: “You will now be connected to our hotline. 
Please hold the line.”).

Do not confuse the Transfer control with the ConnectCall 
control.

Icon Functionality
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The Disconnect control plays one or several announce-
ments and disconnects the current phone call.

The CreateCall control dials a phone number.

The ConnectCall control turns an unaccepted (inactive) 
call into an accepted (active) call. From this moment, the 
caller incurs call charges.

Do not confuse the ConnectCall control with the Transfer 
control .

The DeflectCall control routes the current phone call to 
another phone number.

Via the Record control you can make voice recordings.

The Transitions control switches to another application.

The Grammar control creates a grammar specification file 
for ASR from an application variable at runtime.

The NLU control enables a voice-controlled interaction 
(ASR) with the user. 

With help of the SpeechMenu control the caller can navi-
gate through a menu making speech inputs. 

Via the SpeechInput control the user can make speech 
inputs evaluated by the application using ASR.

UC Controls

UC controls appear in callflows and subflows of applications only if this has been config-
ured in the application settings.

The Send Control sends documents, e.g. a voice record-
ing or a resource as e-mail at one or several recipients.

The Message control can play different forms of mes-
sages and treat messages differently.

The Authentication control executes the authentication 
via the ONS number or the user ID. 

The ChangePIN control enables a logged-in user to 
change his/her authentication data.

The Presence control updates, invokes or displays the 
current status or all available presence statuses.

The ContactSearch control searches the contact data-
base for contacts. You can look for contacts via the phone 
number (ONS number) or the vanity code. A list of contact 
variables that contain various contact attributes such as 
name, phone number, fax number, etc. is returned.

The UserSearch control searches the user database for 
users. A list of user variables that contains different user 
attributes is returned.

Icon Functionality
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You use the Conference control to create conferences. 
You can create an ad-hoc conference, join a conference 
or look for conferences.

The CallJournal control allows querying the phone jour-
nal. 

ACD Controls

ACD controls appear in callflows and subflows of applications only if this has been con-
figured in the application settings.

The AcdInit control determines the contact center for reg-
istering and processing a call.

The AcdExit control cancels a call's registration in the 
contact center.

You can configure the following properties in the AcdStart 
control:

• Name of the queue in which a call is enqueued

• Call priority

• Preferred agent to process the call

• Waiting time in which the attempt is made to reach the 
preferred agent

• Assigning contact information to the call

• Assigning statistics variables 

– Calls in the queue

– Position in the queue

– Estimated waiting time

The AcdStop control removes a call from the queue.

You can use the AcdCallback control to configure the fol-
lowing properties of a callback.

You can use the AcdContactData control to provide addi-
tional contact data. 

You can use the AcdRoutingInfo control to store routing 
information about the call in a variable for the contact cen-
ter to retrieve such information.

You use the AcdQueueInfo control to retrieve the status 
of a contact center queue.

You can use the AcdCallInfo control to receive informa-
tion about a call. Such information helps improving the call 
processing.

Custom Controls

A custom control is created by the Application Builder 
user. It allows to fulfill specific requirements.

Icon Functionality
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4.3.7.31  Context Menu of the Controls in the Palette

To open the context menu of palette, right click the control within the palette's 
area. It provides the following options:

• Layout offers several options to change the palette's representation. The 
contents in the views are the same but they are displayed in a different 
manner. The following options exist:

– Columns

– List

– Icons only

– Details

• Use Large Icons enlarges the icon display.

• Settings... opens the Customize Palette dialog for editing the Name and the 
Description as well as for configuring different Options of the single controls 
and their group folders.
The left dialog area provides an overview of all available controls, sorted 
according to various groups (drawer).

NOTICE:  The settings of the Tools drawer and of the tools 
contained therein cannot be edited.

If you select a control or a group folder you can use the Up or Down buttons 
to change the position of the control or group folder in the list. In the right 
dialog area you can edit the name and description of a selected control or 
group folder.
By activating the Hide option you can decide whether or not to display a 
control or a whole group of controls.
The Open drawer at start-up option can be selected for group folders and 
determines whether the respective control group is displayed opened at the 
Application Builder start, i.e. the single controls are displayed in the palette.
The Pin drawer open at start-up option determines if a group folder is 
furnished with an activated pen at the Application Builder start.

• XSettings...X opens the palette settings dialog.
Push the Change... button to open the dialog for setting the font. You can 
define Font, Font size, Size, Color and Effects.
A click on the Restore Default button resets the font to its original values.
In the Layout and List layout options sections you can change the palette 
display like in the palette context menu.
The Drawer options specify how the display of opened group folders of 
controls shall be handled.
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• Custom Controls... opens the Configure Symvia Custom Controls dialog.

You find further descriptions of custom controls in the Custom Controls 
section.

• Custom Groups... opens the Configure Symvia Custom Control 
Categories dialog.

• Reset Palette resets the palette settings to their default values.
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4.3.7.32  Context Menu of the Caption Bar of the Palette

To open the context menu of the caption bar, rightclick the top window bar of the 
palette. It provides the following options:

• Resizing
As soon as you select the option, the mouse pointer changes and is set to the 
inner margin of the window. Now you can resize the width of the palette 
window.

• Anchoring
You may dock the window at the left or the ride hand side.

4.3.7.33  Context Menu of the Groups in the Palette

When you rightclick a group folder (drawer), the context menu contains the 
additional option With Pen. With an active pen you can prevent an open drawer 
in the palette display from getting closed.

4.4  Outline View

The outline displays the entire callflow in a minimized representation. Depending 
on the selected zoom factor, the callflow may be shown in the callflow editor only 
in one extract.

You change the zoom factor by modifying the numerical value in the corre-
sponding field in the toolbar. Another method is to click on the workspace of the 
callflow editor, then turn the mouse wheel while keeping the Ctrl key pressed.

If the callflow editor does not display the entire callflow, the portion you can see 
in the callflow editor is blue highlighted in the outline view. You can move this blue 
section with the left mousebutton kept pressed. The area shown in the workspace 
of the callflow editor is updated accordingly.

4.5  Problem View

The problem view shows errors and warnings of all settings in the workspace of 
all compositions and applications. This is independent from the callflow shown in 
the callflow editor. 
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The view has the format of a table with the following columns:

• Description
This column precisely describes the error or warning. For example, it states 
that a control does not have a mandatory connection to another control or that 
not all necessary properties have been specified for a control.

• Resource
This column states for each error or warning the control type, for example 
application prompt, DtmfMenu control etc.

• Path
This column specifies for each error or warning the path of the concerned 
control. Example: Workspace Grammars/Grammar1.

4.5.1  Context Menu of the Problem View

You open the context menu of the problem view with a rightclick on an entry to be 
provided with the following options:

• Go To opens the corresponding position of the error or warning. For example, 
the callflow is opened in the callflow editor and the control selected in which 
the problem occurred.

NOTICE:  Doubleclicking the entry also opens the respective 
error or warning position.

• The Copy option copies the content of the selected problem to the clipboard.

• Select All selects all entries in the problem view.

• Update refreshes the problem view by searching all configurations in the 
workspace, in compositions, in applications (compositions) and callflows for 
faulty settings.

• Properties opens the Properties dialog in which the Description, the 
Resource and the Resource Path of an error or warning are put out.
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4.6  Properties View

The properties view shows the properties of the elements selected in the callflow 
editor view and their values. The properties are the hight and width of the element 
and the geometric position in X- and Y-coordinates of the control in the callflow.

Caption Bar Icons

The Properties view features the following icons on the right margin of the caption 
bar:

4.7  Bookmark View

Bookmarks serve as marker for quickly finding specific features or jobs. Uncom-
pleted configurations or remarks can be quickly viewed in this way. Especially 

Icon Meaning

Display categories. 

Display extended settings. 

Restore default. 

Maintains the current selection on the properties page.

When you click the triangle, a menu opens. Each menu 
option corresponds to an executable icon in the caption bar. 
A ticked menu option is active. Selecting a menu option has 
the same effect as pushing the corresponding icon.

Minimize properties view

Maximize properties view
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users who have not created the callflow themselves can then receive additional 
information.

Bookmarks can be added to callflows, controls, variables, prompts, grammars, 
languages, databases or resources. Select the desired element for this purpose.

• Control in the callflow editor

• Variable on the tab Workspace, Composition or Application Variable

• Prompt on the tab Workspace, Composition or Application Prompts

• Grammar on the tab Workspace, Composition or Application Grammars

• Language or database on the Workspace Settings tab or 

• Resource on the tab Application or Composition Resources.

Click in the menu bar on Edit > Add Bookmark.... 

If you want to furnish a callflow with a bookmark, open it with a doubleclick on the 
name of the desired callflow in the workspace and select on the menu bar Edit > 
Add Bookmark....

NOTICE:  The bookmarks of the bookmark view do not corre-
spond to the help bookmarks.

4.7.1  Caption Bar Icons

The bookmark view features the following icons on the right margin of the caption 
bar:

Icon Function

Delete selected bookmark

Delete all bookmarks

Minimize bookmark view

Maximize bookmark view
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4.7.2  Context Menu of the Bookmark View

You open the context menu of the bookmark view with a rightclick on an entry to 
be provided with the following options:

• Go to opens the page the bookmark refers to.

NOTICE:  Double-clicking the entry also opens the page the 
bookmark refers to.

• The Copy option copies the content of the selected bookmark to the 
clipboard.

• Select All marks all entries of the bookmark view.

• Delete removes a selected entry from the bookmark view.

• Edit Description enables modifying the description of the selected 
bookmark.

• Properties opens the Properties dialog in which the Description, the 
Resource and the Resource Path of an error or bookmark are put out.

4.8  Search View

The search view shows the results of the search for a character string in all appli-
cations. The search is started via the Search menu option and the Search dialog 
then open.

• Description
This column states the name of the element in which the character string was 
found.

• Resource
This column specifies the resource type, for example Application 1.

• Path
This column indicates the path of the concerned element, for example Appl07/
Callflow07/Phone Number Input Control.

NOTICE:  The search view does not correspond to the help 
search-page.
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4.8.1  Caption Bar Icons

The search view features the following icons on the right margin of the caption 
bar:

4.8.2  Context Menu of the Search View

You open the context menu of the search view with a rightclick on a search hit to 
be provided with the following options:

• Go To opens the dialog or tab in which the string searched for was found.

NOTICE:  Doubleclicking the entry also opens the search hit 
position.

• Doubleclicking the entry also opens the respective error or warning position.

• Copy copies the content of the selected search hit to the clipboard.

• Select All marks all entries of the search view.

• Delete removes a selected entry from the search view.

• Properties opens the Properties dialog in which the Description, the 
Resource and the Resource Path of a search hit are put out. 

4.9  Help View

The help view shows the context-sensitive help. It opens when you select the 
element about which you want to have information and then push the F1 key. An 
element can e.g. be a view, a tab or a control. In addition, you can open the help 
view via the menu bar under Help > Dynamic Help.

NOTICE:  Selecting Tools > Preferences in the menu bar opens 
a dialog. When you then click on Help in this dialog's navigator 
and select In an Infopop from the Open window context help 
combo box, you can later decide in a dialog after pushing the F1 

Icon Function

Delete selected search hit

Delete all search hits

Minimize search view

Maximize search view
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key whether the context-sensitive help shall appear in the help 
view or in a pop-up.

The help view displays various links:

• Related Topics shows the links that provide information about the desired 
element

• All Topics leads to the help's table of contents

• Search shows the page including a search item

• Bookmarks displays the help pages that you have selected as bookmark.

• Index opens the keyword overview of the help

4.9.1  Caption Bar Icons

The help view has additional icons in the caption bar. Which icons are displayed 
depends on the link selected in the help view.

NOTICE:  The help search-page does not correspond to the 
search view. Likewise, the help bookmarks do not correspond to 
the bookmarks of the bookmark view.

Icon Function

Fold all elements of the table of contents in this view.

Display the categories of the search results on the help 
pages. 

Display the descriptions of the search results on the help 
pages.

Display the entry of the displayed help page in the table of 
contents.

Add a bookmark to the displayed page

Show last displayed help page.

Undo skipping to the last help page.

Minimize help view

Maximize help view
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4.9.2  Context Menus of the Help View

The help view features different context menus for different help pages.

NOTICE:  The help pages Related Topics, Index and Search 
have identical context menus.

You open the context menu (All Topics) of the table of contents with a rightclick 
on an entry.

• Open displays the context sensitive help in the help view.

• Open in Help contents opens the desired help page in a separate help 
dialog.

• Add Bookmark sets a new bookmark for the selected entry of the help's table 
of contents.

• Back shows the help page displayed last.

• Next undoes skipping to the last help page.

• Help Contents opens the online help.

You open the context menu (Reference Information) on this help page with a 
rightclick on a free space.

When you rightclick one of the reference links displayed on this page, the above 
context menu of the table of contents opens. 

When you rightclick a bookmark on this page, the following context menu 
Bookmark):

• Open displays the context sensitive help in the help view. 

• Delete removes the selected bookmark of the help. 

• Delete All deletes all bookmarks of the help.

• Back shows the help page displayed last. 

• Next undoes skipping to the last help page.

• Help Contents opens the online help.

If no bookmarks have been added to the help view, the context menu only 
contains the three lower options. 

4.9.3  Browsing the Help Pages 

Open the search and enter the search item you wish to find on the help pages in 
the Search expression field. Then click on Go. 

When you click on Search expression the following search options are 
displayed:
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The link to the right of Search scope indicates the search range. If not otherwise 
modified, the search range is called Default. When you click the small black 
triangle on the left, an information section opens that indicates where the help is 
searching. The default is Local Help. The Advanced Settings link allows 
detailed settings for the search.

In the area thereunder you can see the hits of the completed search process in 
the form <defined search scope> (<number> hits). With a click on the triangle 
to the left, all search results are listed for the corresponding search scope. The 
search hits are displayed as links and a short extract of the help text is also 
shown.

4.9.3.1  How to Select a Search Scope Set

Step by Step

1) Click on the link to the right of the Search scope. 

The Select Scope Sets dialog opens.

Remove deletes the selected scope set entry.

The settings dialog of a selected search scope is opened via the Edit... 
button.

2) You can set the desired search scope as current search scope in two ways:

• Double-click the desired entry in the list of search scope sets.

• Select the desired entry in the list of search scope sets and click on OK.

The search scope name appears as link to the right of Search scope.

4.9.3.2  Configuring the Search Scope

In the Select Scope Sets dialog click on the Edit... button. The left-hand section 
of the Scope <search scope name> dialog may feature the search engine types 
Local Help, Information Center and Web Search. Each entry may appear 
several times. You remove an entry from the list with the Delete button. A new 
search engine is created via the New... button.

The three search engine types mentioned above are available. After you have 
selected the desired search engine type and clicked on the Finish button, the 
search engine list features this type for this search scope.

Option Function

* Look for any string

? Look for any character

"" Look for the expression embedded between the two 
inverted commas

AND, OR, NOT Use Boolean operators for the search
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In the right section you can set a search engine's properties. All search engines 
can be activated by ticking off the XEnable search engineX check box. In the 
following we will explain the settings of the three possible search engines.

Local Help

The XNameX and Description cannot be modified.

If the Search all topics radio button is active, all topics of the selected search 
engine are searched. If the XSearch only the following topicsX radio button is 
active, only pages among those pages are searched that are ticked off in the 
Working set content field.

The Restore Defaults button resets all values to the defaulted ones.

The performed modifications are copied via the Apply button.

Info Center

The Name and Description of the search engine cannot be modified. Enter the 
internet address of the search engine in the URL field.

If the Search all topics radio button is active, all topics of the selected search 
engine are searched. If the Search only the following topics radio button is 
active, only pages entered in the Working set content field are searched.

The Restore Defaults button resets all values to the defaulted ones.

The performed modifications are copied via the Apply button.

Web Search

The Name and Description of the search engine cannot be modified. You can 
receive the URL template by copying the web query from the internet browser 
address field and replacing the search item with {openscape}.

The Restore Defaults button resets all values to the defaulted ones.

The performed modifications are copied via the Apply button.
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5  Controls

You add a control to a callflow by 

• clicking the control in the palette once and adding the control with a second 
click to the desired position of the workspace or

• doubleclicking the corresponding control in the palette or

• dragging the control into the workspace with the left mousebutton kept 
pressed.

To move a control, select it in the callflow and place it in the target position with 
the left mousebutton kept pressed.

Controls are displayed as rectangles with rounded corners. Within the rectangle 
you see the icon, the control type and the control name.

The name of a created control is always pre-defined by the control type 
description and a digit as numbering (for example “Prompt Control 1”).

When you doubleclick a control or the context menu, its Properties configuration 
dialog opens. In this dialog you can always perform the following three settings 
on the General tab:

• You can enter a Name for the new control or change the existing Name (max. 
63 characters, special characters are not allowed).

• You can optionally enter a Description. The description is displayed as tooltip 
of the control and does not affect the control's functionality.

• The Enable Runtime Tracing check box activates logging for the control. 
The log messages depend on the control and are written to the server log. 

• The Restore Defaults button resets all settings of a control except Name and 
Description to the default values.

In some controls, variables and announcements can be used. You can use only 
variables and announcements that were created either for the workspace or for 
the application.

Further setting options depend on the control type and are described in detail for 
each single control in the respective section.

NOTICE:  A callflow always begins with a control of type Start and 
may end with a control of type End if it is no composition or a 
subflow.

NOTICE:  In a callflow, several controls may have the same 
name.

5.1  General Information about Controls

While working with the Application Builder, procedures in the controls are 
repeated (standard procedures). In order to focus the information in the single 
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controls on the basic functions, the standard procedures are described in detail 
beforehand. The respective paragraphs refer to the content.

5.1.1  Context Menu of a Control

All properties of a control's context menu are available in a callflow, a subflow, a 
composition and in both branches of a parallel flow.

Every control has a context menu. You open the context menu with a rightclick on 
the control.

The context menu offers the following functions:

• Undo
Undoes the action or modification performed last.

• Repeat
Executes the action or modification performed last once again.

• Cut
The control is cut out of its position and can be pasted in another position if 
required. 

• Copy
Copies the control. You can paste a duplicate in another position. 

• Paste
Pastes the control copied or cut last. 

• Delete
Removes the selected control permanently.

• Properties
Opens the Properties configuration dialog of the control.

If you have selected two or more controls, the following two additional features 
are provided:

• Align

– Align Left
Aligns all selected controls to the left margin of the control clicked with the 
mouse last.

– Align Center
Aligns all selected controls to the vertical middle line of the control clicked 
with the mouse last.

– Align Right
Aligns all selected controls to the right margin of the control clicked with 
the mouse last.
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– Align Top
Aligns all selected controls to the top margin of the control clicked with the 
mouse last.

– Align Middle
Aligns all selected controls to the horizontal middle line of the control 
clicked with the mouse last.

– Align Bottom
Aligns all selected controls to the bottom margin of the control clicked with 
the mouse last.

• Match

– Match Width
The width of the control clicked last is adopted by all other selected 
controls.

– Match Height
The height of the control clicked last is adopted by all other selected 
controls.

– Match Size
The width and height of the control clicked last is adopted by all other 
selected controls.

If you have selected three or more controls, the following additional features are 
provided:

• Arrange Horizontally
The controls positioned in the middle of all selected controls seen horizontally 
are moved in such a way that the horizontal distances between all selected 
controls are the same.

• Arrange Vertically
The controls positioned in the middle of all selected controls seen vertically 
are moved in such a way that the vertical distances between all selected 
controls are the same.

5.1.2  Quick-Configuration Menu

Every control has a quick-configuration menu. You open this menu by placing the 
mousepointer onto the control. The quick-configuration menu that opens is 
semitransparent. When you position the mousepointer onto the quick-configu-
ration menu, it becomes transparent and you can click the functions with the 
mouse. 

The quick-configuration menu offers the following functions:

• Delete
Removes the selected control permanently.

• Cut
The control is cut out of its position and can be pasted in another position if 
required. 
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• Copy
Copies the control. You can paste a duplicate in another position. 

• Properties
Opens the Properties configuration dialog of the control.

5.1.3  Speech Recognition

In case of applications created with the Application Builder, the user may have to 
make entries for continuing with the callflow. 

If a speech recognition system has been installed, the Application Builder allows 
making entries by specifying digits on the phone keypad and by voice. Speech 
recognition is performed by a software with a speech grammar that decodes 
announcements, compares them with permanent entries and, as the case may 
be, executes associated commands. 

NOTICE:  For further information about speech recognition 
please consult the manuals of the speech recognition software 
used.

5.1.4  How to Add a Prompt

Step by Step

1) Click on and select the Add Prompt option.

The Select Prompts for Announcements List dialog opens, which lists all 
announcements already imported and created. These announcements are 
created either for the entire workspace or for an application. You can also 
insert announcements for selection.

2) Select the Create new Prompt... link.

The dialog Create Symvia Application Prompt opens for creating 
announcements for an application. The configuration occurs analog to 
creating prompts for applications (see section Application Prompts).

3) Select the prompts that are to be copied to the announcement list and confirm 
your selection with OK.

The selected prompts are now listed. The sequence of the prompts in the list 
corresponds to the sequence of the announcement playback. If you select 
further announcements they will be added to the end of the list.
 A31003-S50A0-U103-02-7619, 10/2020
180 OpenScape UC Application V10 Fusion Application Builder, User Guide



Controls
General Information about Controls
5.1.5  How to Add a Variable

Step by Step

1) Click on and select the Add Variable option.

The dialog dialog lists all variables already imported and created. These 
variables are created either for the entire workspace or for an application. If a 
text-to-speech program is installed, the value of this variable (text) is 
converted into speech while the application is run through.

NOTICE:  Check with the system administrator whether a text-to-
speech program is installed on the UC server and whether the text 
to be converted into speech is available in a language that this 
program can process.

2) Select the variables that are to be copied to the variable list and confirm your 
selection with OK.

The selected variables are listed. The sequence of the variables in the list 
corresponds to the sequence of the announcement playback. If you select 
further variables, they are added to the end of the list.

5.1.6  How to Add a Pause

Step by Step

1) Click on and select the Add Pause option.

The Specify Pause for Announcement List opens.

2) Specify the pause length (ms) and confirm your selection with a click on OK.

The selected files are listed. The sequence of the files in the list corresponds 
to the sequence of the announcement and pause playback.

5.1.7  How to Add a Playback Option

Prerequisites

• The playback option is available for recorded prompts only. Prompts created 
by (TTS) are excluded from the function. 

Step by Step

1) Select an element in the announcement list and click on 

A selection list with the options Direct Playback and Custom Playback... 
opens.

2) If you select the Custom Playback... option. The Announcement Playback 
dialog opens.
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This dialog lists all configured announcements and variables of the DtmfSe-
lection control. 

3) A click on the Close button closes the Announcement Playback dialog.

4) If you select the Direct Playback option, a selected announcement is played 
directly.

5.1.8  Connection

Via connection a call is forwarded from one control to the next.

NOTICE:  You cannot set up connections between all kinds of 
controls; for example not between a Start control and an End 
control. 

The color and the line type of a connection represent the call status: 

Icon Description

You use these icons to control the playback of a selected 
announcement. 

With this icon you can select the playback language, if an 
announcement is available in several languages. 

This icon activates/deactivates the continuous playback.
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The thick stroke width of a connection indicates that the event which caused 
leaving the last control was desired. This is the case for example with a successful 
database query. However, if an undesired event caused leaving the last control 
(for example a failed database query), a thin stroke width is used for the 
connection. The stroke width is independent from the call status.

Positioning the mouse over a connection displays a tooltip providing information 
about the call status and about the event that lead to this connection.

Depending on the call status a connection may only lead to the entry of specific 
controls. If a non-permitted control is connected, an error is created and displayed 
in the control's tooltip and in the problem view. Controls that require an active call 
status at the entry have a green receiver icon top left in the graphic represen-
tation. 

This graphic representation is also used within a Parallel Flow control. The call 
status behind the exit of a Parallel Flow control is determined by the connection 
of the highest priority that leads to the exit. There is the following priority list:

• Active and accepted (highest priority)

• Active and unaccepted

• Inactive and alerted

• Inactive and accepted

• Unknown (lowest priority)

5.1.8.1  How to Create a Connection

Prerequisites

• There must be at least two controls in the callflow. 

Graphic Representation Call Status Meaning

Color Line Type Stroke 
Width

Gray Straight Thick Unknown The last control before this connection is disconnected at 
the entry.

Thin

Green Straight Thick Active Accepted Prompts can be played to the caller and inputs can be 
accepted from him/her. Call charging has been started.

Thin

Dotted Thick Unaccepted Prompts can be played to the caller and inputs can be 
accepted from him/her. Call charging has not been 
started yet.Thin

Red Straight Thick Inactive Accepted No prompts can be played to the caller and no inputs can 
be accepted from him/her. Call charging has been 
started.Thin

Dotted Thick Alerted No prompts can be played to the caller and no inputs can 
be accepted from him/her. Call charging has not been 
started yet.Thin
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Step by Step

1) Select Connection in the palette.

A plug-icon is attached to the mousepointer.

2) Click on the control the connection is to be started from and keep the mouse-
button pressed. Now point the electric plug to the control to which you would 
like to create a connection.

For each connection the connection name is displayed, which is identical with 
the event name and the position of which (as closely as possible to the 
connection startpoint) is automatically defined.

If a control can have several outbound connections, a dialog opens in which 
you select the event to be used for the connection.

If allowed, a connection is set up between the two controls.

NOTICE:  Connecting the Start and End control directly is not 
allowed.

Alternatively, you can directly draw a connection between controls by moving 
the mousepointer along the edge of a control. Three semitransparent handles 
appear on the edge and the mouse pointer becomes an electric plug. Click 
and keep the left mouse button pressed and drag the connection to the 
desired control. Release the left mouse button to establish the connection.

NOTICE:  The number of connections is limited to those allowed 
by the control. When all possible connections have been set up, 
no further handles are displayed.

5.1.8.2  How to Edit a Connection

Step by Step

1) Choose Select in the palette. 

2) Click the connection you wish to edit. 

The connection name appears blue. The connection line receives diamonds 
and squares as handles.

3) Select the desired handle with the mousebutton kept pressed, drag the 
connection line to the desired position and release the button. 

The new position of the connection line is maintained.

All relocations of the dots can be made undone. A connection can be 
straightened by selecting Normalize Connection in the connection's context 
menu.
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5.1.8.3  Context Menu of a Connection

You open the context menu with a rightclick on the bent connection.

The context menu offers the following functions:

• Undo:
Undoes the action or modification performed last.

• Redo
Executes the action or modification performed last once again.

• Normalize Connection:
Straightens the bent connection. 

NOTICE:  The functions Cut, Copy, Paste and Properties are 
not available in the context menu for connections. 

5.2  Callflow Link

The callflow link connects two callflows within an application. The callflow linking 
with an arbitrary, configured control of the other callflow serves as point of entry 
in the other callflow.

A subflow cannot have a callflow link.

5.2.1  How to Create a Callflow Link 

Step by Step

1) Click on the Callflow Link in the palette, keep the left mousebutton pressed 
and drag the callflow link to the desired position. Release the mousebutton. 

The callflow link position is maintained.

2) Double-click the callflow link with the left mousebutton. 

The Select Target Item dialog opens. 

3) Select the target item from another callflow to be linked.

4) Click on OK.

The specifications are copied. 

5.2.2  Context Menu of the Callflow Link

You open the context menu with a rightclick on the callflow link.

The context menu offers the following functions:

• Go to Target Item:
Opens the selected target item in the linked callflow. 
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• Undo:
Undoes the action or modification performed last.

• Redo
Executes the action or modification performed last once again.

• Cut
The callflow link is cut out of its position and can be pasted in another position 
if required. 

• Copy
The callflow link is copied. You can paste a duplicate in another position. 

• Paste
Inserts the callflow link copied or cut last. 

• Delete
Deletes the selected callflow link permanently.

• Set Target Item:
Select the target item from another callflow.

NOTICE:  The Properties function is not available in the context 
menu. 

5.3  Sticky Note

With a sticky note you can add comments to a callflow.

NOTICE:  A sticky note does not affect the callflow functionality 
and process in any way.

5.3.1  How to Create a Sticky Note

Step by Step

1) Click on Sticky Note in the palette, keep the left mousebutton pressed and 
drag the sticky note in the callflow to the desired position. Release the mouse-
button. 

The position of the sticky note is maintained.

2) Doubleclick the sticky note with the left mousebutton for changing the text of 
the sticky note and enter the text. 

3) Click in a free area of the callflow to conclude the process.

The text of the sticky note is copied.
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5.3.2  How to Link a Sticky Note to a Control

You can link a sticky note to a control to point out the information's association. 

Prerequisites

• There must be a control to be linked up with the sticky note. 

Step by Step

1) Create a sticky note as described under How to Create a Sticky Note.

2) Select Connection in the palette.

A plug-icon is attached to the mousepointer.

3) Click on the sticky note from which you wish to create a link and then on the 
control.

A link is set up. The link is highlighted by color to separate the sticky note link 
from the control connections. 

5.3.3  Context Menu of a Sticky Note

You open the context menu with a rightclick on the sticky note.

The context menu offers the following functions:

• Undo:
Undoes the action or modification performed last.

• Redo
Executes the action or modification performed last once again.

• Cut
The sticky note is cut out of its position and can be pasted in another position 
if required. 

• Copy
The note is copied. You can paste a duplicate in another position. 

• Paste
Pastes the sticky note copied or cut last. 

• Delete
Deletes the selected sticky note permanently.

• Edit Note:
You can edit the text of the sticky note. 

NOTICE:  The Properties function is not available in the context 
menu. 
A31003-S50A0-U103-02-7619, 10/2020
OpenScape UC Application V10 Fusion Application Builder, User Guide 187



Controls
List Group
5.4  List Group

This group contains the list controls. They serve for modifying variable lists. A list 
control is partly handled like a normal control. 

The extract from the palette view shows which elements are part of this group.

5.4.1  List Sorter Control

The List Sorter controls contains the Properties view.

Properties view

In the Properties view of the control you can perform the following settings. See 
section General Information about Controls.

Under List Sorting you specify the variable list to be sorted, the sort order and 
the sort criterion. The sort criterion is the variable type of the list or one of its sub-
variables. For configuration proceed as follows:

1. Specify the Variable List to sort. Use the ... button to select the corre-
sponding variable and click on OK.

2. Select the Sort Order:
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• Sort Ascending

• Sort Descending

3. Select a Sort Criterion by which the variable list shall be sorted.
If the variable you selected is of the type date list, you can choose between 
the variable date and the member variables year, month or day.

4. Click on OK.
The configurations are saved.

5.4.2  List Iterator Control

A List Iterator control serves for running through a variable list step by step and 
to execute actions programmed in a subflow for each of the variables.

When you add a List Iterator control to a callflow, the name of this control is 
automatically displayed in the workspace in one of the following places:

• <application name> > application callflows> <callflow name>

• Symvia Control Compositions > <composition name> > <composition 
callflows> > <callflow name>

An iterator is assigned to exactly one subflow and a subflow is assigned to exactly 
one iterator.

NOTICE:  In the example application AutomaticSurvey, the List 
Iterator control is available in the Samples\Applications sub-
folder of the Application Builder's installation folder (not in the 
workspace directory). This application is shipped with the Appli-
cation Builder. The How to Import Workspace Elements section 
describes how to provide this application.

The List Iterator control contains the Properties view.
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Properties view 

In the Properties view of the control you can perform the following settings. See 
section General Information about Controls.

The name of the Listen Iterator control is identical with the name of the assigned 
subflow. A click on the Listen Iterator control in the callflow opens the configu-
ration dialog of the control. In contrast, a click on the entry of the same name in 
the workspace opens the assigned subflow.

Under List Iteration you specify the variable list and the name of the Iterator 
variable. The Iterator variable is the loop variable during traversing all list 
elements. For configuration proceed as follows:

1. Specify the Variable List to iterate. Use the ... button to select the corre-
sponding variable and click on OK.

NOTICE:  You can access the Iterator variable in the subflow. You 
open the subflow via the Open corresponding Sub Callflow 
Editor link or by double-clicking the subflow name in the 
workspace. You find further information in the Subflow section.

2. Enter an Iterator variable name.

3. Click on OK.
The configuration has been saved.
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5.4.2.1  Subflow

When a List Iterator control is created or deleted, a subflow assigned to this List 
Iterator control is automatically created or deleted also. A List Iterator control 
serves for running through a variable list step by step and to execute actions 
programmed in the associated subflow for each of these variables. 

A subflow differs from the a normal callflow in the following points:

• A List Iterator control is assigned to exactly one subflow and a subflow is 
assigned to exactly one List Iterator control.

• The name of the List Iterator control is identical with the name of the subflow.

• When you add a List Iterator control to a callflow, the name of the subflow is 
automatically displayed in the workspace in one of the following places:

– <application name> > application callflows> <callflow name>

– Symvia Control Compositions > <composition name> > <compo-
sition callflows> > <callflow name>

• There are the following two options to open a subflow:

– In the configuration dialog of the associated List Iterator control with a 
click on the Open corresponding Sub Callflow Editor link.

– With a double-click on the name on the subflow in the workspace.

• A subflow cannot have a Start control and callflow link.

• The following controls can only be used in a subflow:

– Subflow Entry

– Subflow Exit

– Subflow Loop

• Each subflow starts mandatorily with a Subflow Entry control connected to a 
Subflow Loop control. 

5.4.3  List Modifier Control

The List Modifier view contains the Properties view.
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Properties view

In the Properties view of the control you can perform the following settings. See 
section General Information about Controls.

Under List Modification you specify the variable list and the argument variable 
or constant. You can either add the argument to the end of the list or remove it 
from the list. For configuration proceed as follows:

1. Specify the Variable List to modify. Use the ... button to select the corre-
sponding variable and click on OK.

2. Select whether to specify an Argument Variable or an Argument Constant 
by placing a tick in the appropriate checkbox.

3. Select the List Operation:

• Append Argument

• Remove Argument

4. Click on OK.
The configuration has been saved.

5.4.4  String Operator Control

With the String Operator control you can apply the following operations to a 
variable of type String:

• Initialize string

• Insert string

• Delete substring
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• Copy substring

• Append string

• Remove blank from string

• Convert string to capital letters

• Convert string to small letters

• Split string in substring using a regular expression

• Replace substring using a regular expression

• Split string in substrings using separators

• Reverse string

• Determine string length

• Search string forward for substring

• Search string backward for substring

You need a result variable for each operation. Depending on the operation, you 
also require a source variable and/or parameters (strings, format specifications or 
a regular expression). 

5.4.4.1  How to Initialize a String

This section describes how to fill a string variable with text.

Step by Step

1) Click in the palette on the String Operator control and drag it into the callflow 
editor. 

2) Release the mousebutton.

3) Double-click this control.
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4) If required, change the value in the Name field, for example to Initialize 
String.

5) If needed, enter a value in the Description field.

6) Click on the Operations tab.
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7) Click on the icon.

8) Select value Initialize [String < - String] from the Variable Operation 
Method combo box.

9) Click on Next.
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10) In the Method Parameters section, click in the first row of the Value column. 
A button with the ellipsis appears.

INFO:  This button appears only if you use specific Windows 
themes such as any Aero theme or the Windows 7 basic theme.

You can change the Windows theme for example by clicking on 
the desktop background with the right mouse button and selecting 
Personalize. Alternatively, you can open Start > Control Panel > 
Personalization or Start > Control Panel > Appearance and 
Personalization > Personalization.

11) Click on this button.
 A31003-S50A0-U103-02-7619, 10/2020
196 OpenScape UC Application V10 Fusion Application Builder, User Guide



Controls
List Group
12) Enter the text to be used for initializing the string in the Pattern field. If you 

wish to enter variable values in this field indirectly, click on the icon, select 
the variable the value of which you wish to use and click on OK. The selected 
variable is displayed in the Arguments field. The Tag column displays the 
format tag that corresponds to the variable, for example {0}. If you wish to 

remove a variable from the Arguments field, click on the icon. You can 

change the variable - format tag assignment using the icons  and  . 
Place the format tags in the subject line in positions where the corresponding 
variable values are required. When you click in the Pattern field and push the 
hotkey CTRL + space bar, a selection of format tags is provided. Click on the 
appropriate format tag and push the enter key.

Example of a pattern with format tags:

Project Status: {0}, Project Target Date: {1}

INFO:  The description of the Java class MessageFormat 
provides further information about format tags; see for example 
docs.oracle.com/javase/6/docs/api/java/text/
MessageFormat.html. This page also describes the use of the 
number, date, time and choice format types as well as of the short, 
medium, long, full, integer, currency, percent and Subfor-
matPattern format styles.

Example of a pattern with two format types and one format style: 

13) Click on the OK button.

14) In the Result Variable section, click on the button, select the string variable 
to store the result of the string initialization and click on OK.

Project Status: {0,number,percent}, Project target date: {1,date}
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15) If you wish to test the string initialization, click on Next.

16) Click on Test Variable Operation Setup....
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17) Enter the test values in the right column of the Operation Settings field.

18) Click on Calculate.
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The Operation Result field shows the result.

19) Click on OK.
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20) Click on Finish.

21) Click on OK.
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5.4.4.2  How to Insert a Substring

This section describes how to insert text in a specific position in a string variable.

Step by Step

1) Click in the palette on the String Operator control and drag it into the callflow 
editor. 

2) Release the mousebutton.

3) Double-click this control.

4) If required, change the value in the Name field, for example to Insert 
Substring.

5) If needed, enter a value in the Description field.

6) Click on the Operations tab.
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7) Click on the icon.

8) Select value Insert [String < - Integer, String] from the Variable Operation 
Method combo box.

9) Click on Next.
A31003-S50A0-U103-02-7619, 10/2020
OpenScape UC Application V10 Fusion Application Builder, User Guide 203



Controls
List Group
10) In the Source Variable section, click on the button, select the string 
variable the value of which you wish to use as starting point for adding a 
substring and click on OK.

11) In the Method Parameters section, click in the first row of the Value column. 

The button appears.

INFO:  This button appears only if you use specific Windows 
themes such as any Aero theme or the Windows 7 basic theme.

You can change the Windows theme for example by clicking on 
the desktop background with the right mouse button and selecting 
Personalize. Alternatively, you can open Start > Control Panel > 
Personalization or Start > Control Panel > Appearance and 
Personalization > Personalization.

12) Click on this button.
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13) If you wish to use a variable value for the position in which the substring shall 

be inserted, click on the button, select a variable and click on OK. 

If, in contrast, you wish to use a permanent numerical value, activate the 
Constant radio button and enter the value. The position must be greater than/
equal to 0 and smaller than/equal to the string length.

INFO:  If the position is identical with the string length, the 
substring is attached to the string. In this case you can use the 
variable operation method Append [String < - String] instead of 
Insert [String < - Integer, String].

14) Click on OK.

15) Proceed analog for the text to be inserted.

16) In the Result Variable section, click on the button, select the string variable 
to store the result of the text insertion and click on OK.
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17) If you wish to test the text insertion, click on Next.

18) Click on Test Variable Operation Setup....

19) Enter the test values in the right column of the Operation Settings field.

20) Click on Calculate.
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The Operation Result field shows the result.

21) Click on OK.

22) Click on Finish.

23) Click on OK.

5.4.4.3  How to Remove a Substring

This section describes how to remove a substring from the value of a string 
variable.

Step by Step

1) Click in the palette on the String Operator control and drag it into the callflow 
editor. 

2) Release the mousebutton.

3) Double-click this control.

4) If required, change the value in the Name field, for example to Remove 
Substring.

5) If needed, enter a value in the Description field.

6) Click on the Operations tab.
A31003-S50A0-U103-02-7619, 10/2020
OpenScape UC Application V10 Fusion Application Builder, User Guide 207



Controls
List Group
7) Click on the icon.

8) Select value Delete [String < - Integer, Integer] in the Variable Operation 
Method combo box.

9) Click on Next.
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10) In the Source Variable section, click on the button, select the string 
variable the value of which you wish to use as starting point for removing a 
substring and click on OK.

11) In the Method Parameters section, click in the first row of the Value column. 

The button appears.

INFO:  This button appears only if you use specific Windows 
themes such as any Aero theme or the Windows 7 basic theme.

You can change the Windows theme for example by clicking on 
the desktop background with the right mouse button and selecting 
Personalize. Alternatively, you can open Start > Control Panel > 
Personalization or Start > Control Panel > Appearance and 
Personalization > Personalization.

12) Click on this button.
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13) If you wish to use a variable value for the position where the substring to be 

removed begins, click on the button, select a variable and click on OK.

If, in contrast, you wish to use a permanent numerical value, activate the 
Constant radio button and enter the value.

The position must be greater than/equal to 0 and smaller than the string 
length.

14) Click on OK.

15) Proceed analog for the end position of the test to be removed. The end 
position must be greater than 0 and smaller than/equal to the string length.

16) In the Result Variable section, click on the button, select the string variable 
to store the remaining string after the text has been deleted and click on OK.
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17) If you wish to test the text deletion, click on Next.

18) Click on Test Variable Operation Setup....

19) Enter the test values in the right column of the Operation Settings field.

20) Click on Calculate.
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The Operation Result field shows the result.

21) Click on OK.

22) Click on Finish.

23) Click on OK.
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5.4.4.4  How to Copy a Substring

This section describes how to copy a substring from the value of a string variable.

Step by Step

1) Click in the palette on the String Operator control and drag it into the callflow 
editor. 

2) Release the mousebutton.

3) Double-click this control.

4) If required, change the value in the Name field, for example to Copy 
Substring.

5) If needed, enter a value in the Description field.

6) Click on the Operations tab.
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7) Click on the icon.

8) Select value Substring [String < - Integer, Integer] in the Variable 
Operation Method combo box.

9) Click on Next.
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10) In the Source Variable section, click on the button, select the string 
variable the value of which you wish to use as starting point for copying a 
substring and click on OK.

11) In the Method Parameters section, click in the first row of the Value column. 

The button appears.

INFO:  This button appears only if you use specific Windows 
themes such as any Aero theme or the Windows 7 basic theme.

You can change the Windows theme for example by clicking on 
the desktop background with the right mouse button and selecting 
Personalize. Alternatively, you can open Start > Control Panel > 
Personalization or Start > Control Panel > Appearance and 
Personalization > Personalization.

12) Click on this button.
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13) If you wish to use a variable value for the position where the substring to be 

removed begins, click on the button, select a variable and click on OK. 

If, in contrast, you wish to use a permanent numerical value, activate the 
Constant radio button and enter the value.

The position must be greater than/equal to 0 and smaller than the string 
length.

14) Click on OK.

15) Proceed analog for the end position of the test to be removed. The end 
position must be greater than 0 and smaller than/equal to the string length.

16) In the Result Variable section, click on the button, select the string variable 
to store the substring to be copied and click on OK.
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17) If you wish to test the text copying, click on Next.

18) Click on Test Variable Operation Setup....

19) Enter the test values in the right column of the Operation Settings field.

20) Click on Calculate.
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The Operation Result field shows the result.

21) Click on OK.

22) Click on Finish.

23) Click on OK.
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5.4.4.5  How to Append a String

This section describes how to append a string to another string.

Step by Step

1) Click in the palette on the String Operator control and drag it into the callflow 
editor. 

2) Release the mousebutton.

3) Double-click this control.

4) If required, change the value in the Name field, for example to Append 
String.

5) If needed, enter a value in the Description field.

6) Click on the Operations tab.
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7) Click on the icon.

8) Select value Append [String < - String] from the Variable Operation 
Method combo box.

9) Click on Next.
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10) In the Source Variable section, click on the button, select the string 
variable the value of which you wish to use as starting point for appending a 
string and click on OK.

11) In the Method Parameters section, click in the first row of the Value column. 

The button appears.

INFO:  This button appears only if you use specific Windows 
themes such as any Aero theme or the Windows 7 basic theme.

You can change the Windows theme for example by clicking on 
the desktop background with the right mouse button and selecting 
Personalize. Alternatively, you can open Start > Control Panel > 
Personalization or Start > Control Panel > Appearance and 
Personalization > Personalization.

12) Click on this button.
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13) If you wish to use a variable value for the string to be appended, click on the 

button, select a variable and click on OK. 

If, in contrast, you wish to use a constant, activate the Constant radio button 
and enter the value.

14) Click on OK.

15) In the Result Variable section, click on the button, select the string variable 
to store the original string with the appended string and click on OK.

16) If you wish to test the string attachment, click on Next.
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17) Click on Test Variable Operation Setup....

18) Enter the test values in the right column of the Operation Settings field.

19) Click on Calculate.
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The Operation Result field shows the result.

20) Click on OK.

21) Click on Finish.

22) Click on OK.
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5.4.4.6  How to Remove Blanks from a String

This section describes how to remove leading and trailing blanks from a string.

Step by Step

1) Click in the palette on the String Operator control and drag it into the callflow 
editor. 

2) Release the mousebutton.

3) Double-click this control.

4) If required, change the value in the Name field, for example to Trim a 
string.

5) If needed, enter a value in the Description field.

6) Click on the Operations tab.
A31003-S50A0-U103-02-7619, 10/2020
OpenScape UC Application V10 Fusion Application Builder, User Guide 225



Controls
List Group
7) Click on the icon.

8) Select value Trim [String] from the Variable Operation Method combo box.

9) Click on Next.
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10) In the Source Variable section, click on the button, select the string 
variable from the value of which you wish to remove blanks and click on OK.

11) In the Result Variable section, click on the button, select the string variable 
to store the result string and click on OK.
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12) If you wish to test the removal of blanks, click on Next.

13) Click on Test Variable Operation Setup....

14) Enter the test values in the right column of the Operation Settings field.

15) Click on Calculate.
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The Operation Result field shows the result.

16) Click on OK.

17) Click on Finish.

18) Click on OK.
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5.4.4.7  How to Convert a String into Capital Letters

This section describes how to convert all letters in a string into capital letters.

Step by Step

1) Click in the palette on the String Operator control and drag it into the callflow 
editor. 

2) Release the mousebutton.

3) Double-click this control.

4) If required, change the value in the Name field, for example to Convert 
into Capital Letters.

5) If needed, enter a value in the Description field.

6) Click on the Operations tab.
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7) Click on the icon.

8) Select value Upper Case [String] from the Variable Operation Method 
combo box.

9) Click on Next.
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10) In the Source Variable section, click on the button, select the string the 
letters of which are to be converted into small letters and click on OK.

11) In the Result Variable section, click on the button, select the string variable 
to store the result string and click on OK.
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12) If you wish to test the conversion into capital letters, click on Next.

13) Click on Test Variable Operation Setup....

14) Enter the test values in the right column of the Operation Settings field.

15) Click on Calculate.
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The Operation Result field shows the result.

16) Click on OK.

17) Click on Finish.

18) Click on OK.
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5.4.4.8  How to Convert a String into Small Letters

This section describes how to convert all letters in a string into small letters.

Step by Step

1) Click in the palette on the String Operator control and drag it into the callflow 
editor. 

2) Release the mousebutton.

3) Double-click this control.

4) If required, change the value in the Name field, for example to Convert 
into Small Letters.

5) If needed, enter a value in the Description field.

6) Click on the Operations tab.
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7) Click on the icon.

8) Select value Lower Case [String] from the Variable Operation Method 
combo box.

9) Click on Next.
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10) In the Source Variable section, click on the button, select the string the 
letters of which are to be converted into small letters and click on OK.

11) In the Result Variable section, click on the button, select the string variable 
to store the result string and click on OK.
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12) If you wish to test the conversion into small letters, click on Next.

13) Click on Test Variable Operation Setup....

14) Enter the test values in the right column of the Operation Settings field.

15) Click on Calculate.
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The Operation Result field shows the result.

16) Click on OK.

17) Click on Finish.

18) Click on OK.
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5.4.4.9  How to Divide a String Using a Regular Expression

This section describes how to divide a string and store the result in a string list 
with a regular expression determining where to divide. The regular expression 
[ot] for example divides the string To be or not to be. That is the 
question. in the string list T, be, r n, , be. Tha, is, he, ques, i, n.. If the 
regular expression is not fulfilled anywhere in the string, the entire string is copied 
to the string list.

Step by Step

1) Click in the palette on the String Operator control and drag it into the callflow 
editor. 

2) Release the mousebutton.

3) Double-click this control.

4) If required, change the value in the Name field, for example to Divide 
String.

5) If needed, enter a value in the Description field.

6) Click on the Operations tab.
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7) Click on the icon.

8) Select value Split [String List < - String] from the Variable Operation 
Method combo box.

9) Click on Next.
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10) In the Source Variable section, click on the button, select the string 
variable the value of which you wish to divide and click on OK.

11) In the Method Parameters section, click in the first row of the Value column. 

The button appears.

NOTICE:  This button appears only if you use specific Windows 
themes such as any Aero theme or the Windows 7 basic theme.

You can change the Windows theme for example by clicking on 
the desktop background with the right mouse button and selecting 
Personalize. Alternatively, you can open Start > Control Panel > 
Personalization or Start > Control Panel > Appearance and 
Personalization > Personalization.

12) Click on this button.
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13) If you wish to use a variable value for the regular expression, click on the 

button, select a variable and click on OK. 

If, in contrast, you wish to use a constant, activate the Constant radio button 
and enter the value.

[ot] for example divides the string in places where a small o or a small t 
occurs.

14) Click on OK.

15) In the Result Variable section, click on the button, select the string list 
variable to store the result and click on OK.

16) If you wish to test the string division, click on Next.
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17) Click on Test Variable Operation Setup....

18) Enter the test values in the right column of the Operation Settings field.

19) Click on Calculate.
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The Operation Result field shows the result.

20) Click on OK.

21) Click on Finish.

22) Click on OK.
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5.4.4.10  How to Replace a Substring using a Regular Expression

This section describes how to replace a substring with another substring with help 
of a regular expression in a string. The regular expression [ot] replaces for 
example in the string To be or not to be. That is the question. all 
occurrences of the letters o and t with one or several characters to be selected. 
If you select for example letter x as replacement, you receive the following result: 
Tx be xr nxx xx be. Thax is xhe quesxixn.

Step by Step

1) Click in the palette on the String Operator control and drag it into the callflow 
editor. 

2) Release the mousebutton.

3) Double-click this control.

4) If required, change the value in the Name field, for example to Replace 
Substring.

5) If needed, enter a value in the Description field.

6) Click on the Operations tab.
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7) Click on the icon.

8) Select value Replace [String < - String] from the Variable Operation 
Method combo box.

9) Click on Next.
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10) In the Source Variable section, click on the button, select the string the 
value of which you wish to partly replace and click on OK.

11) In the Method Parameters section, click in the first row of the Value column. 

The button appears.

INFO:  This button appears only if you use specific Windows 
themes such as any Aero theme or the Windows 7 basic theme.

You can change the Windows theme for example by clicking on 
the desktop background with the right mouse button and selecting 
Personalize. Alternatively, you can open Start > Control Panel > 
Personalization or Start > Control Panel > Appearance and 
Personalization > Personalization.

12) Click on this button.
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13) If you wish to use a variable value for the regular expression, click on the 

button, select a variable and click on OK. 

If, in contrast, you wish to use a constant, activate the Constant radio button 
and enter the value.

[ot] for example divides the string in places where a small o or a small t 
occurs.

14) Click on OK.

15) Proceed analog for the Replacement parameter, thus for the string to replace 
the substring.

16) In the Result Variable section, click on the button, select the string variable 
to store the result and click on OK.
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17) If you wish to test the substring replacement, click on Next.

18) Click on Test Variable Operation Setup....

19) Enter the test values in the right column of the Operation Settings field.

20) Click on Calculate.
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The Operation Result field shows the result.

21) Click on OK.

22) Click on Finish.

23) Click on OK.
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5.4.4.11  How to Divide a String Using Separators

This section describes how to divide a string and store the result in a string list 
with separators determining where to divide. The separators ot for example 
divide the string To be or not to be. That is the question. in the 
string list T, be, r n, , be. Tha, is, he, ques, i, n.. If the string does not contain 
the separators, the entire string is copied to the string list.

Step by Step

1) Click in the palette on the String Operator control and drag it into the callflow 
editor. 

2) Release the mousebutton.

3) Double-click this control.

4) If required, change the value in the Name field, for example to Divide 
String.

5) If needed, enter a value in the Description field.

6) Click on the Operations tab.
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7) Click on the icon.

8) Select value Tokenize [String List -> String] from the Variable Operation 
Method combo box.

9) Click on Next.
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10) In the Source Variable section, click on the button, select the string 
variable the value of which you wish to divide and click on OK.

11) In the Method Parameters section, click in the first row of the Value column. 

The button appears.

INFO:  This button appears only if you use specific Windows 
themes such as any Aero theme or the Windows 7 basic theme.

You can change the Windows theme for example by clicking on 
the desktop background with the right mouse button and selecting 
Personalize. Alternatively, you can open Start > Control Panel > 
Personalization or Start > Control Panel > Appearance and 
Personalization > Personalization.

12) Click on this button.

13) If you wish to use a variable value for the separators, click on the button, 
select a variable and click on OK. 

If, in contrast, you wish to use a constant, activate the Constant radio button 
and enter the value.

ot for example divides the string in places where a small o or a small t 
occurs.

14) Click on OK.

15) In the Result Variable section, click on the button, select the string list 
variable to store the result and click on OK.
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16) If you wish to test the string division, click on Next.

17) Click on Test Variable Operation Setup....

18) Enter the test values in the right column of the Operation Settings field.
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19) Click on Calculate.

The Operation Result field shows the result.

20) Click on OK.

21) Click on Finish.
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22) Click on OK.

5.4.4.12  How to Reverse a String

This section describes how to copy the characters of a string to another string in 
reverse order.

Step by Step

1) Click in the palette on the String Operator control and drag it into the callflow 
editor. 

2) Release the mousebutton.

3) Double-click this control.
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4) If required, change the value in the Name field, for example to Reverse 
String.

5) If needed, enter a value in the Description field.

6) Click on the Operations tab.
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7) Click on the icon.

8) Select value Reverse [String] from the Variable Operation Method combo 
box.

9) Click on Next.
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10) In the Source Variable section, click on the button, select the string 
variable the value of which you wish to reverse and click on OK.

11) In the Result Variable section, click on the button, select the string list 
variable to store the result and click on OK.

12) If you wish to test the string reversal, click on Next.
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13) Click on Test Variable Operation Setup....

14) Enter the test values in the right column of the Operation Settings field.

15) Click on Calculate.

The Operation Result field shows the result.

16) Click on OK.

17) Click on Finish.
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18) Click on OK.

5.4.4.13  How to Determine the Length of a String

This section describes how you determine the length of a string.

Step by Step

1) Click in the palette on the String Operator control and drag it into the callflow 
editor. 

2) Release the mousebutton.

3) Double-click this control.
 A31003-S50A0-U103-02-7619, 10/2020
262 OpenScape UC Application V10 Fusion Application Builder, User Guide



Controls
List Group
4) If required, change the value in the Name field, for example to Determine 
String Length.

5) If needed, enter a value in the Description field.

6) Click on the Operations tab.
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7) Click on the icon.

8) Select value Reverse [String] from the Variable Operation Method combo 
box.

9) Click on Next.
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10) In the Source Variable section, click on the button, select the string the 
value length of which you wish to determine and click on OK.

11) In the Result Variable section, click on the button, select the string list 
variable to store the result and click on OK.

12) If you wish to test the string length determination, click on Next.
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13) Click on Test Variable Operation Setup....

14) Enter the test values in the right column of the Operation Settings field.

15) Click on Calculate.

The Operation Result field shows the result.

16) Click on OK.

17) Click on Finish.
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18) Click on OK.

5.4.4.14  How to Search Forward for a Substring

This section describes how to search forward for a substring from a starting point 
to be specified in a string. When the substring searched for is found for the first 
time, the position of the substring's first character is returned. If the substring 
cannot be found, -1 is returned.

Step by Step

1) Click in the palette on the String Operator control and drag it into the callflow 
editor. 

2) Release the mousebutton.

3) Double-click this control.
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4) If required, change the value in the Name field, for example to Search 
Forward.

5) If needed, enter a value in the Description field.

6) Click on the Operations tab.
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7) Click on the icon.

8) Select value Index Of [Integer < - String, Integer] from the Variable 
Operation Method combo box.

9) Click on Next.
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10) In the Source Variable section, click on the button, select the string 
variable the value of which you wish to search for a substring and click on OK.

11) In the Method Parameters section, click in the first row of the Value column. 

The button appears.

INFO:  This button appears only if you use specific Windows 
themes such as any Aero theme or the Windows 7 basic theme.

You can change the Windows theme for example by clicking on 
the desktop background with the right mouse button and selecting 
Personalize. Alternatively, you can open Start > Control Panel > 
Personalization or Start > Control Panel > Appearance and 
Personalization > Personalization.

12) Click on this button.

13) If you wish to use a variable value for the substring to the searched for, click 

on the button, select a variable and click on OK. 

If, in contrast, you wish to use a constant, activate the Constant radio button 
and enter the value.

14) Click on OK.

15) In the Method Parameters section, click in the second row of the Value 

column. The button appears.

INFO:  This button appears only if you use specific Windows 
themes such as any Aero theme or the Windows 7 basic theme.

You can change the Windows theme for example by clicking on 
the desktop background with the right mouse button and selecting 
Personalize. Alternatively, you can open Start > Control Panel > 
Personalization or Start > Control Panel > Appearance and 
Personalization > Personalization.

16) If you wish to use a variable value for the position from where the substring 

search shall start, click on the button, select a variable and click on OK. 

If, in contrast, you wish to use a permanent numerical value, activate the 
Constant radio button and enter the value. The position must be greater than/
equal to 0 and smaller than the string length.

INFO:  If the position is identical with the string length, -1 is 
returned.

17) Click on OK.

18) In the Result Variable section, click on the button, select the integer 
variable to store the result and click on OK.
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19) If you wish to test the forward search, click on Next.

20) Click on Test Variable Operation Setup....

21) Enter the test values in the right column of the Operation Settings field.
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22) Click on Calculate.

The Operation Result field shows the result.

23) Click on OK.

24) Click on Finish.

25) Click on OK.
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5.4.4.15  How to Search Backward for a Substring

This section describes how to search backward for a substring from a starting 
point to be specified in a string. When the substring searched for is found for the 
first time, the position of the substring's first character is returned. If the substring 
cannot be found, -1 is returned.

Step by Step

1) Click in the palette on the String Operator control and drag it into the callflow 
editor. 

2) Release the mousebutton.

3) Double-click this control.

4) If required, change the value in the Name field, for example to Search 
Backward.

5) If needed, enter a value in the Description field.

6) Click on the Operations tab.
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7) Click on the icon.

8) Select value Last Index Of [Integer < - String, Integer] from the Variable 
Operation Method combo box.

9) Click on Next.
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10) In the Source Variable section, click on the button, select the string 
variable the value of which you wish to search for a substring and click on OK.

11) In the Method Parameters section, click in the first row of the Value column. 

The button appears.

INFO:  This button appears only if you use specific Windows 
themes such as any Aero theme or the Windows 7 basic theme.

You can change the Windows theme for example by clicking on 
the desktop background with the right mouse button and selecting 
Personalize. Alternatively, you can open Start > Control Panel > 
Personalization or Start > Control Panel > Appearance and 
Personalization > Personalization.

12) Click on this button.

13) If you wish to use a variable value for the substring to the searched for, click 

on the button, select a variable and click on OK. 

If, in contrast, you wish to use a constant, activate the Constant radio button 
and enter the value.

14) Click on OK.

15) In the Method Parameters section, click in the second row of the Value 

column. The button appears.
A31003-S50A0-U103-02-7619, 10/2020
OpenScape UC Application V10 Fusion Application Builder, User Guide 275



Controls
List Group
INFO:  This button appears only if you use specific Windows 
themes such as any Aero theme or the Windows 7 basic theme.

You can change the Windows theme for example by clicking on 
the desktop background with the right mouse button and selecting 
Personalize. Alternatively, you can open Start > Control Panel > 
Personalization or Start > Control Panel > Appearance and 
Personalization > Personalization.

16) If you wish to use a variable value for the position from where the substring 

search shall start, click on the button, select a variable and click on OK. 

If, in contrast, you wish to use a permanent numerical value, activate the 
Constant radio button and enter the value. The position must be greater than/
equal to 0 and smaller than the string length.

INFO:  If the position is equal to 0, -1 is returned.

17) Click on OK.

18) In the Result Variable section, click on the button, select the integer 
variable to store the result and click on OK.

19) If you wish to test the backward search, click on Next.
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20) Click on Test Variable Operation Setup....

21) Enter the test values in the right column of the Operation Settings field.

22) Click on Calculate.
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The Operation Result field shows the result.

23) Click on OK.

24) Click on Finish.

25) Click on OK.

5.4.5  Date Operator Control

With the Date Operator control you can apply the following operations to a 
variable of type Date:

• Initialize date by a text

• Initialize date by year, month and day

• Initialize date by a temporal value in milliseconds

• Add year, month and day to a date

• Subtract year, month and day from a date

• Convert date to milliseconds

• Convert date to a string

You need a result variable for each operation. Depending on the operation, you 
also require a source variable and/or parameters (for example format specifica-
tions). 

5.4.5.1  How to Initialize a Date by Text

This section describes how to initialize a date variable by text.
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Step by Step

1) Click in the palette on the Date Operator control and drag it into the callflow 
editor. 

2) Release the mousebutton.

3) Double-click this control.

4) If required, change the value in the Name field, for example to Initialize 
Date by Text.

5) If needed, enter a value in the Description field.

6) Click on the Operations tab. 

7) Click on the icon.

8) Select value Initialize (Text) [Date < - String, String] from the Variable 
Operation Method combo box.

9) Click on Next.

10) In the Method Parameters section, click in the first row of the Value column. 

The button appears.

11) Click on this button.

12) If you wish to use a variable value for the text to initialize the date, click on the 

button, select a variable and click on OK. 

If, in contrast, you wish to use a constant value, activate the Constant radio 
button and enter the value.
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INFO:  The description of the Java class SimpleDateFormat 
provides further information about formats, see for example 
docs.oracle.com/javase/6/docs/api/java/text/
SimpleDateFormat.html. 

13) Click on OK.

14) Proceed analog for the Format parameter.

15) In the Result Variable section click on the button, select the data variable 
to be initialized and click on OK.

16) If you wish to test the date initialization, click on Next.

17) Click on Test Variable Operation Setup....

18) Enter the test values in the right column of the Operation Settings field.

19) Click on Calculate.

The Operation Result field shows the result.

20) Click on OK.

21) Click on Finish.

22) Click on OK.

5.4.5.2  How to Initialize a Date by Year, Month and Day

This section describes how to initialize a date variable by specifying year, month 
and day.

Step by Step

1) Click in the palette on the Date Operator control and drag it into the callflow 
editor. 

2) Release the mousebutton.

3) Double-click this control.

4) If required, change the value in the Name field, for example to Initialize 
Date by Year, Month and Day.

5) If needed, enter a value in the Description field.

6) Click on the Operations tab.

7) Click on the icon.
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8) Select value Initialize (Values) [Date < - Integer, Integer, Integer] from the 
Variable Operation Method combo box.

9) Click on Next.

10) In the Method Parameters section, click in the first row of the Value column. 

The button appears.

INFO:  This button appears only if you use specific Windows 
themes such as any Aero theme or the Windows 7 basic theme.

You can change the Windows theme for example by clicking on 
the desktop background with the right mouse button and selecting 
Personalize. Alternatively, you can open Start > Control Panel > 
Personalization or Start > Control Panel > Appearance and 
Personalization > Personalization.

11) Click on this button.

12) If you wish to use a variable value for the year number to initialize the date, 

click on the button, select an integer variable and click on OK. 

If, in contrast, you wish to use a constant value, activate the Constant radio 
button and enter the value.

13) Click on OK.

14) Proceed analog for the parameters Months and Days.

15) In the Result Variable section click on the button, select the data variable 
to be initialized and click on OK.
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16) If you wish to test the date initialization, click on Next.

17) Click on Test Variable Operation Setup....

18) Enter the test values in the right column of the Operation Settings field.

19) Click on Calculate.

The Operation Result field shows the result.

20) Click on OK.

21) Click on Finish.

22) Click on OK.

5.4.5.3  How to Initialize a Date by a Temporal Value in Milliseconds

This section describes how to initialize a date variable by the number of milli-
seconds since 01 January 1970 00:00:00 UTC.

Step by Step

1) Click in the palette on the Date Operator control and drag it into the callflow 
editor. 

2) Release the mousebutton.

3) Double-click this control.

4) If required, change the value in the Name field, for example to Initialize 
Date by Milliseconds.

5) If needed, enter a value in the Description field.

6) Click on the Operations tab. 

7) Click on the icon.
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8) Select value Initialize (Milliseconds) [Date < - String] from the Variable 
Operation Method combo box.

9) Click on Next.

10) In the Method Parameters section, click in the first row of the Value column. 

The button appears.

INFO:  This button appears only if you use specific Windows 
themes such as any Aero theme or the Windows 7 basic theme.

You can change the Windows theme for example by clicking on 
the desktop background with the right mouse button and selecting 
Personalize. Alternatively, you can open Start > Control Panel > 
Personalization or Start > Control Panel > Appearance and 
Personalization > Personalization.

11) Click on this button.

12) If you wish to use a variable value for the number of milliseconds to initialize 

the date, click on the button, select a string variable and click on OK. 

If, in contrast, you wish to use a constant value, activate the Constant radio 
button and enter the value.

13) Click on OK.

14) In the Result Variable section click on the button, select the data variable 
to be initialized and click on OK.

15) If you wish to test the date initialization, click on Next.
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16) Click on Test Variable Operation Setup....

17) Enter the test value in the right column of the Operation Settings field.

18) Click on Calculate.

The Operation Result field shows the result.

19) Click on OK.

20) Click on Finish.

21) Click on OK.

5.4.5.4  How to Add Year, Month and Day to a Date

This section describes how to add a temporal value to a date variable by speci-
fying year, month and day.

Step by Step

1) Click in the palette on the Date Operator control and drag it into the callflow 
editor. 

2) Release the mousebutton.

3) Double-click this control.

4) If required, change the value in the Name field, for example to Add Time to 
Date.

5) If needed, enter a value in the Description field.

6) Click on the Operations tab.

7) Click on the icon.
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8) Select value Add [Date < - Integer, Integer, Integer] in the Variable 
Operation Method combo box.

9) Click on Next.

10) In the Source Variable section, click on the button, select the date variable 
the value of which you wish to use as starting point for the time addition and 
click on OK.

11) In the Method Parameters section, click in the first row of the Value column. 

The button appears.

INFO:  This button appears only if you use specific Windows 
themes such as any Aero theme or the Windows 7 basic theme.

You can change the Windows theme for example by clicking on 
the desktop background with the right mouse button and selecting 
Personalize. Alternatively, you can open Start > Control Panel > 
Personalization or Start > Control Panel > Appearance and 
Personalization > Personalization.

12) Click on this button.

13) If you wish to use a variable value for the number of years to be added to the 

date, click on the button, select an integer variable and click on OK. 

If, in contrast, you wish to use a constant value, activate the Constant radio 
button and enter the value.

14) Click on OK.
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15) Proceed analog for the parameters Months and Days.

16) In the Result Variable section, click on the button, select the date variable 
to which the years, months and days shall be added and click on OK.

17) If you wish to test time addition, click on Next.

18) Click on Test Variable Operation Setup....

19) Enter the test values in the right column of the Operation Settings field.

20) Click on Calculate.

The Operation Result field shows the result.

21) Click on OK. 

22) Click on Finish.

23) Click on OK.

5.4.5.5  How to Subtract Year, Month and Day from a Date

This section describes how to subtract a temporal value from a date variable by 
specifying year, month and day.

Step by Step

1) Click in the palette on the Date Operator control and drag it into the callflow 
editor. 

2) Release the mousebutton.

3) Double-click this control.

4) If required, change the value in the Name field, for example to Subtract 
Time from Date.

5) If needed, enter a value in the Description field.

6) Click on the Operations tab.

7) Click on the icon.
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8) Select value Remove [Date < - Integer, Integer, Integer] from the Variable 
Operation Method combo box.

9) Click on Next.

10) In the Source Variable section, click on the button, select the date variable 
the value of which you wish to use as starting point for the time subtraction 
and click on OK.

11) In the Method Parameters section, click in the first row of the Value column. 

The button appears.

INFO:  This button appears only if you use specific Windows 
themes such as any Aero theme or the Windows 7 basic theme.

You can change the Windows theme for example by clicking on 
the desktop background with the right mouse button and selecting 
Personalize. Alternatively, you can open Start > Control Panel > 
Personalization or Start > Control Panel > Appearance and 
Personalization > Personalization.

12) Click on this button.

13) If you wish to use a variable value for the number of years to be subtracted 

from the date, click on the button, select an integer variable and click on OK. 

If, in contrast, you wish to use a constant value, activate the Constant radio 
button and enter the value.

14) Click on OK.
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15) Proceed analog for the parameters Months and Days.

16) In the Result Variable section, click on the button, select the date variable 
from which the years, months and days shall be subtracted and click on OK.

17) If you wish to test the time subtraction, click on Next.

18) Click on Test Variable Operation Setup....

19) Enter the test values in the right column of the Operation Settings field.

20) Click on Calculate.

The Operation Result field shows the result.

21) Click on OK. 

22) Click on Finish.

23) Click on OK.

5.4.5.6  How to Convert a Date to Milliseconds

This section describes how to convert a date to the number of milliseconds since 
01 January 1970 00:00:00 UTC.

Step by Step

1) Click in the palette on the Date Operator control and drag it into the callflow 
editor. 

2) Release the mousebutton.

3) Double-click this control.

4) If required, change the value in the Name field, for example to Convert 
Time to Milliseconds.

5) If needed, enter a value in the Description field.

6) Click on the Operations tab.

7) Click on the icon.
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8) Select value To Milliseconds [String]from the Variable Operation Method 
combo box.

9) Click on Next.

10) In the Source Variable section, click on the button, select the date variable 
the value of which you wish to use as starting point for the conversion to milli-
seconds and click on OK.

11) In the Result Variable section, click on the button, select the string variable 
to store the milliseconds and click on OK.

12) If you wish to test the conversion to milliseconds, click on Next.

13) Click on Test Variable Operation Setup....

14) Click on Calculate.

The Operation Result field shows the result.

15) Click on OK. 

16) Click on Finish.

17) Click on OK.

5.4.5.7  How to Convert a Date to a String

This section describes how to convert a date to a string, for example 2013-08-
05 12:47:01.344 +0200.
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Step by Step

1) Click in the palette on the Date Operator control and drag it into the callflow 
editor. 

2) Release the mousebutton.

3) Double-click this control.

4) If required, change the value in the Name field, for example to Convert 
Time to String.

5) If needed, enter a value in the Description field.

6) Click on the Operations tab.

7) Click on the icon.

8) Select value To String [String -> String] from the Variable Operation 
Method combo box.

9) Click on Next.

10) In the Source Variable section, click on the button, select the date variable 
the value of which you wish to use as starting point for the conversion to a 
string and click on OK.

11) In the Method Parameters section, click in the first row of the Value column. 

The button appears.

12) Click on this button.
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13) If you wish to use a variable value for the format of the conversion to a string, 

click on the button, select a variable and click on OK. 

If, in contrast, you wish to use a constant value, activate the Constant radio 
button and enter the value.

Example: yyyy-MM-dd HH:mm:ss.SSS Z

INFO:  The description of the Java class SimpleDateFormat 
provides further information about formats, see for example 
docs.oracle.com/javase/6/docs/api/java/text/
SimpleDateFormat.html. 

14) Click on OK.

15) Proceed analog for the Format parameter.

16) In the Result Variable section, click on the button, select the string variable 
to store the converted date and click on OK.

17) If you wish to test the conversion to a string, click on Next.

18) Click on Test Variable Operation Setup....

19) Click on Calculate.

The Operation Result field shows the result.

20) Click on OK. 

21) Click on Finish.

22) Click on OK.
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5.4.6  Time Operator Control

With the Time Operator control you can apply the following operations to a 
variable of type Time:

• Initialize time by text

• Initialize time by hours, minutes and seconds

• Initialize time by a temporal value in milliseconds

• Add time to a time

• Subtract time from a time

• Convert time into milliseconds

• Convert time into a string

You need a result variable for each operation. Depending on the operation, you 
also require a source variable and/or parameters (for example format specifica-
tions). 

You perform such operations analog to the operations described in section Date 
Operator Control.

5.4.7  Parallel Flow Control 

The Parallel Flow control allows you to divide the processing of a callflow into two 
parallel branches at the control's starting point. The execution in the two branches 
occurs independently from each other. You can deploy different controls in the two 
branches. Using the mouse, you drag such controls either from the remaining 
callflow or from palette into the Parallel Flow control. If you drag several controls 
into the Parallel Flow control simultaneously, connections that may exist between 
them are maintained. However, connections to other controls in the remaining 
callflow are automatically removed. The Parallel Flow control has one exit only 
and this is where both branches end. At this exit, both branches are connected 
with an exclusive OR link, i. e. the branch executed fastest is lead out of the 
Parallel Flow control and processing the other branch is abandoned.
 A31003-S50A0-U103-02-7619, 10/2020
292 OpenScape UC Application V10 Fusion Application Builder, User Guide



Controls
List Group
The Parallel Flow control appears maximized by default so that you can see both 
branches with their controls in the workspace of the callflow editor. By default, the 
control is divided in two areas of the same size positioned on top of each other for 
the two branches. In the control's properties you can activate the Vertical (from 
top to bottom) radio button in the Parallel Flow Layout section to position the 
two areas next to each other. 

In the Primary Subflow Ratio field you can configure the size of the upper or left 
area relative to the entire area of the control. Allowed are values from 10 to 90.

If you activate the Flow is displayed minimized check box, the control is repre-
sented smaller and like all other controls, i. e. you cannot see the branches in the 
control anymore.

The properties of the control's connections and context menu in the two branches 
are identical with the properties in a callflow.

The primary branch appears always on top or on the left.

The primary branch adopts always the call status of the connection that leads to 
the entry of the Parallel Flow control. The secondary branch starts always with the 
Inactive and Accepted call states. This prevents the primary and secondary 
branch from having the Active call status and thus prompts from being played in 
both branches at the same time.

The call status behind the exit of a Parallel Flow control is determined by the 
connection of the highest priority that leads to the exit. There is the following 
priority list:

• Active and accepted (highest priority)

• Active and unaccepted

• Inactive and alerted 

• Inactive and accepted

• Unknown (lowest priority)
A31003-S50A0-U103-02-7619, 10/2020
OpenScape UC Application V10 Fusion Application Builder, User Guide 293



Controls
Group General Controls
5.5  Group General Controls

In the group General Controls you find all basic controls that have no telephony 
function.

The extract from the palette view shows which controls are part of this group.

5.5.1  Start Control

A Start control corresponds to starting the application by one of the following 
events: 

• Incoming call

• Custom start events
You can configure custom start events under <application name> > Appli-
cation Settings > Application Configuration > Start Events.

NOTICE:  For an application, there is always only one callflow that 
contains a Start control and that is assigned to the Incoming Call 
start event. If you create a second callflow with the Incoming Call 
start event, a Start control is not automatically assigned to this 
callflow and you cannot add a Start control to it manually either. 
You need to remove the Start control from the first callflow before 
you can add a Start control to the second callflow manually. The 
same applies for callflows with a custom start event.

If you use one of the following start events, a Callflow Entry control is 
automatically used instead of the Start control:
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• Call connection interrupted

• Contact center agent ready

• Contact center error

Each callflow must not contain more than one Start control.

You cannot use the Start control in a callflow of a composition or in a subflow.

NOTICE:  In all example applications, the Start control is available 
in the Samples\Applications sub-folder of the Application 
Builder's installation folder (not in the workspace directory). These 
applications are shipped with the Application Builder. The How to 
Import Workspace Elements section describes how to provide 
these applications.

The configuration dialog of the Start control provides the tabs General and 
Startup.

“General” tab

On the General tab of the control you can perform the following settings. See 
section General Information about Controls.

"Startup" tab

If you use the Incoming Call event, you can configure the start mode of the appli-
cation on the Start control's Startup tab. The following options are available:

• Normal (Immediate Accept)

• Unaccepted (Early Media)
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• Alerted (Free of Charge Deflection)

The following table provides an overview of the start event, the start mode and the 
call status. For the sake of completeness, we also provide information on callflows 
that begin with a Callflow Entry control instead of a Start control.

Application

Start Event Start Mode Callflow

First 
Control

Connection from the first to the second control

Graphic Representa-
tion

Call Status Meaning

Color Line Type

Incoming call Normal 
(Immediate 
Accept)

Start 
control

Green Straight Active Accepted The caller accepted the call 
immediately. Prompts can be 
played to the caller and inputs 
can be accepted from him/her. 
Call charging has been started.

Unaccepted 
(Early 
Media)

Start 
control

Green Dotted Active Unaccepted The callee has not yet explicitly 
accepted the call. Prompts can 
be played to the caller and inputs 
can be accepted from him/her. 
Call charging has not been 
started yet.

Alerted (Free 
of Charge 
Deflection)

Start 
control

Red Dotted Inac-
tive

Alerted The callee has not yet explicitly 
accepted the call. No prompts 
can be played to the caller and 
no inputs can be accepted from 
him/her. Call charging has not 
been started yet.

Custom start 
event

- Start 
control

Red Straight Inac-
tive

Accepted The caller accepted the call 
immediately. No prompts can be 
played to the caller and no inputs 
can be accepted from him/her. 
Call charging has been started.

Call connec-
tion interrupted

- Call-
flow 
Entry

Red Straight Inac-
tive

Accepted No prompts can be played to the 
caller and no inputs can be 
accepted from him/her. Call 
charging has been started.

Contact center 
agent ready

- Call-
flow 
Entry

Green Straight Active Accepted The caller accepted the call 
immediately. Prompts can be 
played to the caller and inputs 
can be accepted from him/her. 
Call charging has been started.

Contact center 
error

- Call-
flow 
Entry

Green Straight Active Accepted The caller accepted the call 
immediately. Prompts can be 
played to the caller and inputs 
can be accepted from him/her. 
Call charging has been started.
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5.5.2  End Control

The End control does not only represent the point of exit in the graphic callflow 
design, but also serves the purpose of disconnecting the call from the system. 

Each application must have at least one End control.

You cannot use the End control in a callflow or subflow of a composition.

NOTICE:  In the example applications, the End control is available 
in the Samples\Applications sub-folder of the Application 
Builder's installation folder (not in the workspace directory). These 
applications are shipped with the Application Builder. The How to 
Import Workspace Elements section describes how to provide 
these applications.

The End control contains the Properties configuration dialog only.

"Properties" tab

On the Properties tab of the control you can perform the following settings. See 
section General Information about Controls.

5.5.3  Assign Control

With the Assign control, you define one or several variables or assign values to 
existing variables. Such variables can be read in other controls of the same 
application, and if they are not write-protected they can be written.
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You can assign a string, a number, a language file etc. to a variable. It does not 
have to be defined right at an application's start, but only when it is needed. 
Variables have specific data types and accept only compatible values.

You can define variables in other areas also. However, you can freely define the 
variable value only in the Assign control.

In addition, you can define variables for the entire workspace or for applications. 
See section Workspace View on this.

You can use the following default-system variables in an application:

NOTICE:  In the example application SpeakingClock, the Assign 
control is available in the Samples\Applications sub-folder of 
the Application Builder's installation folder (not in the workspace 
directory). In the example compositions Logon and Change-
Password, the control is also available in the Samples\Compo-
sitions folder. The application and compositions are shipped 
with the Application Builder. The How to Import Workspace 
Elements section describes how to provide the application and 
compositions.

The configuration dialog of the Assign control provides the tabs General and 
Commands.

Variable name Description Data type

DATE Date at the time of the application start Date

TIME Time at the time of the application start Time

REDIRECTED Phone number of the redirected phone String

CALLED Phone number of the callee String

CALLER Phone number of the caller String

LANGUAGE current language of the application String
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“General” Tab

On the General tab of the control you can perform the following settings. See 
section General Information about Controls.

“Commands” Tab

On the Commands tab you can assign values to several variables. The definition 
occurs with the help of a wizard.

The following icons are available:

Icon Description

This icon lets you create a new assignment command. See 
under this table Defining a new Assignment Command.

A click on this icon enables you to modify the settings of an 
already created and selected assignment command in the 
Edit Assignment Command dialog.

You use this icon to remove a selected assignment com-
mand from the list.

If you have created several assignment commands, they 
are applied in order from top to bottom. Using these icons 
you can move a selected assignment command in the list 
up or down.
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5.5.3.1  How to Define a new Assignment Command

Step by Step

1) Click on to define a new command for assigning a value of a new or of an 
already existing variable.

The Create new Assignment Command dialog opens.

2) Click on ... next to the fields of the target variable. 

The Select Variable dialog opens.

3) Select a user-defined variable from the list or create a new variable via the 
Create new variable... link.

4) Click on OK.

5) Select the desired assignment via the radio buttons and click on OK.
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5.5.4  Compare Control

With the help of the Compare control you can perform comparisons by previously 
defined rules. You can specify a list of rules, so that for example all incoming calls 
are assigned to their country of origin on the basis of the phone number's leading 
digits.

NOTICE:  In the example application SpeakingClock, the 
Compare control is available in the Samples\Applications 
sub-folder of the Application Builder's installation folder (not in the 
workspace directory). In the example compositions Logon and 
ChangePassword, the control is also available in the 
Samples\Compositions folder. The application and composi-
tions are shipped with the Application Builder. The How to Import 
Workspace Elements section describes how to provide the appli-
cation and compositions.

The configuration dialog of the Compare control provides the tabs General and 
Rules.

“General” Tab

On the General tab of the control you can perform the following settings. See 
section General Information about Controls.

“Rules” tab

On the Rules tab you define one or several rules for comparing values in 
variables. This definition is realized with the help of a wizard.
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The following icons are available:

5.5.4.1  How to Create a new Comparison Rule

You perform comparisons using a comparison operation like greater than, smaller 
than, etc. This comparison operation serves as condition for declaring the result 
of a rule as true or false.

Step by Step

1) Click on . The Create new Comparison Rule dialog opens.

2) In the Left Value section select a Variable , a Constant or an already created 
Rule via the radio button which is to deliver the first comparison value. You 
can fall back to variables, constants or rules you have specified for the entire 
workspace or for the application.

3) Select a comparison operation from the drop-down list in the Condition 
section. 

4) Then determine in the Right Value section the value to be compared with the 
variable in the Left Value section.

The value of the Variable to Compare is compared under the Condition with 
the value from the variable in the Right Value section with a fixed text or a 
rule. The comparison is stored as rule and implemented in the application 
upon the execution of the Compare control. Depending on the result of a rule 
comparison (true or false), the call is forwarded to the next control. The control 
has its own exit for each rule that is used as exit when the rule applies.

Example: The callers' phone numbers are stored in the variable in the Left 
Value section. If you want to filter all calls from Germany, use the Leading 
characters are equal to condition and specify "+49" in the Compare with 
Text field. For each caller from Germany the call is forwarded to a specific 
control.

5) If you have made all entries for creating a comparison rule, click on OK.

The created rule appears now in the Comparison Rule List on the Rules tab.

Icon Description

This icon lets you create a new comparison rule. See under 
this table Defining a new Comparison Rule.

A click on this icon enables you to modify the settings of an 
already created and selected comparison rule in the Edit 
Comparison Rule dialog.

You use this icon to remove a selected comparison rule 
from the list.

If you have created several comparison rules, they are 
applied in order from top to bottom. Using these icons you 
can move a selected comparison rule in the list up or down.
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You can rename the newly created rule with a click on the defaulted Name of 

the rule. Doubleclicking the icon next to the predefined rule name opens the 
Edit Comparison Rule dialog. Enter the desired rule name, for example 
Caller from Germany, and then push the Enter key . Your modifications 
are copied.

5.5.5  SystemInfo Control

The SystemInfo control assigns one or several of the following points to variables 
of a suitable type.

• Current Date

• Current Time

• Enabled Languages

• Logged On User

NOTICE:  In the example applications SpeakingClock and Switch-
Language, the SystemInfo control is available in the 
Samples\Applications sub-folder of the Application Builder's 
installation folder (not in the workspace directory). It is also 
available in the Logon example composition in the 
Samples\Compositions folder. The applications and compo-
sition are shipped with the Application Builder. The How to Import 
Workspace Elements section describes how to provide the appli-
cations and composition.

The configuration dialog of the SystemInfo control provides the tabs General and 
Retrievals.
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“General” tab

On the General tab of the control you can perform the following settings. See 
section General Information about Controls.

"Retrievals" tab

On the Retrievals tab you define one or several rules for the system information 
and the variable of the new information retrieval. The assigned value is then the 
value of the system information. This definition is realized with the help of a 
wizard.

The following icons are available on the Retrievals tab.

Icon Description

This icon lets you create a new retrieval. See under this 
table Defining a new Retrieval.

A click on this icon enables you to modify the settings of an 
already created and selected retrieval in the Edit Informa-
tion Retrieval dialog.

You use this icon to remove a selected retrieval from the list.

If you have created several retrievals, they are applied in 
order from top to bottom. Using these icons you can move a 
selected retrieval in the list up or down.
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5.5.5.1  How to Configure a SystemInfo Control

Step by Step

1) Click on the Retrievals tab.

2) Click on .

3) Select the system information of the new information retrieval.

• Current Date

• Current Time

• Enabled Languages

• Logged On User

4) Click on ... next to the fields of the target variable.

5) Select one of the offered variables or create a new one via Create new 
Variable.

6) Select OK.

7) If required, repeat this process for further assignments.

5.5.6  File Control

The File control specifies the file storage that shall be accessed and the file 
operation that shall be processed by the storage command.

The configuration dialog of the File control provides the tabs General and 
Commands.
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“General” tab

On the General tab of the control you can perform the following settings. See 
section General Information about Controls.

"Commands" tab

On the Commands tab you can assign values to several variables. The definition 
occurs with the help of a wizard.

The following icons are available on the Commands tab.

Icon Description

This icon lets you create a new storage command.

A click on this icon enables you to modify the settings of an 
already created and selected storage command.

You use this icon to remove a selected storage command 
from the list.

If you have created several commands, they are applied in 
order from top to bottom. Using these icons you can move a 
selected storage command in the list up or down.
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5.5.6.1  How to Define a new Storage Command

Step by Step

1) Click on to define a new storage command that represents an operation on 
a file storage which is hosted by the server the application is running on.

The Specify Command for Storage Command List dialog opens.

2) Specify the file storage that is being accessed by the command by clicking in 
the radio button of your choice.

• Application File Storage holds files that are only accessible by the appli-
cation itself.

• Global File Storage holds files that are accessible by all applications.

3) From the drop down menu, select the file operation that is being processed 
by the command. The operation determines in which way the file storage is 
altered or examined.

• Store an external file in the storage stores an external file in the server 
file storage. The specified file will be copied into the storage selected 
above.

• Retrieve the location of a file in the storage retrieves the absolute URI 
of a file within the server file storage. The resulting URI will be set to a 
variable.
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• Remove a file from the storage removes a file from the server file 
storage. The specified file will be deleted from the selected storage.

• Move a file within the storage moves a file within the server file storage. 
The specified file will be moved ore renamed in the selected storage. 

• List the files in the storage lists the files in the server file storage using 
an optional filter. The resulting URI list will be set to a variable.

4) Click Next.

5) Specify the optional filter the files in the file storage shall be listed for and the 
variable for the result. The following icons are available:

6) Click Finish.

5.5.7  WebService Control

The WebService control queries a web service. You can store parts of the query 
result in a variable.

The last query result is stored for each web service and can be used as reference 
for the assigning variables. However, the structure of the result is not sure to still 
be valid then.

The WebService control contains the Properties configuration dialog only.

Icon Description

This icon lets you create a new parameter used in the 
parameterized text. The parameter does not require a 
reference value.

This icon enables you to modify the settings of an 
already created parameter.

You use this icon to remove a selected parameter from 
the list.

This icon lets you select the Symvia application variable 
or one of its member variables to be used to store the 
listed files. Only those variables or member variables are 
a valid selection that have the requested variable type 
'Uri List'.
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"Properties" tab

On the Properties tab of the control you can perform the following settings. See 
section General Information about Controls.

You configure the web service query under Queried Webservice. You can either 
select a web service configured in the workspace under <application name> > 
Application Settings > Applications Webservices > All Application Webser-
vices or you create a new web service configuration.

5.5.7.1  How to Configure the Query of a Web Service

Step by Step

1) Select the entry Create new Webservice Configuration from the drop-down 
list under Queried Webservice.

The Add Webservice to Composition dialog opens. 

2) Specify a Name and optionally a Description for the web service.

3) Specify the Webservice Type.

4) Specify the Webservice Access URI.

5) Select OK.

The query result is stored for every web service. 
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5.5.8  DatabaseWrite Control

The DatabaseWrite control writes data records in already available databases. 
For example, an order can be written in a database for a user who calls a mail 
order service. 

The DatabaseWrite control contains the Properties configuration dialog only.

"Properties" Tab

On the Properties tab of the control you can perform the following settings. See 
section General Information about Controls.

Under Connected Database you perform the required settings or select an 
already configured database to be connected.

5.5.8.1  How to Create a Database Configuration

Step by Step

1) If you wish to use an already existing database configuration, select it from 
the Connected Database drop-down list and continue with step 9. 

INFO:  Existing database configurations are also displayed in the 
workspace under Symvia Control Compositions > <compo-
sition name> > Composition Settings > Composition 
Databases > All Symvia Composition Databases and under 
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<application name> > Application Settings > Application 
Databases > All Application Databases.

If you wish to create a new database configuration, click on the Create new 
Database Configuration... entry. The Add Database to Application dialog 
opens. Continue with step 2.

2) Specify a Database Name and, optionally, a Database Description.

3) Select the Database Driver Archive.

The database driver archive is a Java archive that contains the driver classes 
for the database configuration.

Example: 

4) Select a Database Driver Classname.

Select the Java class name that corresponds to the driver from the specified 
archive. 

Example: com.mysql.jdbc.Driver

5) Specify a Database Access URL.

Example: 

6) Specify the Database Login User.

Example: root

NOTICE:  The configuration data of your database must be 
known. Please ask your database administrator. You probably 
need not enter any user data and can consequently skip step 6 
and 7.

7) Specify the Database Login Password for the database user.

8) Select OK.

The application database has now been added to the drop-down list and can 
be selected.

9) Click on Next.

10) Select the Create new Database Query... option from the drop-down list.

The Add a new Query to the Database dialog opens.

11) Enter the query name under Query Name and enter optionally a description 
under Query Description.

12) Enter a valid SQL statement in the SQL Statement field.

Example of reading from the database:

C:\binary\mysql-jdbc-driver\mysql-connector-java-5.1.13-bin.jar

jdbc:mysql://<IP address of the database computer>:3306/<database name>
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Example of writing in the database:

13) Click on Continue to check the query result.

NOTICE:  The query must once run successfully so that the 
Control can be used.

5.5.9  DatabaseRead Control

This control queries data records from existing databases and puts them out. A 
caller is, for example, able to query the current state of his/her order from a 
contact center.

NOTICE:  In the example application AutomaticSurvey, the 
DatabaseRead control is available in the Samples\Applica-
tions sub-folder of the Application Builder's installation folder 
(not in the workspace directory). This application is shipped with 
the Application Builder. The How to Import Workspace Elements 
section describes how to provide this application.

The DatabaseRead control contains the Properties configuration dialog only.

SELECT idquestion, question, max(if(name='A', answer, 0)) as 
A, max(if(name='B', answer, 0)) as B, max(if(name='C', answer, 
0)) as C FROM (question inner join possibleanswer on idques-
tion = fiquestion and fisurvey = 1) group by idquestion;

INSERT INTO `survey`.`result` 
(   `idresult`,   `date`,   `fiquestion`,   `fipossibleAnswer
`)VALUES (   NULL ,   NOW(),   <IDQUESTION>,   '1');
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"Properties" tab

On the Properties tab of the control you can perform the following settings. See 
section General Information about Controls.

Under Connected Database you perform the required settings or select an 
already configured database to be connected.

5.5.9.1  How to Create a Database Configuration

Step by Step

1) If you wish to use an already existing database configuration, select it from 
the Connected Database drop-down list and continue with step 9. 

INFO:  Existing database configurations are also displayed in the 
workspace under Symvia Control Compositions > <compo-
sition name> > Composition Settings > Composition 
Databases > All Symvia Composition Databases and under 
<application name> > Application Settings > Application 
Databases > All Application Databases.

If you wish to create a new database configuration, click on the Create new 
Database Configuration... entry. The Add Database to Application dialog 
opens. Continue with step 2.

2) Specify a Database Name and, optionally, a Database Description.
A31003-S50A0-U103-02-7619, 10/2020
OpenScape UC Application V10 Fusion Application Builder, User Guide 313



Controls
Group General Controls
3) Select the Database Driver Archive.

The database driver archive is a Java archive that contains the driver classes 
for the database configuration.

Example: 

4) Select a Database Driver Classname.

Select the Java class name that corresponds to the driver from the specified 
archive. 

Example: com.mysql.jdbc.Driver

5) Specify a Database Access URL.

Example: 

6) Specify the Database Login User.

Example: root

NOTICE:  The configuration data of your database must be 
known. Please ask your database administrator. You probably 
need not enter any user data and can consequently skip step 6 
and 7.

7) Specify the Database Login Password for the database user.

8) Select OK.

The application database has now been added to the drop-down list and can 
be selected.

9) Click on Next.

10) Select the Create new Database Query... option from the drop-down list.

The Add a new Query to the Database dialog opens.

11) Enter the query name under Query Name and enter optionally a description 
under Query Description.

12) Enter a valid SQL statement in the SQL Statement field.

Example of reading from the database:

Example of writing in the database:

C:\binary\mysql-jdbc-driver\mysql-connector-java-5.1.13-bin.jar

jdbc:mysql://<IP address of the database computer>:3306/<database name>

SELECT idquestion, question, max(if(name='A', answer, 0)) as 
A, max(if(name='B', answer, 0)) as B, max(if(name='C', answer, 
0)) as C FROM (question inner join possibleanswer on idques-
tion = fiquestion and fisurvey = 1) group by idquestion;
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13) Click on Continue to check the query result.

NOTICE:  The query must once run successfully so that the 
Control can be used.

5.5.10  TimeProfile Control

Depending on the time of a call, this control branches to different controls.

For example, the call is forwarded to a Connect control if the office of a company 
is open. If the company is closed, the call is forwarded to a Prompt control and the 
Prompt control plays the following announcement: ”You are calling outside our 
business hours. You can reach us daily from ... until .... Goodbye!”. After playing 
the announcement the End control terminates the call. If the call is made during 
a break, it is forwarded to the DTMF Menu control. The caller can then use the 
menu options to decide how to further proceed with the call.

The configuration dialog of the TimeProfile control provides the tabs General and 
Profiles.

INSERT INTO `survey`.`result` 
(   `idresult`,   `date`,   `fiquestion`,   `fipossibleAnswer
`)VALUES (   NULL ,   NOW(),   <IDQUESTION>,   '1');
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“General” tab

On the General tab of the control you can perform the following settings. See 
section General Information about Controls.

Under Time Zone Setting you specify the time zone in which the control shall be 
executed. The time zone of the current location is selected by default.

"Profiles" tab

On the Profiles tab you define one or several time profiles for a TimeProfile 
control.

INFO:  A TimeProfile control may contain one or several time 
profiles. Each time profile may contain one or several time profile 
ranges. Another term for time profile range is time range.

The following icons are available:

5.5.10.1  How to Create a Time Profile

INFO:  This section describes how to create a time profile exclu-
sively available in a single TimeProfile control. If you need a time 
profile available to all TimeProfile controls, create a server time 
profile under OpenScape Servers > OpenScape Server 
Content > Server Time Profiles. To do this you must logged in at 
an OpenScape UC Application. You find details in section How to 
Create a Server Time Profile.

Icon Description

This icon lets you create a new time profile for this control. 
See section How to Create a Time Profile.

After clicking the small black triangle next to this icon you 
can select Add new Profile... to add an already existing 
server time profile. See section How to Add an Existing 
Server Time Profile.

A click on this icon enables you to modify the settings of an 
already created and selected time profile in the Edit Time 
Profile dialog.

You cannot apply this icon to server time profiles. 

Via this icon a selected time profile is removed from the list.

If you have created several time profiles, they are applied in 
order from top to bottom. Using these icons you can move 
selected time profiles in the list up or down.
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Step by Step

1) Double-click the TimeProfile control.

2) Click on the Profiles tab.

3) Click on .

The Create new Time Profile dialog opens. 

4) Specify under Time Profile Name the name of the new time profile, for 
example During business hours, Outside business hours, 
Public holiday or Company holidays.

The Time Range List itemizes already created time profile ranges for the 
time profile.

5) Click on .

The Create new Time Profile Range dialog opens. 

6) Specify the values of the new time profile range. For this purpose, activate 
one of the radio buttons described in the following:

a) Specify range of full Calendar Days (will not recur): Here you can 
select the start date and end date of a time range. The time profile range 
comprises whole days and does not recur.

Example: 20.11.2013 - 27.11.2013

b) Specify Range within a specific Day of Year (will recur every Year): 
Here you can select a day of a month, a month, a start time and an end 
time. This time profile range recurs every year.

Example: Every 20 November from 00:09:00 to 17:00:00

c) Specify Range within a specific Day of Week (will recur every week): 
Here you can select a weekday, a start time and an end time. This time 
profile range recurs weekly.

Example: Every Wednesday from 00:09:00 to 17:00:00

7) Click on OK.

The Create new Time Profile Range dialog closes.

8) Click on OK.

INFO:  Each time profile in this list corresponds to a new exit of 
the TimeProfile control. 

The created time profile has been added to the time profiles list.

INFO:  Descriptions can only be displayed for server time profiles.

9) Click on OK or Apply.
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5.5.10.2  How to Add an Existing Server Time Profile

This section describes how to add a server time profile to a TimeProfile control. 
Server time profiles are available to all TimeProfile controls. However, if you 
require a time profile exclusively available to one single TimeProfile control, 
please read section How to Create a Time Profile.

Prerequisites

• You must have logged in at an OpenScape UC Application under OpenScape 
Servers > OpenScape Server Login > Login.

• You must have created a server time profile under OpenScape Servers > 
OpenScape Server Content > Server Time Profiles.

Step by Step

1) Double-click the TimeProfile control.

2) Click on the Profiles tab.

3) Click on the small black triangle next to the icon and select Add Server 
Profile....

The Select Server Profiles for Profiles List dialog opens. 

4) Activate the check boxes of one or several server time profiles.

5) Click on OK.

INFO:  Each time profile in this list corresponds to a new exit of 
the TimeProfile control. 

The server time profile has been added to the time profiles list. 

Server time profiles appear grayed out. If you are no longer logged in at an 
OpenScape UC Application, <Unknown Profile> is displayed. This is also 
the case after you have logged in again.

6) Click on OK.

7) Click on OK or Apply.

5.5.11  Delay Control

The Delay control enables placing breaks in a callflow. With e. g. millisecond 
specifications you can determine how much time must pass until the next 
connected control is forwarded to. This will delay playing back greetings or 
generally delay executing each control.

NOTICE:  In the example application SpeakingClock, the Delay 
control is available in the Samples\Applications sub-folder of 
the Application Builder's installation folder (not in the workspace 
directory). This application is shipped with the Application Builder. 
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The How to Import Workspace Elements section describes how to 
provide this application.

The Delay control contains the Properties configuration dialog only.

“General” tab

On the General tab of the control you can perform the following settings. See 
section General Information about Controls.

In the Callflow Delay section you configure the callflow delay. 

5.5.11.1  How to Configure a Delay

Step by Step

1) Activate one of the following radio buttons and specify the corresponding 
value:

• Specify by Value (ms)

Specify the delay in milliseconds. Values from 1 to 360000 are allowed.

• Specify by Variable

Specify the variable name. The value of this integer variable specifies the 
delay in milliseconds.

• Specify by Pattern

Enter a pattern in milliseconds. The pattern value matches if you can 
divide the time by the value without remainder. If you enter for example 
360000, the system will always wait until the next full hour. If the call 
comes in at 2:58 p.m., two minutes are waited in the Delay control. If the 
call comes in at 2:06 p.m., 54 minutes are waited in the Delay control.

2) Click on OK.

5.6  Group IVR Controls

In the group IVR Controls you find controls with which you can execute telephony 
functions such as playing prompts or entering telephone keys via DTMF.

The extract from the palette view shows which controls are part of this group.
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5.6.1  Prompt Control

A Prompt control defines a list of announcements, which are either prompts, 
variables or pauses. The list is processed when the control is reached in the call 
flow.

NOTICE:  In all example applications, the Prompt control is 
available in the Samples\Applications sub-folder of the 
Application Builder's installation folder (not in the workspace 
directory). The same applies for the example compositions in the 
Samples\Compositions directory. These applications and 
compositions are shipped with the Application Builder. The How 
to Import Workspace Elements section describes how to provide 
these applications and compositions.
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The configuration dialog of the Prompt control provides the tabs General and 
Announcements.

“General” tab

On the General tab of the control you can perform the following settings. See 
section General Information about Controls.

“Announcements” tab

On this tab you specify the announcement(s) for the Prompt control. All 
announcements or variables assigned to the control are listed in the Announce-
ments column. Transformation transforms variable values into complete 
announcements the user can understand. You need to enter the transformations 
for every available language to be used.

The following icons are available:
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5.6.2  BackingPrompt Control

The BackingPrompt control is in charge of playing announcements until the next 
prompt is played.

NOTICE:  In the example application SpeakingClock, the 
BackingPrompt control is available in the Samples\Applica-
tions sub-folder of the Application Builder's installation folder 
(not in the workspace directory). This application is shipped with 
the Application Builder. The How to Import Workspace Elements 
section describes how to provide this application.

The BackingPrompt control contains the General configuration dialog only.

Icon Description

This icon enables playing a selected announcement. See 
section General Information about Controls/Playback 
Options.

A click on the triangle of the icon depicted on the left opens 
a list to select the options Add Prompt ..., Add Variable... 
or Add Pause.... Depending on the option you select, the 
corresponding icon is displayed. These icons enable creat-
ing or adding a new prompt or variable to the list. See sec-
tion General Information about Controls/Adding a Prompt, 
Variable or Pause.

By clicking this button you may change the selected 
announcement, prompt or variable in the list.

This icon lets you remove a selected announcement, vari-
able or pause from the list.

If you have inserted several announcements, variables or 
pauses, they are played in order from top to bottom. Using 
these icons you can move a selected announcement, vari-
able or pause in the list up or down.
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“General” Tab

On the General tab of the control you can perform the following settings. See 
section General Information about Controls.

Under Backing Prompts you can optionally specify a prompt to be played for 
bridging temporary silence. 

All announcements or variables assigned to the control are listed in the 
Announcements column. Transformation transforms variable values into 
complete announcements the user can understand. You need to enter the trans-
formations for every available language to be used.

The following icons are available:
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5.6.3  DtmfInput Control

The caller can use this control for entering digit strings like his/her customer 
number via his/her telephone keypad. Furthermore, a safety question can be 
posed, so that not every calling customer can access all data. Instead, he/she can 
request individual data, such as the status of a purchase order, after he/she has 
been authenticated by entering the customer number.

NOTICE:  If you wish to make entries by voice rather than by 
phone keypad, either use the NLU control or the SpeechInput 
control.

NOTICE:  In the example compositions Logon and Change-
Password, the DtmfInput control is available in the 
Samples\Compositions sub-folder of the Application Builder's 
installation folder (not in the workspace directory). These compo-
sitions are shipped with the Application Builder. The How to 
Import Workspace Elements section describes how to provide 
these compositions.

The configuration dialog of the DTMF Input control provides the tabs General, 
Input and Announcements.

Icon Description

This icon enables playing a selected announcement. See 
section General Information about Controls/Playback 
Options.

A click on the triangle of the icon depicted on the left opens 
a list to select the options Add Prompt ..., Add Variable... 
or Add Pause.... Depending on the option you select, the 
corresponding icon is displayed. These icons enable creat-
ing or adding a new prompt or variable to the list. See sec-
tion General Information about Controls/Adding a Prompt, 
Variable or Pause.

By clicking this button you may change the selected 
announcement, variable or pause in the list.

This icon lets you remove a selected announcement, vari-
able or pause from the list.

If you have inserted several announcements, variables or 
pauses, they are played in order from top to bottom. Using 
these icons you can move a selected announcement, vari-
able or pause in the list up or down.
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“General” Tab

On the General tab of the control you can perform the following settings. See 
section General Information about Controls.

In the Menu Parameters section you can define the behavior of the control in 
case of time-out (no input after a certain amount of time). The following settings 
are available:
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“Input” tab

In the Key Layout for Confirm/Cancel section you define the key allocation for 
the actions confirm and cancel. You can choose from two options by activating the 
respective checkbox.

In the Input Parameters section you specify the data entry options. These are:

NOTICE:  Please note that the Maximum Input Length must be 
greater than/equal to the Minimum Input Length.

In the Input Storage section you need specify a variable to store the confirmed 
input. You can either use a variable already available or create a new one. The 
Variable for confirmed Input stores the sequence of pressed keys. The 
Variable for Input Length specifies the number of keys pressed for the entry, this 
variable is optional.

Field Description

Menu Timeout (seconds) Enter here the time (in seconds) available to the caller to 
make his/her input by keypad after the announcement(s) 
have been played. If you enter a ’0', the caller can wait an 
undefined period of time until he/she makes an entry via a 
key. The default value is 10 seconds.

Menu Repetitions (No 
Input) and (Invalid Input)

If the caller has made an invalid entry by keypad or no entry 
at all, the announcement is repeated. You specify how often 
an entry can be repeated before the control reports the error 
event, whereby the next control is moved to. The value 
refers to the number of missing/invalid entries. In case of 
value 3, the entry and thus also the announcement will be 
repeated three times, so with the first execution the 
announcement is played altogether four times. If you enter a 
’0’, the announcement is not repeated but the caller is 
directly forwarded to the control configured for the error 
event after a missing/invalid entry. Three repetitions are 
allowed by default.

Field Description

Minimum Input Length In this field you enter the minimum length of the digit string 
the caller has to enter. If the number of entered digits falls 
short of this and the time specified in the Menu Timeout 
(seconds) has elapsed, the process is aborted. The caller 
may then repeat his/her entry if allowed by the settings in 
the Menu Repetitions field. By default, value 0 deactivates 
this feature and an empty entry is also allowed.

Maximum Input Length In this field you enter the maximum length of the digit string 
the caller may enter. If the caller exceeds this entry restric-
tion, a default announcement will be played. His/her entry is 
finished. If you enter a 0 in the Maximum Input Length 
field, the entry will become the value that is saved if you 
loose the field focus, e.g. if you click Apply. By default, 10 
keystrokes are defined as entry.
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“Announcements” Tab

On this tab you specify the announcement(s) for the DtmfInput control. All 
announcements or variables assigned to the control are listed in the Announce-
ments column. Transformation transforms variable values into complete 
announcements the user can understand. You need to enter the transformations 
for every available language to be used. 

In the Confirmation Prompts section you can specify announcements for the 
cases Prompt for cleared Input and Prompt for invalid Input that play a signal 
to the user. You select the prompt files from the drop-down list or create a new 
one.

The following icons are available:

5.6.4  DtmfMenu Control

With this control you enable the caller to navigate through a menu with the help 
of his/her phone keypad.

The caller may hear the following example announcement: ”If you wish to be 
connected to our customer service, please push 1. If you wish to be connected to 
our sales department, please push 2.”

After the announcement, the caller has a certain period of time for his/her entry. If 
in the example the caller pushes 1 within this period, he/she is forwarded to the 
next control that connects him/her to the customer service. If he/she enters 2, he/
she is forwarded to a control that connects him/her to the sales department. But 
if he/she does not make an entry within the specified period or the entry is 
incorrect, he/she can be forwarded to another control (for example an End 
control).

Icon Description

This icon enables playing a selected announcement. See 
section General Information about Controls/Playback 
Options.

A click on the triangle of the icon depicted on the left opens 
a list to select the options Add Prompt ..., Add Variable... 
or Add Pause.... Depending on the option you select, the 
corresponding icon is displayed. These icons enable creat-
ing or adding a new prompt or variable to the list. See sec-
tion General Information about Controls/Adding a Prompt, 
Variable or Pause.

By clicking this button you may change the selected 
announcement, prompt or variable in the list.

This icon lets you remove a selected announcement or vari-
able from the list.

If you have inserted several announcements or variables, 
they are played in order from top to bottom. Using these 
icons you can move a selected announcement or variable in 
the list up or down.
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The configuration dialog of the DTMF Menu control provides the tabs General 
and Announcements.

“General” Tab

On the General tab of the control you can perform the following settings. See 
section General Information about Controls.

In the Menu Parameters section you can determine the behavior of the control in 
case of time-out (no input after a certain amount of time). The following settings 
are available:
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“Announcements” Tab

On this tab you specify the announcement(s) for the DtmfMenu control. All 
announcements or variables assigned to the control are listed in the Announce-
ments column. Transformation transforms variable values into complete 
announcements the user can understand. You need to enter the transformations 
for every available language to be used. 

In the Confirmation Prompts section you can specify an announcement for the 
case Prompt for invalid Input that plays a signal for the user. You select the 
prompt file from the drop-down list or create a new one.

The following icons are available:

Field Description

Menu Timeout (seconds) Enter here the time in seconds available to the caller to 
make his/her input by keypad or voice after the announce-
ment(s) have been played. If you enter a ’0', the caller can 
wait an undefined period of time until he/she makes an 
entry via a key. The default value is 10 seconds.

Menu Repetitions (No 
Inupt) and (Invalid Input)

If the caller has made no/an incorrect entry by keypad, the 
announcement will be repeated. You specify how often an 
entry can be repeated before the control reports the event 
error, whereby the next control is moved to. The value 
refers to the number of missing/invalid entries. In case of 
value 3, the entry and thus the announcement will be 
repeated three times, so with the first execution the 
announcement is played altogether four times. If you enter 
a ’0’, the announcement is not repeated but the caller is 
directly forwarded to the control configured for the error 
event after a missing/invalid entry. Three repetitions are 
allowed by default.

Icon Description

This icon enables playing a selected announcement. See 
section General Information about Controls/Playback 
Options.

A click on the triangle of the icon depicted on the left opens 
a list to select the options Add Prompt ..., Add Variable... 
or Add Pause.... Depending on the option you select, the 
corresponding icon is displayed. These icons enable creat-
ing or adding a new prompt or variable to the list. See sec-
tion General Information about Controls/Adding a Prompt, 
Variable or Pause.
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5.6.5  DtmfSelection Control

The DtmfSelection control links the variable list elements to the telephone keys. 
You can select a variable from the list. Therefore the single variables and the key 
to be pressed are announced.

NOTICE:  In the example applications SetPresenceState and 
SwitchLanguage, the DtmfSelection control is available in the 
Samples\Compositions sub-folder of the Application Builder's 
installation folder (not in the workspace directory). These applica-
tions are shipped with the Application Builder. The How to Import 
Workspace Elements section describes how to provide these 
applications.

The configuration dialog of the DtmfSelection control provides the tabs General, 
Introduction, Iterationand Selection.

By clicking this button you may change the selected 
announcement, prompt or variable in the list.

This icon lets you remove a selected announcement, vari-
able or pause from the list.

If you have inserted several announcements or variables, 
they are played in order from top to bottom. Using these 
icons you can move a selected announcement or variable in 
the list up or down.

Icon Description
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“General” tab

On the General tab of the control you can perform the following settings. See 
section General Information about Controls.

In the Selection List Parameters section you can determine the behavior of the 
control in case of a time-out (no input is made after a specific period). The 
following settings are available:
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"Introduction" tab

On this tab you define the introductory announcements played before the 
selection list announcements. All announcements or variables assigned to the 
control are listed in the Announcements column. Transformation transforms 
variable values into complete announcements the user can understand. You need 
to enter the transformations for every available language to be used.

In the Confirmation Prompt section you can specify a Prompt for invalid Input 
that acoustically signal errors to the user. You select the prompt file from the drop-
down list or create a new one.

The following icons are available:

Field Description

Menu Timeout (seconds) Specify here the time (in seconds) available to the caller to 
make his/her input by keys after the announcement (s) has 
been played. If you enter a ’0', the caller can wait an unde-
fined period of time until he/she makes an entry via a key. 
The default value is 10 seconds.

Menu Repetitions (No 
Input) and (Invalid Input)

If the caller has made no/an incorrect entry, the announce-
ment will be repeated. You specify how often an entry can 
be repeated before the control reports the error event, 
whereby the next control is moved to. The value refers to 
the number of missing/invalid entries. In case of value 3, the 
entry and thus the announcement will be repeated three 
times, so with the first execution the announcement is 
played altogether four times. If you enter a ’0’, the 
announcement is not repeated but the caller is directly for-
warded to the control configured for the error event after a 
missing/invalid entry. Three repetitions are allowed by 
default.

Icon Description

This icon enables playing a selected announcement. See 
section General Information about Controls/Playback 
Options.

A click on the triangle of the icon depicted on the left opens 
a list to select the options Add Prompt ..., Add Variable... 
or Add Pause.... Depending on the option you select, the 
corresponding icon is displayed. These icons enable creat-
ing or adding a new prompt or variable to the list. See sec-
tion General Information about Controls/Adding a Prompt, 
Variable or Pause.
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"Iteration" tab

On this tab you specify what you wish to iterate over and the iterator, selection key 
and event store variable name.

Leave the Iterate over Variable List radio button activated if you wish to iterate 
via the variable list. Activate the Iterate over Enumeration Type Values radio 
button if you wish to iterate via the values of an enumeration variable type. 

"Selection" tab

On this tab you specify the selection list announcements to be played during the 
iteration for every variable in the list. The following settings are available:

By clicking this button you may change the selected 
announcement, prompt or variable in the list.

This icon lets you remove a selected announcement, vari-
able or pause from the list.

If you have inserted several announcements or variables, 
they are played in order from top to bottom. Using these 
icons you can move a selected announcement or variable in 
the list up or down.

Field Description

Variable List to iterate 
respectively Enumeration 
Type to iterate

If you wish to iterate via a variable list, select a variable list 
via the ... field and click on OK.

If you wish to iterate via an enumeration variable type, click 
in the field and select an enumeration variable type.

Iterator Variable Name The Iterator Variable Name enters the name that is used 
for the current variable list element during the iteration. The 
iterator variable is the loop variable during traversing all list 
entries. This variable is available in this control only, thus 
neither in other DtmfSelection controls nor anywhere else in 
the application or workspace.

Selection Key Variable 
Name

Specify the variable name. The value of the variable is the 
respective DTMF key assigned to the selection of the cur-
rent list element or to the value of the enumeration variable 
type. This variable is available in this control only, thus nei-
ther in other DtmfSelection controls nor anywhere else in 
the application or workspace.

Variable for selected Ele-
ment

Specify in the Result Storage section a variable for a 
selected element. Use the ... button to select the appropri-
ate variable and click on OK. You can select only one vari-
able of the same type as the above selected enumeration 
type or as the list elements of the above selected list. This 
variable is used for storing the list element or value of the 
enumeration variable type. 

Icon Description
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In the Navigation Prompts section you can set prompts for the single user inter-
actions. The following settings are available:

NOTICE:  Next or previous page means that the selection list 
announcement may contain an indefinite number of prompts. 
Because the caller interacts via the telephone keys, the prompts 
must be combined in groups (pages) of 9 prompts. The "0" key is 
reserved.

5.6.6  Language Control

With this control you can change the language of the announcements to be 
played at the application's runtime. At the same time, this language is the appli-
cation language. You can switch to all languages licensed and installed on the UC 
server.

Before the initial execution of a Language control the application uses the default 
language.

Icon Description

This icon enables playing a selected announcement. See 
section General Information about Controls/Playback 
Options.

A click on the triangle of the icon depicted on the left opens 
a list to select the options Add Prompt ..., Add Variable... 
or Add Pause.... Depending on the option you select, the 
corresponding icon is displayed. These icons enable creat-
ing or adding a new prompt or variable to the list. See sec-
tion General Information about Controls/Adding a Prompt, 
Variable or Pause.

By clicking this button you may change the selected 
announcement, prompt or variable in the list.

This icon lets you remove a selected announcement, vari-
able or pause from the list.

If you have inserted several announcements or variables, 
they are played in order from top to bottom. Using these 
icons you can move a selected announcement or variable in 
the list up or down.

Field Description

Prompt for next Page Name of the prompt played as instruction for skipping to the 
next page. The optional prompt is bound to the pound key. 

Prompt for previous Page Name of the prompt played as instruction for skipping to the 
previous page. The optional prompt is bound to the star key.

Prompt to cancel Selec-
tion

Name of the prompt played as instruction for cancelling a 
selection. The optional prompt is bound to the "0" key.
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IMPORTANT:  Default languages are DE-DE and EN-US. For 
languages deviating from the defaults you must install the 
matching ASR/TTS language packages on the UC server.

NOTICE:  In special cases you can also use the Grammar control 
to change the language.

NOTICE:  In the example application SwitchLanguage, the 
Language control is available in the Samples\Applications 
sub-folder of the Application Builder's installation folder (not in the 
workspace directory). This application is shipped with the Appli-
cation Builder. The How to Import Workspace Elements section 
describes how to provide this application.

The Language control contains the General configuration dialog only.

“General” Tab

On the General tab of the control you can perform the following settings. See 
section General Information about Controls.

In the New Language Activation section you specify the language either directly 
or via a variable. 

• Under Specify by Language you can choose from all languages that are 
already activated. 
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• Under Specify by Variable you can select the variable the value of which 
specifies the language to be used after the execution of this control. 

IMPORTANT:  The value of this variable must be a valid language 
code.

The assignment of such a value to a variable must have been performed in 
another control, for example, a Definition control or a DatabaseRead control, 
before the execution of the Language control. If this variable does not include 
valid code, the event error is reported.

NOTICE:  No variables can be created at this point. The variables 
to be selected are specified either for the workspace or for the 
application.

NOTICE:  Please keep in mind that the variable value must be 
written in capital letters.

In the Former Language Storage section the former language code is stored in 
a variable if you select a variable.

5.6.7  Transfer Control

The Transfer control dials a phone number after one or several announcements 
have been played (“You will now be connected to the hotline. Please hold the 
line.”). When a connection has been successfully established to a new target by 
dialing a phone number, the caller will be connected to this target. The Transfer 
control plus the entire application are shut down. If the connection attempt fails, 
the call is forwarded to the control configured for the event of a failed connection 
(error).

INFO:  Do not confuse the Transfer control with the ConnectCall 
control, which turns an unaccepted call into an accepted call.

The ConnectCall control must have an unaccepted call at its 
entry; the Transfer control, in contrast, an accepted call.

The Transfer control differs from the CreateCall control in the following:

• You can select whether a connection shall be set up blind, supervised, ringing 
or bridged.

• Announcements before the connection setup

• You can cancel the connection setup by pushing a specific key

• You cannot store the internal ID of the created call in a variable.

The configuration dialog of the Connect control provides the tabs General, Origi-
nator, Announcements and Events.
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“General” tab

On the General tab of the control you can perform the following settings. See 
section General Information about Controls.

In the Connection Target section you specify the phone number to be called. 
There are two options:

• Specify by Text: Specify the phone number to be used.

• Specify by Variable: Specify the variable that contains the phone number.

In the Connection Settings section you specify the type of connection attempt 
and determine how much control the platform maintains during the connection 
setup. 

1. Specify the Transfer Type. Select one of the following options:

• Blind Transfer: The current session ends even if the outgoing call is not 
put through by the connection setup. 

• Consultation (Supervised) Transfer: The current session stays active at 
the end of the outgoing call.
If you select the supervised connection setup, the fields Transfer 
Timeout (Seconds) and Transfer Attempt Cancel Key become active.

• Ringing Transfer: The current session monitors the progress of the 
outbound call until the target device is ringing and is not busy, then the 
current session ends.
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• Bridged transfer: The current session retains control over the outbound 
call and continues after the target device has finished the call (additionally 
listens for external events).

2. Specify under Transfer Timeout (Seconds) the number of seconds a 
connection setup will be waited for. 

3. Specify under Transfer Attempt Cancel Key an input key for abandoning the 
connection setup. 

4. Click on OK, Apply or switch to another tab for performing further settings. 

"Originator" tab

On the Originator tab you define the originator to be used as calling subscriber 
during the connection setup. You can specify any or a custom originator as calling 
subscriber for the connection. This, however, affects billing the outgoing call. 

1. Activate the Use custom Connection Originator check box. 

2. Select one of the two options:

• Specify by Text: Specify the phone number to be used for the connection 
originator.

• Specify by Variable: Specify the variable that contains the phone number 
for the connection originator. 

3. Click on OK, Apply or switch to another tab for performing further settings. 

“Announcements” tab

On the Announcements tab you define the announcements to be played shortly 
before the connection attempt and the playback order. Transformation trans-
forms variable values into complete announcements the user can understand. 
You need to enter the transformations for every available language to be used.

In the Transfer Prompt section you can optionally specify a prompt to be played 
while a connection is being set up. You select the prompt files from the drop-down 
list or create a new one. This option is only available if you have selected General 
for the setting connection setup type Consultation (Supervised) Transfer.

The following icons are available:

Icon Description

This icon enables playing a selected announcement. See 
section General Information about Controls/Playback 
Options.

A click on the triangle of the icon depicted to the left opens a 
list to select the options Add Prompt ..., Add Variable... or 
Add Pause.... Depending on the option you select, the cor-
responding icon is displayed. These icons enable creating 
or adding a new prompt or variable to the list. See section 
General Information about Controls/Adding a Prompt, Vari-
able or Pause.
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"Events" tab

On the Events tab you can specify the events that can occur during a bridged call. 
Each event list entry represents a subflow, that is processed when the event is 
received. 

The following icons are available:

5.6.8  Disconnect Control

The Disconnect control terminates the current call after one or several greetings 
were probably played.

The configuration dialog of the Disconnect control contains the General tab only.

This icon allows you to change the selected announcement, 
prompt or variable in the list.

This icon allows you remove a selected announcement, 
variable or pause from the list.

If you have inserted several announcements or variables, 
they are played in order from top to bottom. Using these 
icons you can move a selected announcement or variable in 
the list up or down.

Icon Description

This icon allows you to see the corresponding subflow of 
the selected event.

This icon allows you to add an event to the bridged transfer 
event list by opening a new window that allows you to spec-
ify the identifier, the name and the description of the exter-
nal bridged transfer event. 

This icon allows you to edit a selected event.

This icon allows you remove a selected event from the list.

If you have several events, use these icons to move a 
selected event in the list up or down.

Icon Description
A31003-S50A0-U103-02-7619, 10/2020
OpenScape UC Application V10 Fusion Application Builder, User Guide 339



Controls
Group IVR Controls
“General” Tab

On the General tab of the control you can perform the following settings. See 
section General Information about Controls.

In the Disconnect Prompts section you optionally specify one or several prompts 
to be played before the current phone call is terminated. 

All announcements or variables assigned to the control are listed in the 
Announcements column. Transformation transforms variable values into 
complete announcements the user can understand. You need to enter the trans-
formations for every available language to be used.

The following icons are available:

Icon Description

This icon enables playing a selected announcement. See 
section General Information about Controls/Playback 
Options.

A click on the triangle of the icon depicted on the left opens 
a list to select the options Add Prompt ..., Add Variable... 
or Add Pause.... Depending on the option you select, the 
corresponding icon is displayed. These icons enable creat-
ing or adding a new prompt or variable to the list. See sec-
tion General Information about Controls/Adding a Prompt, 
Variable or Pause.
 A31003-S50A0-U103-02-7619, 10/2020
340 OpenScape UC Application V10 Fusion Application Builder, User Guide



Controls
Group IVR Controls
5.6.9  CreateCall Control

The CreateCall control dials a phone number. When a connection has been 
successfully established to a new target by dialing a phone number, the caller will 
be connected to this target. 

The CreateCall control requires an inactive call status at its entry.

The configuration dialog of the CreateCall control provides the tabs General and 
Originator.

By clicking this button you may change the selected 
announcement, variable or pause in the list.

This icon lets you remove a selected announcement, vari-
able or pause from the list.

If you have inserted several announcements, variables or 
pauses, they are played in order from top to bottom. Using 
these icons you can move a selected announcement, vari-
able or pause in the list up or down.

Icon Description
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“General” Tab

On the General tab of the control you can perform the following settings. See 
section General Information about Controls.

In the Connection Target section you specify the phone number to be called. 
There are two options:

• Specify by Text: Specify the phone number to be used.

• Specify by Variable: Specify the variable that contains the phone number.

In the Connection Settings section you specify the time a connection setup may 
take in the Connection Timeout (Seconds) field. 

The Result Storage area contains the Variable for Call ID field to specify the 
variable of type string that will store the internal ID of the created call. This ID may 
serve for example in the AcdInit control to identify the call.

"Originator" tab

On the Originator tab you define the originator to be used as calling subscriber 
during the connection setup. You can specify any or a custom originator as calling 
subscriber for the connection. The calling subscriber pays for the outgoing call. 

1. Activate the Use custom Connection Originator check box. 

2. Select one of the two options:

• Specify by Text: Specify the phone number to be used for the connection 
originator.

• Specify by Variable: Specify the variable that contains the phone number 
for the connection originator. 

3. Click on OK. 

5.6.10  ConnectCall Control

If you have configured the startup mode Unaccepted (Early Media) or Alerted 
Free of Charge Deflection) for an application, an unaccepted call is present, i. 
e. the caller does not pay any charges. The connections in the callflow appear as 
dotted line. Applying the ConnectCall control turns the call into an accepted call 
and from this moment the caller pays charges. If the call has been successfully 
connected by the ConnectCall control, the connection line to the next control is 
straight; otherwise a dotted line connects the next control.

INFO:  Do not confuse the ConnectCall control with the Transfer 
control, which forwards the caller to a phone number to be dialed. 

The ConnectCall control must have an unaccepted call at its 
entry; the Transfer control, in contrast, an accepted call.

The configuration dialog of the ConnectCall control contains the General tab only.
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“General” tab

On the General tab of the control you can perform the following settings. See 
section General Information about Controls.

5.6.11  DeflectCall Control

The DeflectCall control forwards a call to a phone number to be dialed. 

Independent from the connection type at the entry of the DeflectCall control there 
is always an inactive (red) and accepted (straight) connection at the control's exit. 

The configuration dialog of the DeflectCall control contains the General tab only.
A31003-S50A0-U103-02-7619, 10/2020
OpenScape UC Application V10 Fusion Application Builder, User Guide 343



Controls
Group IVR Controls
“General” tab

On the General tab of the control you can perform the following settings. See 
section General Information about Controls.

In the Connection Target section, activate one of the following radio buttons and, 
if required, specify appropriate values:

• Specify by Text
Enter the phone number to be dialed.

• Specify by Variable
Select the string that contains the phone number to be dialed as value.

• Do not deflect to target (will Signal busy Subscriber to Caller)

5.6.12  Record Control

Using this control a caller can make a recording that is e.g. subsequently trans-
mitted to an addressee with a Send control.

The configuration dialog of the Record control provides the tabs General, 
Recording and Announcements.
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“General” Tab

On the General tab of the control you can perform the following settings. See 
section General Information about Controls.

In the Menu Parameters section you can determine the behavior of the control in 
case of time-out (no input after a certain amount of time). The following settings 
are available:

Field Description

Menu Timeout (Seconds) Here you specify the time in seconds that a caller has for 
speaking. If the caller does not say anything within the set 
time, the specified prompt is repeated. The default value is 
2 seconds.

Menu Repetitions If the caller makes an incorrect voice entry or none at all, 
the announcement is repeated. You define how often an 
input can be repeated before the control reports the event 
error, whereby the next control is moved to. The value 
refers to the number of missing/invalid entries. In case of 
value 3, the entry and thus the announcement will be 
repeated three times, so with the first execution the 
announcement is played altogether four times. If you enter 
a ’0’, the announcement is not repeated but the caller is 
directly forwarded to the control configured for the error 
event after a missing/invalid entry. The feature is then deac-
tivated. Three repetitions are allowed by default.
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“Recording” Tab

On the Recording tab you can configure the options in the sections Recording 
Parameters, Recording Storage and Recording Behavior. 

In the Recording Parameters section you configure:

• Maximum Recording Length: Time (seconds) the caller has for making his/
her voice entry. If the caller does not make and entry, recording is abandoned. 
Alternatively, the caller can push a DTMF key to finish the recording.

• Final Recording Silence is the length of the silence that is used when the 
signal to end the recording is played. 

• Check box Finish Recording via arbitrary DTMF Key: The user can finish the 
recordings via a DTMF input. 

In the Recording Storage section you configure the variable in which the 
recording is to be stored. Click on ... for selecting the corresponding variable. 

In the Recording Behavior section you configure a variable for the event that the 
Recording Storage variable already contains a recording. You can attach the new 
recording to the old one or overwrite the old one. Click on ... for selecting the 
corresponding variable. 

“Announcements” Tab

On the Announcements tab you define the announcements to be played and the 
playback order. Transformation transforms variable values into complete 
announcements the user can understand. You need to enter the transformations 
for every available language to be used.

The following icons are available:

In the Recording Prompts section you can specify announcements for the 
events Prompt played as beep and Prompt for terminated Recording that give 

Icon Description

This icon enables playing a selected announcement. See 
section General Information about Controls/Playback 
Options.

A click on the triangle of the icon depicted on the left opens 
a list to select the options Add Prompt ..., Add Variable... 
or Add Pause.... Depending on the option you select, the 
corresponding icon is displayed. These icons enable creat-
ing or adding a new prompt or variable to the list. See sec-
tion General Information about Controls/Adding a Prompt, 
Variable or Pause.

By clicking this button you may change the selected 
announcement, prompt or variable in the list.

This icon lets you remove a selected announcement, vari-
able or pause from the list.

If you have inserted several announcements or variables, 
they are played in order from top to bottom. Using these 
icons you can move a selected announcement or variable in 
the list up or down.
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the user acoustic feedback. You select the prompt files from the drop-down list or 
create a new one.

5.6.13  Transition Control

The Transition control enables changing to another application.

It contains the Properties configuration dialog only.

“General” tab

On the General tab of the control you can perform the following settings. See 
section General Information about Controls.

Under Target Application you define the desired application and its point of entry 
to be used as transition target. There are two options for specifying the infor-
mation:

• Select from Server:
Name of the application and its point of entry to be used as target.

• Specify by Variable:
Name of the variable that contains the name of the application to be used as 
transition target. Click on ... for selecting the corresponding variable. 

Under Extra Application Information you can add relevant information to the 
control. 
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5.6.14  Grammar Control

A Grammar control temporarily replaces a genuine grammar with another 
grammar during runtime of the application. This other grammar is composed of 
information from database records, variables or constant values. You can store 
this grammar in a file on the speech recognition system and precompile it to 
increase the performance. A grammar may deliver several results if the speech 
recognition is ambiguous. By default, the Grammar control uses the language 
currently set in the application. You can configure the Grammar control to make it 
use another language.

In the Mandatory area you can use the Enable Runtime Tracing check box to 
perform the settings described in section General Information about Controls. 

You find further details in section How to Configure the Grammar Control.

5.6.14.1  How to Configure the Grammar Control

Prerequisites

• A variable of type Dataset List must be available for providing information to 
create a grammar.

• A grammar to be temporarily replaced with the grammar created by the 
Grammar control must be available.
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Step by Step

1) Click on the ... button next to the Variable for Source Data field.

2) Select the variable of type Dataset List to be used a data source for creating 
a grammar. 

Each variable of type Dataset has sub-variables. Such sub-variables 
represent columns of a database query. You can use each sub-variable for 
defining the grammar in the ensuing steps.

3) Click the OK button.

4) Click on Next.

The Grammar Entry List field shows the list of assignments Utterance --> 
Semantic Result, which will be part of the grammar to be created.

5) Click on the icon to create a new assignment.

The Create new Entry for Grammar Entry List dialog opens.

Assemble here an utterance of the caller to be recognized by the automatic 
speech recognition from one or several segments.

6) In step 2 you configured a variable of type Dataset List as data source. This 
variable consists of a list of variables of type Dataset. If you wish to use the 
value of a sub-variable of such a variable as segment, click on the  icon and 
select the value. 

7) If you wish to use a constant text as segment, click on the  icon and enter 
the text. 

You can remove a segment with the  icon. You can move a segment to the 
left or right with the  icons.

8) If you configured a sub-variable as data source in step 6, this sub-variable 
may be empty during runtime of the application, which leads to unexpected 
recognitions of the grammar. To avoid this, you can activate the Skip Entry 
for empty Source Data Member check box. This will only be possible if at 
least one sub-variable is used as segment.

The left-hand side of an assignment Utterance --> Semantic Result is now 
defined.

9) Click on the Result tab.

On this tab you define the right-hand side of such an assignment. 

INFO:  The semantic result is independent from languages. 

Example:
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If different semantic results were configured for an utterance in 
different languages, the following example error message would 
be put out: Grammar ’grammar01’ delivers grammar files with 
different semantic results.

10) Select for the semantic result either a sub-variable of the data source, select 
a string variable, enter a constant text or activate the Do not use concrete 
Result (will use Alternative’s Text) radio button. An alternative text is here 
the left-hand portion of an assignment in a grammar file.

11) Click the OK button.

The new assignment is displayed in the Grammar Entry List field.

You can perform the following actions:

12) If required, add further grammar entries.

13) Click on Next.

14) Click on the ... button next to the Target Grammar field.

15) Select the grammar to be replaced with the grammar determined by the 
Grammar control during runtime of the application.

The grammar file of the grammar determined by the Grammar control is 
created according to the Grammar control configuration and for a language 
valid at runtime of the application.

INFO:  Please consider that the new grammar file is created for 
the speech recognition system only temporarily. The local file is 
never changed.

16) Click the OK button.

Language Utterance Semantic Result

English yes YES

no NO

German ja YES

nein NO

Icon Description

Adding a new grammar entry

Editing a grammar entry

Copying and editing a grammar entry

Removing a grammar entry

Changing a grammar entry's sequence
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17) The new temporary grammar is generally only created in the working memory 
before being sent to the speech recognition. The grammar can optionally be 
created in a real file on the file system. This enables debugging and precom-
piling the grammar.

If you wish the new temporary grammar file to be created as real file on the 
speech recognition system, activate the Grammar File is physically created 
on Speech Recognition System check box.

18) When creating a real, temporary grammar you can precompile this file before 
it is used by the speech recognition. This will improve the general speech 
recognition performance. 

INFO:  Please consider that a precompilation should always be 
performed if the grammar contains a large number of assign-
ments.

If you wish to perform a precompilation, activate the Grammar File is 
precompiled for Speech Recognition System check box.

19) When precompilation is used, enter the path to the binary files of the compiler 
on the speech recognition system in the Compiler Directory field.

Example:

C:\MS_Starter_Kit\ms_starter_kit\speech\Recognizer

20) Click on Next.

21) If a grammar contains phonetically identical utterances, the speech recog-
nition may return a list of semantic results of all recognized utterances. This 
list consists of single semantic results separated by a separator to be 
specified further below. If the grammar does not support any of such multiple 
semantic results, the sole result of an ambiguous speech recognition is a 
randomly selected result entry from the list.

If the new temporary grammar supports multiple semantic results, activate the 
Created Grammar supports multiple Semantic Results check box.

22) When the Created Grammar supports multiple Semantic Results is 
active, you can specify the multiple semantic results separator in the Result 
List Separator field.

INFO:  Please consider that the separator must not be contained 
in any of the possible results.

23) Click on Next.

24) The language currently set is generally used for the speech recognition. You 
can optionally change the language for the case that an utterance is present 
in another language, for example an English name in a German grammar. 
This requires the data source providing information about which language to 
use for the speech recognition of this utterance.

If another language is to be used, activate the Use custom Language for 
Recognition check box.
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INFO:  Do not confuse this language changing with the language 
changing by the Language control.

25) When the Use custom Language for Recognition check box is active, 
select the language code to be used in the Source Data Member field. 

The Code describes the values of the CultureInfo class defined by Microsoft, 
which contain the cultural properties of a country. These properties contain 
the name of the culture, the writing system, the calendar used as well as the 
date format and sorted character strings. The code consists of a two-digit 
culture code in small letters according to ISO 639 linked to a language and 
also of a two-digit fractional culture code in small letters linked to a country or 
region. The format consists of two letters, a hyphen and two letters, for 
example ja-jp for Japan.

26) Click on Next.

27) Some words may be pronounced totally differently from their written 
appearance as is sometimes the case with names or foreign words. If this 
occurs, you must add a new assignment Original Data Member --> Substi-
tuting Data Member in the Pronunciation Mapping List field, which 
replaces the original word with the desired one.

28) Click on the Finish button.

5.6.15  NLU Control

Like the DtmfInput control, the NLU (Natural Language Understanding) control 
stores a caller's input in a variable. However, the user's input here is not made by 
keys but by voice (utterance). The way the utterance is made it is recognized by 
ASR and its meaning, the semantic result, is stored in a variable in compliance 
with a grammar. Consequently, there is the following causal chain: utterance --> 
recognized utterance --> meaning (semantic result) --> variable value. In case of 
an ambiguous utterance recognition, all likely results can optionally be stored in 
a variable list.

The NLU (Natural Language Understanding) control serves for configuring the 
automatic speech recognition (ASR).

NOTICE:  Speech recognition with subsequent storing of a result 
in a variable is, besides in the NLU control, also performed in the 
SpeechInput control. However, in contrast to the SpeechInput 
control that allows processing only one result, you can process 
several results in the NLU control. Furthermore, results in the NLU 
control are stored in a variable of type Tree, whereas a 
SpeechInput control stores the result in a variable of type Recog-
nitionResult.
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NOTICE:  No control can translate a caller's spoken language in 
written text.

NOTICE:  In the example applications Appointment and 
ReadTheMeter, the NLU control is available in the 
Samples\Applications sub-folder of the Application Builder's 
installation folder (not in the workspace directory). These applica-
tions are shipped with the Application Builder. The How to Import 
Workspace Elements section describes how to provide these 
applications.

The configuration dialog of the NLU control provides the tab General, Intro-
duction, Slots, Result, Confirmation, Options and Help.

“General” tab

On the General tab of the control you can perform the following settings. See 
section General Information about Controls.

In the Menu Parameters section you can determine the behavior of the control in 
case of time-out (no input after a certain amount of time). The following settings 
are available:
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In the Test Setup section you can test the correct flow of all grammars relevant 
for the control. This is only possible if a valid configuration exists. To achieve a 
useful test result, set up a real callflow that contains obvious user utterances. 
Enter such utterances in the text field via keyboard.

How to test the correct flow of the relevant grammars:

1. Click on the Test Speech Recognition Setup icon.
The Test Speech Recognition Setup dialog opens.

2. Select from the Language drop-down list the language you wish to test for the 
flow. 

3. Enter the utterances of the possible call flow under Utterance.

4. Click on the Recognize button to copy the settings. 
In the Recognition Result section you receive the single utterance fragments 
in the Utterance column. The grammar assignment is displayed in the 
Grammar column. 
Words important for the call flow must be contained in the created grammar. 
Irrelevant elements of the utterance should be assigned to a garbage 
grammar. Utterances that are irrelevant for the all flow and not assigned to a 
garbage grammar can be assigned to an application-specific garbage 
grammar via the recycle bin icon. The global garbage grammar contains 
automatically a link to the application-specific garbage grammar. 

5. Click the OK button to close the test dialog.

"Introduction" Tab

On this tab you specify the announcement(s) to serve as introduction for the NLU 
control. All announcements or variables assigned to the control are listed in the 
Announcements column. Transformation transforms variable values into 
complete announcements the user can understand. You need to enter the trans-
formations for every available language to be used.

The following icons are available:

Field Description

Menu Timeout (seconds) Specify here the time (in seconds) available to the caller to 
make his/her input after the announcement (s) has been 
played. If you enter a ’0', the caller can wait an undefined 
period of time until he/she makes an entry via a key. The 
default value is 10 seconds.

Menu Repetitions (No 
Input) and (Invalid Input)

If the caller has made no/an incorrect voice input, the 
announcement will be repeated. You define how often an 
input can be repeated before the control reports the event 
error, whereby the next control is moved to. The value 
refers to the number of missing/invalid entries. In case of 
value 3, the entry and thus the announcement will be 
repeated three times, so with the first execution the 
announcement is played altogether four times. If you enter 
a ’0’, the announcement is not repeated but the caller is 
directly forwarded to the control configured for the error 
event after a missing/invalid entry. The feature is then deac-
tivated. Three repetitions are allowed by default.
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"Slots" Tab

On this tab you specify the recognition slots to be filled in by the user via voice. 
Each slot corresponds to a single entry value demanded from the user. The result 
of a slot grammar is the value with which a slot is filled in. The following settings 
are available:

How to add a slot:

1. Click on the icon.
The dialog Create new Slot for Recognition Slot List opens. 

Icon Description

This icon enables playing a selected announcement. See 
section General Information about Controls/Playback 
Options.

A click on the triangle of the icon depicted on the left opens 
a list to select the options Add Prompt ..., Add Variable... 
or Add Pause.... Depending on the option you select, the 
corresponding icon is displayed. These icons enable creat-
ing or adding a new prompt or variable to the list. See sec-
tion General Information about Controls/Adding a Prompt, 
Variable or Pause.

By clicking this button you may change the selected 
announcement, prompt or variable in the list.

This icon lets you remove a selected announcement, vari-
able or pause from the list.

If you have inserted several announcements or variables, 
they are played in order from top to bottom. Using these 
icons you can move a selected announcement or variable in 
the list up or down.

Icon Description

This icon enables creating or adding a new slot to the list. 
See How to add a slot under this table.

This icon allows editing a selected slot.

You use this icon to remove a selected slot from the list. 

If you have inserted several slots, they are dialed in order 
from top to bottom. Using these icons you can move a 
selected slot in the list up or down.
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2. Enter a name for the slot. 

3. Specify the Slot Grammar. Use the ... button to select the corresponding 
grammar and click on OK.

NOTICE:  You can import a new grammar file via the Create new 
Grammar link. 

4. Activate the Optional Slot checkbox if the slot shall not be announced. The 
slot can be left empty for the recognition. The Slot Announcements section 
becomes inactive. 

5. When activating the Optional Slot, specify a Default Value. The default 
value is executed if the user does not fill in the slot. 

6. In the Slot Announcements section you specify the announcement(s) for the 
slot that the user needs to fill in. All announcements or variables assigned to 
the control are listed in the Announcements column. Transformation trans-
forms variable values into complete announcements the user can under-
stand. You need to enter the transformations for every available language to 
be used.
The following icons are available:
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7. Click on OK.
The dialog Create new Slot for Recognition Slot List closes and the config-
uration is saved.

“Results” Tab

On this tab you specify the variable that stores the speech recognition result. The 
specified variable stores the complete speech recognition result, which consists 
of all single results of the defined recognition slot. Each slot is available as sub-
variable of the specified variable.

1. Specify the Variable for Recognition Result. Use the ... button to select the 
corresponding variable and click on OK.

2. Switch to the next tab or click on OK or Apply.
The configurations are saved.

"Confirmation" Tab

On this tab you define the announcement to be played by the control as final result 
after all necessary slots have been filled in. 

The following icons are available on the Confirmation tab.

Icon Description

This icon enables playing a selected announcement. 
See section General Information about Controls/Play-
back Options.

A click on the triangle of the icon depicted on the left 
opens a list to select the options Add Prompt ..., Add 
Variable... or Add Pause.... Depending on the option 
you select, the corresponding icon is displayed. These 
icons enable creating or adding a new prompt or variable 
to the list. See section General Information about Con-
trols/Adding a Prompt, Variable or Pause.

By clicking this button you may change the selected 
announcement, prompt or variable in the list.

This icon lets you remove a selected announcement, 
variable or pause from the list.

If you have inserted several announcements or vari-
ables, they are played in order from top to bottom. Using 
these icons you can move a selected announcement or 
variable in the list up or down.
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After a click on the Advanced Confirmation Settings... link you can perform the 
advanced settings for confirming the variable. 

In the Confirmation Grammars section the default grammars are active, if at 
least one confirmation announcement has been configured.. You can specify 
further grammars that were previously created. The grammars should demand a 
positive or a negative confirmation for the recognized values. Use the ... button to 
select the appropriate variable and click on OK.

Icon Description

This icon enables playing a selected announcement. See 
section General Information about Controls/Playback 
Options.

A click on the triangle of the icon depicted on the left opens 
a list to select the options Add Prompt ..., Add Variable... 
or Add Pause.... Depending on the option you select, the 
corresponding icon is displayed. These icons enable creat-
ing or adding a new prompt or variable to the list. See sec-
tion General Information about Controls/Adding a Prompt, 
Variable or Pause.

By clicking this button you may change the selected 
announcement, prompt or variable in the list.

This icon lets you remove a selected announcement, vari-
able or pause from the list.

If you have inserted several announcements or variables, 
they are played in order from top to bottom. Using these 
icons you can move a selected announcement or variable in 
the list up or down.
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In the Non Confirmation Response section the optional prompt of the non 
confirmation response is played in case of a negative confirmation of the user. 
You select the prompt files from the drop-down list or create a new prompt.

"Options" Tab

In the Filter Grammars section you define redundant and unimportant contents 
to be filtered out of the user's utterances. You can specify a grammar applied to 
the beginning of the utterance (Grammar for leading Garbage) and one applied 
to the remaining content (Grammar for inner Garbage). Use the ... button to 
select the corresponding variable and click on OK.

In the Control Grammars section you can activate further default grammars. 
This enables the user to repeat the entry (Grammar for Menu Repetition) or 
cancel the entire process (Grammar for Menu Abortion). In case of an abortion 
the control delivers an additional event. Use the ... button to select the corre-
sponding variable and click on OK.

"Help" Tab

On this tab you define the announcements played by the control if the user has 
asked for help. The prompts are to contain detailed information about the purpose 
and use of the control.

The following icons are available:

In the Help Grammar section you can as a rule use the default help grammar 
activated automatically as soon as a help prompt is configured. Use the ... button 
to select the corresponding variable and click on OK.

Icon Description

This icon enables playing a selected announcement. See 
section General Information about Controls/Playback 
Options.

A click on the triangle of the icon depicted on the left opens 
a list to select the options Add Prompt ..., Add Variable... 
or Add Pause.... Depending on the option you select, the 
corresponding icon is displayed. These icons enable creat-
ing or adding a new prompt or variable to the list. See sec-
tion General Information about Controls/Adding a Prompt, 
Variable or Pause.

By clicking this button you may change the selected 
announcement, prompt or variable in the list.

This icon lets you remove a selected announcement, vari-
able or pause from the list.

If you have inserted several announcements or variables, 
they are played in order from top to bottom. Using these 
icons you can move a selected announcement or variable in 
the list up or down.
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5.6.16  SpeechMenu Control

Like the DtmfMenu control, the SpeechMenu control provides the caller with a 
menu from which he/she can select an option. However, the user's input is not 
made by keys but by voice (utterance). The way the utterance is made it is recog-
nized by ASR and its meaning, the semantic result, is determined according to a 
grammar. This semantic result determines the event to be triggered. This event 
determines the connection that forwards to the next control. Consequently, there 
is the following causal chain: utterance --> recognized utterance --> meaning 
(semantic result) --> event --> connection --> next control.

NOTICE:  No control can translate a caller's spoken language in 
written text.

NOTICE:  In the example application ReadTheMeter, the 
SpeechMenu control is available in the Samples\Applica-
tions sub-folder of the Application Builder's installation folder 
(not in the workspace directory). This application is shipped with 
the Application Builder. The How to Import Workspace Elements 
section describes how to provide this application.

The configuration dialog of the SpeechMenu control provides the tabs General, 
Grammars, Announcements and Analysis.
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“General” tab

On the General tab of the control you can perform the following settings. See 
section General Information about Controls.

In the Menu Parameters section you can determine the behavior of the control in 
case of time-out (no input after a certain amount of time). The following settings 
are available:

In the Recognition Parameters section you configure the Minimum Recog-
nition Confidence. This specification is the minimum speech recognition quality 
that must be reached for regarding the speech recognition as valid. The value 
may range between 0 and 100. The default value is 10.

Field Description

Menu Timeout (Seconds) Specify here the time (in seconds) available to the caller to 
make his/her input after the announcement (s) has been 
played. If you enter a ’0', the caller can wait an undefined 
period of time until he/she makes an entry by voice. The 
default value is 10 seconds.

Menu Repetitions (No 
Input) and (Invalid Input)

If the caller has made no/an incorrect voice input, the 
announcement will be repeated. You specify how often an 
input can be repeated before the control reports the event 
error, whereby the next control is moved to. The value 
refers to the number of missing/invalid entries. In case of 
value 3, the entry and thus the announcement will be 
repeated three times, so with the first execution the 
announcement is played altogether four times. If you enter 
a ’0’, the announcement is not repeated but the caller is 
directly forwarded to the control configured for the error 
event after a missing/invalid entry. Three repetitions are 
allowed by default.
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"Grammars" tab

On the Grammars tab you add the grammars used for assigning utterances of 
the caller to events of this control. 

Click on the icon. Activate the check box that precedes the grammar you wish 
to add or create a new grammar with a click on the Create new Grammar... link.

NOTICE:  When creating a new grammar you must use certain 
Windows themes such as any Aero theme or the Windows 7 basic 
theme for displaying specific buttons.

You can change the Windows theme for example by clicking on 
the desktop background with the right mouse button and selecting 
Personalize. Alternatively, you can open Start > Control Panel > 
Personalization or Start > Control Panel > Appearance and 
Personalization > Personalization.

NOTICE:  After adding the grammars check whether the 
Semantic Results column shows the semantic results of your 
desired keywords. In doing so please consider that the semantic 
result is the representation of the textual meaning but not the 
textual meaning itself. This difference is important when creating 
the utterance --> semantic result assignment for several 
languages, because the textual meaning of an utterance always 
depends on a language but the semantic result must be 
language-independent.

Check grammars that do not display anything at all in the 
Semantic Results column because the grammar selection dialog 
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includes faulty grammars also. In such a case the problem view 
shows for example the following error message: Grammar 
'ws01_ grammar_01' specifies grammar files having different 
semantic results.

NOTICE:  The number of results of this control depends on the 
added grammars. If no grammar has yet been added, only the 
Menu Aborted event exists, i. e. there can only be a connection 
from the SpeechMenu control to the next control. 

Faultless grammars added to the control create one or several 
comma-separated values in the Semantic Results column. Each 
of these values effects another event. Repetitions of values in 
another row do not effect any further events.

Example: One or several rows of the Semantic Results column 
contain No, Yes. This effects two further events: Result ’No’ and 
Result ’Yes’. Consequently, a total of three connections can be 
created to the next controls.

The following icons are available:

“Announcements” tab

On this tab you specify the announcement(s) for the SpeechMenu control. Use 
them to inform the caller about his/her selection options.

Example

If you wish to be forwarded to a specific coworker, say 
"One", if you wish to query the delivery status of your 
order, say "Two", if you wish to speak to the customer 
service, say "Three".

For event "One" you are forwarded to a SpeechInput control that queries the 
coworker's name, for event "Two" you are forwarded to a DatabaseRead control 
and for event "Three" you are forwarded to a Connect control that routes the call 
to the already known phone number of the customer service.

All announcements or variables assigned to the control are listed in the 
Announcements column. Transformation transforms variable values into 

Icon Description

This icon opens the dialog for adding one or several grammars. See for 
example section Workspace Grammars.

This icon opens the dialog for editing a grammar.

This icon removes the selected grammar.

If you have inserted several grammars, they are processed in top-to-bot-
tom order. If a caller's utterance is recognized as valid, the grammars 
further down in the list are not applied. Using these icons you can move 
a selected grammar in the list up or down.
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complete announcements the user can understand. You need to enter the trans-
formations for every available language to be used. 

In the Confirmation Prompts section you can specify an announcement for the 
case Prompt for invalid Input that plays a signal for the user. You select the 
prompt file from the drop-down list or create a new one.

The following icons are available:

Icon Description

This icon enables playing a selected announcement. See 
section General Information about Controls/Playback 
Options.

A click on the triangle of the icon depicted on the left opens 
a list to select the options Add Prompt ..., Add Variable... 
or Add Pause.... Depending on the option you select, the 
corresponding icon is displayed. These icons enable creat-
ing or adding a new prompt or variable to the list. See sec-
tion General Information about Controls/Adding a Prompt, 
Variable or Pause.

By clicking this button you may change the selected 
announcement, prompt or variable in the list.

This icon lets you remove a selected announcement, vari-
able or pause from the list.

If you have inserted several announcements or variables, 
they are played in order from top to bottom. Using these 
icons you can move a selected announcement or variable in 
the list up or down.
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"Analysis" tab

On this tab you specify via the Record invalid speech input setting, whether to 
record and save invalid speech input or not. The recorded speech input will be 
stored on the OpenScape server and might later be used to optimize the used 
grammars.

If recording is enabled, each user utterance that is not properly recognized by the 
speech recognition system will be stored on the server along with the corre-
sponding (active) grammar files. The files will be saved into the folder <Speech/
<control-name>/<call-id> within the application’s file storage and can be 
downloaded from the server for analysis.

5.6.17  SpeechInput Control

Like the DtmfInput control the SpeechInput control stores a caller's input in a 
variable. However, the user's input here is not made by keys but by voice 
(utterance). The way the utterance is made it is recognized by ASR and its 
meaning, the semantic result, is stored in a variable in compliance with a 
grammar. Consequently, there is the following causal chain: utterance --> recog-
nized utterance --> meaning (semantic result) --> variable value. In case of an 
ambiguous utterance recognition, all likely results can optionally be stored in a 
variable list.

NOTICE:  Speech recognition with subsequent storing of a result 
in a variable is, besides in the NLU control, also performed in the 
SpeechInput control. However, in contrast to the SpeechInput 
control, which allows processing only one result, you can process 
several results in the NLU control. Furthermore, results in the NLU 
control are stored in a variable of type Tree, whereas a 
SpeechInput control stores the result in a variable of type Recog-
nitionResult.

NOTICE:  No control can translate a caller's spoken language in 
written text.

The configuration dialog of the SpeechMenu cont.rol provides the tabs General, 
Recognition, Announcements and Analysis.
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“General” tab

On the General tab of the control you can perform the following settings. See 
section General Information about Controls.

In the Menu Parameters section you can determine the behavior of the control in 
case of time-out (no input after a certain amount of time). The following settings 
are available:

In the Recognition Parameters section you configure the Minimum Recog-
nition Confidence. This specification is the minimum speech recognition quality 

Field Description

Menu Timeout (Seconds) Specify here the time (in seconds) available to the caller to 
make his/her input after the announcement (s) has been 
played. If you enter a ’0', the caller can wait an undefined 
period of time until he/she makes an entry by voice. The 
default value is 10 seconds.

Menu Repetitions (No 
Input) and (Invalid Input)

If the caller has made no/an incorrect voice input, the 
announcement will be repeated. You specify how often an 
input can be repeated before the control reports the event 
error, whereby the next control is moved to. The value 
refers to the number of missing/invalid entries. In case of 
value 3, the entry and thus the announcement will be 
repeated three times, so with the first execution the 
announcement is played altogether four times. If you enter 
a ’0’, the announcement is not repeated but the caller is 
directly forwarded to the control configured for the error 
event after a missing/invalid entry. Three repetitions are 
allowed by default.
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that must be reached for regarding the speech recognition as valid. The value 
may range between 0 and 100. The default value is 10.

"Recognition" tab

On the Recognition tab you add the grammars used for assigning utterances of 
the caller to events of this control. 

Click on the icon. Activate the check box that precedes the grammar you wish 
to add or create a new grammar with a click on the Create new Grammar... link. 

NOTICE:  When creating a new grammar you must use certain 
Windows themes such as any Aero theme or the Windows 7 basic 
theme for displaying specific buttons.

You can change the Windows theme for example by clicking on 
the desktop background with the right mouse button and selecting 
Personalize. Alternatively, you can open Start > Control Panel > 
Personalization or Start > Control Panel > Appearance and 
Personalization > Personalization.

After adding the grammars check whether the Semantic Results column shows 
the semantic results of your desired keywords. In doing please consider that 
semantic results must correspond to their keywords but need not be identical with 
them. A semantic result is valid for all languages of a grammar. For example, the 
German keyword "Ja" and the English keyword "Yes" may be assigned to the 
semantic result "Yes".

Check grammars that do not display anything at all in the Semantic Results 
column because the grammar selection dialog includes faulty grammars also. In 
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such a case the problem view shows for example the following error message: 
Grammar 'ws01_ grammar_01' specifies grammar files having different 
semantic results.

The following icons are available:

In the Result Storage area click on the ... button next to the Variable for Recog-
nition Result field and select the variable to store the best meaning of the caller's 
recognized utterance, the semantic result. This variable must be of type Recog-
nition Result. In the Variable for Recognition Result List field you can 
optionally select a variable of type RecognitionResult List. In this variable all 
likely meanings of the utterance are stored. This is of importance if no best 
meaning can be uniquely determined.

“Announcements” tab

On this tab you specify the announcement(s) for the SpeechInput control. Use 
them for telling the user which keywords he/she is expected to put in.

Example

Please state the name of the coworker you wish to be 
forwarded to.

You may then be routed to a DatabaseRead control that queries the phone 
number of the desired coworker.

All announcements or variables assigned to the control are listed in the 
Announcements column. Transformation transforms variable values into 
complete announcements the user can understand. You need to enter the trans-
formations for every available language to be used. 

Icon Description

This icon opens the dialog for adding one or several grammars. See for 
example section Workspace Grammars.

This icon opens the dialog for editing a grammar.

This icon removes the selected grammar.

If you have inserted several grammars, they are processed in top-to-bot-
tom order. If a caller's utterance is recognized as valid, the grammars 
further down in the list are not applied. Using these icons you can move 
a selected grammar in the list up or down.
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In the Confirmation Prompts section you can specify an announcement for the 
case Prompt for invalid Input that plays a signal for the user. You select the 
prompt file from the drop-down list or create a new one.

The following icons are available:

Icon Description

This icon enables playing a selected announcement. See 
section General Information about Controls/Playback 
Options.

A click on the triangle of the icon depicted on the left opens 
a list to select the options Add Prompt ..., Add Variable... 
or Add Pause.... Depending on the option you select, the 
corresponding icon is displayed. These icons enable creat-
ing or adding a new prompt or variable to the list. See sec-
tion General Information about Controls/Adding a Prompt, 
Variable or Pause.

By clicking this button you may change the selected 
announcement, prompt or variable in the list.

This icon lets you remove a selected announcement, vari-
able or pause from the list.

If you have inserted several announcements or variables, 
they are played in order from top to bottom. Using these 
icons you can move a selected announcement or variable in 
the list up or down.
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"Analysis" tab

On this tab you specify via the Record invalid speech input setting, whether to 
record and save invalid speech input or not. The recorded speech input will be 
stored on the OpenScape server and might later be used to optimize the used 
grammars.

If recording is enabled, each user utterance that is not properly recognized by the 
speech recognition system will be stored on the server along with the corre-
sponding (active) grammar files. The files will be saved into the folder <Speech/
<control-name>/<call-id> within the application’s file storage and can be 
downloaded from the server for analysis.

5.6.18  SpeechSelection Control

Like the DtmfSelection control, the SpeechSelection control links the variable list 
elements to the telephone keys. However, the user's input is not made by keys 
but by voice (utterance). The way the utterance is made it is recognized by ASR 
and its meaning, the semantic result, is determined according to a grammar. This 
semantic result determines the event to be triggered.

NOTICE:  No control can translate a caller's spoken language in 
written text.

NOTICE:  In the example application ReadTheMeter, the 
SpeechMenu control is available in the Samples\Applica-
tions sub-folder of the Application Builder's installation folder 
(not in the workspace directory). This application is shipped with 
the Application Builder. The How to Import Workspace Elements 
section describes how to provide this application.

The configuration dialog of the SpeechSelection control provides the tabs 
General, Introduction, Iteration, Selection and Analysis.
 A31003-S50A0-U103-02-7619, 10/2020
370 OpenScape UC Application V10 Fusion Application Builder, User Guide



Controls
Group IVR Controls
“General” tab

On the General tab of the control you can perform the following settings. See 
section General Information about Controls.

In the Selection List Parameters section you can determine the behavior of the 
control in case of time-out (no input after a certain amount of time). The following 
settings are available:

In the Recognition Parameters section you configure the Minimum Recog-
nition Confidence. This specification is the minimum speech recognition quality 

Field Description

Menu Timeout (Seconds) Specify here the time (in seconds) available to the caller to 
make his/her input after the announcement (s) has been 
played. If you enter a ’0', the caller can wait an undefined 
period of time until he/she makes an entry by voice. The 
default value is 10 seconds.

Menu Repetitions (No 
Input) and (Invalid Input)

If the caller has made no/an incorrect voice input, the 
announcement will be repeated. You specify how often an 
input can be repeated before the control reports the event 
error, whereby the next control is moved to. The value 
refers to the number of missing/invalid entries. In case of 
value 3, the entry and thus the announcement will be 
repeated three times, so with the first execution the 
announcement is played altogether four times. If you enter 
a ’0’, the announcement is not repeated but the caller is 
directly forwarded to the control configured for the error 
event after a missing/invalid entry. Three repetitions are 
allowed by default.
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that must be reached for regarding the speech recognition as valid. The value 
may range between 0 and 100. The default value is 10.

"Introduction" tab

On this tab you define the introductory announcements played before the 
selection list announcements. All announcements or variables assigned to the 
control are listed in the Announcements column. Transformation transforms 
variable values into complete announcements the user can understand. You need 
to enter the transformations for every available language to be used.

In the Confirmation Prompt section you can specify a Prompt for invalid Input 
that acoustically signal errors to the user. You select the prompt file from the drop-
down list or create a new one.

The following icons are available:

"Iteration" tab

On this tab you specify what you wish to iterate over and the iterator, selection key 
and event store variable name.

Leave the Iterate over Variable List radio button activated if you wish to iterate 
via the variable list. Activate the Iterate over Enumeration Type Values radio 
button if you wish to iterate via the values of an enumeration variable type. 

Icon Description

This icon enables playing a selected announcement. See 
section General Information about Controls/Playback 
Options.

A click on the triangle of the icon depicted on the left opens 
a list to select the options Add Prompt ..., Add Variable... 
or Add Pause.... Depending on the option you select, the 
corresponding icon is displayed. These icons enable creat-
ing or adding a new prompt or variable to the list. See sec-
tion General Information about Controls/Adding a Prompt, 
Variable or Pause.

By clicking this button you may change the selected 
announcement, prompt or variable in the list.

This icon lets you remove a selected announcement, vari-
able or pause from the list.

If you have inserted several announcements or variables, 
they are played in order from top to bottom. Using these 
icons you can move a selected announcement or variable in 
the list up or down.
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"Selection" tab

On this tab you specify the selection list announcements to be played during the 
iteration for every variable in the list. The following settings are available:

Field Description

Variable List to iterate 
respectively Enumeration 
Type to iterate

If you wish to iterate via a variable list, select a variable list 
via the ... field and click on OK.

If you wish to iterate via an enumeration variable type, click 
in the field and select an enumeration variable type.

Iterator Variable Name The Iterator Variable Name enters the name that is used 
for the current variable list element during the iteration. The 
iterator variable is the loop variable during traversing all list 
entries. This variable is available in this control only, thus 
neither in other DtmfSelection controls nor anywhere else in 
the application or workspace.

Selection Key Variable 
Name

Specify the variable name. The value of the variable is the 
respective DTMF key assigned to the selection of the cur-
rent list element or to the value of the enumeration variable 
type. This variable is available in this control only, thus nei-
ther in other DtmfSelection controls nor anywhere else in 
the application or workspace.

Variable for selected Ele-
ment

Specify in the Result Storage section a variable for a 
selected element. Use the ... button to select the appropri-
ate variable and click on OK. You can select only one vari-
able of the same type as the above selected enumeration 
type or as the list elements of the above selected list. This 
variable is used for storing the list element or value of the 
enumeration variable type. 

Icon Description

This icon enables playing a selected announcement. See 
section General Information about Controls/Playback 
Options.

A click on the triangle of the icon depicted on the left opens 
a list to select the options Add Prompt ..., Add Variable... 
or Add Pause.... Depending on the option you select, the 
corresponding icon is displayed. These icons enable creat-
ing or adding a new prompt or variable to the list. See sec-
tion General Information about Controls/Adding a Prompt, 
Variable or Pause.

By clicking this button you may change the selected 
announcement, prompt or variable in the list.

This icon lets you remove a selected announcement, vari-
able or pause from the list.

If you have inserted several announcements or variables, 
they are played in order from top to bottom. Using these 
icons you can move a selected announcement or variable in 
the list up or down.
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In the Navigation Prompts section you can set prompts for the single user inter-
actions. The following settings are available:

NOTICE:  Next or previous page means that the selection list 
announcement may contain an indefinite number of prompts. 
Because the caller interacts via the telephone keys, the prompts 
must be combined in groups (pages) of 9 prompts. The "0" key is 
reserved.

"Analysis" tab

On this tab you specify via the Record invalid speech input setting, whether to 
record and save invalid speech input or not. The recorded speech input will be 
stored on the OpenScape server and might later be used to optimize the used 
grammars.

If recording is enabled, each user utterance that is not properly recognized by the 
speech recognition system will be stored on the server along with the corre-
sponding (active) grammar files. The files will be saved into the folder <Speech/
<control-name>/<call-id> within the application’s file storage and can be 
downloaded from the server for analysis.

5.7  Group UC Controls

In the group UC Controls you find controls that can execute Unified 
Communications functions, such as playing messages or receiving faxes.

The extract from the palette view shows which controls are part of this group.

Field Description

Prompt for next Page Name of the prompt played as instruction for skipping to the 
next page. The optional prompt is bound to the pound key. 

Prompt for previous Page Name of the prompt played as instruction for skipping to the 
previous page. The optional prompt is bound to the star key.

Prompt to cancel Selec-
tion

Name of the prompt played as instruction for cancelling a 
selection. The optional prompt is bound to the "0" key.
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5.7.1  Send Control

The configuration dialog of the Send control is divided in the tabs General, Body, 
Document, Message, Originator and Recipients.

“General” tab

On the General tab of the control you can perform the following settings. See 
section General Information about Controls.
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Enter the message's header in the Subject field. If you wish to specify variable 
values in this field indirectly, click on the ... button. The Select Arguments for 

Patterns dialog opens. Click on the icon, select the variable the value of which 
you wish to use and click on OK. The selected variable is displayed in the 
Arguments field. The Tag column displays the format tag that corresponds to the 
variable, for example {0}. If you wish to remove a variable from the Arguments 

field, click on the icon. You can change the variable - format tag assignment 

using the icons  and  . When you click the Pattern Text button, the content 
of the Subject field is displayed. Click the OK button. The assignment of format 
tag to variable is shown beneath the subject. Place the format tags in the subject 
line in positions where the corresponding variable values are required. When you 
click in the Subject field and push the hotkey CTRL + space bar, a selection of 
format tags is provided. Click on the appropriate format tag and push the enter 
key.

Example of a subject with format tags:

Project Status: {0}, Project Target Date: {1}

INFO:  The description of the Java class MessageFormat 
provides further information about format tags; see for example 
docs.oracle.com/javase/6/docs/api/java/text/
MessageFormat.html. This page also describes the use of the 
number, date, time and choice format types as well as of the short, 
medium, long, full, integer, currency, percent and Subfor-
matPattern format styles.

Example of a subject with two format types and one format style: 

"Body" tab

Enter the optional message content in the Body field.

Analog to the subject you can use format tags in the Body field also.

"Document" tab

In the Message Document area, you can specify a file to be sent optionally. 

After activating the Specify by Resource radio button and clicking in the field of 
the same name, you can select one of the displayed files.

INFO:  If you use the Send control in an application, only the appli-
cation resource files are displayed for selection. They are also 
listed in the workspace view under <application name> > Appli-
cation Resources. You find these files in the directory 
<workspace path>\items\symvia-<application 
name>\resources.

If, in contrast, you use the Send control in a composition, only the 
composition resource files are displayed for selection. They are 

Project Status: {0,number,percent}, Project Target Date: {1,date}
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also listed in the workspace view under Symvia Control compo-
sitions > <composition name> > Composition Resources. 
You find these files in the directory <workspace 
path>\items\symvia-compositions\<composition 
name>\resources.

After clicking in the Specify by Resource field and then on Import new 
Resource..., you can select any file available on the file system.

INFO:  If you use the Send control in an application, this file is 
added to the application resource files. 

If, in contrast, you use the Send control in a composition, this file 
is added to the composition resource files. 

After activating the Specify by Variable radio button and clicking on the ... button, 
you can select a variable of type URI the value of which identifies the file to be 
attached to the message. This file may have been filled by a Record control.

In the Display Name of Document field you can assign a name that will be 
displayed within the message. Enter the name manually.

"Message" tab

On the Message tab you can configure the sensitivity, the importance and the 
delivery receipt of a message.

You can select one of the following values from the Specify Sensitivity by Value 
combo box to assign it manually to the message's sensitivity:

• None

• Personal

• Private

• Confidential

In the Specify Sensitivity by Variable field you can configure the sensitivity 
using a variable of type Message Sensitivity.

You can select one of the following values from the Specify Importance by Value 
combo box to assign it manually to the message's importance:

• Low

• Normal

• High

In the Specify Importance by Variable field you can configure the importance 
using a variable of type Message Importance.

If you activate the Request Message Delivery Receipt check box, a delivery 
receipt is sent to the message originator after the message's successful delivery. 
The message originator is the user logged in at OpenScape UC Application. If no 
user is logged in, the custom originator configured on the "Originator" tab is taken 
as the message originator. If neither a user is logged in nor a custom originator 
has been configured, sending a receipt may fail.
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INFO:  A delivery receipt is no read confirmation.

"Originator" tab

On the Originator tab you can set a message originator. The user currently 
logged in at OpenScape UC Application is specified as message originator by 
default. The originator pays for the all.

If no user has logged in, the custom user (if configured) is deployed as originator. 
To configure a custom originator, activate the Use custom Message Originator 
check box. You have the following options: 

• Specify by Text
Enter the message originator manually.

• Specify by Variable
Specify the variable of type String that contains the message originator.

If no user is logged in at OpenScape UC Application and no custom originator has 
been configured, OpenScape UC Application determines the originator.

"Recipients" tab

On the Recipients tab you specify the recipients of a message and determine 
their order. A list entry may correspond to one recipient or to a list of recipients.

The following icons are available on the Recipients tab.

5.7.1.1  How to Add a User to the Recipient List

Step by Step

1) Click on the black triangle next to the  icon and select Add User....

The Add User to Recipient List dialog opens. 

2) In this dialog there are three options for specifying the user data. 

a) Specify single User by concrete User

Check that the Application Builder is connected to an OpenScape UC 
Application (Workspace > OpenScape Servers > OpenScape Server 

Icon Description

This icon adds a recipient entry. 

This icon opens a recipient entry for editing.

This icon removes a recipient entry.

If you have created several recipients, they are applied in 
order from top to bottom. Using these icons you can move 
selected recipient entries in the list up or down.
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Login > Current Status). Only then the Specify single User by 
concrete User field will display OpenScape UC Application users for 
selection. Select a user (example: Olga Olgova). If there is no connection 
to an OpenScape UC Application, the message User Selection is not 
available due to missing Server Connection.

The Address by field provides the account name of the user for selection 
(example: Account (’olgova@system’)). If you wish to use the user's e-
mail address instead of the account name, use Add Contact... instead of 
Add User....

b) Specify single User by Variable

Specify the variable of type User that contains the user the message shall 
be sent to. 

c) Specify multiple Users by Variable List

Specify the variable list of type User List that contains the users the 
message shall be sent to. 

3) Click on OK. 

The selected recipients are added to the Message Recipient List.

4) Click on OK or switch to another tab for performing further settings.

5.7.1.2  How to Add a Contact to the Recipient List

Step by Step

1) Click on the black triangle next to the  icon and select Add Contact....

The Add Contact to Recipient List dialog opens. 

2) In this dialog there are three options for specifying the contact data. 

a) Specify single Contact by concrete Contact

Check that the Application Builder is connected to an OpenScape UC 
Application (Workspace > OpenScape Servers > OpenScape Server 
Login > Current Status). Only then the Specify single Contact by 
concrete Contact field will display contacts of the OpenScape UC Appli-
cation for selection. Select a contact (example: Olga Olgova). If there is 
no connection to an OpenScape UC Application, the message Contact 
Selection is not available due to missing Server Connection informs 
you accordingly.

The Address by field provides the contact's account name for selection 
(example: Account (’olgova@system’)). If an e-mail address has been 
configured for this contact, it is provided for selection as well (Example: 
Email: ’olgova@mycompany.com’).

INFO:  You find the e-mail address of a contact or user in the CMP 
under User Management > Administration > Users & 
Resources > <user name> > General > E-mail address 1.
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b) Specify single Contact by Variable

Specify the variable of type Contact that contains the contact the message 
shall be sent to. 

c) Specify multiple Contacts by Variable List

Specify the variable list of type Contact List that contains the contacts the 
message shall be sent to. 

3) Click on OK. 

The selected recipients are added to the Message Recipient List.

4) Click on OK or switch to another tab for performing further settings.

5.7.1.3  How to Add an E-Mail Address to the Recipient List

Step by Step

1) Click on the black triangle next to the  icon and select Add Email....

The Add Email Address to Recipient List dialog opens. 

2) In this dialog there are three options for specifying the contact data. 

a) Specify single Email Address by concrete Text

Enter an e-mail address manually.

b) Specify single Email Address by Variable

Specify the variable of type String that contains the e-mail address the 
message shall be sent to. 

c) Specify multiple Email Addresses by Variable List

Specify the variable list of type String list that contains the e-mail 
addresses the message shall be sent to. 

3) Click on OK. 

The selected recipients are added to the Message Recipient List.

4) Click on OK or switch to another tab for performing further settings.

5.7.2  Message Control

The Message control contains the Properties configuration dialog. It can play, 
delete, answer and forward messages. Additionally, the control can update the 
message status, answer meeting requests and play mailbox messages.
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IMPORTANT:  If using the Message control in an application, the 
control will work only if a user has been previously logged in at an 
OpenScape UC Application in the application through use of the 
Authentication control. 

If no use has been logged in, a corresponding error message is 
issued in the control (see screenshot). 

In contrast, if using the Message control in a composition, no such 
error message is put out because within the composition there is 
no way of checking in which application the composition is used 
and whether a login has been performed within the application.

Properties view

In the Change Properties for Message view you can perform the following 
settings. See section General Information about Controls.

The Message Control can work in different modes. These are:

• Play back a Message

• Delete a Message

• Reply to a Message

• Forward a Message

• Update the Status of a Message

• Respond to a Meeting Request

• Retrieve Messages from Mailbox
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When a message is sent, the user logged in at the OpenScape UC Application is 
used as message originator.

5.7.2.1  How to Configure the Play back a Message Mode

Prerequisites

• You have opened the properties dialog of the Message control.

Step by Step

1) Select the Play back a Message item from the Control Mode combo box.

2) Click on Next.

3) Select a variable of type Message in the Message Playback section via the 
... button. 

4) Select prompts for different situations in the Playable Prompts section from 
the combo box or create a new prompt via the Create New Prompt... link. You 
need prompts for the following situations:

• Prompt for empty Body 

• Prompt for Attachment Separator

• Prompt for Invalid Attachment

NOTICE:  When creating a new prompt you must use certain 
Windows themes such as any Aero theme or the Windows 7 basic 
theme for displaying specific buttons.

You can change the Windows theme for example by clicking on 
the desktop background with the right mouse button and selecting 
Personalize. Alternatively, you can open Start > Control Panel > 
Personalization or Start > Control Panel > Appearance and 
Personalization > Personalization.

NOTICE:  If the Message Control is used in a composition and 
you create a new prompt, no composition prompt is created.

If, in contrast, the Message Control is used in an application and 
you create a new prompt, an application prompt is created.

You find details of creating prompts in section "How to Create and Configure 
an Application Prompt". Those details apply likewise for composition prompts.

5) Click on Next.

You can define message information that can be added to your playable 
message.

6) In the Include column, enable the check boxes of the properties you would 
like to add to your message.
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7) Click the Finish button to complete the configuration.

5.7.2.2  How to Delete a Message

Prerequisites

• You have opened the properties dialog of the Message control.

Step by Step

1) Select the Delete a Message item from the Control Mode combo box.

2) Click on Next.

3) Select a variable of type Message in the Message Deletion section via the ... 
button. 

4) If you would like to delete the message permanently, enable the check box 
Delete Message permanently.

NOTICE:  If you activate this mode, the messages cannot be 
restored.

5) Click the Finish button to complete the configuration.

5.7.2.3  How to Reply to a Message

Prerequisites

• You have opened the properties dialog of the Message control.

Step by Step

1) Select the Reply to a Message item from the Control Mode combo box.

2) Click on Next.

3) Next to the Variable for Message field click on the ... button to select the 
variable of type Message that contains the message to be replied to. 

4) Next to the Variable for Comment field click on the ... button to select the 
variable of type URI that contains the path to the media file to be inserted. The 
typical contents of this media file is spoken language recorded with the 
Record control.

5) Click the Finish button to complete the configuration.

6) If you wish to reply to all other persons besides the message originator, 
activate the Reply to All (instead of replying to message Sender only) 
check box.

7) Click the Finish button to complete the configuration.
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5.7.2.4  How to Forward a Message

Prerequisites

• You have opened the properties dialog of the Message control.

Step by Step

1) Select the Forward a Message item from the Control Mode combo box.

2) Click on Next.

3) Next to the Variable for Message field click on the ... button to select the 
variable of type Message that contains the message to be forwarded. 

4) Next to the Variable for Comment field click on the ... button to select the 
variable of type URI that contains the URI of the media file to be inserted in 
the message to be forwarded. The typical contents of this media file is spoken 
language recorded with the Record control.

INFO:  Specifying this variable is optional.

INFO:  The user who has logged in at the OpenScape UC Appli-
cation with help of the Authentication control is used as originator 
of the message to be forwarded.

5) Click on Next.

6) Next to the Message Recipient List click on the icon to add a user to the 
list or click on the black triangle next to the icon to add a user, a contact or an 
e-mail.

Another dialog opens. There are three options for you to decide whether to 
add a user, a contact or an e-mail address. Pick one of them. 

NOTICE:  The  icon changes to if you have selected 
Add Email....

Actions User Contact E-mail

Concrete 
informa-
tion

Select a user via the 
combo box.

Select a contact from 
the combo box and 
select an address from 
the Address by: 
combo box.

Enter an e-mail 
address in the field.

Variable Select a variable of the 
type User via the ... 
button .

Select a variable of the 
type Contact via the ... 
button.

Select a variable of the 
type String via the ... 
button.

Variable 
List

Select a variable of the 
type User list via the ... 
button.

Select a variable of the 
type Contact list via 
the ... button.

Select a variable of the 
type String via the ... 
button.
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NOTICE:  The concrete user and contact selection are only 
available if you are logged in at an OpenScape UC Application. 
Check this in the workspace view under OpenScape Servers > 
OpenScape Server Login > Current Status.

7) Finish your selection with OK.

8) Click the Finish button to complete the configuration.

5.7.2.5  How to Set a Message Status

Prerequisites

• You have opened the properties dialog of the Message control.

Step by Step

1) Select the Update the Status of a Message item from the Control Mode 
combo box.

2) Click on Next.

3) In the Message Deletion section click on the ... button to select a variable of 
type Message. 

4) Select value Read or Unread from the New Message Status combo box.

5) Click the Finish button to complete the configuration.

5.7.2.6  How to configure the Respond to a Meeting Request Mode

Prerequisites

• You have opened the properties dialog of the Message control.

Step by Step

1) Select the Respond to a Meeting Request Mode item from the combo box 
next to Control Mode: combo box.

2) Click on Next.

3) Select a variable in the Variable for message section via the ... button. 

NOTICE:  The variable must be of the type Message.

4) Select a variable in the Variable for Comment section via the ... button. 

NOTICE:  The variable must be of the type URI.
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5) Select from the combo box next to Response to Invitation one of the 
following options:

• Accept

• Tentatively Accept

• Decline

6) Click the Finish button to complete the configuration.

5.7.2.7  How to Configure the Retrieve Messages from Mailbox Mode

Prerequisites

• You have opened the properties dialog of the Message control.

Step by Step

1) Select the Retrieve Messages from Mailbox item from the combo box next 
to Control Mode .

2) Click on Next.

3) Select a variable in the Variable for Result section via the ... button. 

NOTICE:  The variable must be of the type Message List.

4) Enter the limit in the field next to Number of Search Results.

5) Click on Next.

Another dialog opens in which you need to define a message filter. Filtering 
has four configuration options.

• Message Type

• Message Priority

• Message Status

• Message Receiving Time

NOTICE:  You need to select at least one type and one priority.

6) Enable a check box in the Retrieved Messages by Type group.

7) Enable a check box in the Retrieved Messages by Importance group.

8) Select the Read State from the drop-down list. 

9) Select the receiving time from the lower drop-down list. 

10) Click the Finish button to complete the configuration.
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5.7.3  Authentication Control

A user deploys the Authentication control to log on to the OpenScape UC Appli-
cation by specifying either the ONS number or the user ID.

NOTICE:  In the example composition Logon, the Authentication 
control is available in the Samples\Compositions sub-folder of 
the Application Builder's installation folder (not in the workspace 
directory). This composition is shipped with the Application 
Builder. The How to Import Workspace Elements section 
describes how to provide this composition.

The Authenticationcontrol contains the General configuration dialog only.

“General” Tab

On the General tab of the control you can perform the following settings. See 
section General Information about Controls.

In the Authentication Data section you define the desired authentication type. 
There are two options for specifying the information:

• Specify by ONS Number:
Name of the variable that contains the one-number service (ONS) number 
used for logging on. Click on ... for selecting the corresponding variable.

• Specify by User ID:
Name of the variable that contains the user ID used for logging on. Click on 
... for selecting the corresponding variable. 
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Add under Variable for PIN/Password via ... the name of the variable that 
contains the authentication information. If you have selected the Specify by ONS 
Number: option, the variable will contain a PIN, if you have selected the Specify 
by User ID: option, the variable will contain a Password.

In the User Storage section you specify the variable that stores the user who was 
logged in at the system after a successful authentication. Click on ... for selecting 
the corresponding variable.

5.7.4  ChangePin Control

Using the ChangePin control you can modify the PIN for any user.

NOTICE:  In the example composition ChangePassword, the 
ChangePin control is available in the Samples\Compositions 
sub-folder of the Application Builder's installation folder (not in the 
workspace directory). This composition is shipped with the Appli-
cation Builder. The How to Import Workspace Elements section 
describes how to provide this composition.

The ChangePin control contains the General configuration dialog only.

“General” Tab

On the General tab of the control you can perform the following settings. See 
section General Information about Controls.
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Under Authentication Data you specify the variable for the user ID and for 
changing the PIN.

• Variable for User ID: Specify the variable that contains the ID of the user 
whose PIN shall be changed. Click on ... for selecting the corresponding 
variable. 

• Variable for old PIN: Specify the variable of the PIN to be changed. Click on 
... for selecting the corresponding variable. 

• Variable for new PIN: Specify the variable that contains the new PIN. Click 
on ... for selecting the corresponding variable. 

5.7.5  Presence Control

You can use the Presence control to execute different functions with regard to the 
user's presence status. The contained information may later indicate whether a 
user is for example in a meeting, absent or available.

NOTICE:  In the example applications GetPresenceState and 
SetPresenceState, the Presence control is available in the 
Samples\Applications sub-folder of the Application Builder's 
installation folder (not in the workspace directory). These applica-
tions are shipped with the Application Builder. The How to Import 
Workspace Elements section describes how to provide these 
applications.

The Presence control contains the Properties configuration dialog only.
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"Properties" tab

On the Properties tab of the control you can perform the following settings. See 
section General Information about Controls.

In the Control Mode section you specify the mode in which the control is to 
operate. How to configure the status information:

5.7.5.1  How to Configure the Presence status

Step by Step

1) Activate one of the three checkboxes

NOTICE:  If no user is specified, the presence status of the user 
currently logged in is updated. If no user was previously logged in, 
retrieving the current presence status fails. 

a) Update Presence State of logged on User: The presence status is 
always updated for the user currently logged in.

b) Retrieve Presence State of a User: The presence status is retrieved for 
a specific user or the user currently logged in.
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c) Retrieve Presence States available for a User: The available presence 
statuses are always retrieved for the user currently logged in.

2) Click on Next >.

The displayed dialog depends on the previously selected presence status.

3) Configure the settings:

a) Update Presence State of logged on User: You can specify the new 
status as explicit presence status (Specify by State) or as variable 
(Specify by Variable). There must be a server connection. Use the ... 
button to select the variable and click on OK.

b) Retrieve Presence State of a User:Specify the Variable for User ID for 
which the current presence status is to be retrieved and the Variable for 
State in which the ID of the retrieved status is stored. Use the ... button to 
select the corresponding variable and click on OK. 

c) Retrieve Presence States available for a User: Specify the Variable for 
States in which the ID of all available presence statuses is to be stored. 
Use the ... button to select the variable and click on OK.

4) Click on Finish.

5.7.6  ContactSearch Control

The ContactSearch control searches for a user who matches a previously deter-
mined name dialing number.

The configuration dialog of the ContactSearch control provides the tabs General 
and Search.
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“General” Tab

On the General tab of the control you can perform the following settings. See 
section General Information about Controls.

In the Result Storage section you configure the search and store options for 
searching for a contact. 

Specify the variable (for the result) to be used for storing the search results. Use 
the ... button to select the corresponding variable and click on OK.

The Limit Number of retrieved Results checkbox lets you restrict the number of 
retrieved contacts. Activate the checkbox and enter the desired number. 

"Search Settings" Tab

On the Search tab you define the search criterion, the search scope and the 
search prompt. 

In the Search Criterion section you can configure whether the contact is to be 
searched via ONS number or vanity Code. Activate the corresponding checkbox. 
Use the ... button to select the corresponding variable and click on OK.

In the Search Scope section you can restrict the search to private contacts and 
also extend it to global ones. The default setting always includes all contacts in 
the search. Activate the corresponding checkbox. You can activate both search 
scopes. 

In the Search Prompt section you can cover the required search time with a 
prompt. The prompt cannot be played if the search time is too short. You select 
the prompt file from the drop-down list or create a new one.

5.7.7  UserSearch Control

The UserSearch control offers the caller to enter a name dialing number and to 
subsequently search for the corresponding user.

The configuration dialog of the UserSearch control provides the tabs General and 
Search Settings.
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“General” tab

On the General tab of the control you can perform the following settings. See 
section General Information about Controls.

In the Result Storage section you configure the search and store options for 
searching for a user. 

Specify the variable (for result) to be used for storing the search results. Use the 
... button to select the corresponding variable and click on OK.

The Limit Number of retrieved Results checkbox lets you restrict the number of 
retrieved users. Activate the checkbox and enter the desired number. 

"Search Settings" tab

On the Search Settings tab you define the search criterion and the search 
prompt. 

In the Search Criterion section you configure the user search via the ONS 
number. Use the ... button to select the corresponding variable and click on OK.

In the Search Prompt section you can cover the required search time with a 
prompt. The prompt cannot be played if the search time is too short. You select 
the prompt file from the drop-down list or create a new one.
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5.7.8  Conference Control

A conference is a virtual meeting between at least two participants. Besides the 
default communication between two participants, conference may also be held by 
several participants. 

The Conference control contains the Properties configuration dialog only.

“General” Tab

On the General tab of the control you can perform the following settings. See 
section General Information about Controls.

In the Control Mode section you specify the mode in which the control is to 
operate. 

5.7.8.1  How to Create and Configure a Conference

Step by Step

1) Select one of the following modes from the drop-down list:

• Create and join a new Conference

• Start and join an already created Conference

• Join an already started Conference

• Search for available Conferences

2) Click on Next.
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The displayed dialog depends on the previously selected configuration 
settings.

3) Depending on the selected mode, perform the configuration:

a) Create and join a new Conference: Create the conference by specifying 
the variables for the conference information and for the participants. Use 
the ... button to select the variable and click on OK.

b) Start and join an already created Conference: The conference must 
have been previously created by the user logged in at the system. If no 
user is logged in at the system or the conference has not been created by 
this user, it will fail to start. You need to specify the variable that contains 
the conference information. Use the ... button to select the appropriate 
variable and click on OK.

c) Join an already started Conference: The user logged in at the system 
must have been invited for the conference. If no user is logged in at the 
system or the user has not been invited for the conference, joining the 
conference will fail. For joining the conference you must specify the 
variable that contains the conference information. Use the ... button to 
select the appropriate variable and click on OK.

d) Search for available Conferences: Use the ... button to select the 
variable in which the result of searching for conferences shall be stored 
and click on OK. Only the conferences that the logged-in user has created 
or for which he/she has been invited will be put out. If no user is logged 
in, searching for conferences will fail. Set the Conference Type to 
Joinable Conferences or Startable Conferences. Select Limit Number 
of retrieved Results. 

4) Click on Finish.

5.7.9  CallJournal Control

The CallJournal Controls lists calls corresponding to the respective configuration 
for the user.

The configuration dialog of the CallJournal control provides the tabs General and 
Filter.
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“General” Tab

On the General tab of the control you can perform the following settings. See 
section General Information about Controls.

In the Result Storage section you configure the search and store options for the 
retrieved call journal entries. 

Specify the variable (for result) to be used for storing the search results. Use the 
... button to select the corresponding variable and click on OK.

The Limit Number of retrieved Results checkbox lets you restrict the number of 
retrieved contacts. Activate the checkbox and enter the desired number. 

“Filter” Tab

On the Filter tab you define the criteria by which the calls shall be filtered. You 
can filter by Direction/Status and Time.

In the Filter by Direction/Status section you configure which calls are included 
in the search. You can select one of the following configurations from the 
Included Calls drop-down list:

• All Calls

• Only Incoming Calls

• Only Outgoing Calls

• Only Missed Incoming Calls

In the Filter by Time section you can limit the number of retrieved calls. This 
restriction may occur by time (Specify by Period) or number of calls (Specify by 
Value). Activate the corresponding checkbox. You can select one of the following 
configurations from the Specify by Period drop-down list:
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• Only Calls from Today

• Only Calls from Today and Yesterday

• Only Calls from the last 7 Days

• All Calls

5.8  Control Group ACD

In the control group ACD (Automatic Call Distribution) you find the controls that 
serve controlling an OSCC (OpenScape Contact Center).

INFO:  Using the ACD controls requires administrator knowledge 
of the contact center.

The extract from the palette shows which controls are part of this group.

INFO:  After you have opened the callflow of an application you 
see ACD controls in the palette only if the Support of Contact 
Center (ACD) Controls check box is active in the workspace 
under <application name> > Application Settings > Appli-
cation Configuration > Capability Settings. This applies for 
subflows also.

After you have opened the callflow of a composition you see ACD 
controls in the palette only if the Support of Contact Center 
(ACD) Controls check box is active in the workspace under 
Symvia Control Compositions > <composition name> > 
Composition Settings > Composition Configuration > 
Capability Settings. This applies for subflows also.

5.8.1  AcdInit Control

The AcdInit control determines the contact center for registering and processing 
a call.
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5.8.1.1  How to Configure an AcdInit Control 

This section describes how to introduce a contact center to the application.

Prerequisites

• You can see ACD controls in the palette only if the Support of Contact 
Center (ACD) Controls check box is active in the application settings under 
Application Configuration  > Capability Settings.

Step by Step

1) Click in the palette on the AcdInit control and drag it into the callflow editor. 

2) Release the mousebutton.

3) Double-click this control.

4) If required, change the value in the Name and Description field.

5) Activate the Use custom Contact Center check box and enter the name the 
contact center has on the OSCC server (OpenScape Contact Center) in this 
field.

If you do not specify a value, the default value is used.

6) If the queue belongs to a specific customer on the contact center server, you 
must activate the Use custom Business Unit check box and enter the name 
of the business unit in this field.

If you do not specify a value, the default value is used.

7) Click on the Phone Call tab.

8) In the Variable for Call Identifier field, select the variable of type string that 
contains the internal ID of the call. This ID may have been assigned for 
example in the CreateCall control.

Next steps

Typically, use the AcdStart control next to enqueue the call in a contact center 
queue, to prioritize it, to assign it to a contact center agent and to specify 
additional contact data for the call.

5.8.2  AcdStart Control

You can configure the following properties in the AcdStart control:

• Name of the queue in which a call is enqueued

• How the call behaves while in hold mode

• Call priority

• Preferred agent to process the call

• Waiting time in which the attempt is made to reach the preferred agent

• Assigning contact information to the call

• Assigning statistics variables 
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– Calls in the queue

– Position in the queue

– Estimated waiting time

• Variables used to store the result of the enqueue

5.8.2.1  How to Configure an AcdStart Control 

Prerequisites

• You can see ACD controls in the palette only if the Support of Contact 
Center (ACD) Controls check box is active in the application settings under 
Application Configuration  > Capability Settings.

• The contact center must have been determined through use of the AcdInit 
control.

Step by Step

1) Click in the palette on the AcdStart control and drag it into the callflow editor. 

2) Release the mouse button.

3) Double-click this control.

4) If required, change the value in the Name and Description field.

5) If you do not wish to use a variable for the name of the queue in which a call 
shall be enqueued, specify the queue name in the Specify by Text field. If you 
wish to use a variable for the name of the queue, activate the Specify by 

Variable radio button, click on , select a string variable and click on OK. 

After a call has been enqueued, it can be routed to a contact center agent.

6) Click on the Hold tab.

Hold mode allows you to specify how a call on hold will be held by the system 
while waiting for an agent to become available.

7) Select the hold mode for the call from the drop down menu. The following 
options are available:

• Hold in OpenScape Server (IVR Hold)

Holds the call within the OpenScape Server until an agent becomes 
available. The application will usually play a prompt while waiting for an 
agent and will continue running. When an agent becomes available the 
application gets notified by a corresponding runtime event that provides 
the transfer number the agent can be reached on.

• Hold in Contact Center (ACD Hold)

Holds the call within the Contact Center until and agent becomes 
available. The application will usually immediately transfer the call to the 
contact center and will stop running afterwards. When an agent becomes 
available, the contact center will route the call to the agent.

8) Click on Apply.
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9) Click on the Results tab.

When the hold mode is set in the Hold tab, the relevant variables become 
maintainable in the Results tab. This allows you to specify how to store the 
result of the enqueue or how to store the transfer number to the contact 
center. If you selected Hold in OpenScape Server (IVR Hold) then you can 
select the variables:

• to be used for calls in queue

• for estimated wait time

If you select Hold in Contact Center (ACD Hold) then you can select the 
variables for the transfer number.

10) Click on Apply.

11) Click on the Enqueue tab.

12) You can provide a custom description of the contact. An agent can obtain this 
description to use the information for identifying the call. If you wish such a 
description to be used, activate the Use custom Call Description check box.

INFO:  Do not confuse the custom description of the contact with 
the contact data. Such data is specified on the Contact Data tab 
(see below).

a) If you do not wish to use a variable for the custom call description, enter 
the description in the Specify by Text field.

b) If you wish to use a variable for the custom call description, activate the 

Specify by Variable radio button, click on , select an integer variable 
and click on OK. 

13) In the Call Priority section you can specify an initial priority of the call. 

a) If you do not wish to use a variable for the initial priority, select an integer 
value in the Specify by Text field.

b) If you wish to use a variable for the initial priority, activate the Specify by 

Variable radio button, click on , select an integer variable and click on 
OK. 

14) Click on Apply.

15) Click on the Agent tab.

16) You can assign the call to a preferred agent. In case of such an assignment 
the contact center will try to route the call to this agent within a specific period. 
If this routing fails, the call is enqueued in a queue. If no preferred agent is 
used, the call is instantly enqueued in a queue.

a) If you wish to assign a call to a preferred agent, activate the Use 
preferred Agent check box.

b) If you do not wish to use a variable for the ID of the preferred agent, enter 
the agent's ID in the Specify Agent by Text field.
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c) If you wish to use a variable for the ID of the preferred agent, activate the 

Specify Agent by Variable radio button, click on , select a string 
variable and click on OK. 

d) If you do not wish to use a variable for the period in which the attempt is 
made to route a call to the preferred agent, select an integer value in the 
Specify Timeout by Text field.

e) If you wish to use a variable for the period in which the attempt is made to 
route a call to the preferred agent, activate the Specify Timeout by 

Variable radio button, click on , select an integer variable and click on 
OK. 

17) Click on the Contact Data tab.

18) You can specify additional contact data for a call. Such contact data can be 
used to transfer further data to the contact center. The data can influence a 
call's routing and may be obtained by an agent who can use the data for 
identifying a call.

INFO:  Contact data can also be assigned to a call in the AcdCon-
tactData control.

a) Click on the icon to add an entry to the Contact Data List field.

b) If you wish to use a variable, click on the button, select a string variable 
and click on OK.

c) If you wish to use a permanent value, activate the Constant radio button 
and enter the value.

d) Click on OK.

e) In the contact data list, you can edit and delete entries as well as change 
their sequence.

f) Click on OK.

19) After a call has been enqueued, the number of calls in the queue, the position 
of the call in the queue and the estimated waiting time until an agent 
processes the call can be stored in variables. To do this, click on the button 

to the right of the Variable for Calls in Queue or Variable for Estimated 
Wait Time field, select an integer variable and click on OK.

20) Click on OK.

5.8.3  AcdExit Control

The AcdExit control cancels a call's registration in the contact center. The call can 
subsequently not be processed in the call center anymore. 
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5.8.3.1  How to Configure an AcdExit Control 

Prerequisites

• You can see ACD controls in the palette only if the Support of Contact 
Center (ACD) Controls check box is active under Application Configu-
ration  > Capability Settings.

• The contact center must have been determined through use of the AcdInit 
control.

• If the call was already in a queue, we urgently recommend to remove it from 
there using the AcdStop control before you cancel the call's registration in the 
contact center with help of the AcdExit control.

Step by Step

1) Click in the palette on the AcdExit control and drag it into the callflow editor. 

2) Release the mousebutton.

3) Double-click this control.

4) If required, change the value in the Name and Description field.

5) Click on OK.

Next steps

If the call center is to process the call at a later date again, the call must be previ-
ously registered with the contact center by the AcdInit.

5.8.4  AcdStop Control

The AcdStop control removes a call from the queue. A removed call is not routed 
to an agent. The call remains registered with the contact center, though.

5.8.4.1  How to Configure an AcdStop Control 

Prerequisites

• You can see ACD controls in the palette only if the Support of Contact 
Center (ACD) Controls check box is active in the application settings under 
Application Configuration  > Capability Settings.

• The contact center must have been determined through use of the AcdInit 
control.

• The call must have been enqueued in a contact center queue with help of the 
AcdStart control.
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Step by Step

1) Click in the palette on the AcdStop control and drag it into the callflow editor. 

2) Release the mousebutton.

3) Double-click this control.

4) If required, change the value in the Name and Description field.

5) Click on OK.

Next steps

If you wish to re-enqueue the call in the contact center queue at a later date, use 
the AcdStart control.

If required, you can unregister the call with the contact center using the AcdExit 
control. After the call has been unregistered, it cannot be processed by the call 
center anymore.

5.8.5  AcdCallback Control

You can use the AcdCallback control to configure the following properties of a 
callback:

• Name of the callback queue in which the callback shall be enqueued

• Contact who requested the callback

• Reason for the callback

• Time zone difference between UTC and local time of the caller

• Phone number for the callback

• Callback time ranges

– Start date

– Start time

– End date

– End time

5.8.5.1  How to Configure an AcdCallback Control 

Prerequisites

• You can see ACD controls in the palette only if the Support of Contact 
Center (ACD) Controls check box is active in the application settings under 
Application Configuration  > Capability Settings.

• The contact center must have been determined through use of the AcdInit 
control.
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Step by Step

1) Click on the AcdCallback control in the palette and drag it into the callflow 
editor. 

2) Release the mouse button.

3) Double-click the control.

4) If required, change the value in the Name and Description field.

5)  Specify the name of the callback queue in which the callback shall be 
enqueued.

a) If you do not wish to use a variable for the name of the callback queue, 
enter the queue name in the Specify by Text field.

b) If you wish to use a variable for the name of the callback queue, activate 

the Specify by Variable radio button, click on , select a string variable 
and click on OK.

You must specify the queue with the name it has on the contact center server.

6) Click on the Callback tab.

7) Specify the contact who requested the callback.

a) If you do not wish to use a variable for the contact, enter the contact in the 
Specify Contact by Text field. 

b) If you wish to use a variable for the contact, activate the Specify Contact 

by Variable radio button, click on , select a string variable and click on 
OK. 

8) Specify the callback reason.

a) If you do not wish to use a variable for the callback reason, enter the 
callback reason in the Specify Description by Text field. 

b) If you wish to use a variable for the callback reason, activate the Specify 

Description by Variable radio button, click on , select a string variable 
and click on OK. 
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9) If the person to be called back does not live in the UTC time zone, specify the 
difference between his/her time zone and UTC in hours.

a) If you do not wish to use a variable for the time zone difference, select the 
difference in the Specify by Text field. 

Time Zone Difference to UTC

Honolulu -10

Anchorage -9

Pacific Standard Time -8

Mountain Standard Time -7

Central Standard Time -6

Eastern Standard Time -5

Atlantic Standard Time -4

Sao Paulo -3

South Georgia -2

Azores -1

Reykjavik 0

London 0

Lisbon 0

Berlin 1

Madrid 1

Paris 1

Rome 1

Cairo 2

Johannesburg 2

Moscow 3

Tehran 3:30

Eriwan (Armenia) 4

Calcutta 5:30

Dhaka 6

Ho Chi Minh 7

Hong Kong 8

Shanghai 8

Taipei 8

Tokyo 9

Sydney 10

Solomon Islands 11

Auckland 12
A31003-S50A0-U103-02-7619, 10/2020
OpenScape UC Application V10 Fusion Application Builder, User Guide 405



Controls
Control Group ACD
b) If you wish to use a variable for the time zone difference, activate the 

Specify by Variable radio button, click on , select an integer variable 
and click on OK. 

10) Click on the Schedule tab.

11) Click on the icon to add an entry to the Callback Schedule List field.

12) The callback target is the phone number under which the person who initiated 

the callback can be reached. Click on the button next to the Variable for 
Phone Number field, select a string variable and click on OK.

13) Specify the time range in which the callback shall be performed. 

a) Click on the button next to the Variable for Start Date field, select the 
date variable that contains the earliest date for the callback and click on 
OK.

b) Click on the button next to the Variable for Start Time field, select the 
time variable that contains the earliest time on the start date for the 
callback and click on OK.

c) Click on the button next to the Variable for End Date field, select the 
date variable that contains the latest date for the callback and click on OK.

d) Click on the button next to the Variable for End Time field, select the 
time variable that contains the latest time on the end date for the callback 
and click on OK.

14) Click on OK.

15) In the callback schedule list you can create further entries, edit and delete 
them as well as change their sequence.

16) Click on OK.

5.8.6  AcdContactData Control

You can use the AcdContactData control to provide additional contact data. Such 
contact data can be transferred to the contact center. The data can influence a 
call's routing and may be obtained by an agent who can use the data for identi-
fying a call.

INFO:  Contact data can also be assigned to a call in the AcdStart 
control.
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5.8.6.1  How to Configure an AcdContactData Control 

Prerequisites

• You can see ACD controls in the palette only if the Support of Contact 
Center (ACD) Controls check box is active under Application Configu-
ration  > Capability Settings.

• The contact center must have been determined through use of the AcdInit 
control.

Step by Step

1) Click in the palette on the AcdContactData control and drag it into the callflow 
editor. 

2) Click on the icon to add an entry to the Contact Data List field.

3) If you wish to use a variable, click on the button, select a string variable and 
click on OK.

4) If you wish to use a permanent value, activate the Constant radio button and 
enter the value.

5) Click on OK.

6) In the contact data list, you can create further entries, edit and delete them as 
well as change their sequence.

7) Click on OK.

5.8.7  AcdRoutingInfo Control

You can use the AcdRoutingInfo control to store routing information about the call 
in a variable for the contact center to retrieve such information. Routing infor-
mation can be used to display the status of the routing progress and to improve a 
call's processing.

5.8.7.1  How to Configure an AcdRoutingInfo Control 

Prerequisites

• You can see ACD controls in the palette only if the Support of Contact 
Center (ACD) Controls check box is active in the application settings under 
Application Configuration  > Capability Settings.

• The contact center must have been determined through use of the AcdInit 
control.

Step by Step

1) Click in the palette on the AcdRoutingInfo control and drag it into the callflow 
editor. 

2) Release the mousebutton.
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3) Double-click this control.

4) If required, change the value in the Name and Description field.

5) Click on the  button to the right of the Variable for Result field and select 
the routing info variable in which information shall be stored. 

6) Click on OK.

7) Click on OK.

5.8.8  AcdQueueInfo Control

You use the AcdQueueInfo control to retrieve the status of a contact center queue. 
Queue information may improve a call's processing. 

5.8.8.1  How to Configure an AcdQueueInfo Control 

Prerequisites

• You can see ACD controls in the palette only if the Support of Contact 
Center (ACD) Controls check box is active in the application settings under 
Application Configuration  > Capability Settings.

• The contact center must have been determined through use of the AcdInit 
control.

Step by Step

1) Click in the palette on the AcdQueueInfo control and drag it into the callflow 
editor. 

2) Release the mousebutton.

3) Double-click this control.

4) If required, change the value in the Name and Description field.

5) Executing one of the following sub-steps, specify the name of the queue from 
which you wish to retrieve information. 

INFO:  The queue about which information shall be stored need 
not be the queue in which the current call is enqueued.

a) If you do not wish to use a variable for the name of the queue, enter the 
queue name in the Specify Queue by Text field. 

b) If you wish to use a variable for the name of the queue, activate the 

Specify Queue by Variable radio button, click on , select a string 
variable and click on OK.

You must specify the queue with the name it has on the contact center server.
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6) If the queue belongs to a specific customer on the contact center server, you 
must activate the Use custom Business Unit check box and enter the name 
of the business unit in this field.

7) Click on the Result tab.

8) Click on the  button and select the queue info variable in which information 
about the queue shall be stored. 

9) Click on OK.

10) Click on OK.

5.8.9  AcdCallInfo Control

You can use the AcdCallInfo control to receive information about a call. Such 
information helps improving the call processing.

5.8.9.1  How to Configure an AcdCallInfo Control 

Prerequisites

• You can see ACD controls in the palette only if the Support of Contact 
Center (ACD) Controls check box is active under Application Configu-
ration  > Capability Settings.

• The contact center must have been determined through use of the AcdInit 
control.

Step by Step

1) Click on the AcdCallInfo control in the palette and drag it into the callflow 
editor. 

2) Release the mouse button.

3) Double-click the control.

4) If required, change the value in the Name and Description field.

5) Click on the  button next to the Variable for Queue Position field, select an 
integer variable and click on OK.

6) Click on the  button next to the Variable for Call Status field, select a string 
variable and click on OK.

7) Click on OK.

5.9  Custom Controls

These controls are created by the client. The client may design controls according 
to his/her individual requests and can then integrate them into the Application 
Builder. The custom controls are listed in the controls palette. Therefore, a new 
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group must be created. The control has the same basic properties as the controls 
that are automatically provided by the Application Builder.

5.9.1  How to Create a Custom Control

Step by Step

1) Execute one of the following sub-steps:

a) Select the Tools > Configure Symvia Custom Controls... option from 
the menu bar.

b) Right-click the control palette and select the Custom Controls... option 
from the context menu.

The Configure Symvia Custom Controls dialog opens.

The following buttons are displayed:

Option Function

Add Via this button controls can be added. 

Edit Click on Edit to edit the properties of the selected con-
trol.

Copy Via this option you can copy a custom control
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2) Click on Add... to create a custom control.

The following dialog opens:

3) Click on the ... button to assign a java library to your control.

The Select File dialog opens. 

4) Click on the Import... button and select a Java archive.

5) Then click the OK button and then Next in the configuration dialog. 

6) Determine the desired implementation class in the Class of Custom 
Controls section from the drop-down list next to Java Class:.

In the Control Library Dependencies section you must specify the depen-
dencies of your determined implementation class.

Remove You may delete the selected control by clicking on it.

Up/ Down Using these icons you can move a selected control the 
list up or down.

Importing Custom Con-
trol from another Work-
space

Click this link to import a custom control from another 
workspace. The Import Symvia Custom Control dialog 
opens. Specify a workspace via Browse. The bottom 
section of the dialog displays all custom controls. Select 
the controls that you want to import and then click on 
OK.

Option Function
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Then click Next.

7) Click on Next.

8) Enter the control type in the Custom Control Settings section and add a 
description.

9) Click in the Custom Control Icons section on the ... button to assign icons to 
your control.

10) Click on Next.

11) In the Custom Control Category section select a group in which your control 
is to be placed from the drop-down list.

12) Click on Next.

13) Accomplish the configuration with a click on Finish.
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6  Deploying an Application

This section describes how to integrate your application into your PBX system. 
You should test your application before deploying it. For this, the Application 
Builder provides a simulator.

6.1  Simulating an Application

NOTICE:  The application to be simulated, the workspace 
prompts and the workspace grammars must not contain any 
errors. The connection to the OpenScape UC Application and 
other applications, however, may contain errors. Only those 
Symvia Control Compositions not used in the application to be 
simulated may contain errors.

Select one of the following methods for opening the Simulation of ’<application 
name>’ view:

• Click on the icon on the toolbar.

• Click on the black triangle in the icon on the toolbar and select the appli-
cation to be simulated.

• In the workspace view, click with the right mouse button on the application to 
be simulated and select Test Application....

Simulation view

The simulation view is divided in three parts. You can customize the size of the 
parts. The simulation can be configured in the upper left part. The upper right part 
serves to display variables and the lower part displays several messages.

Simulation control

To start or end your simulation you will find the Start simulation and Stop 
simulation. You can control the simulation in two different ways. If you would like 
to delay the single simulation steps, activate the Delay of each Step (ms): check 
box. At the right hand side you can enter the delay time (1-9999). If you would like 
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to conduct the simulation step by step, activate the Step through Simulation 
check box.

Simulation parameters

There are three parameters that you can edit:

• Caller number

• Called number

• Forwarded number

Simulation Status

Two states are displayed.

• Green signifies that the application to be tested is valid. If you have modified 
your application incorrectly, red writing signifies that the simulation is not 
possible.

• Blue writing shows the current simulation status.

Runtime Variables

Here you can watch all variables and their sub-variables. The variables are listed 
with their content. The variable value is refreshed after each simulation step. The 
last variable displayed is in blue writing. The variable that has been refreshed last 
is in red.

Runtime Process

This area represents the callflow. At the top on the right-hand side you can 
minimize or maximize the representation. The selected control shows at which 
position in the callflow you currently are.

The lower editor area serves for displaying different messages and provides 
configuration options during the simulation runtime. This editor area is divided in 
three sections.

Runtime Output

Here, messages at runtime are displayed. The messages are, depending on their 
type, of a different color. All messages start by default with a time stamp. The top 
right area features a toolbar for influencing the output.

All icons are listed in the following table.
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Runtime Input

If you have activated the Step through Simulation check box, the Continue 
Simulation becomes visible here. You can continue the simulation stepwise by 
clicking on this button.

NOTICE:  If you would like to toggle the simulation types, you 
must deactivate the current simulation type before defining a new 
one.

Icon Function

Via this button you can freeze the message output. A click with the 
left mouse button selects the icon and the ongoing message display 
stops. To view the current messages you need to navigate to the 
respective position. Another click undoes the selection and ongoing 
messages are displayed again.

Via this button you can remove all messages in the output area.

Via the following buttons you can show or hide messages. The messages have certain 
writing colors that match the icon colors. A click with the left mouse button selects the 
icon and the selected message type is no longer displayed. Another click undoes the 
selection and messages of this type are displayed again.

Hide Status Messages

The status messages are in black writing. Status messages are 
messages about the simulation status, e.g. processing the ’Control 
Name’ control.

Hide Prompt Messages

The prompt messages are in green writing. 

Hide Input Messages

The input messages are in blue writing. Input messages are mes-
sages about events that have been executed at runtime.

Hide Variable Messages

The variable messages are in yellow writing. Variable messages 
have the format: "Assigning Value ’Value’ to Variable ’Variable 
name’".

Hide Information Messages

The information messages are in purple writing. Information mes-
sages are messages

Reset Message Filters

With a click on this button you undo all hidings.
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Runtime Events

In this section you can specify an event type from a combo box and send the 
event via the FireEvent button. The running simulation works internally with a 
copy. If you make changes to your application, you must restart the simulation to 
trace the effects of your changes.

6.2  How to Provide an Application (Deployment)

Prerequisites

• The application to be deployed, the workspace prompts and the workspace 
grammars must not contain any errors. The connection to the OpenScape UC 
Application and other applications, however, may contain errors. So may 
Symvia Control Compositions not used in the application to be deployed.

• While deploying an IVR application on a connected Media Server the appli-
cation can be bound to one or more phone numbers. To avoid binding 
conflicts it will be checked if at least one of these phone numbers is already 
bound to another IVR application. In this case the application has to be 
deployed with another phone number binding. Multiple phone number 
bindings of an deployed IVR application can also be changed in the Appli-
cation Management of the Application Builder without redeploying the appli-
cation. But a change to a phone number binding which is already in use by 
another IVR application is also not possible. To support multiple phone 
number bindings within the Application Builder, multiple phone numbers can 
be specified by a comma separated list. It is also possible to specify phone 
number ranges. The format of a multiple phone number binding is:

– phoneNumberBinding := number | range ["," number | range]*

– range := number "-" number

– number := ["+"]digit*

• If the application to be deployed contains a Webservice control, provide the 
following data of the web service. They will be needed in step 37.

INFO:  You find these data in the Application Builder if you select 
a web service in the workspace view under <application name> 
> Application Settings > Application Webservices > All 
Symvia Application Webservices or under Symvia Control 
Compositions > <composition name> > Composition 

Field Description

Webservice Name The name serves as unique identifier of the webservice. 

Webservice Description Optional webservice description. 

Webservice Type The type determines the architectural style, for example REST archi-
tecture, or the protocol used, for example SOAP. 

Webservice Access URI Specify the Werbservice Access URI used for connecting to the ser-
vice. Example:

http://weather.yahooapis.com/forecastrrs?=94089u=c
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Settings > Composition Webservices > All Symvia Compo-
sition Webservices.

• If the application to be deployed contains a DatabaseRead or DatabaseWrite 
control, provide the following database data. They will be needed in step 39.

INFO:  You find these data in the Application Builder if you select 
a database in the workspace view under <application name> > 
Application Settings > Application Databases > All Symvia 
Application Databases or under Symvia Control Composi-
tions > <composition name> > Composition Settings > 
Composition Databases > All Symvia Composition 
Databases.

Step by Step

1) In the menu bar, click on the icon to provide the current application or 
select an application from the combo box via the triangle.

The Application Deployment dialog opens.

2) There are two options: If you wish to deploy the application directly on the 
OpenScape UC Application, continue with step 3. If you wish to create the 
application locally and copy it to the OpenScape UC Application manually, 
continue with step 17.

3) If the Currently not connected to an OpenScape Server message is 
displayed, select a value in the server profile field.

If there are no values for selection, create a server profile under Workspace 
> OpenScape Servers > Server Profile Configuration first.

4) Click on Login.

5) Enter the password for this server profile.

6) Click on the OK button.

Field Description

Database Name The name serves as unique identifier of the data-
base. 

Database Description Optional description of the database. 

Database Driver Class-
name

Specify the Java class name that corresponds to the 
driver from the specified archive.

Database Access URL Specify the Database Access URL in the described 
format.

jdbc:mysql://<Host>:3306/<database>

Database Login User Specify the user name for authentication.

Database Login Password Specify the login password for authenticating the 
user.
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7) Click on Next.

8) If this application can be triggered by an ’Incoming Call’ start event, enter the 
telephone number under which the application is to be reached in the Phone 
Number: field.

9) You can activate the Enable Runtime Tracing check box.

If you activate this check box, the application will create log data in the server 
log. This data may help you understanding problems or errors that occurred 
at the application's runtime.

With this check box enabled, all controls configured for this purpose will 
create log data. The controls will not create any log data if the check box 
remains disabled.

10) Click on Next.

11) Activate or deactivate the check boxes on the left-hand side in the Language 
workspace to provide the respective language.

12) Click on Next.

13) You can activate the Create full Export including Resource Files check 
box.

The created deployment package contains automatically an export of the 
application that corresponds to a single archive file. This ensures that the 
application is represented consistently on both the OpenScape UC 
Application and the corresponding application within the workspace.

The created archive file always contains definition files that form the appli-
cation and its compositions used. Furthermore, you can create the archive 
inclusive the resource files (prompt media files, grammar files, etc.) used, this 
providing a complete backup copy of the local application.

Please note that including the resource files will enlarge the archive file. As a 
result, transferring the export to the OpenScape UC Application will be more 
time consuming.

14) Click on the Finish button.

15) Click on the OK button.

16) Continue with step 26.

17) Activate the Deploy into a local Deployment Package check box.

18) Enter the directory for the deployment package in Target Folder:. Click on the 
Browse button to select a directory.

19) Enter the telephone number under which the application is to be reached in 
the Phone Number: field.

20) Click on Next.

21) Activate or deactivate the check box Enable Runtime Tracing.

22) Click on Next.

23) Activate or deactivate the check boxes on the left-hand side in the Language 
workspace to provide the respective language.
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24) Click on Finish. 

A dialog that confirms the successful deployment opens. Click the OK button 
to close the dialog.

25) To apply the application, the deployment package must be loaded on the 
Media Server. You find detailed information about how to proceed in the 
Administrator Documentation OpenScape Media Server.

Continue with step 26.

26) The application is now deployed on the OpenScape UC Application and can 
be configured. Log on to the CMP.

27) Open Configuration > UnifiedCommunications > Configuration > Media 
Server.

28) Double-click the computer on which the media server is installed.

NOTICE:  The names of the OpenScape UC Application 
computers displayed here are determined in the knut.respon-
sefile.txt file during the OpenScape UC Application setup. 
Typically, these names are no host names or FQDNs. The default 
value for the back end computer of the OpenScape UC Appli-
cation (application computer) is offboard. Please obtain details 
from the OpenScape UC Application, Installation and Upgrade 
setup guide.
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29)  Click on the Applications tab.
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An entry with the application's name, for example SymviaApplication1, is 
displayed.

30) Click on this entry.
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31) If you use a proxy server the configuration of which shall be detected automat-
ically, activate the Automatically detect Proxy Server Settings radio 
button.

If you wish to configure the proxy server manually, activate the Manual Proxy 
Server Configuration radio button and execute the following sub-steps:

a) Enter the proxy server's IP address in the HTTP(S) Proxy Server field.

b) Enter the port number of the port the proxy server communicates over in 
the Port field.

c) If required, activate the Enable Proxy Server Authentication check box 
and fill the User name field with the user name to be deployed and the 
Password field with the password.

32) Select the language to be used by the application as default in the Appli-
cation Default Language field.

33) If you do not wish to use the default address translation context, select 
another value in the Address translation context field.

On the CMP, address translation contexts are created under Configuration 
> Unified Communications > Configuration > Address Translation 
Contexts. Please obtain details on this from the OpenScape UC Application, 
Installation and Upgrade setup guide and the administrator documentation 
OpenScape UC Application, Configuration and Administration.

34) Click on the Deployment tab.
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35) If the application is to create log data, activate the Enable Runtime Tracing 
check box.

36) Click on the Application Webservices tab.
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37) If you use a Webservice control in the application, select a web service in the 
All Application Webservices section and enter the values for the following 
fields:

Use the values you see in the Application Builder when you select a web 
service in the workspace view under <application name> > Application 
Settings > Application Webservices > All Symvia Application Webser-
vices or under Symvia Control Compositions > <composition name> > 
Composition Settings > Composition Webservices > All Symvia Compo-
sition Webservices.

38) Click on the Databases tab.

39) If you use a DatabaseRead or DatabaseWrite control in the application, select 
a database in the All Databases section and enter the values for the following 
fields:

Field Description

Webservice Name The name serves as unique identifier of the webser-
vice. 

Webservice Description Optional webservice description. 

Webservice Type The type determines the architectural style, for exam-
ple REST architecture, or the protocol used, for 
example SOAP. 

Webservice Access URI Specify the Werbservice Access URI used for con-
necting to the service. Example:

http://weather.yahooapis.com/
forecastrrs?=94089u=c
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Use the values you see in the Application Builder when you select a database 
in the workspace view under <application name> > Application Settings > 
Application Databases > All Symvia Application Databases or under 
Symvia Control Compositions > <composition name> > Composition 
Settings > Composition Databases > All Symvia Composition 
Databases.

40) Click on the Save button.

41) If the OpenScape UC Application is available in the Large Deployment or Very 
Large Deployment scenario and several Media Server computers are 
present, execute steps 28 to 40 for all other Media Server computers also.

Please obtain details on the Large Deployment and Very Large Deployment 
scenarios from the OpenScape UC Application Planning Guide.

6.3  Practical Example

This section illustrates by means of an example the creation of an application that 
includes a composition and is meant to help you to familiarize with the Application 
Builder's functionality.

NOTICE:  You find example applications and compositions in the 
Samples folder. This folder is automatically created during the 
installation. You find detailed information in the section Importing 
a Workspace Item.

6.3.1  Creating a Concept

At first, a concept with the demands to the voice application will first be formulated 
and the proceeding defined. Subsequently, the application or composition will be 

Field Description

Database Name The name serves as unique identifier of the data-
base. 

Database Description Optional description of the database. 

Database Driver Class-
name

Specify the Java class name that corresponds to the 
driver from the specified archive.

Database Access URL Specify the Database Access URL in the described 
format.

jdbc:mysql://<Host>:3306/<database>

Database Login User Specify the user name for authentication.

Database Login Password Specify the login password for authenticating the 
user.
A31003-S50A0-U103-02-7619, 10/2020
OpenScape UC Application V10 Fusion Application Builder, User Guide 425



Deploying an Application
Practical Example
configured step by step in the extension, application and controls areas and 
eventually tested before being put into operation.

Before you configure an application or composition, you should first create a 
concept. Consider the following issues as a starting point:

• What sort of service will be offered to the callers?

• How many or which options are to be provided to the caller?

• What does my menu structure look like?

• Which announcement is necessary?

• Are time-dependent announcements necessary?

• Which telephone numbers are provided?

Make Draft

After you have written down the course of the procedure, you should outline your 
draft. A draft is quite useful for representing the entire flow of your customer 
service over the telephone.

This draft is to contain a tree structure with “branches” and “leaves”. Each of these 
leaves corresponds to a control of the Application Builder.

Each Application Builder control represents a specific action in the application 
and has thus individual functions. For example, there is a control for playing back 
the greeting text, a control for checking the connected user and a control for 
forwarding to the authentication.

Using the draft you can check whether the application structure has a closed form. 
This means that each tree branch in the draft must lead to a control that either 
finishes the call or routes to a further control.

With the help of the designed concept and the draft as starting point the creation 
of the application is continued with the Application Builder.
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6.3.2  Practical Example Composition

The example application forms the basis of the function to retrieve the presence 
status of a connected user: Logon. The composition checks whether a user is 
connected to the system. If this is not the case, the user has to log on to the 
system. The composition is stored as example in the Samples folder and can be 
imported. You find detailed information in the section Importing a Workspace 
Item.

Prerequisite for creating the composition

• Systeminfo Control: Retrieving the current login status. 

• Compare Control: Querying whether a user is currently logged on.

• DTMF Input Control: Command prompt via DTMF input.

• Authentication Control: User is authenticated. 

• Prompt Control: Acoustic playback for user orientation.

• Assign Control: Assigns the user.

• ChangeNumericPassword Composition: The composition asks the 
logged-in user to change the password.

Composition structure

The composition starts via the Composition Entry. The Systeminfo returns 
whether a user is connected. After the information playback has finished, the call 
is transferred to the Compare control. 
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The Compare control compares the user. If the user is connected, the call is 
forwarded to the Assign control and after the assignment the login is finished 
successfully. 

If the Compare control returns no match, the user is asked to log on. The call is 
forwarded to the DTMF Input Enter Extension. After the confirmed entry the 
DTMF input Enter numeric password takes place. After the confirmed input the 
user authentication takes place. 

The authentication is extensive because of the possible results and the 
respective forwardings. The control disposes of 6 exits that will be explained in 
the following paragraph:

• Logon Successful: The call is forwarded to the Assign control. After the 
assignment the login is finished successfully.

• Invalid Logon Data: The call is forwarded to the Authentication failed 
prompt. An announcement is played for the user and he/she is asked to 
repeat the DTMF input. The call is again forwarded to the DTMF Input. The 
number of login repetitions are defined beforehand. By default, three login 
attempts are configured. 
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• Account Locked: The account is locked if the authentication has failed 
during the defined repetitions. The call is forwarded to the Account locked 
prompt. An announcement is played for the user. The authentication is 
completed without success. 

• Error: If an error occurs during the authentication, the call is forwarded to the 
Service not available prompt. An announcement is played for the user. The 
authentication is completed without success.

• Too many attempts: The call is forwarded to the Too many login attempts 
prompt, if the authentication has failed during the defined repetitions. An 
announcement is played for the user. The authentication is completed without 
success.

• Change PIN required: The user is asked to change his/her password. The 
call is forwarded to the PIN needs to be changed prompt. An announcement 
is played for the user. The call is transferred to the change password compo-
sition. 
In the change password composition, the user needs to change his/her 
password. If the process is successful, the call is transferred to the Authenti-
cation control. If the user does not change his/her password, the authenti-
cation has failed.

The composition is completed with the Composition Exit either with Authenti-
cation Successful or Authentication Failed. The call is transferred to the appli-
cation control that follows in the callflow. In this practical example the Presence 
control follows in the Get Presence State application.

6.3.3  Practical Example Application

The example application forms the basis of the function to retrieve the presence 
status of a connected user: Get Presence State. This application is stored as 
example in the Samples folder and can be imported. You find detailed information 
in the section Importing a Workspace Item. 

Prerequisite for creating the application

• Presence Control: Retrieving the current status of a certain user

• Presence Control: Announcement of the current status of a certain user

• Login Control Composition: The composition checks whether a user is 
connected to the system. If this is not the case, the user has to log on to the 
system. 

Application structure

The application starts. The user is forwarded to the login. Login (Login Control 
Composition) checks whether a user is connected to the system. If no user is 
logged on to the system, the user is asked to log on to the system. 
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If the login was incorrect, the caller is forwarded to an Error Prompt that is 
played. The number of login repetitions are defined beforehand. By default, three 
login attempts are configured. If the login is successful, the call is transferred to 
the Presence control. 

In the Presence control the Retrieve Presence State of a User function is 
activated. The query variable contains the user account. If the presence query is 
incorrect, the caller is forwarded to an Error Prompt that is played. The appli-
cation is finished with the End control. 

Next comes a Prompt control that plays the retrieved user status. The 
announcement is composed of a prompt file and a variable that queries the status 
already in the Presence control. The prompt contains the phrase: The presence 
state is...<variable value>

Prerequisite for the application

• Minimum requirement is OpenScape UC V6

• The application must be operated on an OpenScape UC Media Server, since 
the OpenScape Presence Service is used. 

• A TTS server must be configured on the MediaServer. 
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